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About This Guide
Intended Audience

1.1

1.2

1.3

About This Guide

This guide provides comprehensive instructions for system administration and the daily operations
and maintenance of Oracle Financial Services Transaction Filtering. The logical architecture provides
details of the Transaction Filtering process for a better understanding of the pre-configured
application, which allows you to make site-specific enhancements using OFSAAI.

Intended Audience

This Administration Guide is designed for use by the Implementation Consultants and System
Administrators. Their roles and responsibilities, as they operate within Oracle Financial Services
Transaction Filtering, include the following:

Implementation Consultant: Installs and configures Oracle Financial Services Transaction
Filtering at a specific deployment site. The Implementation Consultant also installs and
upgrades any additional Oracle Financial Services solution sets and requires access to
deployment-specific configuration information (For example, machine names and port
numbers).

System Administrator: Configures, maintains, and adjusts the system, and is usually an
employee of a specific Oracle customer. The System Administrator maintains user accounts and
roles, configures the EDQ, archives data, loads data feeds, and performs post-processing tasks.

Access to Oracle Support

Oracle customers have access to electronic support through My Oracle Support (MOS). For
information, visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info

Or visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing-impaired.

How This Guide is Organized

The Oracle Financial Services Transaction Filtering Administration Guide includes the
following chapters:

About Oracle Financial Services Transaction Filtering provides a brief overview of the Oracle
Financial Services Transaction Filtering application.

Getting Started explains common elements of the interface, includes instructions on how to
configure your system, access Transaction Filtering, and exit the application.

Managing User Administration explains the user administration of the Oracle Financial Services
(OFS) Transaction Filtering application.

General Configurations describes how to configure the SWIFT (Society for Worldwide Interbank
Financial Telecommunication) message and screening parameters, run the migration utility, run
the Purge utility, and do Version Control for messages in the Oracle Financial Services
Transaction Filtering application.

Configuring the SWIFT Message Parameters describes how to configure the SWIFT message
parameters.

Configuring the Fedwire Message Parameters describes how to configure the Fedwire message
parameters.

Configurations for the ISO20022 Message Parameters describe how to configure the ISO20022
message parameters and run the ISO20022 batch.
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About This Guide
Where to Find More Information

1.4

1.5

Configurations for the US NACHA Batch Process describes how to configure the US NACHA
batch.

Enterprise Data Quality (EDQ) Configurations describes how to configure the EDQ parameters.

Configuring Risk Scoring Rules describes how to configure business rules in the Inline
Processing Engine (IPE).

Creating a JSON describes how to create a JavaScript Object Notation (JSON) for SWIFT
messages with sequences and SWIFT messages without sequences.

Appendix A: Watch Lists explains the details of each of the pre-configured watch lists that can be
used by Oracle Transaction Filtering.

Appendix B: System Audit Logging Information contains information on the logs related to the
Debug and Info log files.

Appendix C: Process Modeller Framework (PMF) Configurability describes how to configure the
Process Monitor Facility (PMF) workflow.

Appendix D: Time Zone Configuration describes how to set the time zone for a user.

Appendix E: Delta Watch List Configurations describes how to run and download the delta
updates.

Appendix F: Message Categories and Message Types shows the different message types
available for the SWIFT, Fedwire, ISO 20022, and US NACHA message types.

Where to Find More Information

For more information about Oracle Financial Services Transaction Filtering, see the following
Transaction Filtering application documents, which can be found on the Oracle Help Center page:

User Guide

Installation and Configuration Guide
Matching Guide

Reporting Guide

To find additional information about how Oracle Financial Services solves real business problems, see
our website at Oracle for Financial Services home page.

Conventions Used in this Guide

The following table mentions the conventions used in this guide.

Table 2: Conventions Used

Table 2lists the conventions used in this guide.

Table 2: Conventions Used in this Guide

Conventions Description

Italics e Names of books, chapters, and sections as references

e Emphasis
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About This Guide
Conventions Used in this Guide

Table 2: Conventions Used in this Guide

Conventions Description

Bold e The object of an action (menu names, field names, options,
button names) in a step-by-step procedure

e Commands typed at a prompt

e Userinput

Monospace e Directories and subdirectories
e File names and extensions
e Process names

e Code sample, including keywords and variables within the text
and as separate paragraphs, and user-defined program ele-
ments within the text.

Asterisk Mandatory fields in User Interface

<Variable> Substitute input value
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2.1

About Oracle financial Services Transaction Fil-
tering

Oracle Financial Services Transaction Filtering is a Sanctions screening system that identifies
Individuals, entities, cities, countries, goods, ports, BICs, and Stop keywords that may either be
suspicious, restricted, or sanctioned with relation to a financial transaction that is processed through
the Transaction Filtering application. The application enables you to integrate with any clearing or
payment system, accept messages from the source system, and scans them against different watch
lists maintained within the application to identify any suspicious data present within the message. The
Transaction Filtering application can scan messages which are in the SWIFT, ISO20022, Fedwire, or
NACHA category, or any custom format.

The OFS Transaction Filtering application is built using components of the Oracle Financial Services
Analytical Applications (OFSAA) product suite. These components are Oracle Enterprise Data Quality
(OEDQ) and Inline Processing Engine (IPE).

Financial Institutions are required to comply with regulations from different authorities. Some of them
are as follows:

USA PATRIOT Act

U.S. Treasury's Office of Foreign Assets Control (OFAC), USA

Office of the Superintendent of Financial Institutions (OSFI), Canada
Financial Action Task Force (on Money Laundering) (FATF/GAFI)

EU Commission

Country-specific authorities

While the regulations can differ between countries, the spirit of regulatory intervention is uniform, and
that is to hold financial institutions responsible and accountable if they have been a party, intentionally
or unintentionally, to a criminal or terrorist-related transaction.

Sanctions include the withholding of diplomatic recognition, the boycotting of athletic and cultural
events, and the sequestering of the property of citizens of the sanctioned country. However, the forms
of sanctions that attract the most attention and are likely to have the greatest impact are composed of
various restrictions on international trade, financial flows, or the movement of people.

Transaction Filtering against government-regulated watch lists and internal watch lists is a key
compliance requirement for financial institutions across the globe. At the turn of the century, Financial
Institutions (Fls) were expected to identify customers who were either sanctioned or who lived in
sanctioned countries and identify any transactions which were associated with these customers. Fls are
now expected to also identify any suspicious dealings and parties involved in the transaction, and more
recently identify information that is deliberately hidden or removed.

The Transaction Filtering application delivers a strong, effective filter that identifies all sanctioned
individuals or entities with true positives and exploits all available information (internal and external) to
reduce false positives and therefore minimizes the operational impact on Fls.

Transaction Filtering Workflow

The following image describes the Transaction Filtering workflow.
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Figure 1: Transaction Filtering Workflow
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The application first receives a message from the payment system and scans it against the watch lists,
then provides a risk score for the message. If no suspicious data is found during screening, then the
Transaction Filtering application sends a feedback message with the status CLEAN back to the
payment system through the message queue. If suspicious data is found during screening, then the
message is sent to an Analyst who investigates it using the Transaction Filtering User Interface.
Feedback is sent to the payment system through a message queue, which indicates that the message is
on hold. The Analyst reviews the message, which is the first level of review and decides to release,
block, or escalate the message. Based on the decision, the system sends a feedback message, either
CLEAN or BLOCKED, to the payment system for the reviewed message.

If the four-eyes workflow is enabled, then the Analyst can additionally Recommend to Release,
Recommend to Block, or escalate the message to the Supervisor. If the Analyst escalates the message,
then the message is sent to the Supervisor, which is the second level of review. The Supervisor can
block or release the message and add comments. For a four-eyes workflow, the Supervisor can Release,
Block, or Reject the message. You can view the associated matched data of a message from the Match
Summary section. You can also view the risk score details from the Risk Summary section. Both these
sections are present in the Investigation User Interface.
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Getting Started

This chapter provides step-by-step instructions to log in to the Transaction Filtering System and
different features of the Oracle Financial Services Analytical Applications (OFSAA) Application page.

Accessing the Oracle Financial Services Analytical
Applications (OFSAA) Page

Access to the Oracle Financial Services Transaction Filtering application depends on the Internet or
Intranet environment. The system administrator provides the intranet address uniform resource locator

(URL), User ID, and Password.

NOTE After the first login, you will be prompted to change your
password.

To access the Oracle Financial Services Analytical Applications page, follow these steps:
1. Enter the URL into your browser using the following format:

<scheme/ protocol>://<ip address/ hostname>:<port>/<context-name>/
login.jsp

For example: https://myserver:9080/ofsaaapp/login.jsp

The Oracle Financial Services Analytical Applications login page is displayed.

Figure 2: Oracle Financial Services Analytical Applications Login Page

ORACLE Financial Services Analytical Applications

Language US-English 'S
User ID

Password
Login
Version 8.0.8.1.0

Copyright © 1993, 2020, Oracle and/or its affiliates. All rights reserved.

2. Select the language from the Language drop-down list. This allows you to use the application in
the language of your selection.

3. Enter your User ID and Password in the respective fields.

4. C(lick Login. The Financial Services Analytical Applications Transactions Filtering landing
page is displayed.
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Figure 3: Financial Services Analytical Applications Transactions Filtering Landing Page

— ORACLE’ @ G Us-English +  ANALYST v E) A

APPLICATIONS

Financial Services Analytical
Applications Transactions
Filtering

Application for transactions filtering

5. To view the Financial Services Analytical Applications Transactions Filtering landing page,

click Calendar .

3.2 Managing the Oracle Financial Services Analytical
Applications (OFSAA) Page

From the Oracle Financial Services Analytical Applications page, you can access the menus for the
different message configurations. You can change the default transaction currency from USD to
another currency in the Process Modeller page and view the Good Guy Summary page, which has
details related to the records added in the good guy list.

3.2.1 Transaction Filtering Admin Menu

The Transaction Filtering Admin menu allows the system administrator to configure the application-
level parameters, good guy matching parameters, the cut-off time for messages, and assignment type
for a message (manual or automatic). For more information, see General Configurations.

To view the menu, follow these steps:

1. From the Navigation List, click Financial Services Sanctions Pack.

Figure 4: Financial Services Sanctions Pack Menu

= ORACLE rinancial Services Analytical Applications Transactions Filtering

Navigation List

Common tasks >

Financial Services Sanctions Pack >
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3.2.2

2. From the Navigation List, click Transaction Filtering Admin. The Configuration Screen dis-
plays.

Figure 5: Transaction Filtering Admin Sub-menu

@& Home — ORACLE Financial Services Analytical Applications Transactions Filtering

Financial Services San...

Transaction Filtering Admin

1s020022/XML Configuration Admin

SWIFT Configuration Admin

FEDWIRE Configuration Admin

Process Modeller

Post Load Changes

Process Monitor

Run Definition

List Management

Inline Processing

ISO20022 Configuration Admin Menu

The 1S020022/ XML Configuration Admin menu allows the system administrator to configure the
I1SO20022 parser parameters. For more information, see Configurations for ISO20022 Message
Parameters.

To view the menu, follow these steps:

1. Click Financial Services Sanctions Pack.

Figure 6: Financial Services Sanctions Pack Menu

# Home — ORACLE rinancial Services Analytical Applications Transactions Filtering
Navigation List

Common tasks >

Financial Services Sanctions Pack >

1. Click 1IS020022/XML Configuration Admin. The Configuration Screen displays.
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3.2.3

Figure 7: 1S020022/XML Configuration Admin Sub-menu

A Home

Financial Services San...

Transaction Filtering Admin

1S020022/XML Configuration Admin

SWIFT Configuration Admin

FEDWIRE Configuration Admin

Process Modeller

Post Load Changes

Process Monitor

Run Definition

List Management

Inline Processing

ORACLE Financial Services Analytical Applications Transactions Filtering

SWIFT Configuration Admin Menu

The SWIFT Configuration Admin menu allows the system administrator to configure the SWIFT
parser parameters. For more information, see General Configurations.

To view the Configuration Admin menu, follow these steps:

1.

Click Financial Services Sanctions Pack.

Figure 8: Financial Services Sanctions Pack Menu

# Home

Navigation List

Common tasks

Financial Services Sanctions Pack

>

>

ORACLE rinancial Services Analytical Applications Transactions Filtering

Click SWIFT Configuration Admin. The Configuration Screen displays.
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Figure 9: SWIFT Configuration Admin Sub-menu

# Home = ORACLE Financial Services Analytical Applications Transactions Filtering

Financial Services San...

Transaction Filtering Admin

1S020022/XML Configuration Admin

SWIFT Configuration Admin

FEDWIRE Configuration Admin

Process Modeller

Post Load Changes

Process Monitor

Run Definition

List Management

Inline Processing

3.2.4 Process Modeller Menu

The Process Modeller menu allows the System Administrator to provide the security and operational
framework required for the Infrastructure.

You can view the PMF process flow for the standard, four-eyes, and good guy workflows. For more
information on the workflows, see the Transaction Filtering WorkFlows section in the Oracle
Financial Services Transaction Filtering User Guide.

To view the ready-to-use PMF flows, click Process Modeller. The Process Modeller page is displayed.
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3.2.4.1

Figure 10: Process Modeller Page

Process Modeller

Sort by: | b I Fipsling Citars Process X || Run X | Stream X |
Business Restructure Process 0 0 Application:Business Restructure
Process Code: BR1 Type:Business Process Pipeline
Process Description: Business Restructure Process Version Instances
Questionnaire Process 0 0 Application:Questionnaire
Process Code: QTNR ) ) Type:Business Process Pipeline
Process Description: Questionnaire Process Version Instances
ECM CS Real Time Screening 0 0 Application:Customer Screening
Process Code: CSRT ) Type:Business Process Pipeline
Process Description: ECM CS Real Time Screening Version Instances
TF List Management 0 10 Application:TF List Management
Process Code: OFS_SAC_LIST . Type:Business Process Pipeline
Process Description: TF List Management Version Instances
Transaction Filtering 0 0 Application:Transaction Filtering
Process Code: OFS_SAC Type:Business Process Pipeline
Process Description: Transaction Filtering Version Instances

To expand the window, click Navigation Menu —.

Configuring the Transaction Currency

You can change the default transaction currency (USD) to another currency. To configure the currency,
follow these steps:

1. Onthe Process Modeller page, click the Application Rule subtab.
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3.2.5

Figure 11: Application Rule Subtab

Process Flow Definition Application Rule DataFields @
B Add - Edt | 3 Delete
Select Rule Name Rule Type Implementation Type
Sup_Access_Aftr_ Rule DecisionRule Atiribute Expression
O Analyst_Access_Aftr Rule DecisionRule Affribute Expression
O Default DecisionRule  SQL
Cutcome Approve DecisionRule Cutcome
@] COutcome Reject DecisionRule  Outcome
O Qutcome Subrmit DecisionRule  Qutcome
O Hold_Outcome DecisionRule  Cutcome
@] Asgsigned_Outcome DecisionRule  Outcome
Escalate_Outcome DecisionRule Cutcome
@] Release_Quitcome DecisionRule  Outcome
O Block_Outcome DecisionRule  Cutcome
i F_to_Release Cutcome DecisionRule Atiribute Expression
O R_to_Block_Outcome DecisionRule Attribute Expression

2. Tochange the currency for a released transaction, select R_to_Release_Outcome. To change the
currency for a blocked transaction, select R_to_Block_Outcome.

3. Click Edit.
4. C(Clickinside the TF_Currency drop-down list and select the required currency.
Click Save.

FEDWIRE Configuration Admin Menu

The FEDWIRE Configuration Admin menu allows the system administrator to configure the Fedwire
parser parameters. For more information, see General Configurations

To view the FEDWIRE Configuration Admin menu, follow these steps:

1. Click Financial Services Sanctions Pack.
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3.2.6

Figure 12: Financial Services Sanctions Pack Menu

ORACLE Financial services Analytical Applications Transactions Filtering

Navigation List

Common tasks >

Financial Services Sanctions Pack >

1. Click FEDWIRE Configuration Admin. The Configuration Screen is displayed.

Figure 13: FEDWIRE Configuration Admin Sub-menu

# Home = ORACLE Financial Services Analytical Applications Transactions Filtering
Financial Services San...

Transaction Filtering Admin

1S020022/XML Configuration Admin

SWIFT Configuration Admin

FEDWIRE Configuration Admin

Process Modeller

Post Load Changes

Process Monitor

Run Definition

List Management

Inline Processing

Process Monitor Menu

The Process Monitor menu allows the System Administrator to configure the workflow for a process.
To do this, click Process Monitor. The Process Monitor page is displayed.
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Figure 14: Process Monitor Menu Page

Process Monitor

Execution Start Time: 26-APR-19

Process Name: Transaction Filtering ., . -
50542 Process Description: Transaction o N
Object Id: 50542 Filtering I;$s1t7E0)§)ecutlon Time: 26-APR-19

Execution Start Time: 26-APR-19

Process Name: Transaction Filtering
50541 - rans 1N 14.16:59
Object Id: 50541 ';.’lfc9ss Description: Transaction | ;o4 Eyecution Time: 26-APR-19
Hienng 11:17:00

Execution Start Time: 23-APR-19

Process Name: Transaction Filtering S~~~
50501 Process Description: Transaction 08 02,50 " —
Object Id: 50501 Filtering Last Execution Time: 23-APR-19

06:02:38

Execution Start Time: 16-APR-19

Process Name: Transaction Filtering
50422 t LA °1NG 02:33:27
Object Id: 50422 ;rlf:iﬁfgs Description: Transaction | ot Execution Time: 23-APR-19
05:49:59

Execution Start Time: 12-APR-19

Process Name: Transaction Filtering S -
50402 Process Description: Transaction 09.90: 14 .
Object Id: 50402 Filtering Iagsstfzx;cutlon Time: 23-APR-19

To expand the window, click Navigation Menu —.

3.2.7 Run Definition Menu

The Run Definition menu allows the system administrator to run the batches for the message
categories.

To run the batches, follow these steps:

1. Click Financial Services Sanctions Pack.

Figure 15: Financial Services Sanctions Pack Menu

# Home = ORACLE Financial Services Analytical Applications Transactions Filtering
Navigation List

Common tasks

Financial Services Sanctions Pack >

1. Click Run Definition. The Run page is displayed.
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3.2.8

Figure 16: Transaction Filtering Admin Sub-menu

# Home

Financial Services San...

Transaction Filtering Admin

15S020022/XML Configuration Admin
SWIFT Configuration Admin
FEDWIRE Configuration Admin
Process Modeller

Post Load Changes

Process Monitor

Run Definition

List Management

Inline Processing

ORACLE Financial services Analytical Applications Transactions Filtering e o

List Management Menu

The List Management menu allows the system administrator to view the Good Guy Summary page.
For more information on the Good Guy Summary page, see the Good Guy Summary section in the
Oracle Financial Services Transaction Filtering User Guide.

To view the page, follow these steps:
1.

Click Financial Services Sanctions Pack.

Figure 17: Financial Services Sanctions Pack Menu

1.

# Home

Navigation List

Common tasks

Financial Services Sanctions Pack

ORACLE Financial Services Analytical Applications Transactions Filtering

Click List Management. The Good Guy Summary page is displayed.
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3.2.9

Figure 18: List Management Sub-menu

Inline Processing Menu

# Home

Financial Services San...

Transaction Filtering Admin

15020022/XML Configuration Admin

SWIFT Configuration Admin

FEDWIRE Configuration Admin

Process Modeller

Post Load Changes

Process Monitor

Run Definition

List Management

Inline Processing

ORACLE Financial services Analytical Applications Transactions Filtering e L3

The Inline Processing menu allows the System Administrator to view and configure the details related
to Inline Processing Engine (IPE). For more information, see Configuring Risk Scoring Rules.

To view the Inline Processing page, follow these steps:

1.

Click Financial Services Sanctions Pack.

Figure 19: Financial Services Sanctions Pack Menu

1.

Navigation List

Common tasks

>

Financial Services Sanctions Pack >

ORACLE Financial Services Analytical Applications Transactions Filtering

Click Inline Processing. The Inline Processing page is displayed.
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3-3

3.3.1

Figure 20: Inline Processing Sub-menu

# Home = ORACLE Financial Services Analytical Applications Transactions Filtering

Financial Services San...

Transaction Filtering Admin

15020022/XML Configuration Admin

SWIFT Configuration Admin

FEDWIRE Configuration Admin

Process Modeller

Post Load Changes

Process Monitor

Run Definition

List Management

Inline Processing

Queue Management

Queue Management is a common dashboard where the following users can see queues related to CS
and TF that are created by the Queue Administrator and the system (Out Of Box):

Analyst
Supervisor
Senior Supervisor
Queue Administrator
You can view the Queue details in the following formats:
List View
Grid View

By default, queue details are displayed in the List View. Only queue admin can assign the user groups
for the queues in the Grid View.

For more information on Queue Administrator, see the OFS Sanctions Queue Management User Guide.

List View

1. Login to the application as Analyst, Supervisor, or Senior Supervisor.
2. Select the Financial Services Analytical Applications Transaction Filtering.

3. From the Application Navigation List, select Queue Management.

You can select the hamburger = icon to view the Queue List for All Teams in List View.

By default, queue details are displayed in the List View.

Queue List displays the queues assigned to all user groups and the value. All Team is selected in the
drop-down list and is disabled. It is displayed as the title for Queue List.
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Figure 21: Queue List in List View

ORACLE Financial services Analytical Applications Transactions Filtering e * US-English QADMN » B
All Teams All Teams v E ®@

Queue List +Add Queue

ALL SAN ALERTS SUPERVISOR GEN  CS Supervisor Access Group 09/14/2021 02:16:27 by QADMN s B 8

DOMAIN

All SAN Alerts GEN DOMAIN ANALYST  CS Analyst Access Group 09/14/2021 01:26:59 by SYSTEM S w8

ALL SAN ALERTS SUPERVISOR CWS  CS Supervisor Access Group 09/14/2021 02:23:17 by QADMN PR

DOMAIN

RT GEN DOMAIN ANALYST CS Analyst Access Group 09/14/2021 08:06:12 by QADMN s 8w 8

RT CWS SUPERVISOR CS Senior Supervisor Access Group,CS Supervisor Access Group 09/14/2021 08:07:54 by QADMN PR )

The following details are displayed in the List View for All Teams:
Queue Name
User Group names (that are assigned by the Queue Administrator)
Date Time Created By (For example, 09/09/202114:06:39 by QADMIN/SYSTEM)
Queue Action
You can view ten queues in Queue List and use the navigation to view the next set of queues.

You can perform the following actions on each queue:

+Add Queue: Click button top-right in the Queue List to add a new queue. (only for
Queue Admin.)

Delete: Click the Ellipsis menu and then select Delete and click Yes to delete the queue.
Edit: Click the Ellipsis menu and then select Edit to edit the queue details and click Finish.
Open: Click the Ellipsis menu and then select Open to open the queue to see its details.

Assign: Click the Ellipsis menu and then select Assign to assign the queue to Groups. (only for
Queue Admin)

§& Select the Groups to assign the queue.
§ Click Assign.

You can change the order of queues are as follows:

According to your requirement, you can select the Queue to change the order, drag and drop in
the list.

Perform the following steps:

§& Select the Queue and right-click. The menu options are displayed as Cut, Paste Before,
and Paste After. The only Cut is enabled.

Select Cut.

Locate the cursor wherever it needs to be added and right-click. The menu options are
Cut, Paste Before, and Paste After. Only Paste Before and Paste After are enabled.

§ Select the Paste Before or Paste After to place the Queue.
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3.3.2

NOTE

If the User Group is selected as the All Teams in the Select Teams menu, then the Queue Admin
cannot sort the priority of the Queues.

Grid View

EEN
You can select the thumbview == icon to view the Queue List for All Teams in Grid View.

Queue List displays the queues assigned to all user groups and the value. All Team is selected in the
drop-down list and is disabled. It is displayed as the title for Queue List.

Figure 22: Queue List in Grid View

All Teams E =
Queue List

SWIFT Informative .. SWIFT Payments - Blocking . PaymentFedwire

o 517 0

Total Total Total
58.8%
W High B Medum M Low W o Data Found W High = Medium

View All Alerts View All Alerts
View Top Priority Alert View Top Priority Alert

SWIFT Payments - Non Blocking TF Default Queue = All_status_gueue

NOTE Only Analyst/Supervisor/Senior Supervisor can view the number
of alerts details in each Queue.

The Queue List appears in doughnut charts displays each cell's data as a slice of a doughnut. A pie
chart data visualization uses a single circle divided into "slices," each slice representing a numerical
proportion of the whole circle's value. Hover over the slices to see the details of the Series and the
Value of the queue.

By default, the color-coding displayed for three priorities of the alerts and the Total numeric value indi-
cates the number of alerts in that Queue.
The following are the only available priorities in the application:

High

Medium

Low

And also priority configuration for all the alerts to be defined before transaction filtering.

You can view six queues in Queue List and use the navigation to view the next set of queues.
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You can perform the following actions on each queue:

+Add Queue: Click button top-right in the

Queue Admin.)

Queue List to add a new queue. (only for

Delete: Click the Ellipsis menu and then select Delete and click Yes to delete the queue.

Edit: Click the Ellipsis menu and then select Edit to edit the queue details and click Finish.

Open: Click the Ellipsis menu and then select Open to open the queue to see its details.

Assign: Click the Ellipsis menu and then select Assign to assign the queue to Groups. (only for

Queue Admin)
§ Select the Groups to assign the queue.
§ Click Assign.

Archiving a Queue

To archive the inactive queues, follow these steps:
1.
2.

Log on to the Customer Screening application.

page appears.

3.

Figure 23: Process Page

Click Common Tasks, then click Rule Run Framework, and then click Process. The Process

Search for Queue in the Code field and select QueueArchive.

ORACLE Financial Services Analytical Applications Customer Screening

Process

Code queue
Name

Folder v

+ New [ View Edit bgy Copy Remove % Authorize = Export Trace Definition

2 O Folder

Code Name

QueueArchive QueueArchive TFLSEGMENT

Page 1 of1 (1-15of 1items)

US-English CSADMN

Search Reset

Version 0

Active  Yes

Version Active

0 Yes

Records Per Page 1

4. Click Edit

. The Process page opens in Edit mode.
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Figure 24: Process Definition (Edit Mode)

Process

Process Definition(Edit Mode)
Linked to

Folder TFLSEGMENT LG

Master Information Ef Properties

D 1633605741491

Code QueueArchive
Name QueueArchive
Executable
Y Subprocess [ZlComponent @ Precedence £ Move Remove
= Process Object

QueueArchival

QueueArchival

Save Close
Version 0
Active Yes
Type  Process Tree v
Route Execution to High
Precedence Node
Show Details
Precedence Type Parameter  Executable
Data
“csn

Transformation

5. Select the QueueArchival object and then select Component.

6. Inthe Parameters window, select the QueuArchival task and then click drop-down list ==. By
default the parameter value will be selected as “TF".

Figure 25: Component Selector Window

Search

List

Component
+
Data Extraction Rules
- &
Load Data Rules
+ Qs
File Loading Rules
+
Insertion Rules
—. @l
Transformation Rules
+- @
Database Functions-Transformations
-3
Base Rules
+ H
Classification Rules
+-
Computation Rules
+1. A
Processes
-8

Ok Close

Sort

Q Ascending Descending

Tasks In ROOT [1]
O Object
[J QueueArchival =

Parameters

E )

Ok

Close

7. Click OK to close the Parameters window.

8. Click OK.
9. C(lick Save.
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3.4.1

3.4.2

3-4-3

3.4-4

A confirmation message appears, click Yes to save the definition as a new version. A successful
message appears, click Close.

Troubleshooting Your Display

If you experience problems logging into Oracle Financial Services Transaction Filtering or with your
display, the browser settings may be incompatible with running OFSAA applications. The following
sections provide instructions for setting your Web display options for OFSAA applications.

Enabling JavaScript

This section describes how to enable JavaScript.

To enable JavaScript, follow these steps:

Navigate to the Tools menu.

Click Internet Options. The Internet Options dialog box is displayed.
Click the Security tab and then click Local Intranet.

Click Custom Level. The Security Settings dialog box is displayed.

In the Settings list and under the Scripting setting, select all options.

o U A WN 2

Click OK, then click OK again to exit the Internet Options dialog box.

Enabling Cookies

Cookies must be enabled. If you have problems troubleshooting your display, contact your System
Administrator.

Enabling Temporary Internet Files

Temporary Internet files are pages that you view on the Internet and store in a folder for quick viewing
later. You must adjust this setting to always check for new versions of a stored page.

To adjust your Temporary Internet File settings, follow these steps:

Navigate to the Tools menu.

Click Internet Options. The Internet Options dialog box is displayed.
On the General tab, click Settings. The Settings dialog box is displayed.
Click Every visit to the page.

I N O

Click OK, then click OK again to exit the Internet Options dialog box.

Enabling File Downloads

This section describes how to enable file downloads.

To enable file downloads, follow these steps:
1. Navigate to the Tools menu.
2. Click Internet Options. The Internet Options dialog box is displayed.
3. Click the Security tab and then click Local Intranet.
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4. Click Custom Level. The Security Settings dialog box is displayed.

5.
6.

Under the Downloads section, ensure that Enable is selected for all options.

Click OK, then click OK again to exit the Internet Options dialog box.

3.4.5 Setting Printing Options

This section explains how to enable printing background colors and images.

To enable this option, follow these steps:

1.
2
3.
4
5

Navigate to the Tools menu.

Click Internet Options. The Internet Options dialog box is displayed.
Click the Advanced tab. In the Settings list.

Under the Printing setting, click Print background colors and images.

Click OK to exit the Internet Options dialog box.

browser.

I NOTE For best display results, use the default font settings in your

3.4.6  Enabling the Pop-Up Blocker

You may have trouble running the Oracle Financial Services Transaction Filtering application when the
IE Pop-up Blocker is enabled. It is recommended to add the URL of the application to the Allowed Sites
in the Pop-up Blocker Settings in the IE Internet Options menu.

To enable the Pop-up Blocker, follow these steps:

1.
2.

W

© N o U oA

Navigate to the Tools menu.
Click Internet Options. The Internet Options dialog box is displayed.

Click the Privacy tab. In the Pop-up Blocker setting, select Turn on Pop-up Blocker. The Set-
tings are enabled.

Click Settings to open the Pop-up Blocker Settings dialog box.

In the Pop-up Blocker Settings dialog box, enter the URL of the application in the text area.
Click Add. The URL appears in the Allowed Sites list.

Click Close, then click Apply to save the settings.

Click OK to exit the Internet Options dialog box.

3.4.7  Setting Preferences

Use the Preferences section to enable you to set your OFSAA home page.

To access this section, follow these steps:

1.

In the Financial Services Analytical Applications Transactions Filtering landing page, select
Preferences from the user name drop-down list. The Preferences page is displayed.

OFS Transaction Filtering Admin Guide | 29



Getting Started
Troubleshooting Your Display

Figure 26: Preferences Page

1.

Preferences

Home Page
Property Mame

Set My Home Pags

Property Value

Diefault Screen v

- Zglect - v

Save Cancel

In the Set My Home Page drop-down list, select the window that you want to view when you log

n.

When a new application is installed, the related window for that application is found in the drop-

down list.

In the Date Format drop-down list, select the date format that you want to see. The options

available are dd/MM/yyyy or M/dd/yyyy.

Click Save to save your preferences.
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Managing User Administration

This chapter provides instructions for performing the user administration of Oracle Financial Services
(OFS) Transaction Filtering.

About User Administration

User administration involves creating and managing users and providing access rights based on their
roles. This section discusses the following:

Administrator permissions

Creating roles and granting and authorizing a user

Managing User Administration

The following sections provide information on how to create and authorize a user and map the users to
user groups in the Transaction Filtering application.

The following table lists the various actions and associated descriptions of the user administration
process flow:

Table 3: User Administration

Action Description

Creating and Authorizing a Create a user. This involves providing a user name, user designation, and the
User dates between which the user is active in the system.
Mapping a User with a User Map a user to a user group. This enables the user to have certain privileges
Group that the mapped user group has.
4.2.1 Creating and Authorizing a User
The sysadmn user creates a user and the sysauth user authorizes a user in the Transaction Filtering
application. For more information on creating and authorizing a user, see the Oracle Financial Services
Analytical Applications Infrastructure User Guide.
4.2.2  Mapping Users with User Groups

This section explains how to map Users with User Groups. The user has access to privileges as per the
role. The sysadm user maps a user to a user group in the Transaction Filtering application. The
following table describes the predefined User Roles and corresponding User Groups.

Table 4: User Group-Role Mapping

Role Group Name User Group Code
Administrator Transaction Filtering Administrator Group TFLTADMINISTATORGRP
Analyst Transaction Filtering Analyst Group TFLTANALYSTGRP
Supervisor Transaction Filtering Supervisor Group TFLTSUPERVISORGRP
Senior Supervisor Transaction Filtering Senior Supervisor Group | TFSNRRSUPERVISORGRP
Audit Transaction Filtering Audit Group TFAUDITGRP
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For each role, you can configure the time zones that apply to them. For information on the time zone
values, see Time Zone Configuration.

OFS Transaction Filtering Admin Guide | 32



General Configurations
Configuring the Application Level Parameters

5.1

General Configurations

The following sections provide information on how to configure the application and message and
screening parameters, configure the transaction workflow to accommodate the four-eyes principle and
the good guy component, define the cut-off time for the message workflow (including investigations),
set a priority for a message category, define the assignment type for messages (manual or automatic),
define the SLAs and cut-off times for alerts, run the purge and migration utilities, add a good guy
record, view the different emails generated based on the transaction status, segregate the alerts based
on jurisdictions and business domains, and do version control for SWIFT messages, 1IS020022
messages, and IPE.

Configuring the Application Level Parameters

Use the Application Level Parameter Configuration tab to configure the parameters for the
Transaction Filtering application, such as enabling or disabling the four-eyes workflow, define the
parameters that must be matched during the good guy workflow, define the cut-off time required to
complete the entire transaction workflow, and assign messages manually or automatically.

To configure the parameters, follow these steps:

1. Navigate to the Financial Services Analytical Applications Transactions Filtering landing
page.

2. Click Transaction Filtering Admin. The Application Level Parameter Configuration is dis-
played.

Figure 27: Application Level Parameter Configuration Tab

Application Level Parameter Configuration | Good quy matching configuration  SLA Configuration  Auto Assignment Configuration  Cut-Off Configuration

Audit

EDQURL:  nitp. Il whfooden.in.ora : 8090

£DQ webservice status username:

£DQ webservice status password
ECM L2 Analysis:

“Enable: @ Yes O No

ECM L2 Case Creation URL:  htip://100.76.133.237-7002/ECM812

ECML2 Case Ci

n Usemame: - ecmsupervisor

ECM L2 Case Creation Password:  vsssseee

FEEDBACK

3. Inthe Audit section, select Yes to view the Debug details or select No to view the Info details.

If you select Yes, then all the steps are logged in the system irrespective of the value in the Sta-
tus column. If you select No, then only those steps for which the value is Y in the Status column

are logged in the system.

NOTE For more information on the values in the Status column, see
System Audit Logging Information.
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5.2

4. Inthe 4 Eyes section, select Yes to enable the four-eyes workflow and select No to disable the
four-eyes workflow.

NOTE If the 4 Eyes workflow is enabled, then the new alert data should
be posted to the Ul to view the new options which are Message
Statuses, Blocked Recommended and Released Recommended.

5. Inthe EDQ section, provide the following values:
m  EDQ URL in the following format:

<http>: <Hostname of the server in which EDQ is installed>: Port Num-
ber

m  EDQ user name: The default username is displayed. You can update the username if
required.

m  EDQ password: The default password is displayed. You can update the password if required.
= EDQ webservice status username
m  EDQ webservice status password
6. Inthe ECM L2 Analysis section, select Yes to enable and then provide the following values:
m  ECM L2 Case Creation URL in the following format

m  <http>: <Hostname of the server in which ECM is installed>: <Port Num-
ber>/<Context>

s ECM Case Creation user name: Enter the ECM username.
m ECM Case Creation password: Enter the ECM password.

7. Inthe FEEDBACK section, enter the URL where we need to post messages for HOLD, RELEASE,
CLEAN, BLOCK in the feedback queue in the FEEDBACK URL field.

8. C(lick Save. The following confirmation message is displayed: Records Updated Successfully.

Configuring the Good Guy Matching Parameters

The parameters shown here are applicable only when the good guy workflow is enabled. The
Transaction Filtering application checks if there is a match or not for every parameter which is enabled,
and if there is a match, the record is added to the good guy list. For more information on the good guy
workflow, see the Managing Transaction Filtering chapter in the Oracle Financial Services
Transaction Filtering User Guide.

To enable or disable the good guy parameters, follow these steps:

1. Navigate to the Financial Services Analytical Applications Transactions Filtering landing
page.
2. (Click Transaction Filtering Admin and then click the Good Guy Matching Configuration tab.
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Figure 28: Good Guy Matching Configuration Tab

Configuration Screen

Application Level Parameter Configuration Good guy matching configuration SLA Configuration Auto Assignment Configuration Cut-Off Configuration

Good guy matching configuration:

Payment Entity Full Name : ® Yes D No
Watchlist Record Name : O Yes @ No
Payment Entity Jurisdiction : O Yes ® No
Watchlist Name : O Yes ®© No
Watchlist Record ID : O Yes ®© No
Payment Account ID : O Yes @ No
Watchlist Last Update Date : O Yes @ No

¢ Payment Entity Full Name: The payment entity full name must be matched, so it is mandatory
to set the value in the Payment Entity Full Name to Yes. If you do not set it to Yes, an error
message, “The Payment Entity Full Name should be set as Yes mandatorily.” is displayed.

Configuring the SLA Parameters

Banks or Fls want to settle payments within a specified time. To achieve this, related alerts should be
closed well within this specified time. The cut-off time is the defined duration by when the alert has to
be closed. This is the time from when the Analyst starts working on the alert till the time the alert is
closed. The SLA is defined as the time from when the alert is created or reopened to when the Payment
is made. The Cut-off time will be well within the SLA. You must define the cut-off time and SLA.

Use the SLA Configuration window to define an SLA for a combination of message category, message
type, currency, jurisdiction, business domain, message direction, transaction amount range, and
message priority.

INUII:

The SLA time must be defined in HH: MM: SS format.

You can set an automatic action to be taken by the system if the alert is not investigated within the
defined SLA using the Auto Action Parameter field (this is an optional step). For example, if you select
Escalate, then the alert is escalated to the Supervisor after the SLA time is passed. You can also set a
notification to be sent for overdue alerts as soon as the cut-off time is passed for an alert to any user
role, for example, to a supervisor. For more information, see the Generating Email for Different Statuses
section.

To set the SLA time, follow these steps:

1. Navigate to the Financial Services Analytical Applications Transactions Filtering landing
page.
2. Click Transaction Filtering Admin and then click the SLA Configuration tab.
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Figure 29: SLA Configuration Tab

Application Level Parameter Configuration  Good guy matching configuration | SLA Configuration | Auto Assignment Configuration  Cut-Off Configuration

Add Clear  EnableAll | Disable All

Message Type Jurisdiction  Business Domain Currency From Amount To Amount Priority SLATime

A
A
Any Any
A

Enter the SLA time in HH:MM: SS format.
4. Select an automatic action for an alert that is overdue. You can do one of the following:
m  Recommend to block the transaction
m  Block the transaction
m  Recommend to release the transaction
m  Release the transaction
m  Escalate the transaction
5. Select Yes to enable a specific combination, else select No.
6. To create a combination, use the following conditions. This is an optional step.

m  Message Category: Select the message category used for the transaction. You can also
select Any to indicate that regardless of the message category, the SLA time is enabled for
the combination. If you select Any, you cannot select a message type.

m  Message Types: Select a message type for the message category. You can also select All to
indicate that the SLA time is enabled for all message types.

m  Currency: Enter the ISO currency code of the currency used for the transaction.

m Jurisdiction: Select the jurisdiction/geography if the defined SLA time must apply to only
this jurisdiction. You can also select All to select all jurisdictions/geographies.

m  Business Domain: Select the business domain if the defined SLA time must apply to only
this business domain. You can also select All to select all business domains.

m  Message Direction: Select INBOUND for transactions that are coming into your account and
select OUTBOUND for transactions that are going out of your account. You can also select
Any to select any message direction.

m  Amount: Select the amount range used in the transaction.

m  Priority: Set a specific alert priority or select Any to indicate that the alert can have any pri-
ority.

After you select the values in the required fields, you can do the following:

Table 5: General Actions

Do this...

Add a configuration Click Add. The values appear in a tabular format.
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Table 5: General Actions

To... Do this...

Update a configuration Select the configuration you want to update, update the value of one or
more fields, and click Update. The updated value is displayed in the
table.

Remove a configuration Select the configuration you want to remove and click Remove. The

selected configuration is removed from the table.

Clear the values of some of Click Clear. You can only clear the values of the Cut-Off Time, Currency,
the fields in a configuration | and Amount fields.

Enable all configurations Click Enable All.

Disable all configurations Click Disable All.

5.4 Automatic Assignments of Alerts
The Transaction Filtering application provides two options for assigning alerts:

e Manual assignment: Here the user must manually assign alerts one by one using the lock
button in the Investigation Use Interface.

When you manually assign an alert, then all alerts which belong to the selected jurisdiction/busi-
ness domain are displayed. You can manually assign an alert if, for example, the Analyst to whom
the alert is assigned is on leave. In this case, the Supervisor moves the status of the alert from
ASSIGNED to HOLD in the Investigation User Interface. The Analyst can self-assign the alert
using the lock/unlock feature. For more information on the Investigation User Interface, see the
Managing Transaction Filtering chapter in the Oracle Financial Services Transaction Filtering
User Guide.

¢ Automatic assignment: Alerts are automatically assigned to the selected user role and
respective user IDs. When you auto-assign an alert, the alert is automatically assigned to all
users who belong to the selected role. You can use two options: load balancing or load balancing
along with specific criteria, to assign the alert.

NOTE e Ihe [ransaction Fitering apphcation assigns all New alerts
to the Analyst by default.
e Alerts cannot be assigned to a user who is mapped to the
Admin role.
NOTE You cannot change the mode of assignment from automatic to
manual for an alert that is already assigned. You can only select a
mode of assignment for new alerts.

To configure an alert to be assigned manually or automatically, follow these steps:

1. Navigate to the Financial Services Analytical Applications Transactions Filtering landing
page.
2. Click Transaction Filtering Admin and then click the Auto Assignment Configuration tab.

3. Select Automatic to auto-assign the alert to the selected role. Select Manual to manually assign
an alert to the selected user.
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If you select Automatic, you can choose between Based On Load Balancing to select a user role
or Custom Criteria With Combination Of Load Balancing to select a user role along with the
following conditions.

If you select Based On Load Balancing, all users who belong to the role are assigned the alert
and the maximum capacity for each user role must be defined.

Figure 30: Auto Assignment Configuration Tab with Based on Load Balancing Selection

Application Level Parameter Configuration  Good quy matching

SLAConfiguration | Auto Assignment Configuration | Cut-Off Configuration

Auto Assignment Configuration

Alert Assignment Option: = Manual @ Automatic
Automatic Configuration : © Based On Load Balancing Custom Criteria With Combination Of Load Balancing
User Role: User : Jurisdiction Business Domain: Max Capacity: Enable:
TFLTANYST v TFANALYST v Ay v Ay v Enter Gapac Yes
Add Clear  EnableAll | Disable All
User Role Userid Max Capacity Jurisdiction Business Domain Enable
TFLTANYST TFANALYST 2 Al Al

If you select Custom Criteria With Combination Of Load Balancing, you can select a user role
and a specific combination of conditions. The system then applies load balancing along with
these conditions, while also applying the maximum capacity defined for the users.

Figure 31: Auto Assignment Configuration Tab Custom Criteria with Combination of Load Balancing

‘Anplication Level Parameter Configuration  Good guy matching configuration  SLA Configuration | Auto Assignment Configuration | Cut-Of Configuration

Auto Assignment Configuration

Alert Assignment Option: © Manual @ Automatic

Automatic Confiuration: O Based On Load Balancing ~ ® Custom Griteria With Combination Of Load Balancing

User Role: User Jurisiction Business Domain Max Capaciy Enable

TELTANYST v TRANALYST v Ay v an

Message Category: Message Type Match Score:

FEDWIRE v Ay

Priority: Currency: Amount.

Any v Enteran 150 currenc

Add Clear | EnableAll | Disable Al

User Role Userid Max Capacity Jurisdiction  Business Domain Enavie e MessageType oMM 1o 1atcn score Currency Prioriy From Amount To Amount
TFLTANYST TFANALYST 2 Al Al M Any 10 0 Any 10 2000

The following conditions must be defined:

m  User Role: Select the role to whom you want to automatically assign alerts. When you select
the role, all users who belong to that role are displayed in the User ID field. You can assign
an alert to any user except the Admin user.

m  User ID: Select the user to whom you want to automatically assign alerts.

m Jurisdiction: Select the jurisdiction applicable to the combination, or select All to indicate
that for all jurisdictions, the alert auto-assignment is enabled for the combination.

m  Business Domain: Select the business domain applicable to the combination or select All.

m  Max Capacity: Select the maximum number of alerts that can be investigated by the
selected user.

m  Enable Flag: Select Yes to enable the combination.

The following additional fields can be used to create a combination when you select Custom Cri-
teria With Combination Of Load Balancing:
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G

m Message Category: Select the message category used for the combination or select Any to
indicate that regardless of the message category, the alert auto-assignment is enabled for

the combination.

m  Message Types: Select a message type for the message category or select None.

m  Match Score: Select the match score range. If the match score is between this range, then
the alert is assigned to the selected user based on the configuration.

m  Priority: Set the message priority or select Any.

m  Currency: Enter the ISO currency code of the currency used during the transaction.

m  Amount: Select the amount range used in the transaction.

After you select the values in the required fields, you can do the following:

Table 6: General Actions

To...

Add a configuration

Do this...

Click Add. The values appear in a tabular format.

Update a configuration

Select the configuration you want to update, update the value of one or
more fields, and click Update. The updated value is displayed in the
table.

Remove a configuration

Select the configuration you want to remove and click Remove. The
selected configuration is removed from the table.

Clear the values of some of
the fields in a configuration

Click Clear. You can only clear the values of the Currency and
Amount fields.

Enable all configurations

Click Enable All.

Disable all configurations

Click Disable All.

Configuring the Cut-Off Parameters for Alerts

Banks or Fls want to settle payments within a specified time. To achieve this, related alerts should be
closed well within this specified time. The cut-off time is the defined duration by when the alert has to
be closed. This is the time from when the Analyst starts working on the alert till the time the alert is
closed. The SLA is defined as the time from when the alert is created or reopened to when the Payment
is made. The Cut-off time will be well within the SLA. You must define the cut-off time and SLA.

Use the Cut-Off Configuration window to set a cut-off time for the investigator to complete the alert
investigation. You can either set a single cut-off time for all alerts or set different cut-off times for each
alert based on multiple conditions such as message category, message type, jurisdiction, business
domain, currency, amount range, message priority, and message direction.

based on your locale.

To set a single cut-off time for all alerts, define the cut-off time in the Cut-Off Time field and then
select Any in the condition fields which have drop-down values. Do not enter a value in the Currency

and Amount fields.
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To set different cut-off times based on specific values, define the cut-off time in the Cut-Off Time

field and then select one or more values in the condition fields. Here, you can enter a value in the

Currency and Amount fields. For more information, see step 6.

NOIE

[t you set different cut-off times, ensure that you define the
conditions in such a way that the cut-off time defined for a specific
set of conditions does not overwrite the cut-off time defined for
another set of conditions.

When the cut-off time is set for an alert, the alert displays the time in green in the Investigation User
Interface until the cut-off time is passed. After the cut-off time is passed, that is, the alert becomes
overdue and is not investigated within the defined cut-off time, then the alert displays the time in red
in the Investigation User Interface. For information on the Investigation User Interface, see the Oracle

Financial Services Transaction Filtering User Guide.

You can set an automatic action to be taken by the system if the alert is not investigated within the
defined SLA using the Auto Action Parameter field (this is an optional step). For example, if you select
Escalate, then the alert is escalated to the Supervisor after the cut-off time is passed. You can also set a
notification to be sent for overdue alerts as soon as the cut-off time is passed for an alert to any user
role, for example, to a supervisor. For more information, see the Generating Email for Different Statuses

section.

To set the cut-off time, follow these steps:

1. Navigate to the Financial Services Analytical Applications Transactions Filtering landing

page.

2. Click Transaction Filtering Admin and then click the Cut-Off Configuration tab.

Figure 32: Cut-Off Configuration Tab

Cut-Off Configuratior

cutoft H M SS Timezone Africa/Addis_Ababa v Enable: Yes

Message = = N s = Message
s Message Type Jurisdiction  Business Domain Currency From Amount To Amount riority CutOffTime  Timezone e

MT695 Any Any Any 00:00:01 OUTBOUND

Clear

Enable Al Disable All

3. Enter the cut-off time in HH: MM: SS format. This is the time period by when the alert must be

closed by the investigator.
4. Enter the locale. The cut-off time is displayed based on your selection.
Select Yes to enable a specific combination, else select No.

6. To create a combination, use the following conditions. This is an optional step.

m Message Category: Select the message category used for the transaction. You can also
select Any to indicate that regardless of the message category, the cut-off time is enabled for

the combination. If you select Any, you cannot select a message type.

m  Message Types: Select a message type for the message category. You can also select All to

indicate that the cut-off time is enabled for all message types.

m Jurisdiction: Select the jurisdiction/geography if the defined cut-off time must apply to only

this jurisdiction. You can also select All to select all jurisdictions/geographies.
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m  Business Domain: Select the business domain if the defined cut-off time must apply to only
this business domain. You can also select All to select all business domains.

m  Currency: Enter the ISO currency code of the currency used for the transaction.
m  Amount: Select the amount range used in the transaction.

m  Priority: Set a specific alert priority or select Any to indicate that the alert can have any pri-
ority.

m  Message Direction: Select INBOUND for transactions that are coming into your account and
select OUTBOUND for transactions that are going out of your account. You can also select
Any to select any message direction.

After you select the values in the required fields, you can do the following:

Figure 33: General Actions

To... Do this...

Add a configuration Click Add. The values appear in a tabular format.

Update a configuration Select the configuration you want to update, update the value of one or
more fields, and click Update. The updated value is displayed in the
table.

Remove a configuration Select the configuration you want to remove and click Remove. The

selected configuration is removed from the table.

Clear the values of some of Click Clear. You can only clear the values of the Cut-Off Time, Currency,
the fields in a configuration | and Amount fields.

Enable all configurations Click Enable All.

Disable all configurations Click Disable All.

Setting the Priority for Messages

You can set the priority for a specific message category as High, Medium, and Low based on certain
criteria such as the message jurisdiction, message type, and amount. The seeded message categories
are High, Medium, and Low. To add other priority types, add the required priority type in the

DIM ALERT PRIORITY TYPE table.

€ ready-10-USe appNcation extracts some of the key Tields of the
message into the FST RT MSG TAG table.

If you want to use any field to define the priority, write an SQL query in the V. ATTRIBUTE VALUEL
column of the SETUP RT PARAMS table. At the end of the query, add the following where clause:

where t.n grp msg id = [GRP _MSG ID] and rownum = 1
To define the priority for a message category, follow these steps:
1. Run the following query to view the SETUP_RT PARAMS table:
select * from SETUP RT PARAMS;

2. Search for the MESSAGE PRIORITY valueinthe V. PARAM NAME column.
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S5-7

5.8.1

3. Inthev ATTRIBUTE VALUEL column, write the query or function to define the priority.

You can write functions or queries based lon your criteria.

Running the Purge Utility

Use the purge utility to maintain all data such as alerts, transactions, and reference data for a specific
archival period for all involved jurisdictions. The archival period can be configured by users who have
the required permissions under each legal entity policy or local data protection requirements.

€ archival period can be configured by USers who have the
required permissions under each legal entity policy or local data
protection requirements. The archival period also applicable for
the AdminGuide_Transaction Filtering_8.0. 7.0.0 and
AdminGuide_Transcation Filtering_811.0.0. For more information,
see Sanctions Application Pack.

To run the purge utility, follow these steps:

1. GotothepurgeTF.shfileinthe<installed area>/ficdb/bin/ directory and replace the
##Infodom## placeholder with the name of your Infodom.

2. Run the purge utility from the <installed area>/ficdb/bin/ directory using the following
command:

./purgeTF.sh <from date in mm/dd/yyyy> <to date in mm/dd/yyyy> S/H
S stands for soft delete and H stands for hard delete.
For example, ./purgeTF.sh 11/11/2019 11/12/2019 S

3. Verify the purge logs in the following directory:

<installed area>/ficdb/log/TFpurge/ path

Adding, Editing or Deleting Good Guy Records

You can add, edit or delete a Good Guy record from the Good Guy List Details page.

Adding a Good Guy Record

Apart from adding a good guy record using the process mentioned in the Good Guy/White List
Matching section in the Oracle Financial Services Transaction Filtering User Guide, you can also
manually add a record to the FCC_WHITELIST table, for example, if the record is a trusted customer.

To add a record, follow these steps:
1. Click List Management on the Financial Services Analytical Applications Transactions Fil-
tering landing page.

2. Inthe Good Guy Summary section, click Add +.A pop-up window is displayed.
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5.8.2.1

5.8.3

Figure 34: Good Guy Summary Pop-up Window

Match criteria for this record:

Payment Entity Full Name = |

Payment Entity Jurisdiction EMEA O yes @ No
Fayment Account ID O ves @® Mo
Watchlist Record Name O vYes @ MNo
wWatchlist Name O ves ® No
WWatchlist Record ID O Yes ® MNo
Watchlist Last Update Date 06/21/2022 O Yes @ Mo
Expiration Date ~ 06/21/2022

Save Cancel

3. Enter the required details.
4. C(lick Save.

Editing a Good Guy Record

After you add a record, you can change the jurisdiction or expiry date of the record by editing the
record.

To edit the good guy record, follow these steps:

In the Good Guy Summary section, click Actions.
From the drop-down list, click Edit.

Make the necessary changes to the record.

Enter your reasons for editing the record.

Click Save.

I N O

Updating the Status of an Expired Alert

If the Supervisor has not worked on the alert and it is past the expiry date, you must move it to the
expiry status. To do this, run the Good Guy Expiry Check batch in the Run page.

Deleting a Good Guy Record

You can delete a record, for example, if the record was added in error or the record must no longer be in
the Good Guy table.

To delete the good guy record, follow these steps:
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5.8.4

1. Inthe Good Guy Summary section, click Actions.
2. From the drop-down list, click Delete.

3. Enter your reasons for deleting the record.

4. C(lick Save.

The following columns in the FCC_ WHITELIST table are used for matching. This match can be against
a single column or column combinations:

e V_ORIGIN: This column contains the watch list name.
o V_WHITE_ENTITY_NAME: This column contains the watch list record name.
e V_WHITE_NAME: This column contains the input message name.

e V_IDENTIFIER_CODE: This column contains the ID of the party name present in the
V_WHITE NAME column and comes from the input message.

e N_RECORD_ID: This column contains the watch list record ID.
V_JURISDICTION: This column contains the watch list jurisdiction.

e D_EXPIRE_ON: This column contains the date after which the record is no longer checked
against the records in the FCC_ WHITELIST table.

Good Guy Attributes

The system will generate a hashcode to capture the current state of attributes on the WL side based on
EDQ configuration.

When a name event/match is taking place, and the Last Updated Date with fingerprinting option is
selected as Yes.

If there is no change to the Last Updated Date field, then this is considered positive for good guy
(match will be considered good guy if all other conditions are met).

If there is a change to the Last Updated Date field, then the hashcode will be compared. If they are
identical, then this is considered positive for a good guy (match will be considered good guy if all other
conditions are met).

The following fields are used for hashcode calculation:

1. WL - entities - prepared data:
m dnListKey (e.g. "DJW")
m dnListSubKey (e.g. "DJW-SAN" or "DJW-EDD")
m dnListRecordType (e.g. "SAN" or "EDD")
m dnListRecordId (e.g. "1044689")
m dnOriginalEntityName
m  dnEntityName
m  dnPrimaryName
m dnOriginalScriptName
m  dnAddress
m dnCity

m  dnState
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2. WL - individuals - prepared data

dnAddressCountryCode
dnAddressCountry

dnAllCountries

dnAllCountryCodes (e.g.

dnListKey (e.g. "DJW")

"RU")

dnListSubKey (e.g. "DJW-SAN" or "DJW-EDD")

dnListRecordType (e.g.

dnListRecordId (e.qg.
dnOriginalFullName
dnOriginalGivenNames
dnOriginalFamilyName
dnFullName
dnGivenNames
dnFamilyName
dnPrimaryName
dnOriginalScriptName
dnAddress

dnCity

dnState
dnAddressCountryCode
dnAddressCountry

dnAllCountries

dnAllCountryCodes (e.g.

"SAN" or "EDD")

"1044689")

"RU")

e The fields used for hashcode calculation should be configurable by consulting as global
configuration (1 set of fields).

e This configuration cannot be changed per list type.

e Thisis expected to be a 1-time activity that will happen during implementation.

This functionality is expected to work for all types of lists - 3rd party lists and internal lists. This means
an analyst should be able to mark a good guy based on an internal list match.

Managing the Good Guy Attributes

To change the Good Guy Attributes, follow these steps:

1. From the EDQ URL, open the Director and the Transaction_Screening Project.
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Figure 35: Transaction Screening Project
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2. From Processes, open the Name & Address Match.

Figure 36: Name and Address Match
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3. Expand the group and double click “Concatenates the flag columns which makes the Hash

Key".

4. You can map and unmap required set of attributes to make the hash key.
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5.9.1

Figure 37: Attributes for Concatenates the flag columns which makes the Hash Key
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Generating Email for Different Statuses

An email is generated for a transaction depending on its status. The following types of emails are
generated:

e Notification Email

e Task Email

Notification Email

A notification email is generated for Blocked and Released transactions and the template is as follows:

Subject: Notification-<id>-Issue Identified - New issue assigned to you

Hi TFSUPERVISOR,

This is to inform you that a Notification is generated for you in your inbox
for

Notification ID: <id>

Transaction Type: <Message Type>
Message Reference: <Message Reference>
Status: <Blocked/Released>

User Comments: <User comments>

Received On: 2017-07-25 12:03:19.0
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Please access the below link to logon to Transaction Filtering System.

<Application URL>

Regards,
Admin

A notification email is generated for nearing cut-off/nearing SLA to supervisor and the template is as
follows. Two different emails are sent for cut-off and SLA.

Subject: Notification-<id>-Issue Identified - New issue assigned to you

Hi TFSUPERVISOR/TFANALYST,

This is to inform you that a Notification is generated for you in your inbox
for

Notification ID : <id>

Message Category: <Message Category>

Transaction Type : <Message Type>

Message Reference: <Message Reference>

Batch Reference: <Batch Reference>

Transaction Reference: <Transaction Reference>

Status : <HOLD/ASSIGNED/ESCALATED/BLOCK RECOMMENDED/RELEASE RECOMMENDED >
User Comments: <User comments>

Received On : <2017-07-25 12:03:19.0>

Please access the below link to logon to Transaction Filtering System.
<Application URL>

Regards,

Admin

Task Email

A task email is generated for Hold and Escalated transactions and the template is as follows:

Subject: Taskid-<id>-Issue Identified - New issue assigned to you

Hi TFSUPERVISOR/TFANALYST,

This is to inform you that a Notification is generated for you in your inbox
for

Task ID: <id>
Transaction Type: <Message Type>
Message Reference: <Message Reference>

Status: <Hold/Escalated>
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User Comments: <User comments> applicable to escalated only

Received On: 2017-07-25 12:03:19.0

Please access the below link to logon to Transaction Filtering System.

<Application URL>

Regards,
Admin

A task email is generated for nearing cut-off/nearing SLA to supervisor and the template is as follows.
Two different emails are sent for cut-off and SLA.

Subject: Taskid-<id>-Issue Identified - New issue assigned to you

Hi TFSUPERVISOR/TFANALYST,

This is to inform you that a Notification has been generated for you in your
inbox for

Task ID : <id>

Message Category: <Message Category>
Transaction Type : <Message Type>

Message Reference: <Message Reference>

Batch Reference: <Batch Reference>

Transaction Reference: <Transaction Reference>

Status : <Overdue Cut-off/ Overdue SLA> Note: not sure exact status
name so use exact status which are used for cut-off overdue and SLA overdue.

User Comments: <User comments> applicable to escalated only
Received On : 2017-07-25 12:03:19.0

Please access the below link to logon to Transaction Filtering System.
<Application URL>

Regards,

Admin

Configuring Alerts in Multiple Jurisdictions and Busi-
ness Domains

Alerts are segregated based on jurisdiction and business unit or line of business. You can also
configure the alerts that are assigned to the users in the t fanalytgroup and t fsupervisorgrp
groups.

Jurisdictions are used to limit user access to data in the database. The user must load all jurisdictions
and associate user groups to jurisdictions in the tables as specified in Configuring Jurisdictions and
Business Domains. User groups can be associated with one or more jurisdictions.
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NOIEN

Alljurisdictions 1n the system reside 1in the
FCC_SWIFT JSRDSN MAP table.

In the Investigation User interface system, users can view only data or alerts associated with
jurisdictions to which they have access. You can use jurisdiction to divide data in the database. For
example:

¢ Geographical: Division of data based on geographical boundaries, such as countries, states, and
so on.

e Organizational: Division of data based on different legal entities that compose the client’s
business.

e Other: Combination of geographic and organizational definitions. Also, it can be customized.

The definition of jurisdiction varies from between users. For example, a user can refer to a branch BIC
as jurisdiction and another user can refer to a customer ID as jurisdiction.

Business domains are used to limit data access. Although the purpose is like jurisdiction, they have a
different objective. The business domain is used to identify records of different business types such as
Private Client versus Retail customer, or to provide more granular restrictions to data such as employee
data.

If a user has access to any of the business domains that are on a business record, the user can view that
record.

NOIE

5.10.1

Al business domains 1n the system reside in the
FCC_SWIFT BUS DMN MAP table.

Configuring Jurisdictions and Business Domains

The default Sanctions groups are tfanalytgroup and tfsupervisorgrp. According to the ready-
to-use product, these groups get all alerts and notifications for all jurisdictions and business domains.
To configure the alerts, follow these steps:

1. Load all the jurisdictions. To do this, run the query SELECT * FROM FCC SWIFT JSRDSN MAP
and load the jurisdictions in the v_JRSDCN_CD column inthe FCC_SWIFT JSRDSN MAP table.

The following columns are provided to populate any additional information:

Table 7: Columns used to provide additional information for Jurisdictions

Column Data Type and Length

YEXIRACTED SWIFT - | yARCHAR2(100 CHAR)
V_JRSDCN_CD VARCHAR2(40 CHAR)
V_CUST_COLUMN_1 VARCHAR2(4000 CHAR)
V_CUST_COLUMN_2 VARCHAR2(4000 CHAR)
V_CUST_COLUMN_3 VARCHAR2(4000 CHAR)
V_CUST_COLUMN_4 VARCHAR2(4000 CHAR)
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Table 7: Columns used to provide additional information for Jurisdictions

Column Data Type and Length

N_CUST_COLUMN_1 NUMBER(20)
N_CUST_COLUMN_2 NUMBER(20)
N_CUST_COLUMN_3 NUMBER(20)
N_CUST_COLUMN_4 NUMBER(20)

Load all the business domains inthe v_BUS DMN CD columninthe FCC_SWIFT BUS DMN MAP
table.

The following columns are provided to populate any additional information:

Table 8: Columns used to provide additional information for Business Domains

Column Data Type and Length

VEXTRACTED SWIFT_- | yARCHAR2(100 CHAR)
V_JRSDCN_CD VARCHAR2(40 CHAR)
V_CUST_COLUMN_1 VARCHAR2(4000 CHAR)
V_CUST_COLUMN_2 VARCHAR2(4000 CHAR)
V_CUST_COLUMN_3 VARCHAR2(4000 CHAR)
V_CUST_COLUMN_4 VARCHAR2(4000 CHAR)
N_CUST_COLUMN_1 NUMBER(20)
N_CUST_COLUMN_2 NUMBER(20)
N_CUST_COLUMN_3 NUMBER(20)
N_CUST_COLUMN_4 NUMBER(20)

Map user groups to the appropriate jurisdiction and business domain. To do this, run the query
SELECT * FROM DOMAIN JUR GRP MAP and do the mappingin the DOMAIN JUR GRP MAP
table and map with the additional columns STATUS CD, ALERT TYPE CD.

NOIE

e Refer N _SANCTION STATUS CODE columnfrom DIM -
SANCTIONS STATUS table for list of Status codes.

e Refer N ALERT TYPE CODE column from DIM SANC T-
F_ALERT TYPE table for list of alert types.

If multiple jurisdictions are mapped to a single user group, create as many rows as the number of
jurisdictions and add the new jurisdiction in each row for the same user group.

If multiple business domains exist for the same user group and same jurisdiction, create as many
rows as the number of business domains and add the new business domain in each row for the
same user group and jurisdiction.

Put the appropriate SQL query in the Message jurisdiction and Message Business Do-
main rows to derive the jurisdiction and business domain respectively inthe Setup Rt Params
table.
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5.10.2

5.10.3

This step is required to define the source of jurisdiction and business domain from the message
or an external source.

The definition and source of jurisdiction and business domain are different for each customer. In
this way, the Transaction Filtering application gives the flexibility to the user to pick any attribute
of the message to define the jurisdiction and business domain. For example, jurisdiction can be
the BIC present in block 1/block 2 of the SWIFT message or the branch ID present in the SWIFT
GPI header.

The ready-to-use application can extract some of the key fields of the message, which are avail-
ableinthe £si rt al msg tagtable. If the customer wants to use any field as a jurisdiction or
business domain from this table, then an SQL query must be written in the Setup Rt Param
table to extract the respective column.

When a message is posted, the system updates the jurisdiction and business domains extracted
instep4inthe FSI RT RAW DATA and FSI_RT ALERTS tables.

Configurations to Automatically Assign Transactions

Inthe setup rt params table, setthe v ATTRIBUTE VALUE1L value for HOST NAME, PORT and
SANC_CONTEXT NAME correspondingtothe N PARAM IDENTIFIER value as 55 andthe
V_PARAM NAME value as XML WEB_ SERVICE BASE URL. Itisin the following format:

http://##HOST NAME##: ##PORT##/##SANC CONTEXT NAME##/SanctionsService
Example:
http://whf00bls:8930/SAN807SEPA/SanctionsService

Configurations to Automatically Release Transactions

To configure a transaction for the Auto Release status, run the following query:
select * from fsi rt auto release;

By default, the configuration is empty, which means that no transactions can be auto released. You can
set the following values inthe £si rt auto release table:

e Message category inthe v_MSG CATEGORY column. For example, a message category of 1is
mapped to the SWIFT message type by default. To see all default values, run the following query:

select * from dim message category;

e Messagetypeinthe N SWIFT MSG_ ID column.For example, a message type of 1is mapped to
the MT101 message type by default. To see all default values, run the following query:

select * from dim sanctions swift;
e Jurisdiction inthe v. JURISDICTION column.
e Business Domain inthe v_BUSINESS DOMAIN column.
e To see the default values for jurisdiction and business domain, run the following query:

select v_attribute valuel from setup rt params where V_PARAM NAME in
('MESSAGE JURISDICTION', 'MESSAGE BUSINESS DOMAIN')

e To enable the configuration, set the F_ENABLED columnto Y.
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5.11.1

5.11.2

5.11.3

5.12

Version Control

Version control for SWIFT messages, IPE, and ISO0200222 is accomplished using the Import/export
feature in Transaction Filtering. Say a file has been moved from one environment to another
environment. Later, the file is updated. The import/export utility will create 2 separate files for each
configuration. You can import both the files into the application and use a text file comparator such as

beyond compatre or a version control tool such as SVN to view the differences between the
exported files.

Version control for EDQ follows a different process. EDQ has an inbuilt version control feature available,
so you will just need to compare the .dxi files to view the differences.

Version Control for SWIFT Messages and IPE

The steps involved for SWIFT messages and IPE are the same. These steps are explained here:
1. Export the new file using the and save it in your local drive.
2. Import the file into the Transaction Filtering application.

You can now compare this file with another file. Ensure that you place these files in separate folders.

Version Control for ISO20022
The steps involved for ISO20022 are explained here:

1. Export the new file and save it in your local drive.
2. Import the file into the Transaction Filtering application.

3. You can now compare this file with another file. Ensure that you place these files in separate
folders.

If you want to restore the current version to a previous version of the file, you can delete data from all
the tables, import a previously exported file that has the date you want to restore into the application,
and restart the webserver. This restores the configuration of the previous version.

Version Control for EDQ

To use the version control feature available within EDQ, follow these steps:

1. Inthe EDQ application, copy the two different versions of the .dx1 files into the EDQ Director
menu.

2. (Click View and select Configuration Analysis in the EDQ Director menu.

3. Inthe popup which appears, select the versions that you want to compare.

4. Click Configuration.

5. Inthe popup which appears, select the differences only and click OK.

6. Inthe same window, select Start Comparison. This gives all changes between the two files.

For more information, see Oracle Enterprise Data Quality Documentation.

Running the Migration Utility for SWIFT and Fedwire

Use this migration utility to import and export the SWIFT and Fedwire message configurations. For
information on configuring the SWIFT message parameters, see Configuring the SWIFT Message
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Parameters. For information on configuring the Fedwire message parameters, see Configuring the
Fedwire Message Parameters.

The message types provided in this utility are available in the TF_Swift Migration Utility/
output/MSG_TYPES directory.

To export the configurations, follow these steps:
1. Navigatetothe TF Swift Migration Utility/config directory.

2. Openthe Dynamic.properties file and update the placeholders as shown:

Table 9: Configurations required in the Dynamic.properties file when running the export file

Placeholder Update with...

##jdbcurl## Your JDBC URL.

##usernamed# ;I;II:, Atomic Schema user name using which you want to execute the
##tpassword## The Atomic Schema password for the user name.

##infodom## Your Infodom name.

Your SWIFT ID. This is availableinthen_sanction swift msg id
columninthedim sanctions swift details table.

If you are providing multiple IDs, add the IDs separated by commas. For
example, 1,2,3,4.

HH#SWIFT_MSG_ID##

3. Navigatetothe TF _Swift Migration Utility/bin directory andrunthe export.sh
SWIFTMSGEXPORT MSG_TYPES command.

MSG_TYPES is the folder name of the folder to which you can export the configurations. Before
you perform the export, change the folder name. For example, Exported.

0 NOt change the Tolder name t0 MSG_TYPES. This will OVerwrite
the ready-to-use message types provided with the utility.

To import the configurations, follow these steps:

1. Navigatetothe FIC HOME/Transaction Processing/TF Swift Migration Utlity/
config directory.

2. Openthe SWIFT MSG TYPES.txt file and add the message types that you want to import to
the Exported folder mentioned in the export configuration steps.

3. Openthe Dynamic.properties file and update the placeholders as shown:

Table 10: Configurations required in the Dynamic.properties file when running the import file

Placeholder Update with...

##jdbcurl## Your JDBC URL.

##tusernamett# The Atomic Schema user name using which you want to execute
the files.

##password## The Atomic Schema password for the user name.
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4. Navigatetothe TF_Swift Migration Utlity/bin directory and runthe import.sh
SWIFTMSGIMPORT MSG_TYPES command.

MSG_TYPES is the folder name of the folder from where you can import the configurations.
Before you perform the import, change the folder name. For example, Imported.

WARNING

5.12.1

Do not change the folder name t0 MSG_TYPES . This will OVerwrite
the ready-to-use message types provided with the utility.

After you complete the export and import steps, restart the web server. To verify if the message types
have been successfully imported or not, check if the message types are available in the Message Type
Configuration field in the Message and Screening Configurations Window .

Restoring a Previous Message Configuration

To restore a configuration, you must first export and then import the configuration from that
environment, and then restart the webserver. This restores the configuration of the previous version.

Follow these steps to restore the configuration:

1. Export the message configuration from the environment.

I NOIE

5-13

Ensure that you save the contiguration.

2. To restore the previous version, Import the saved configuration.

When you import a message configuration, and the message already exists in the system, then
the value of the ¥ LATEST IDENTIFIER columnisupdatedtoYinthe FSI RT SWIFT CON-
F_DTLS and DIM_SANCTIONS SWIFT DETAILS tables.

The audit history is captured inthe FST RT SWIFT CONF DTLS HIST tableinthev HIST -
DESC column and will have the following remark: Configuration Updated Through
Migration Utility.

Running the Migration Utility for ISO20022

Use this migration utility to import and export the ISO20022 message configurations from one
environment to another, for example, from the development server to UAT, and subsequently to
production. For information on configuring the ISO20022 message parameters, see Configurations for
ISO20022 Message Parameters.

To use the utility, first export the configuration from the source environment and then import the file to
the destination environment. To export the configuration, follow these steps:

1. Navigatetothe $SFIC HOME/Transaction Processing/TF Config Migration Util-
ity/config directory.

2. Openthe Dynamic.properties file and update the placeholders as shown:

Table 11: Configurations required in the Dynamic.properties file when running the export file

Placeholder Update with...

##jdbcurl## Your JDBC URL.

The Atomic Schema user name using which you want to execute the

##username## files.
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Table 11: Configurations required in the Dynamic.properties file when running the export file

Placeholder Update with...

#itpassword## The Atomic Schema password for the user name.

##infodom## Your Infodom name.

Your ISO20022 ID. This is available inthen_xsd conf id columnin
the fcc tf xml xsd conf table.

If you are providing multiple IDs, add the IDs separated by commas. For
example, 1,2,3,4.

##N_XSD_CONF_ID##

3. Navigatetothe TF Config Migration Utility/bin directory and run the required com-
mand.

./export.sh SEPA
To import the configuration, follow these steps:
1. Navigatetothe TF Config Migration Utility/config directory.

2. Openthe Dynamic.properties file and update the placeholders as shown:

Table 12: Configurations required in the Dynamic.properties file when running the import file

Placeholder Update with...

##jdbcurl## Your JDBC URL.

#ttuser- i i i i
i The Atomic Schema user name using which you want to execute the files.
##pass- The Atomic Schema password for the user name

word## .

##infodom## | Your Infodom name.

Your 1SO20022 ID. This is availableinthe n_xsd conf idcolumninthe fcc t-

H#H#N_XSD_- f xml xsd conf table.
CONF_ID## If you are providing multiple IDs, add the IDs separated by commas. For example,
1,2,3,4.

3. Navigatetothe TF Config Migration Utility/bin directory and run the required com-
mand.

./ import.sh SEPA.

Configuring JMS Correlation ID

JMS message has two properties (column) called Correlation ID and Message Identifier.

To set the Correlation ID, use the following sample code:

See Code for Adaptor for SWIFT section in the Technical Integration Guide.
SourceEntity srcEntity = new SourceEntity(busName); // already there
srcEntity.setCorrelationID("12345"); // corrid to be set (Optional)

Both initial and final feedback are set with same correlation ID while sending response to output queue.
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Figure 38: JMS Message Output Queue
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Configuring Parallel Processing
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To enable parallel calling of EDQ web services, the following are the new configuration parameters

introduced:

e Setup_rt_params table:

m ENABLE PARALLEL WS CALL - This Parameter is to indicate if a calling of EDQ Webservices
from parser should be parallel or sequential. If the value is set to VY, it will be parallel. If the
value is set to N, it will be sequential.

m ENABLE PARALLEL WS TAGS CALL - This Parameter is to indicate if a calling of EDQ Web-
services tags from the parser should be parallel or sequential. If the value is set to Y, it will be
parallel. If the value is set to N, it will be sequential. By default OOB, both the parameters will

be set to N.

e static.properties file:

The following are the new parameters introduced in the static.properties file under
<DeployedContext>/TFLT.ear/TFLT.war/conf:

] tf.edg.webservices.maxthread.count=6 - This Parameter is used to indicate EDQ
Webservices thread count. This creates a thread pool with 6 threads executing the tasks.

m tf.edg.webservices.tags.maxthread.count=>5 - This Parameter is used to indicate
EDQ Webservices tags thread count. This creates a thread pool with 5 threads executing the
tasks. By default OOB thread count for both parameters is set to 6 and 5, respectively.

Configuring Additional Columns on the Alert List page

This configuration allows you to add additional column(s) on the Alert Search and List page and view
additional information. It also provides the ability to execute the customized query to fetch the data in
the columns against each Alert ID and shows the new columns in the Columns drop-down list while
saving the view. To add a column on the Search and List page and filters, follow these steps :

1. Add an entry in this table "FCC_SANC_LIST_PAGE_CONFIG" to configure a new value in the col-
umn drop-down section for FSI_RT_ALERTS
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See FCC_SANC_LIST_PAGE_CONFIG.xIsx file for sample entries for Case ID and BIC Code Key

NUTE Add an entry only for the DEFAULT view.
"TABLE_NAME" column must have ' FSI_RT_ALERTS' value

"COLUMN_NAME" column must have alias column name value in
the parent table like caseld, bicCodeKey and so on.

2. Add an entry in this table "FCC_SAN_LIST_CONFIG" to configure a new value in the filter search
section for TF_LIST_FILTER.

See fcc_san_list_config.xlIsx file with sample entries for Case ID and BIC Code Key.

3. Add an entry in this table "FCC_SAN_LIST_CONFIG_TL" to configure a new value in the filter
search section.

See fcc_san_list_config_tl.xIsx file for sample entries for Case ID and BIC Code Key.

NOIE N_CONFIG_ID column value 1n this table must match with
N_CONFIG_ID value in "fcc_san_list_config" table..

4. Update "v_query" column in table "FCC_SANC_LIST_PAGE_QUERY_CONF" where "V_QUE-
RY_IDENTIFIER" column value is ‘TF_ALERTLIST_GRID', with the new column details in select
query to get the data for new column.

5. Update "v_query" column in table "FCC_SANC_LIST_PAGE_QUERY_CONF" where "V_QUE-
RY_IDENTIFIER" column value is ‘TF_ALERTLIST_GRID_FROM_QUEUE', with the new column
details in select query to get the data for new column.

6. Update "v_query" column in table "FCC_SANC_LIST_PAGE_QUERY_CONF" where "V_QUE-
RY_IDENTIFIER" column value is ‘TF_CLOSED_ALERT_GRID', with the new column details in
select query to get the data for new column

7. Thisis an optional step.Do not follow the below steps if you are trying to configure the column
from the existing listed tables in the query do not follow the below steps. If not, follow the below

step,

m update "v_query" column in this table "FCC_SANC_LIST_PAGE_QUERY_CONF" where
"V_QUERY_IDENTIFIER " column value is * TF_ALERTS_COUNT_IN_QUEUE’ with the new
column details in select query to get the updated count value.

m update "v_query" column in this table "FCC_SANC_LIST_PAGE_QUERY_CONF" where
"V_QUERY_IDENTIFIER " column value is * TF_ALERTS_ZIPPER_COUNT’ with the new col-
umn details in select query to get the updated count value.

5.17  Retrigger Functionality

While posting the SWIFT/Fedwire/ISO20022 messages, if any of the EDQ web service pointing to the
application is down, messages will be retriggered once all the required web services are up.

The Retrigger configuration parameters are:

e RETRIGGER INTERVAL MINS parameterinthe setup rt params table under atomic
schema. By default, v._ ATTRIBUTE VALUE1l value is set to 30 min which are customizable and
can be changed (increased/decreased) as per user requirement.

e RETRIGGER MAX RETRIES parameterinthe setup rt params table under atomic schema.
By default, v ATTRIBUTE VALUEL value is set to 5, which is customizable and can be changed
(increased/decreased) as per user requirement. Once the max value is reached per message, the
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General Configurations
Configuring New Watchlist Summary Field Name

5.17.1

5.18

retrigger loop will be terminated, and the v. RETRY STATUS CD parameter is updated to T for
the particular message in FSI_RT RAW DATA table.

Configuring Data Source in WebLogic Application Server

If the ENABLE PARALLEL WS CALLand ENABLE PARALLEL WS TAGS CALL parameter valuesare Y
inthe SETUP_RT PARAMS table, it is recommended to perform the following configuration in Weblogic
Application Server to avoid retrigger failure.

1.

o v oA W

Open WebLogic Application Server. For more information, see Oracle Financial Services
Sanctions Pack Installation and Configuration Guide.

From the LHS menu (Domain Structure), click Services Data Sources. The Summary of JDBC
Data Sources window is displayed.

Select SANCINFO from the Data Sources table. The Settings for SANCINFO window is displayed.
Select the Connection Pool tab.
Click Advanced. The Advanced informations are displayed.

Click and select the Test Connections On Reserve Check box and enter the value as SQL IS
VALID in Test Table Name.

Click Save.

Configuring New Watchlist Summary Field Name

To configure or add new watchlist field name to display in the watchlist summary details follow the
subsequent steps:

1.

2.

Access the Config schema and access themessages _en US table.
Map the new field names inmessages_en_US table as below:

m msg identifier as ZTF WATCHLIST <field Name>

®m  msg package as RENDERER

m msg description as <field Name>

the table.

I NOTE The remaining parameter entries can be same as other entries in

For Example:

insert into messages _en us (MSG_PACKAGE, MSG IDENTIFIER, MSG_CODE,
MSG_DESCRIPTION,MSG TYPE) values

("RENDERER', 'ZTF WATCHLIST ADDRESS COUNTRY CODE','80808','Address Country
Code','L");
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Configuring the SWIFT Message Parameters
Message and Screening Configurations Window

6.1

Configuring the SWIFT Message Parameters
To configure the message and screening parameters, follow these steps:

1. Navigate to the Financial Services Analytical Applications Transactions Filtering landing
page.

2. Click SWIFT Configuration Admin. The Message and Screening Configurations tab is dis-
played.

e folliowing screens are the same 1or the Fedwire an
message parameters.

This tab has the following windows:
e Message and Screening Configurations Window
e <Message Type> Subfield Level Configuration Window
e <Message Type> Screening Configuration Window

e <Message Type> Other Field/Subfield Configuration Window

Message and Screening Configurations Window

This window allows you to edit the status, field names, and expressions of the different JISON
parameters in the message.

In the Message Type Configuration field, select the SWIFT message category. All message definitions
are SWIFT 2019 compliant.

The following message types, MTC11, MTC22, MTC33, and MTC44, have been introduced for creating
custom message categories, and they support UTF-8 characters. To add custom message categories,
usethe dim sanc swift msg details table. The new format must contain MTC and must be
followed by a two-digit number.

You can also add a single line or multiple lines for Chinese characters. To add a single line, use 100k for
the expression in the configuration JSON. To add multiple lines, use 100*100k for the expression in
the configuration JSON.
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Figure 39: Sample format for MTC11/MTC22/MTC33/MTC44 SWIFT message type

{1:FO1SIIBSYDA9998525820}
{2:0C11540170801FSBKDZALAXXX1237
0781261708020718N}H4:
20:0AC44591555/5465
11AZFE T E
:12:0sama Bin laden
Pakistan
134T
14:E] [‘5{‘
15:#4E
iR
IR
-16:test data
-H5:{MAC:44544500}
{CHK:3E59F535CT1E9{PDE:{PDE:}
{DLM:HSASACHCOP:SH

In this example, C11 can be either 11 or 11A and not 111. So, the tag can either start with two numbers or

two numbers and one alphabet. The value in the 11A tag represents 100k in the JSON expression, and
the value in the 15 tag represents 100*100k in the JSON expression.

A sample JSON is shown:
{
"attr": {
"id": "t4:2:2",
"field": "12",
"status": "M",
"fieldName": "Entity Type",
"expression": "100k",
"regex": "",

"editable": "Y"

by

"attr": {

"id": "t4:2:3",

"field": "13",
"status": "M",
"fieldName": "Entity Relationship",
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"expression": "100*100k",
"regex": "",

"editable": "Y"

by

Each message type has five blocks: Basic Header Block, Application Header Block, User Header Block,
Text Block, and Trailer Block.

Figure 40: Message and Screening Configurations Window for SWIFT

Message and Screening Configurations

Message Type Configuration

MT101 v Add/Update Reference Configuration Save ’

Expression dd
4 Basic Header Block

Block Identifier
Application Identifier
Service |dentifier
LT Identifier

Session Number

Sequence Number (ISN or OSN)
4 Application Header Block
» Application Header - Input
» Application Header - Output
4 User Header Block
In this figure, the first column lists all the SWIFT blocks and a list of fields within each block which
follows SWIFT naming standards. In this field, if a part of the sequence has multiple formats, then while

uploading the JSON for the message type, update the formats within [ . . ] with unique identifiers. The
other columns are:

e Status: This column mentions whether the field is Mandatory (M) or Optional (0).
e FieldName: This column describes the name of the given field as per SWIFT standards.

o Expression: This column depicts the field structure in terms of expression. For example, if the
field is a data type, then the maximum length of the field is displayed.

To edit a parameter, click the parameter name. After you make the changes, click Save.

6.1.1 Adding or Updating a New Message Type

To add or update an existing message type, follow these steps:
1. Click the Add/Update button. The Attachment Details window is displayed.
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2. Select the type of message that you want to add or update from the drop-down list.

Figure 41: Attachment Details Window

Attachment Details

MT101 Select file to upload: | Choose File | No file chosen

Upload

Status FieldName

No items to display

3. To upload an attachment, click Choose File ' chwsaFis |, You can upload only one attachment at a
time.

I NOIE

6.1.2

I'nis Tile must be ot the Tormat .json Or .txt.

4. C(lick Upload.
5. Click Submit. The message is displayed in the following table as <Message Type draft>.

For more information on the JSON format, see Structure of a JSON.

Repeating Sequences

If the SWIFT message contains sequences and the same tag repeats in both the sequences and the
subsequences, then you must set the v. REPEAT TYPE column to Y in the

dim sanc _swift msg details table before you upload a new message type. If a SWIFT message
has already been uploaded, then after you set the v. REPEAT TYPE columnto Y in the

dim sanc_swift msg details table, you can click the Save button in the Message Type
Configuration.

Configuring Message and Transaction References

Any message which contains message references or transaction references, or both, must be
configured. To view and change the message reference or transaction reference, click Reference
Configuration.

OFS Transaction Filtering Admin Guide 63



Configuring the SWIFT Message Parameters
<Message Type> Subfield Level Configuration Window

Figure 42: Reference Configuration Window

Message Identifier: 20 v
Transaction Reference:

21 v
Save

For the Message Reference field, a unique identifier must be configured at the message level for all
message categories. For the Transaction Reference field, a unique identifier must be configured at
the transaction level only if applicable for the specific message category.

6.2 <Message Type> Subfield Level Configuration Window
This window allows you to add a subfield to a field in the Message Type Configuration Window.

Figure 43: <Message Type> Subfield Level Configuration Window

Message and Screening Configurations

MT101 Subfield Level Configuration < >
Expression Identifier: Must enter a unique identifier Expression Name: Must enter a Name Expression Description: Must enter description
Field: v Field/Subfield Name: v Subfield Expression Format & Occurrence: 1 A
Add R Clear
Expression ID Expression Name Expression Description Field Field/Subfield Name
EXPAMOUNTId Amount Transaction Amount 32B Currency/Transaction Amount
EXPCURRENCYid Currency Transaction Currency 32B Currency/Transaction Amount

1. To add a subfield, provide the required values in the fields shown in the window and click Add

A% Enter values in the following fields:

Table 13: Fields in the <Message Type> Subfield Level Configuration Window

Fields Field Description

Enter a unique identifier. It must begin with an alpha character and must

Expression Identifier not contain any spaces. This is a mandatory field.

Enter a name for the expression. The name must be in capital letters.

Expression Name This is a mandatory field.

Expression Description Enter a description for the Expression. This is a mandatory field.

This field displays a complete list of fields in the drop-down for the given
Field message type. Select the field from this drop-down field to configure the
expression.

This field displays the respective field name or subfield options for the
Field/Subfield Name field that was previously selected. Select the subfield from the drop-
down list.

This field is populated when the Field is selected. Select an expression as
Subfield Expression Format | it as or an element from that expression. You can also enter the number
& Occurrence of occurrences for the expression within that message. By default, it is
always 1.
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Table 13: Fields in the <Message Type> Subfield Level Configuration Window

Fields Field Description

To add a subfield, provide the required values in the fields shown above
Add button Add
and click Add .

To update an existing subfield, click the name of the subfield. After you
Update button
make the changes, click Update “Paa%®

To remove an existing subfield, click the name of the subfield and click

Remove button s
Remove

Cle
Clear button To clear the data in these fields, click Clear o .

2. To update an existing subfield, click the name of the subfield. After you make the changes, click
Update.

3. To remove an existing subfield, click the name of the subfield and click Remove.
4. To clear the data in these fields, click Clear.
You can configure the subfield in two ways:

e By configuring the subfield level data within the option expression: Do this if you want to
configure specific data within the expression.

For example, if field 57 has four optionsa, B, C, and DinMT103 message but you want to
configure BIC (Identifier Code) from option A:

Option A:
[/1'a]l[/34x] (Party Identifier)
41'a2'a2'!lc[3!c] (Identifier Code)

You must enter the names in the Subfield Expression Identifier, Subfield Name, and Subfield
Description fields.

e By configuring the element level data within the subfield expression: Do this if you want to
further configure any data out of the subfield.

In this example, if you want to configure the country code for field 57, then you can config-
ure 2! a from Identifier Code expression as a country code by giving unique names in the Sub-
field Expression Identifier, Subfield Name, and Subfield Description fields.

Option A:
[/1'a]l[/34x] (Party Identifier)
4'a 2'a 2!'c[3!c] (Identifier Code)
6.3 <Message Type> Screening Configuration Window

This window allows you to add, update, remove, and enable or disable a web service.
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ORACLE’ configuration Screen

Message and Screening Configurations

MT101 Screening Configuration

Expression (ID-Name):
Enable:

Business Domain: BranchA

Screening webservice
Identifier
Identifier
Identifier
Identifier
Identifier
|dentifier
Identifier
Identifier
|dentifier

Identifier

Figure 44: <Message Type> Screening Configuration Window

Screening webservice: |dentifier - < >
(OR) Field: - Field/Subfield Name:
Message Direction: v Jurisdiction : INDIA v
Add Update Remove  Enable All Disable All
Expression ID Expression Name Field Field/Subfield Name

S0F[Format1]
50H
56D

50F[Format2]
50F[Formatz]
50F[Format1]

50H

To view a web service, enter values in the following fields:

Table 14: Fields in the <Message Type> Screening Configuration Window

Fields Field Description

Screening WebService

Select a screening web service from the drop-down list. This field lists all
the supported matching web services in the Transaction Filtering
application. The following web services are available:

Identifier

Country and City

Goods Screening

Name and Address

Narrative or Free Text Information
Port Screening

The fields for all web services except Goods Screening are as shown here.
For information on the fields for Goods Screening, see Fields for Goods
Web Services.

Expression (ID-Name)

Select an expression identifier. When you select an expression identifier,
the values are populated in the Field and Field/Subfield Name fields.

Field

Select the field name.

Field/Subfield Name

Select the subfield name. This displays the expression.

Enable

Select Yes to enable the web service. Select No to disable the web ser-
vice.

Message Direction

Select INBOUND(0) and OUTBOUND(i) based on the screening
requirement from the drop-down list. If a field must be screened only for
incoming messages, select inbound, else select outbound. If that field
must be screened for both inbound and outbound, then select ANY.
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Table 14: Fields in the <Message Type> Screening Configuration Window

Fields Field Description

Select All to apply the Webservice for all jurisdictions or select the spe-
cific jurisdiction to apply the webservice for a specific jurisdiction.

Use the kdd_jrsdcn table to configure the jurisdiction values. It has
the following columns:

e JRSDCN_CD: Values must be unique.

Jurisdiction e JRSDCN_NM: Actual jurisdiction name.
e JRSDCN_DSPLY_NM: Jurisdiction name displayed in the Mes-
sage and Configurations screen.
e JRSDCN_DESC_TX: Optional field to adbusinesd descriptions
for the jurisdictions.
To add a web service, provide the required values in the fields shown
Add button

above and click Add

Update button

To update a web service, select the web service that you want to update

and click Update “rda®=

Remove button

To remove a web service, select the web service that you want to remove

and click Remove “*™"®

Enable All button

To enable all web services, click Enable All EMe@=Al

Disable All button

To disable all web services, click Disable All P& Al

The fields you can use to configure the Goods web service are different from the fields you can use to
configure the other web services. These fields are as shown:
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Figure 45: Fields for Goods Web Services

MT101 Screening Configuration Screening WebService: Goods Screening v < >
Goods: Expression Identifier: v {OR) Tag: - Field Name: v
Import Country from:  Expression Identifier: v {OR) Tag: - Field Name: v
Export Country to: Expression Identifier: v (OR) Tag: - Field Name: -

Message Direction: |NBOUND v Enable: yes v

Input: { Expression Name: N/A, Tag Name: 58, Field Name: Name and Address )
Import Country From: ( Expression Name: N/A, Tag Name: 58A, Field Name: Identifier Code )
Export Country To: ( Expression Name: N/A, Tag Name: 59F, Field Name: Name and Address )

Add Update Remove Enable All Disable All

Messege Direction: INBOUND
Enable: Y

Table 15: Fields in the Goods Web Service Window

Fields Field Description

Expression Identifier

Select the Expression for the good.

Tag

Select the tag related to the good. Based on the tag selected, the field
name is populated.

Field Name

The field name is populated based on the tag selected.

Message Direction

Select INBOUND(0) and OUTBOUND(i) based on the screening
requirement from the drop-down list. If a field must be screened only for
incoming messages, select inbound, else select outbound. If that field
must be screened for both inbound and outbound, then select ANY.

Enable

Select Yes to enable the message in a direction. Select No to disable the
message in a direction.

Add button

To add a web service, provide the required values in the fields shown

above and click Add

Update button

To update a web service, select the web service that you want to update

and click Update “Pda®=

Remove button

To remove a web service, select the web service that you want to remove

and click Remove “*™"®

Enable All button

To enable all web services, click Enable All EM@=Al

Disable All button

To disable all web services, click Disable All P& Al

6.3.1 Enabling or Disabling a Web Service

By default, every web service is enabled. You can change the message configuration by disabling a web
service. When you do this, the selected web service is not evaluated.
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6.3.2

6.3.3

To enable or disable one or more web services, replace the [WEBSERVICE IDS] placeholder with the
corresponding web service ID. The web services and the corresponding IDs are shown here:

Table 16: Web Services in Transaction Filtering

Web Service Web Service ID

Name and Address Name and Address

BIC BIC

Country and City Country and City

Narrative or Free Text Information Narrative or Free Text Information
Port Screening Port Screening

Goods Screening Goods Screening

To disable all the web services, replace the [WEBSERVICE IDsS] placeholder with1, 2,3, 4,5, 6 in the
following command:

UPDATE FSI _RT MATCH SERVICE SET F ENABLED = 'N' WHERE N WEBSERVICE ID IN
([WEBSERVICE IDS])

To enable all the web services, change Nto Y.

Updating and Removing a Web Service

To update an existing web service, click the name of the web service. The fields are populated with the
web service parameters. After you make the changes, click Update.

To remove an existing web service, click the name of the web service and click Remove.

Pppulating Data for the Trade Goods and Trade Port Web Ser-
vices
Data for the Trade goods and Trade port web services are taken from a reference table. To populate
data for these web services, do this:
1. Inthe EDQ Director menu, go to the Watch List Management project.
Right-click on the Reference Data Refresh job.
Click Run. Provide a unique run label and run profile.
When you run this job, the port and goods reference data are refreshed at the same time.
Go to the Transaction Filtering project.
Right-click on the MAIN-Shutdown Real-time Screening job to shut down all web services.
Click Run.
Right-click on the MAIN job to restart all web services.
Click Run.

© 0O N o U A WN
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6.4 <Message Type> Other Field/Subfield Configuration

Window

This window allows you to update the other fields which are required for the application. It displays the
list of fixed business data/names for the required fields to run the system for any given message type.
You can select a business data value to mention the source for a given message type.

Figure 46: <Message Type> Other Field/Subfield Configuration Window

Message and Screening Configurations

MT101 Other Field/Subfield Configuration

Generic Business Data:

Expression (ID-Name):

Generic Business Data
Amount
Beneficiary Address
Beneficiary IBAN/Account/Identifier
Currency
Message |dentifier
Originator Address
Originator Address

Originator Address

v Message Direction: v
(0R) Field: v Field/Subfield Name: v

Add Update Remove

Expression ID Expression Name Field Field/Subfield Name

EXPAMOUNTIid Amount

59 Name and Addre

59A Accol
EXPCURRENCYid Currency

20 Sender's Referen

50F[Format1] Name and Addre

50F[Format2] Name and Addre

50H Name and Addre

To update the parameter, click the parameter name. The fields are populated with the field parameters.
The following fields are displayed in this window:

Table 17: Fields in the <Message Type> Other Field/Subfield Configuration Window

Fields Field Description

Generic Business Data

This field displays the Business Name of the record that is selected. It is
mandatory to configure this field.

If the message contains one or more of the B, C, D, or E sequences, you
must configure the field with the first tag of the sequence according to
the SWIFT standard.

Message Direction

Select INBOUND(0) and OUTBOUND(i) based on the screening
requirement from the drop-down list. If a field must be screened only for
incoming messages, select inbound, else select outbound. If that field
must be screened for both inbound and outbound, then select ANY.

Expression (ID-Name)

Select an expression identifier. When you select an expression identifier,
the values are populated in the Field and Field/Subfield Name
fields.

Field

Select the field name.

Field/Subfield Name

Select the Subfield Name. This displays the Expression.

Add button

To add a web service, provide the required values in the fields shown

above and click Add ***

Update button

To update a web service, select the web service that you want to update

and click Update “Pda®=
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Table 17: Fields in the <Message Type> Other Field/Subfield Configuration Window

Fields Field Description

To remove a web service, select the web service that you want to remove

Remove button o
and click Remove

After you make the changes, click Update.
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7

7.1

Configuring the Fedwire Message Parameters
To configure the message and screening parameters, follow these steps:

1. Navigate to the Financial Services Analytical Applications Transactions Filtering landing
page.

2. Click FEDWIRE Configuration Admin. The Message and Screening Configurations tab is dis-
played.

e folliowing screens are the same 1or the Fedwire an
message parameters.

Figure 47: Message and Screening Configurations tab for Fedwire

Message and Screening Configurations

Message Type Configuration

FDBTR1002 v  Add/Update Reference Configuration Save >

Expression dd

4 Text Block
1100 M Message Disposition 2In1leirtlc
110 M Receipt Time Stamp 4lndlndlc
1120 M Output Message Accountability Data 8In8lcé!nd!ndIndlc
1130 o} Error 11c31c35r
1500 M Sender Supplied Information 2In8lctlctlc
1510 M Type/Subtype 2In2!n
1520 M Input Cycle Date/Input Source/Input Sequer 8In8lcéIn
2000 M Amount 12In

This tab has the following windows:
e Message Type Configuration Window
e <Message Type> Subfield Level Configuration Window
e <Message Type> Screening Configuration Window

e <Message Type> Other Field/Subfield Configuration Window

Message Type Configuration Window

This window allows you to edit the status, field names, and expressions of the different JISON
parameters in the message.

In the Message Type Configuration field, select the Fedwire message category.

The following image shows a sample Fedwire message:
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7.1.1

Figure 48: Sample Fedwire Message

{1100}02P 7{1110}03082108FT01{1120}20060309B6B0072D00000103082108FT01{1500}30QWERTYUIPP{1510}1002{1520}20200317CTRFULLC000156{2000}000001234567{3100}123456789IRAN
DEVOTIONAL*{3320}IPE1030800065862{3400}123456789RIHS IVORY COASTS SOMALIA*{3500}PREMSGIDENTIFIER{3600}BTR{4000}BSIIBSYDA*SYRIA INTERNATIONAL ISLAMIC BANK

**%%{4100}D121149*MELLI BANKAS*Paris*FRANCE**{4200}D1234456656* MELLI BANKAS*Paris*FRANCE**{4320}TERRORIST{5000}D123456789*Wells Fargo Bank Texas National*Association 109 North San

Saba*San Antonio Texas 78207**{5100}BBOFAUS3N*COOPER&PRICE MANAGEMENT MANULIFE *PLAZA ROOM 1202-05 12TH FLOOR*THE HK,HONG
KONG**{5200}CCHIPSParticipant*Name*Address1*Address2*Address3*{6000}YOUR INVOICE OFF-0506-7450****{6100}ROUTING NO
026005322******{6200}Terrorist******{6210}LTRLETTERDETAILS******{6300}YOUR INVOICE OFF-0506-7450******{6310}LTRQWERTYUIOP******{6400}L/C NO.CR2016/151479 YR.
REF*RCL/FBDL/151479*****{6410}LTRLETTERDETAILS******{6420}CHECK123456*{6500}CHECK123456* *****

Each message type has a Text Block. The fields in the Text Block may change depending on the
message type.

Figure 49: Message and Screening Configurations tab for Fedwire

Message and Screening Configurations

Message Type Configuration

EDBTR1002 v  Add/Update Reference Configuration Save >

Expression dd

4 Text Block
1100 M Message Disposition 2In1leirilec
110 M Receipt Time Stamp 4IndIndlc
120 M Output Message Accountability Data 8In8lcé!n4!n4Indlc
1130 o} Error 11c31c35r
1500 M Sender Supplied Information 2In8lctlctlc
1510 M Type/Subtype 2In2!n
1520 M Input Cycle Date/Input Source/Input Sequer 8In8lcéIn
2000 M Amount 12In

In this figure, the first column lists all the message identifiers for the Fedwire message category. The
other columns are:

e Status: This column mentions whether the field is Mandatory (M) or Optional (O).
e FieldName: This column describes the name of the given field as per Fedwire standards.

e Expression: This column depicts the field structure in terms of expression. For example, if the
field is a data type, then the maximum length of the field is displayed.

To edit a parameter, click the parameter name. After you make the changes, click Save.

Adding or Updating a New Message Type

To add or update an existing message type, follow these steps:
1. Click Add/Update. The Attachment Details window is displayed.

2. Select the type of message that you want to add or update from the drop-down list.
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Figure 50: Attachment Details Window
Attachment Details C

FDBTR1002 Select file to upload: | Choose File |No file chosen

Upload
Status Field Name

No items to display.

3. To upload an attachment, click Choose File ' chwsaFis |, You can upload only one attachment at a
time.

INUII:

7.1.2

7.2

I'nis Tile must be of the Tormat ..json Or .txt.

4. Click Upload.
5. Click Submit. The message is displayed in the following table as <Message Type_draft>.

For information on the JSON structure, see Structure of a JSON.

Configuring Message and Transaction References

Any message which contains message references or transaction references, or both, must be
configured. To view and change the message reference or transaction reference, click Reference
Configuration.

Figure 51: Reference Configuration Window

Message Identifier:

1120

Save

For the Message Reference field, a unique identifier must be configured at the message level for all
message categories. For the Transaction Reference field, a unique identifier must be configured at the
transaction level only if applicable for the specific message category.

<Message Type> Subfield Level Configuration Window

This window allows you to add a subfield to a field in the Message Type Configuration Window.
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Figure 52: <Message Type> Subfield Level Configuration Window

Message and Screening Configurations

FDBTR1002 Subfield Level Configuration < >

Expression Identifier: Expression Name: Expression Description:

Must enter a unique identifie Must enter a Name Must enter description

Field: Field/Subfield Name:

Subfield Expression Format & Occurrence:
v v
1 A
Add Update e e Clear
Expression ID Expression Name Expression Description Field Field/Subfield Name

1. To add a subfield, provide the required values in the fields shown in the window and click Add

A% Enter values in the following fields:

Table 18: Fields in the <Message Type> Subfield Level Configuration Window

Fields Field Description

Enter a unique identifier. It must begin with an alpha character and must

Expression Identifier not contain any spaces. This is a mandatory field.

Enter a name for the expression. The name must be in capital letters.

Expression Name This is a mandatory field.

Expression Description Enter a description for the Expression. This is a mandatory field.

This field displays a complete list of fields in the drop-down for the given
Field message type. Select the field from this drop-down field to configure the
expression.

This field displays the respective field name or subfield options for the
Field/Subfield Name field that was previously selected. Select the subfield from the drop-
down list.

This field is populated when the Field is selected. Select an expression as

Subfield Expression it as or an element from that expression. You can also enter the number
Format & Occurrence of occurrences for the expression within that message. By default, it is
always 1.

To add a subfield, provide the required values in the fields shown above

Add button Add

and click Add

To update an existing subfield, click the name of the subfield. After you
Update button
make the changes, click Update YFda=

To remove an existing subfield, click the name of the subfield and click

Remove button Remove
Remove

Cle
Clear button To clear the data in these fields, click Clear o .

You can configure the subfield in two ways:
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By configuring the subfield level data within the option expression: Do this if you want to
configure specific data within the expression.

For example, if 1100 has four options 2, B, C, and Dinthe FDBTR1002 message but you want

to configure BIC (Identifier Code) from option A:
Option A:

[/1'all[/34x] (Party Identifier)
41'a2'a2'!'c[3!c] (Identifier Code)

You must enter the names in the Subfield Expression Identifier, Subfield Name, and Subfield
Description fields.

By configuring the element level data within the subfield expression: Do this if you want to
further configure any data out of the subfield.

1.In this example, if you want to configure the country code for field 57, then you can config-
ure 2! a from Identifier Code expression as a country code by giving unique names in the Sub-
field Expression Identifier, Subfield Name, and Subfield Description fields.

Option A:
[/1'all[/34x] (Party Identifier)

4'a 2'a 2'!'c[3!c] (Identifier Code)

~.1

This window allows you to add, update, remove, and enable or disable a web service.

Figure 53: <Message Type> Screening Configuration Window

Message and Screening Configurations

FDBTR1002 Screening Configuration

Expression (ID-Name):

Enable:

Screening webservice
BIC
BIC
BIC
BIC
BIC

BIC

Screening webservice: BIC

Field/Subfield Name:
(OR) Field:

Jurisdiction :
All

Message Direction:

Add Update

Expression ID Expression Name Field

Remove

4000

4100

4200

5000

5100

5200

<Message Type> Screening Configuration Window

Enable All Disable All

Field/Subfield Nan

OFS Transaction Filtering Admin Guide| 76



Configuring the Fedwire Message Parameters
<Message Type> Screening Configuration Window

To view a web service, enter values in the following fields:

Table 19: Fields in the <Message Type> Screening Configuration Window

Fields Field Description

Screening WebService

Select a screening web service from the drop-down list. This field lists all
the supported matching web services in the Transaction Filtering
application. The following web services are available:

BIC

Country and City

Goods Screening

Name and Address

Narrative or Free Text Information
Port Screening

The fields for all web services except Goods Screening are as shown here.
For information on the fields for Goods Screening, see .

Expression (ID-Name)

Select an expression identifier. When you select an expression identifier,
the values are populated in the Field and Field/Subfield Name
fields.

Field

Select the field name.

Field/Subfield Name

Select the subfield name. This displays the expression.

Enable

Select Yes to enable the web service. Select No to disable the web ser-
vice.

Message Direction

Select INBOUND(o) and OUTBOUND(i) based on the screening require-
ment from the drop-down list. If a field must be screened only for incom-
ing messages, select inbound, else select outbound. If that field must
be screened for both inbound and outbound, then select ANY.

Select All to apply the Webservice for all jurisdictions or select the spe-
cific jurisdiction to apply the webservice for a specific jurisdiction.

Use the kdd_jrsdcn table to configure the jurisdiction values. It has
the following columns:

JRSDCN_CD: Values must be unique.

Jurisdiction JRSDCN_NM: Actual jurisdiction name.
JRSDCN_DSPLY_NM: Jurisdiction name displayed in the Mes-
sage and Configurations screen.
JRSDCN_DESC_TX: Optional field to add descriptions for the
jurisdictions.
To add a web service, provide the required values in the fields shown
Add button

above and click Add ™

Update button

To update a web service, select the web service that you want to update

and click Update “rdae=

Remove button

To remove a web service, select the web service that you want to remove

and click Remove ¥
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Table 19: Fields in the <Message Type> Screening Configuration Window

Fields Field Description

Enable All button

To enable all web services, click Enable All EnaeiE Al

Disable All button

To disable all web services, click Disable All P#an Al

The fields you can use to configure the Goods web service are different from the fields you can use to
configure the other web services. These fields are as shown:

Figure 54: Fields for Goods Web Services
MT101 Screening Configuration

Goods: Expression Identifier:

v (OR)
Import Country from:  Expression Identifier: v (OR)
Export Country to: Expression Identifier: v (OR)

Message Direction:  |NBOUND

Input: { Expression Name: N/A, Tag Name: 58, Field Name: Name and Address )
Import Country From: ( Expression Name: N/A, Tag Name: 594, Field Name: Identifier Code )
Export Country To: ( Expression Name: N/A, Tag Name: 59F, Field Name: Name and Address )

Screening WebService: Goods Screening

Tag:

Tag:

Tag:

Enable:  yes

w  Field Name:
v Field Name:

- Field Name:

Add Update Remove Enable All Disable All

Messege Direction: INBOUND
Enable: Y
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7.1.1

Table 20: Fields in the Goods Web Service Window

Fields Field Description

Expression Identifier

Select the Expression for the good.

Tag

Select the tag related to the good. Based on the tag selected, the field
name is populated.

Field Name

The field name is populated based on the tag selected.

Message Direction

Select INBOUND(o0) and OUTBOUND(i) based on the screening require-
ment from the drop-down list. If a field must be screened only for incom-
ing messages, select inbound, else select outbound. If that field must
be screened for both inbound and outbound, then select ANY.

Enable

Select Yes to enable the message in a direction. Select No to disable the
message in a direction.

Add button

To add a web service, provide the required values in the fields shown

above and click Add ™

Update button

To update a web service, select the web service that you want to update

and click Update Uroae

Remove button

To remove a web service, select the web service that you want to remove

and click Remove ¥

Enable All button

To enable all web services, click Enable All EMe@=Al

Disable All button

To disable all web services, click Disable All P#an Al

Enabling or Disabling a Web Service

By default, every web service is enabled. You can change the message configuration by disabling a web
service. When you do this, the selected web service is not evaluated.

To enable or disable one or more web services, replace the [WEBSERVICE IDS] placeholder with the
corresponding web service ID. The web services and the corresponding IDs are shown here:

Table 21: Web Services used in Transaction Filtering

Web Service Web Service ID

Name and Address

Name and Address

BIC

BIC

Country and City

Country and City

Narrative or Free Text Information Narrative or Free Text Information

Port Screening

Port Screening

Goods Screening

Goods Screening
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7.1.2

~.1.3

7.2

To disable all the web services, replace the [WEBSERVICE IDS] placeholder with1, 2,3, 4,5, 6 in the
following command:

UPDATE FSI RT MATCH SERVICE SET F ENABLED = 'N' WHERE N WEBSERVICE ID IN
([WEBSERVICE IDS])

To enable all the web services, change Nto Y.

Updating and Removing a Web Service

To update an existing web service, click the name of the web service. The fields are populated with the
web service parameters. After you make the changes, click Update.

To remove an existing web service, click the name of the web service and click Remove.

Pppulating Data for the Trade Goods and Trade Port Web Ser-
vices
Data for the Trade goods and Trade port web services are taken from a reference table. To populate
data for these web services, do this:
1. Inthe EDQ Director menu, go to the Watch List Management project.
Right-click on the Reference Data Refresh job.
Click Run. Provide a unique run label and run profile.
When you run this job, the port and goods reference data are refreshed at the same time.
Go to the Transaction Filtering project.
Right-click on the MAIN-Shutdown Real-time Screening job to shut down all web services.
Click Run.
Right-click on the MAIN job to restart all web services.
Click Run.

©® N o U AN

<Message Type> Other Field/Subfield Configuration
Window

This window allows you to update the other fields which you can configure in the application. It
displays the list of fixed business data/names for the required fields to run the system for any given
message type. You can select a business data value to mention the source for a given message type.
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Figure 55: Other Field/Subfield Configuration Window

Message and Screening Configurations

FDBTR1002 Other Field/Subfield Configuration <

Generic Business Data: v Message Direction: v
Expression (ID-Name): £ (OR) Field: v Field/Subfield Name: v

Add  Update = Remove

Generic Business Data: Expression ID Expression Name Field Field/Subfield Name

Originator BIC 5000 Identi

Originator IBAN/Account/Identifier 5000 Identi
Originator Address 5000 Name and addre
Beneficiary IBAN/Account/Identifier 4200 Identit
Beneficiary Address 4200 Name and addre

Beneficiary BIC 4200 Identi
Message Identifier 3320 Sender Referer

Requested Execution Date 1520 O e o Sourcefinput
Amount 2000 Amoi

To update the parameter, click the parameter name. The fields are populated with the field parameters.
The following fields are displayed in this window:

Table 22: Fields in the <Message Type> Other Field/Subfield Configuration Window

Fields Field Description

This field displays the business name of the record that is selected. It is
mandatory to configure this field.

Generic Business Data If the message contains one or more of the B, C, D, or E sequences, you
must configure the field with the first tag of the sequence according to
the Fedwire standard.

Select INBOUND(o0) and OUTBOUND(i) based on the screening require-
ment from the drop-down list. If a field must be screened only for incom-
ing messages, select inbound, else select outbound. If that field must be
screened for both inbound and outbound, then select ANY.

Message Direction

Select an expression identifier. When you select an expression identifier,

Expression (ID-Name) the values are populated in the Field and Field/Subfield Name fields.

Field Select the field name.

Field/Subfield Name Select the Subfield Name. This displays the Expression.

To add a web service, provide the required values in the fields shown
Add button S
above and click Add

To update a web service, select the web service that you want to update

Update button
and click Update Uroae

To remove a web service, select the web service that you want to remove

Remove button Remove
and click Remove

After you make the changes, click Update.
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Configurations for ISO20022 Message
Parameters

This chapter explains how to configure the parameters for the ISO20022 message category. The
Configuration window allows you to view the elements associated with an xS file after you upload
the file. The elements are displayed in a tree structure. You must provide the transaction xpath before
submitting the file. After the file is submitted, you can view the elements associated with a specific web
service and define the xPath priority. This xsD file can be downloaded again. The Run page has
information on the different tasks associated with the 1ISO20022 batch.

he XPath of an element 1s the logical structure or hierarchy of the
element within the xsD file.

Configuring the ISO20022 Message Parameters

To configure the ISO20022 message parameters, follow these steps:

1. On the Financial Services Analytical Applications Transactions Filtering landing page, click
1S020022/ XML Configuration Admin. The Configuration window is displayed.

Figure 56: Configuration Window - 1SO20022

Search
Message Provider Sefzct a Message Provider v Message Scheme Ssiect @ Message Scheme v Message Type Seisct a Message Type
Search Refresh
Add Message Remove Message
Message List (10)
Message Provider  Message Scheme Message Type Message Version DownlLoad XSD
15020022 SEPA Credit Transfer Customer Credit Transfer Initiation pain 001.001.08 ﬁ
15020022 SEPA Credit Transfer Fi to FI Customer Credit Transfer pacs.008.001.07 E
15020022 SEPA Direct Dehit Payment Return pain.001.001.08_Draft i
15020022 SEPA Credit Transfer Resolution of Invesfigation pain 001.001.08_Draft i
15020022 Resoluion of Invesfigation pain 001.001.05_Draft i
15020022 Negative/Posifive Response: Resolution of Investigation  pain.001.001.08_Draft i
15020022 Financial Institution Credit Transfer pacs.003.001.02 Ei
15020022 Financial Institution Credit Transfer pacs.005.001.02_Draft E
EPC Financial Institution Credit Transfer pacs.008.001.07_Draft E‘
15020022 Customer to Bank Payment Reversal pain 001.001.08_Draft '_:‘
(|

The Message List displays the xsD files associated with each message provider /scheme/mes-
sage type combination. Click the link in the Message Provider column to view the transaction
XPaths for the message for every screening type. You can download the xsD for a message by

clicking Download E in the Download XSD column. The xsD is downloaded as a zip folder;
unzip the folder to view the xsD files.

2. Toupload a new XSD file, click Add Message. An Attachment Details dialog box opens.
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Figure 57: Add Message Dialog Box

Add Vlessage %
* Message Provider 15020022 v Message Scheme Select a Message Scheme v * Message Type Resolution of Invesfigation v
Select File to Upload g * Select Primary Message pacs.008.001.02.xsd Upload

® pain 001.001.08 xsd

XPath Configuration

Batch:

* Transaction:

Submit

3. Select the message provider and message type for the web service. If required, you can also
select the message scheme. If you select a message scheme, then the message types change
depending on the selected combination of the message provider and message scheme.

€ MesSage provider, message sCheme, and message type
values are mapped inthe fcc_tf xml pro sch msg map table.
4. To upload the parent XSD file and one or more child XSD files, click Upload = and select the
xsD file from your local drive. After you select the file and click Open, the xsD file name appears
next to the Upload button. Select the radio button next to the primary file name and click

Upload. A confirmation message appears, “File uploaded successfully.” The basic elements
related to the uploaded file appear in a tree view.

Figure 58: Add Message Dialog Box

Add Message

* Message Provider Message Scheme Select a M * Message Type
* Select File to Upload S “ select Primary Message pacs.008.001.02.xsd Upload
® pain.001.001.08.xsd
XPath Configuration
Batch:
* Transaction:
Submit
Search eleme v
QO TwnNm
() SubDept
Q AdrLine
QO Ctry
s QO Dept
————— @ Sithim
O CiryOfRes
Ini -— ClelDlis © - O Tunhim
14-Q O rdTw O SubDept
*)[m O Bldghib 8 'é“’r'v"'"e
Q) Dept
Y e
___—CisysMmbio © 0. ﬁ';t‘gjm
Finipstaie-@ — i 8 T ) CirySubDusn
— O AdrT;
GrpHd _ O um ?
“‘m‘_\- O Bldghb
““mﬂ_ — Q) TwnNm
O CreDiTrT ©) SuoDept
O NoOfTxs 8 A
Authstn- Q) Q Dergl
O Msgid P — ® Sitim
O CtriSum Erfchid-@ — g \’&m O Psicd _
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If you want to see the xPath of an element, select the element from the drop-down field. In the
example window, the XPath for the St rNm element is highlighted in red.

To choose the Batch XPath orthe Transaction XPath of the element, right-click any ele-
ment node in the Tree view and click Batch or Transaction respectively. The values appear in the
tree view. It is mandatory to select the Transaction XPath Configuration before you submit the

uploaded files.

NOTE To view the child elements Tor a parent element, MOUSEe over the
parent element and click the parent element in the Tree view. If

Zero “ is displayed beside the element name, it means that there
are no more child elements you can drill down to.

5. Click Submit. The ISO20022 parameter name appears in the Message List section with _Draft
attached to the parameter name.

Figure 59: Message List Window

Message List (10)
Message Provider Message Scheme Message Type Message Version
15020022 SEPA Credit Transfer Customer Credit Transfer Initiation pain.001.001.03
15020022 SEPA Credit Transfer Fl to FI Customer Credit Transfer pacs.008.001.07
15020022 SEPA Direct Debit Payment Return pain.001.001.05_Draft

6. Navigate to 1S020022/XML Configuration Admin in the Admin Ul. To complete the configura-
tion, click the message provider link. The XML Screening Configuration tab is displayed.
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Figure 60: Message List Window

*ML Screening Configuration XML Message Configuration

Screening Type Mame and Address b <

Add Update Remove Enable All Disable All
Screening XPath Cenfiguration List (33)

XPath Enable Message Direction
Document/CsimnCdiTrilnitn/ GrpHdrAnitg Pty ez ANY
Document/CsimrCdtTrilnitn/Prtinf Dbt Yes ANY
Document'CstmrCdt Trilnitn/ProtinfUlimt Dioir Yes ANY
Document'CstmrCdt Trilnitn PrtinFCA TATxd nfUlmiDbir es ANY
Document/CsimrCat Triiniin/PrtinfCATATxdnfCdtr fes ANY
Document'CstmrCdt Trilnitn/Prtinf Cat T nfiUlimiCdir fes ANY
Document/CstmrCadtTrlnitn PrtinfCA TATxdnfRmtin{ Strd/ Inver Yes ANY
DocumentCstmrCdt TRt PrtinfCATATInfRmtinfStrd/Inveee Yes ANY
Document/CsimnCdiTrilnitn/ GrpHdrAnitg Pty/ClciDils ‘ez ANY
Document/CstimrCdTriiniin/PrtinfDbtr ClctDils s ANY
Fags 4 of 33 itams [®]2 3. 4

In this tab, you can view the details of the element xPaths available for the selected web service.
You can also perform the following actions:
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Table 23: Other Actions

To...

Add a web service configu-
ration

Do this...
Click Add. The following fields appear:

Figure 61: Add a web service configuration

Add Update Remove Cnable All Disable All
Screening XPath Configuration List (0)
XPath Enable Message Direction

Mo data to display.

" Message Direction: | INEOUND “ Enable: No

BIC: Document/CstmrCdtTrilnitn =~ %

Save Clear Cancel

Tree

Document O CstmrCdiTriiniin-Q

Select the message direction and enable or disable the web service and
click Save. Clicking Clear clears any values selected. If you click Cancel,
the fields disappear.

In the Tree view, right-click any element node and click the element to
view the element’s XPath. The fields appear in the Screening XPath
Configuration List section.

Figure 62: Add a web service configuration - tree
view

Screening XPath Configuration List (1)
XPath Enable Message Direction

Document No INBOUND

Update a web service con-
figuration

Select the configuration you want to update and click Update. The fields
shown in the previous row appear. Make the required changes and click
Save. The updated values are displayed in the Screening XPath Con-
figuration List section.

Remove a web service con-
figuration

Select the configuration you want to remove and click Remove. The
selected configuration is removed from the Screening XPath Config-
uration List section.
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Table 23: Other Actions

To...

figurations

Enable all web service con-

Do this...

Click Enable All.

figurations

Disable all web service con-

Click Disable All.

7. Navigate to 15020022/ XML Configuration Admin in the Admin Ul and click the message pro-
vider link. To add the screening configuration of External Attribute, select the Attributes under
the Screening External Attribute Configuration list. The Screening External Attribute Con-
figuration list is displayed.

Figure 63: External Attribute List Window

Screening External Attribute Configuration List (2)

Attribute
AdditionalAttribute3

AdditionalAttribute5

Enable

N

N

Add Update Remove

Message Direction
INBOUND

INBOUND

Page 1 of 1 (1-20f2items)

Enable All Disable All

[

In this tab, you can view the details of the attribute name, enable status, and message direction
details. You can also perform the following actions:

NOIE

The Add button will only appear when the User configures the
FCC_TF_XML_EXTERNAL_ATTR and
FCC_TF_XML_EXTERNAL_ATTR_MLS tables. Refer the following

examples.

Example: 1

To configure FCC_TF_XML_EXTERNAL_ATTR table, run the following query similar way in your atomic

schema:

REM INSERTING into FCC TF XML EXTERNAL attr

SET DEFINE OFF;

Insert into FCC TF XML EXTERNAL attr (N ID,V ATTRIBUTE NAME)

(1, "AdditionalAttributel');

Insert into FCC TF XML EXTERNAL attr (N ID,V ATTRIBUTE NAME)

(2, "AdditionalAttribute2');

Insert into FCC TF XML EXTERNAL attr (N ID,V ATTRIBUTE NAME)

(3, "AdditionalAttribute3"');

Insert into FCC TF XML EXTERNAL attr (N ID,V ATTRIBUTE NAME)

(4, "AdditionalAttributed');

Insert into FCC_TF XML EXTERNAL attr (NilD,ViATTRIBUTEiNAME)
(5, "AdditionalAttributeb5');

values

values

values

values

values
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Figure 64: Example 1

select * from FCOC TF ¥ML EXTEENAL attr;

e,

[=|script output x| (B> Query Result x
| 4 E] Eﬁ @ SOL | AllRows Fetched: 5in 0.012 seconds

it N_ATTRIBUTE_ID |{} V_ATTRIBUTE_NAME

1 1 rdditicnalAttributel
2 2 kdditionalkttribute2
3 3 hdditionalkttribute3
4 4 pdditicnalAttributed
3 5 hdditionalkttributes

Example: 2

To configure FCC_TF_XML_EXTERNAL_ATTR_MLS table, run the following query similar way in your
atomic schema:

REM INSERTING into FCC TF XML EXTERNAL attr MLS
SET DEFINE OFF;

Insert into FCC_TF XML EXTERNAL attr MLS

(N ID,V _ATTRIBUTE NAME,V LOCALE CODE) values
(1, 'AdditionalAttributel', 'en US'");

Insert into FCC_TF XML EXTERNAL attr MLS
(N_ID,V_ATTRIBUTE NAME,V LOCALE CODE) values
(2, '"AdditionalAttribute2', 'en US'");

Insert into FCC_TF XML EXTERNAL attr MLS
(N_ID,V_ATTRIBUTE NAME,V LOCALE CODE) values
(3, '"AdditionalAttribute3', 'en US'");

Insert into FCC_TF XML EXTERNAL attr MLS

(N ID,V _ATTRIBUTE NAME,V LOCALE CODE) values
(4, 'AdditionalAttributed', 'en US'");

Insert into FCC_TF XML EXTERNAL attr MLS
(N_ID,V_ATTRIBUTE NAME,V LOCALE CODE) values
(5, '"AdditionalAttribute5', 'en US'");
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Figure 65: Example 2

select ¥ from FCOC_TF XMI. EXTERNAL attr ML5;

|

|| script Output * | [ Query Result

o E E{ﬂ % S0L | All Rows Fetched: 5in 0,024 seconds

it N_ATTRIBUTE_ID |:-} V_ATTRIBUTE_MAME |:-} V_LOCALE_CODE

[ TR Y S I (N B

1l AdditionalAttributel en U3
2RdditionalAttribute2 en U3
JAdditionalAttributed en U3
4 AdditionalAttributed en U3
SRdditionalAttributel en U3

The following table describes how to take additional actions.

Table 24: Other Actions

To...

Add an external attribute
configuration

Do this...
Click Add. The following fields appear:

Figure 66: Add an External Attribute configuration

Screening External Attribute Configuration List (2)

ssssss

rrrrrrrrrrrrrrrrrrrrrrrrrrrr

‘‘‘‘‘‘‘‘

Select the message direction and enable or disable the web service and
click Save. Clicking Clear clears any values selected. If you click Cancel,
the fields disappear.

Update a web service con-
figuration

Select the configuration you want to update and click Update. The fields
shown in the previous row appear. Make the required changes and click
Save. The updated values are displayed in the Screening External
Attribute Configuration List section.

Remove a web service con-
figuration

Select the configuration you want to remove and click Remove. The
selected configuration is removed from the Screening External Attri-
bute Configuration List section.

Enable all web service con-
figurations

Click Enable All.

Disable all web service con-
figurations

Click Disable All.
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1. After configuring the External Attributes, give the following attribute names (Same attribute
names which are populated in the above tables) in message posting jsp.

Example: SanctionsPost.jsp
String AdditionalAttributel = request.getParameter ("AdditionalAttributel");
String AdditionalAttribute? = request.getParameter ("AdditionalAttribute2");

String AdditionalAttribute3 = request.getParameter ("AdditionalAttribute3");

String AdditionalAttributed4 = request.getParameter ("AdditionalAttributed");
String AdditionalAttribute5 = request.getParameter ("AdditionalAttributeb");

2. To view the message tag configurations for a field, click the XML Message Configuration tab.
Figure 67: XML Message Configuration Tab

XML Message Configuration

Message Tag Configuration < Submit

Message Tag Configuration List (2) Add  Update  Remove

Message Tag Field Name Priority 1 Xpath Priority 2 Xpath Message Direction Enable
Batch Reference Document/CstmrCdiTrilnitn/PmiinifUItmiDbtr/ Document/CstmrCdiTriinitn/PmiiniBichBookg  INBOUND N
Eatch Reference Document/CstmrCdiTrilnitn/PmilnifUItmiDbtr/ Document/CstmrC diTrinitn/PmilniBichBookg  INBOUND N

You can also perform the following actions:
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Table 25: Other Actions

To... Do this...

Add a message configura-
tion

Click Add. The following fields appear:

Figure 68: Add a message configuration

XML Screening Configuration XML Message Configuration

Message Tag Configuration < Submit
Message Tag Configuration List (2) Add  Update  Remove
Message Tag Field Name Priority 1 Xpath Priority 2 Xpath Message Direction Enable
Ealch Reference Document/CsimrCyOfRes  Document/CstmrCdiTrilnitn/P INBOUND M
Batch Reference Document/CstmrCyOfRes  Document/CstmrCatTrinitn/P INBOUND N
* Generic Business Data: Transaction Reference *  * Message Direction: OUTEOUND + * Enable: Yes =

* Priority 1 Xpath: Documen:
Priority 2 Xpath: Document/CstmrCdtTriiniin

Save Clear Cancel

Tree

Searcn elements

Dacument O CstmrCaeTrimitn @

Select the business data value, message direction, enable or disable the
value, choose the Priority 1 XPath and Priority 2 XPath, and click
Save. Clicking Clear clears any values selected. If you click Cancel, the
fields disappear.

In the Tree view, right-click any element node and click the element to
view it's XPath. The fields appear in the Message Tag Configura-
tion List section.

Figure 69: Add a message configuration - tree view

Message Tag Configuration List (3)

Message Tag Field Name Priority 1 Xpath Priority 2 Xpath Message Direction Enable
Batch Reference Document/CstmrCdiTriinit Document/CstmrCdiTrinitn/ INBOUND N
Batch Reference Document/CstmrCatTriinitt Document/CstmrCdiTriinitniINBOUND N
Transaction Reference Document Document/CstmrCdiTriinitn OUTBOUND Y

Update a message configu-
ration

Select the configuration you want to update and click Update. The fields
shown in the previous row appear. Make the required changes and click
Save. The updated values are displayed in the Message Tag Configu-
ration List section.
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Table 25: Other Actions

Do this...

Remove a message confia- Select the configuration you want to remove and click Remove. The
g & selected configuration is removed from the Message Tag Configura-

uration . ; ;
tion List section.

€ ready-to-uUse busINess data values are available In the
DIM TF XML MSG TAG FLD column. You can add a new value in
this column.

3. Click Submit. The ISO20022 parameter name is updated in the Message List without _Draft.

Figure 70: Message List Window

Message List (10)

Message Provider Message Scheme Message Type Message Version
15020022 SEPA Credit Transfer Customer Credit Transfer Initiation pain.001.001.03
15020022 SEPA Credit Transfer Fi to Fi Custorner Credit Tranzsfer pacs.008.001.07
15020022 SEPA Direct Debit Payment Return pain.001.001.03
NOIE IT an earher configuration exists with the same message version,
I 'ékr\]%rtl)ltg(;s configuration is disabled, and the new configuration is

8.1.1 Running the ISO20022 Batch

The ISO20022 messages are processed using batches. So, you must first create the following folders
before you run the ISO20022 batch:

1. Create a folder for the MIS date with the folder name as ##FIC MIS DATE## (the date on which
we run the ISO20022 batch) in the following directory structure:

##FTPSHARE PATH##/SANCINFO/STAGE/SEPA/inputXML

For example, /scratch/fccmappchef/SANC807/ftpshare/SANCINFO/STAGE/SEPA/
inputXML/20200214.

20200214 is the MIS Date folder.

2. Create two folders called OUTBOUND and INBOUND inside the MIS Date folder and create a folder
called INPUT inside both the folders.

€ INPUT folder
lnadetheOUTBOUNDfdderortheINPUdederlngdethe
INBOUND folder based on the direction of the message XML. The
ISO20022 batch takes these XMLs as input when it is run.

The directory structures for OUTBOUND and INBOUND are as follows:

##FTPSHARE PATH##/SANCINFO/STAGE/SEPA/inputXML/##FIC MIS DATE##/OUT-
BOUND/INPUT
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##FTPSHARE PATH##/SANCINFO/STAGE/SEPA/inputXML/##FIC_MIS DATE##/INBOUND/
INPUT

For example,

m /scratch/fccmappchef/SANC807/ftpshare/SANCINFO/STAGE/SEPA/inputXML/
20200214/0UTBOUND/INPUT

m /scratch/fccmappchef/SANC807/ftpshare/SANCINFO/STAGE/SEPA/inputXML/
20200214 /INBOUND/INPUT

After you run the ISO20022 batch, the following actions are performed:

The VAL ERROR, PRCSNG_ERROR, PROCESSED, and FEEDBACK folders are created as part of the
batch processing.

If any message XML fails during validation, then it is moved to the VAL ERROR folder. The
directory structures for OUTBOUND and INBOUND are as follows:

##FTPSHARE PATH##/SANCINFO/STAGE/SEPA/inputXML/##FIC MIS DATE##/OUT-
BOUND/VAL_ERROR

##FTPSHARE PATH##/SANCINFO/STAGE/SEPA/inputXML/##FIC_MIS DATE##/INBOUND/
VAL ERROR

If any message XML fails during the parsing process after validation, then it is moved to the
PRCSNG_ERROR folder. The folder structures for OUTBOUND and INBOUND are as follows:

##FTPSHARE PATH##/SANCINFO/STAGE/SEPA/inputXML/##FIC MIS DATE##/OUT-
BOUND/PRCSNG_ERROR

##FTPSHARE PATH##/SANCINFO/STAGE/SEPA/inputXML/##FIC_MIS DATE##/INBOUND/
PRCSNG_ERROR

If any message XML is successfully processed, then it is moved to the PROCESSED folder. The
directory structures for OUTBOUND and INBOUND are as follows:

##FTPSHARE PATH##/SANCINFO/STAGE/SEPA/inputXML/##FIC MIS DATE##/OUT-
BOUND/VAL_ERROR

##FTPSHARE PATH##/SANCINFO/STAGE/SEPA/inputXML/##FIC_MIS DATE##/INBOUND/
VAL ERROR

After the batch is run successfully, a ##FILE NAME#4# feedback.xml fileis created for each
file that is processed. The feedback is created inside the FEEDBACK folder. The directory
structures for OUTBOUND and INBOUND are as follows:

##FTPSHARE PATH##/SANCINFO/STAGE/SEPA/inputXML/##FIC MIS DATE##/OUT-
BOUND/FEEDBACK

##FTPSHARE PATH##/SANCINFO/STAGE/SEPA/inputXML/##FIC_MIS DATE##/INBOUND/
FEEDBACK

The logs of the batch are available in the following path:
##FIC DB HOME##/log/TF XML

For example, /scratch/fccmappchef/SANC807/SANC807/ficdb/log/TF XML
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NOIE when we take an action (RELEASE/BLUCLK) on an alert rrom the

Investigation User Interface, a feedback XML is recreated for the
corresponding file with the name

##FILE NAME## feedback.xml and the name of the previous
file with the same name becomes

##FILE NAME## feedback 1.xml inside the FEEDBACK folder.
So, the ##FILE NAME## feedback.xml is always the latest
feedback file for a corresponding message XML.

To run the batch, follow these steps:

1. Navigate to the Run page. For more information, see the Run Definition Menu.

Figure 71: Run Page

Run
Code
Name
Folder v

+ New W view ¢ Eqit "'iCop:.f Remove & Authorize « ™ Export - %X Fire Run

sfe. Code 4 Name

Good Guy Expiry Check Good Guy Expiry Check:5D
¥ TF_SEPA_messages_batch_process TF_SEPA_messages_batch_process:SD

Page 1 of 1 {1-150f 2 items)

2. Selectthe TF_SEPA messages batch process batch and click Fire Run. The Fire Run page
is displayed.

Figure 72: Fire Run Page
oK Close
Run Definition
Name TF_SEPA_messages_batch_process:SD
Request Type  Single v
Execution Mode
Batch  Create & Execute v MIS Date ke
Wait No v
Others

Parameters

Filters

3. Select Single as the Request Type.
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4. Select Create & Execute in the Batch field. The MIS Date field is displayed.

5. Select the date on which you want to execute the run. This date must be the same as the folder
you create before you run the ISO20022 batch. In the example shown, since the MIS Date folder
nameis 20190913, the date you must selectis 09/13/2019.

6. Click OK.

A message "Batch execution is in progress" is displayed. Click Close to go back to the Run
page. After the batch is executed, you can view the batch details on the Batch Monitor page.

To access the Batch Monitor page, click Operations, and then click Batch Monitor. The Batch
Monitor page has details of all batches. The batch you have executed is the last in the Batch
Details list. To run the batch, follow these steps:

m  Select the Batch and the MIS Date. After you select the MIS Date, the batch ID appears in

the Batch Run ID field.

Figure 73: Batch Monitor Page
Batch Monitor

Batch ID Like  SAN8O7SEPA_

Module

SANBO7SEPA_1581242528188
SANBO7SEPA_1581487886045
SANBO7SEPA_1581506399590
SANBO7SEPA_1581512529883
SANBO7SEPA_1581599172904
SANBO7SEPA_1581686640714

<

Page 1 of1(1-6 of 6 items)
Batch Run Details &3 Start Monitoring - Stop Monitoring  Reset

Information Date 2

Batch Run ID SAN807SEPA_1581686640714_20190913_1

m  Select the batch ID.

(2]

Q. Search O Reset

Batch Description Like

Batch Description

AutoRun_1562321907205_Description
AutoRun_1562321907205_Description
AutoRun_1562321907205_Description
AutoRun_1562321907205_Description
AutoRun_1562321907205_Description
AutoRun_1562321907205_Description

Records Per Page 15

Monitor Refresh Rate (seconds) 5

m  Click Start Monitoring. The task details associated with the batch appears in the Task
Details section. You can also view and export the event logs for the batch in the Event Log

section.

Figure 74: Tasks in the Batch Monitor Page

Batch Run Details Start Monitoring & Stop Monitoring " Reset

Information Date | 20190913 Monitor Refresh Rate (seconds) 5
Batch Run D SANBO7SEPA_1581686640714_20190913_1

Batch Status
Batch Run ID Batch Status
SANBO7SEPA_1581686640714 20190913 1 Successful

Task Details
TaskID & Task Description Metadata Value Component ID Task Status Task Log
Taskl TF_CallXMLParser TF_CallXMLParser TRANSFORM DATA [13314] Successful View Log
Task2 TF_CallXMLEDQ TF_CallXMLEDQ TRANSFORM DATA [13314] Successful View Log
Task3 Message Data Attributes 1593:SANBO7SEPA:OFS_TFLT INLINE PROCESSING [13314] Successful View Log
Taskd TF_CallXMLRTIPopulation TF_CallXMLRTIPopulation TRANSFORM DATA [13314] Successful Viewlog
Tasks TF_CallXMLAlertGeneration TF_CallXMILAlertGeneration TRANSFORM DATA [13314] Successful View Log
Task6 TF _CallXMLImmediateFeedbackCreation TF_CallXMLImmFeedbkCreation TRANSFORM DATA [13314] Successful View Log
Task? TF_CallXML TF_CallXMLImmFdbkFiGeneratn TRANSFORM DATA [13314] Successful Viewlog
Task8 TF_CallXMLHighlight TF_CallXMLHighlight TRANSFORM DATA [13314] Successful Viewlog
Taskd TF CallUpdateAdditionalMsgDtls TF CallUpdateAdditionalMsgDtls TRANSFORM DATA [13314] Successful Viewlog
Task10 TF_CallXMIStructuredSepa TF_CallXMIStructuredSepa TRANSFORM DATA [13314] Successful View Log

Page 1 of 1(1-10 of 10 items)

Event Log ™ Export
Message ID & Description
1081 [1707] Batch started by TFADMN
1109 [1708] Batch Complete

Page 1 of1(1-20f2items)

Records Per Page 15

Severity Time
INFORM 2020-02-14 08:24:01
INFORM 2020-02-14 08:32:18

Records Per Page 15
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Audit Queries

8.2

€ Datlch run tails, you must restar e bailcn. In

batch run ID changes.

Table 26: Task Details

IS Case, the

The task details are as follows:

Task ID Task Name Task Description
Parses the XML data into the pre-pro-
Task1 TF_CallXMLParser cessing tables.
Calls EDQ data to check if there are any
Task2 TF_CallXMLEDQ matches.
Task3 Message Data Attributes NA
Moves data from the 1ISO20022 configu-
Task4 TF_CallXMLRTIPopulation ration tables to the SWIFT configuration
tables to generate OBI reports.
Task5 TE_CallXMLAlertGeneration Creates alerts and loads data into the
alert tables.
TF_CallXMLImmediate-
Task6 FeedbackCreation Populates the feedback table.
Generates the feedback in an XML for-
Task7 TF_CallXMLImmediate- mat in the INBOUND/ feedback direc-
FeedbackFileGeneration tory for the date on which the runis
triggered.
- Populates the highlighted column in the
Task8 TF_CallXMLHighlight £si rt al raw data table.
; Populates the post-processing alert table
Task9 TF_CaIIUpdateAddl— with the additional details provided for
tionalMsgDtls
the alert.
Populates the data in the Structured
Task10 TF_CallXMLStructuredSepa | Message tab in the Investigation User
Interface.

Audit Queries

The following are the audit queries you can run to see the different audit operations:

Table 27: Audit Queries for 1IS020022

Table Name

FCC_TF XML XS-
D_CONF

Query

Select * fromFCC TF XML XS-
D _CONF_HIST

Description

Run this query to see the history of all
the actions that have been performed.

FCC_TF XML MS-
G_TAG_FLD X-

Select * fromFCC TF XML MS-
G_TAG FLD XPATH HIST

Run this query to see the history of all
the actions performed in the XML

PATH Message Configuration tab.
FCC TF XM- .

I SCRENG XPA— Select * fromFCC TF XM- Run this query to see the XPath for
TH GRP L SCRENG_XPATH GRP HIST each parent element.
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Table 27: Audit Queries for 1ISO020022

Table Name Description

FCC TF XM- .

L SCRENG — Select * fromFCC_TF XM- Run this query to see the XPath for
- = each subfield.

FLD XPATH L SCRENG FLD XPATH HIST
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To configure the TF_US Nacha Batch Process batch and to ensure successful completion, follow
these steps:

1.

On the Financial Services Analytical Applications Transactions Filtering landing page, click

Financial Services Sanctions Pack.

Figure 75: Financial Services Sanctions Pack Menu

# Home

Navigation List

Common tasks

Financial Services Sanctions Pack

ORACLE Financial Services Analytical Applications Transactions Filtering

2. (Click Run Definition. The Run page is displayed.

Figure 76: Run Definition Link

3.

A Home

Financial Services San...
Transaction Filtering Admin
1S020022/XML Configuration Admin
SWIFT Configuration Admin
FEDWIRE Configuration Admin
Process Modeller
Post Load Changes
Process Monitor

Run Definition

List Management

Inline Processing

ORACLE Financial services Analytical Applications Transactions Filtering

In the Run page, select the TF_US_NACHA_Batch_Process batch.
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Figure 77: Run Page

Run

Code
Name

Folder

+ New I view (¢ Edit B copy [ Remove & Authorize «™ Export - K Fire Run

] Code 4 Name

Good Guy Expiry Check
] TF_SEPA_messages_batch_process
TF_US_Nacha_Batch_Process

Page 1 of 1 (1-150f 3 items)

v

Good Guy Expiry Check:SD
TF_SEPA_messages_batch_process:SD

TF_US_Nacha_Batch_Process:SD

Type

Base Run

Base Run

Base Run

4. Click Edit “ . The Run page is displayed in Edit mode.

Figure 78: Run Definition (Edit Mode)

Run
Run Definition (Edit Mode)
Linked to
Folder TFLSEGMENT L]
Master Information E Properties

ID 1583487462588

Code TF_US_Nacha_Batch_Process

Name
List &) selector «
( Location Infodom ¥ Run Condition
- —l Job
[J Job KRISINFC 5 Tob Condition ha_Message_Vali...
Job KRISINFO TF_US_Nacha_Data_Parser

12}
Q search O Reset
Version 0
Active  Yes v
Type v
Folder Version Active
TFLSEGMENT 0 Yes
TFLSEGMENT 0 Yes
TFLSEGMENT 0 Yes
Records Per Page 3
o
Next Close
Version 0
Active Yes
Type  Base Run v

Route Execution to High

Precedence Node

TF_US_Nacha_Message_Validation

TF_US_Nacha_Data_Parser

Type Simulation Job Use Descendants

Data
Transformation
Data
Transformation
Nata

5. Click Selector ™ sclector and then click Job = et from the drop-down list. The Component Selec-

tor window is displayed.
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Figure 79: Component Selector Window

Search

List

Component
+ '\J()
Data Extraction Rules
=8
Load Data Rules
+. 08
File Loading Rules
o
Insertion Rules
—. @l
Transformation Rules
+-@

Database Functions-Transformations

Ok Close

Sort

Ascending Descending
Tasks [10]
[] Object
[} TF_US_Nacha_Message_Validation =
[ TF_US Nacha Data Parser =
[J  TF_US_Nacha_Screening_Populate_Input =
[]  TF_US Nacha Screening Call EDQ =
[]  21099:TF87INFO:0OFS_TFLT:NA =
[} TF_US_Nacha_Scoring_Populate_Input =
[} ACH Message Tags =
[]  TF_US Nacha Generate Alerts =
[]  TF_US Nacha Generate Feedback =
[ TF_US_Nacha_Additional_Details =

1. Deselectthe 21099:TF87INFO:0FS TFLT :NA task.

2. Click Ok. The Run page with the Run Definition is displayed in Edit mode.

3. Provide a Name for the batch.

Figure 80: Run Definition (Edit Mode) — Batch Name

Run
Run Definition (Edit Mode)
Linked to
Folder TFLSEGMENT L]
Master Information Ef Properties

ID 1583487462588

Code TF_US_Nacha_Batch_Process

Name  TF_US_Nacha_Batch_Process

List @) Selector «
[J Location Infodom Code
J Job KRISINFO TF_US_Nacha_Message_Vali...
] Job KRISINFO TF_US_Nacha_Data_Parser

4. C(lick Next.
5. Click Save.

Version 0

Active Yes

Type  Base Run

Route Execution to H%v —

Precedence Node

Name Type Simulation Job

Data
Transformation
Data
Transformation
Nata

TF_US_Nacha_Message_Validation

TF_US_Nacha_Data_Parser

6. Click No in the Run Rule Framework dialog box.

o

Next Close

Use Descendants
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Figure 81: Run Rule Framework Dialog Box

[16450] Do you want to save this definition as new version?

Yes No Cancel
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10 Enterprise Data Quality (EDQ) Configurations

The Oracle Financial Services Transactions Filtering application is built using EDQ as a platform. EDQ
provides a comprehensive data quality management environment that is used to understand, improve,
protect, and govern data quality. EDQ facilitates best practices such as master data management, data
integration, business intelligence, and data migration initiatives. EDQ provides integrated data quality
in customer relationship management and other applications.

EDQ has the following key features:
e Integrated data profiling, auditing, and cleansing and matching
e Browser-based client access

e Ability to handle all types of data (for example, customer, product, asset, financial, and
operational)

e Connection to any Java Database Connectivity (JDBC) compliant data sources and targets

e Multi-user project support (Role-based access, issue tracking, process annotation, and version
control)

e Representational State Transfer Architecture (REST) support for designing processes that may
be exposed to external applications as a service

e Designed to process large data volumes

e A single repository to hold data along with gathered statistics and project tracking information,
with shared access

e Intuitive graphical user interface designed to help you solve real-world information quality issues
quickly

e Easy, data-led creation and extension of validation and transformation rules
e Fully extensible architecture allowing the insertion of any required custom processing

For more information on EDQ, see Oracle Enterprise Data Quality Documentation.

10.1 Performance Improvement Measures for EDQ

€ TOllowINg are some recommendations to help IMprove
performance when you are dealing with bulk transactions. Perform
these steps ONLY after you have completed all configurations for
EDQ.

e Web Services are CPU-intensive, that is, they are frequently executed, and receive intermittent
sets of simultaneous requests. Simultaneously running all batch requests slows down the real-
time processing response time. To avoid this, set the following properties in the
director.properties file in the <domain_name>/edq/oedq.local.home/ directory:

m  Run the data preparation job for web services, for example, Watch-1ist Management,
when real-time processing stops.

m  Set the runtime.threads value to a number which is lesser than the total cpu-cores so that both
the cpu-cores can run in parallel. This ensures that the batch does not occupy all cores and
allows real-time processing to run. The default value is 0, that is, the batch threads equal the
number of cpu-cores on the system.

m  Set the runtime.intervalthreads value to display the number of cpu-cores. This allows for simul-
taneous processing, efficient resource utilization, and faster turnaround time. The default
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value is 1, that is, requests are processed sequentially on a single core which leads to
underutilization.

m  Set the workunitexecutor.outputThreads value to a number which is greater than the number of
cpu-cores and number of connection to write results and staged data to the database to
tune 10 heavy real-time process. This is particularly useful when the database machine is
more powerful than the EDQ server.

m  Set the resource.cache.maxrows value to increase the number of rows for the reference data in
memory. This yields a faster response time. By default, the maximum number of rows you
can load is 100000.

e Optimize the data cluster definition and size of each cluster for real-time processing.

e Optimize attributes which are critical to performance such as watch list types, reference data
size, and data store size.

e Optimize data for the EDQ RES and EDQ_STAGING tablespace to improve performance. The
minimum size for EDQ_RES must be 200-300 GB.

e Optimize the OEDQ job performance by minimizing result writing and disabling the sort and
filtering feature.

e Adjust the response time by tuning the java options in the EDQ domain. To do this, follow these
steps:

m  Openthe setStartupEnv.shfileinthe <domain name given for EDQ>/bin directory.

m Updatethe -server -d64 -Xms16G -Xmx16G -XX:+UseGlGC -XX:+UseAdaptive-
SizePolicy -XX:MaxGCPauseMillis=500 -Doracle.jdbc.javaNetNio=false -
XX:InitiatingHeapOccupancyPercent=80 -XX:ReservedCodeCacheSize=128m
attributeinthe # Startup parameters for STARTUP GROUP EDQ-MGD-SVRS section
based on your requirments.

e Set the OEDQ parser processor to Parse Mode instead of to Parse And Profile.

e Update the user credentials for dnadmin from the default realm to the authentication realm.
e Enable the EDQ domain to operate in production mode.

e Disable the following clusters in Name and Address service to improve performance:

e Individual Family Name

e Individual Given Name

e Entity Name Meta

e Entity Start End Name Tokens

e Individual Initials

10.2 EDQ Configuration Process Flow

The following image shows the EDQ configuration process flow:
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Figure 82: Enterprise Data Quality (EDQ) Configuration Steps

Import .dxi files

R1rd

Update

Schema Details
Watchlist Transaction
Management Filtering
Load

Reference Data

Run EDQ Jobs

. |
Watchlist Transaction

Management Filtering

L

Change EDQ URL

To configure EDQ, follow these steps:
1. Importthe watchlist Management.dxi file fromthe FIC HOME/SanctionsCommon path.

2. Importthe Transaction Screening.dxi filefromthe FIC HOME/Transaction Pro-
cessing path (This is for SWIFT messages only).

3. Importthe Transaction Screening SEPA.dxi file fromthe FIC HOME/Transac-
tion Processing path (Thisis for ISO20022 messages only).

4. For these projects, enter the applicable organization-specific Atomic schema details in the Edit
Data Store window. To access the the Edit Data Store window, follow these steps:

m  Go to the EDQ URL and open the Director menu. The Director landing page appears.
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Figure 83: Director Menu in EDQ

ORACL_E Enterprise Data Quality

Launchpad

Director

Match Review

© 0 ©

~N

7
Case Management Administration @ Configuration Analysis

@ Login

Launchpad ~ Web Services

(7] 7]
e Server Console

7] (7]
o Case Management

7]

= Inthe Director landing page, expand the Transaction_Screening project in the Project

Browser pane.

OFS Transaction Filtering Admin Guide | 105



Enterprise Data Quality (EDQ) Configurations

EDQ Configuration Process Flow

Figure 84: Project Browser Pane

Project Browser
@M PRIV
W RH Test
a0 TBAML
=M Transaction_Screening
- &1} Data Stores
----- { § ACY-Entities-IMP

----- {1 ACY-Individuals-IMP

----- U AtomicDatasource

----- U Blacllisted Country Reference D:
..... U CITY

----- £ 4 Cluster Prep - Common Entity Bur
----- {1 Cluster Prep - Common Entity Na
----- {4 Cluster Prep - Common Name Qu
----- U Cluster Prep - Entity Base Tokeni
----- U Cluster Prep - Entity Name Noise
----- U Cluster Prep - Entity Name Remo

----- U Cluster Prep - Insignificant Entity
----- £ 4 Cluster Prep - Name Noise Chara
----- U Cluster Prep - Remove Initials-Jv
----- U Cluster Prep - Standard Accentec
----- U Cluster Prep - Standard Entity Nz
----- £ ] Cluster Prep - Standard Entity Ne
----- {1 Cluster Prep - Titles-JMP

LB maaem = an - e

< >

Expand the Data Stores node and open AtomicDatasource. The Edit Data Store window

appears.
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Figure 85: Edit Data Store Window

"® Edit Data Store |- 23|

Orade Configuration

Database host
Port 1521

Database name |(ORCLDE

Mame type :SID -
Lser name tit_atomic
Password Ty
Schema

The schema nesd not ke anbared iF ik is Hhe deFaulk For Hhe user

[ o ” Cancel ]

5. Load the Reference data. For more information on Reference data, see Viewing Reference Data
for Web Services.

6. Update the command area path in the following locations:
m Watchlist Management > External Tasks > WatchListLoadPreparedData
m Transaction Screening > External Tasks > WatchListLoadData

m Transaction Screening > External Tasks > SanctionedListRefLoadData
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Figure 86: Edit Task Window
(@ Edit Task £3

External Task Options ORACLE

Configure the external task properties

Comrmand WatchListLoadPreparedData.sh
Working Directory  fscratchfofsaebaswork/mwhomefuser_projects/domains/base_domain/config/fmwconfigfed

Arguments

< Bacl Next > | | Cancel |

7. Go to the EDQ URL and open the Server Console menu. The Server Console landing page
appears.
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Figure 87: Server Console Menu in EDQ
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8. Run the following jobs under the Watchlist Management project:
m  Analyze Reference Data Quality
m  Download, Prepare, Filter and Export All Lists
m  Generate StopPhrases

9. Run the MAIN job under the Transaction_Screening project.

10. Change the EDQ URL in the Transaction Filtering application. To change the EDQ URL, see Con-
figuring the Application Level Parameters.

INUII:

10.2.1

10.2.2

The first time you set up the Transaction FIltering application, you
must change the EDQ URL.

1. Configure the message and screening parameters, if required.

Importing the Transaction Screening Project

For information on importing the Transaction Screening project, see the Importing the OFS Customer
Screening and OFS Transaction Filtering Projects section in the Oracle Financial Services Sanctions
Installation Guide.

Configuring Watch List Management and Transaction Filtering

The Oracle Financial Services Transaction Filtering distribution contains two run Profiles for
configuring Watch List Management and screening: watchlist-management.properties and
watchlist-screening.properties. These profiles are available in the <domain name>/edq/
oedqg.local.home/runprofiles/ directory when you loginto the WinSCP server.

Run profiles are optional templates that specify the number of override configuration settings for
externalized options when a Job is run. They offer a convenient way of saving and reusing multiple
configuration overrides, rather than specifying each override as a separate argument.
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Run profiles may be used when running jobs either from the Command Line Interface, using the
runopsjob command, or in the Server Console User Interface.

The watchlist-management.properties run profile controls the following processes:

Which watch lists are downloaded, and the configuration of the download process
Whether filtering is applied to the watch lists or not

Whether Data Quality Analysis is applied to the watch lists.

Real-Time and Batch Screening set up

Screening reference ID prefixes and suffixes

Watch list routing

Configuration of match rules.

INUII:

10.2.2.1

The properties controlling match rules are not included 1n the
watchlist-screening.properties run profile by default. For
more information, see Configuring Match Rules .

Preparing Watch List Data

Oracle Financial Services Transaction Filtering is pre-configured to handle reference data from the
following sources:

HM Treasury

OFAC

EU consolidated list

UN consolidated list
World-Check

Dow Jones watch list

Dow Jones Anti-Corruption List
Accuity Reference Data

For information on the watch lists, see Appendix A: Watch Lists.

10.2.2.2 Setting Up Private Watch List

Oracle financial services Customer Screening is pre-configured to work with commercially available
and government-provided watch lists. However, you can also screen data against your private watch
lists. Sample private watch lists are provided in the config/landingarea/Private directory in the
privateindividuals.csvandprivateentities.csv files.

NOIE

OEDUQ release T2 has a base conftig folder and a local contig folder.
The base config folder is called cedghome and the local config
folder is called cedglocalhome. The names may differ in some
cases. For example, dots or underscores may be inserted in the
names, such as oedg_local home.

To replace the data, follow these steps:

1.

Transform your private watch list data into the format specified in the Private List Interface
chapter in the Oracle Financial Services Data Interfaces Guide.
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2. Replacethedatainthe privateindividuals.csvandprivateentities.csv files with
your transformed private watch list data.

INUII:

I'ne Tiles must be saved iIn U F-o tormat.

To enable the staging and preparation of the private watch list in the watchlist-
management .properties Run Profile, follow these steps:

1. Move your private watch list data to the staging area by setting phase.PRIV\ -\ Stage\
reference\ lists.enabledto.

2. Setphase.PRIV\ -\ Prepare\ without\ filtering.enabledtoY to prepare the pri-
vate watch list without filtering.

Set phase.PRIV\ -\ Prepare\ with\ filtering\ (Part\ 1).enabledand
phase.PRIV\ -\ Prepare\ with\ filtering\ (Part\ 2).enabledtoY to prepare the
private watch list with filtering.

Showing Watch List Staged Data/Snapshots in the Server Console User Interface

10.2.2.2.1
Certain types of staged data and snapshots are hidden in the Server Console User Interface by default.
These are:
e Watch list snapshots
e Intermediate filtered watch list staged data
e Centralized reference data staged data and snapshots
To display this data, set the corresponding visibility property value(s) in the relevant run profileto Y.
For example, to make all HM Treasury watch list snapshots generated during Watch List Management
visible, set the following properties in the watchlist-management.properties run profile:
stageddata.ACY\ Sources.visible =Y
stageddata.ACY_AllLvisible = Y
stageddata.ACY_Sources.visible = Y
10.2.2.2.2 Configuring Match Rules
Match rules and match clusters can be configured and controlled by adding a property to the
watchlist-screening.properties run profile.
NOTE Ensure that data 1s avallable In the ref _port_cntry table before

you begin the matching process. This table contains the port code
for a port name and the corresponding port country. For more
information on matching, see https://docs.oracle.com/
middleware/1221/edq/user/adv_features.htm#DQUSG380.

For example, to disable the Exact name only rule for Batch and Real-Time Sanctions screening, add
the following property to the Run Profile:

phase.*.process.*.[I0100]\ Exact\ name\ only.san ule enabled = false

nsure that values are capitalized and characters are escaped as
applicable.
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10.2.2.2.3

The * character denotes a wildcard and therefore specifies that the above rule applies to all phases and
all processes. If disabling the rule for batch screening only, the property would read:

phase.Batch\ screening.process.*.[I0100]\ Exact\ name\ only.san rule en-
abled = false

For further details on tuning match rules, see the Oracle Financial Services Transaction Filtering
Matching Guide.
Configuring Jobs

To configure a job, it must be configured in the properties file and on the administration window to
enable or disable the web services.

The WatchListLoadPreparedData process is disabled by default. To enable the process, follow these
steps:

1. InthewWatchlist Management-<patch number> project, double-click the Load List data
from Stg to Processed table job. All processes related to the job are displayed.
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Figure 88: EDQ Director Menu
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2. Right-click the WatchListLoadPreparedData process and click Enable.

10.2.2.3 Filtering Watch List Data
The following sections provide information on how to enable and configure the watch list filters.

10.2.2.3.1

10.2.2.3.2

Enabling Watch List Filtering

Watch list data is filtered either during List Management, Screening, or both.

To enable filtering for a specific watch list, set the Prepare Filtering phase (s) inthe appropriate

run profile to Y, and the Prepare Without Filtering phase(s)to N.

Configuring Watch List Filtering

Watch list filtering is controlled by configuring reference data in the watch list projects.
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NOTE After data 1s T1ltered out, 1t 1s not possIbIe to Titer 1t back 1n. For
example, if all entities are filtered out in the Watchlist
Management project, even if the Transaction_Screening project
ids configured to include entities, they will not appear in the results
ata.

The top-level of filtering is controlled by editing the Reference Data Editor - Filter - Settings
reference data.

Figure 89: Reference Data Editor - Filter - Settings Window
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All the reference data filters are set to Y by default, except Linked Profiles whichissetto N.No
actual filtering is performed on watch list data unless these settings are changed.

Nnine Filter - Settings rererence data, a value of Y indicates
that all records must be included - in other words, no filter must be
applied.

Broadly speaking, watch list filtering falls into four categories:
e Bylist and list subkey.
e Bylist record origin characteristics.
e Bylist profile record characteristics.

e Bylinked profiles.
10.2.2.3.3 Primary and Secondary Filtering, and Linked Records

e Primary filtering - These filters are used to return all profiles that match the criteria specified.
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Linked Profiles - If this value is set to Y, then all profiles linked to those captured by Primary
filters are also captured. An example is a filter configured to capture all Sanctions and their
related PEPs.

Secondary filtering - These filters are applied to further filter any linked profiles that are
returned.

INUII:

Only the World-Check and DJW watch Nsts can provide Linked
Profiles.

10.2.2.3.4 Setting Multiple Values for Primary and Secondary Filters

The following filter options require further configuration in additional reference data:

Origins

Origin Regions

Origin Statuses

Primary and Secondary Name Quialities
Primary and Secondary Name Types

Primary and Secondary PEP Classifications

To filter using one or more of these options, set the relevant valueinthe Filter - Settings
reference data to N, and then make further changes to the corresponding reference data.

NOIE

10.2.2.3.5

Whenyou setthe Filter - Settings reference data to N, only
the records that match the values set in the corresponding
reference data are included. For example, if you set the value of
All name qualitiestoNinFilter - Settings, then you
can determine which name qualities must be included for each
watchlistinthe Filter - PrimaryName Qualities reference
data. For instance, if you include a row for high-quality names in
the EU watch list, but you do not include rows for medium-quality
and low-quality names for this watch list, then only records with
high-quality names are included in the watch list.

Some of these reference data sets are pre-populated with rows, to be edited or removed as required.
These rows contain data (generally, but not always) supplied by each watch list provider and are all
contained within the Watchlist Management project.

For example, to view all possible keywords for World-Check data, open the WC Keyword reference data
in the Watchlist Management project. See the following example for further details.

Filtering World-Check Data

This example describes configuring filtering on the World-Check Sanctions list in the Watchlist
Management project and setting further filters in the Transaction_Screening project. You can also
perform the following actions:

Enable filtering in the Run Profiles

Configure the Primary filters in the Watch List Management project to return only active records
for sanctioned individuals (not entities) originating from the EU list

Enable the filtering of Linked Profiles in the Watch List Management project

Configure the Secondary filters in the Transaction Filtering project to further filter out all Linked
Profiles of deceased individuals.
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1.1.1.15.0.0.4Setting Filtering options in the Run Profiles

Inthe watchlist-management.properties Run Profile, set the Wor1ld-Check filtering
phases as follows:

phase.WC\ -\ Prepare\ without\ filtering.enabled = N
phase.WC\ -\ Prepare\ with\ filtering\ (Part\ 1).enabled =Y
phase.WC\ -\ Prepare\ with\ filtering\ (Part\ 2).enabled =Y

In the watchlist-screening.properties Run Profile, set the World-Check
filtering phases as follows:

phase.WC\ -\ Load\ without\ filtering.enabled = N
phase.WC\ -\ Load\ with\ filtering\ (Part\ 1).enabled =Y

phase.WC\ -\ Load\ with\ filtering\ (Part\ 2).enabled =Y

10.1.1.1.6  Setting Primary Filters and Linked Profiles in the Watchlist Management Project

To set the primary filters, follow these steps:

1.

© 0O N o U AWN

Inthe Director menu,opentheWatchlist Management projectand expandthe Reference
Data node.

Locatethe Filter - Settings reference data and double-click to open it.
Ensure the List/sub-list value in the WC-SAN row is setto Y.

Set the Entities value in the WC-SAN row to N.

Set the Tnactive value in the WC-SAN row to N.

Setthe A1l Origins valueinthe WC-SAN row to N.

Ensure all other values in the WC-SAN row are setto Y.

Click OK to close the reference data and save changes.

Locatethe Filter - Origins reference data and double-click to open it.

10. Add a new row with the following values:

1.
12.

m List Key - WC

m  List Sub Key - WC-SAN

s Origin-EU

Change the Linked Profiles valueinthe WC-SANrowtoY.

Click OK to close the Filter Settings reference data and save changes.

10.1.1.1.7  Setting Secondary Filters in the Transaction_Screening Project

To set secondary filters, follow these steps:

1.
2
3.
4

Open the Transaction Screening project, and expand the reference data link.
Locatethe Filter - Settings reference data file, and double-click to open it.
Set the Deceased value in the WC-SAN row to N.

Click OK to close the reference data and save changes.
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10.1.1.1.8 Screening All Data Using Sanctions Rules

By default, watch list records are routed to the different screening processes depending on their record
type, that is, SAN, PEP, or EDD. This allows different rules, and hence different levels of rigor, to be
applied to the list data according to risk appetite.

However, if you want to use the same screening logic for all list records, and do not want the overhead
of maintaining separate rule sets, the system can be configured to reroute all list records to the SAN
screening processes. To do this, set the phase.*.process.*.Screen\ all\ as\ SANvalueinthe
watchlist-screening.properties Run ProfiletoY.

10.1.1.2 Viewing Reference Data for Web Services

Previously, all reference data was available in EDQ. From 807 onwards, only data related to name and
address is enabled in EDQ. All other reference data is available in the database in the following tables:

e Goods prohibition reference data is available in fcc_prohibiton goods ref data
e Ports prohibition reference data is available in fcc_port ref data

e Bad BICs reference data is available in dim sanctioned bic

e Stop Keywords reference data is available in dim stop keywords

o Blacklisted Cities reference data is available in dim sanctioned city

e Blacklisted Countries reference data is available in dim sanctioned country
10.1.1.2.1 Bad BICs Reference Data

The following columns are available in the template for BICs:

e Record ID: This column displays the record serial number for the blacklisted BIC. The record ID is
unique for every BIC.

e BIC: This column displays the name of the BIC.
e Details of BIC: This column displays the details of the BIC.
e Data Source: This column displays the source of the data for the BIC.
e Risk Score: This column displays the risk score for the BIC.
Sample Data for Sanctioned BICs

The following table provides examples based on BICs:

Table 28: Sample Data for Sanctioned BICs

Record ID BIC Data Source Risk Score
1 SIIBSYDA OFAC (Office of Foreign Assets Control) 85
2 FTBDKPPY OFAC (Office of Foreign Assets Control) 90
3 DCBKKPPY OFAC (Office of Foreign Assets Control) 85
4 ROSYRU2P OFAC (Office of Foreign Assets Control) 90
5 INAKRU41 OFAC (Office of Foreign Assets Control) 90
6 SBBARUMM OFAC (Office of Foreign Assets Control) 90
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10.1.1.2.2 Blacklisted Cities Reference Data

The following columns are available in the template for blacklisted cities:

e Record ID: This column displays the record serial number for the blacklisted city. The record ID is
unique for every city.

e Country: This column displays the name of the country of the blacklisted city.
e City: This column displays the name of the blacklisted city.
e ISO City Code: This column displays the ISO code of the blacklisted city.
e Data Source: This column displays the source of the data for the blacklisted city.
e Risk Score: This column displays the risk score for the blacklisted city.
Sample Data for Sanctioned Cities

The following table provides examples for blacklisted cities:

Table 29: Sample Data for Sanctioned Cities

RecordID Country (@147 I1SO City Code Data Source Risk Score

1 IRAQ ARBIL ABL OFAC (Office of Foreign Assets Control) G0

2 IRAQ ABU AL FULUS | ALF OFAC (Office of Foreign Assets Control) 90
AMARA (AL- . .

3 IRAQ AV Alg) AMA OFAC (Office of Foreign Assets Control) 85

4 IRAQ ARAK ARK OFAC (Office of Foreign Assets Control) 90

10.1.1.2.3 Blacklisted Countries Reference Data

The following columns are available in the template for blacklisted countries:

e Record ID: This column displays the record serial number for the blacklisted country. The record
ID is unique for every country.

e Country: This column displays the name of the blacklisted country.
e ISO Country Code: This column displays the ISO code of the blacklisted country.
e Country Synonyms: This column displays the synonyms of the blacklisted country.
e Data Source: This column displays the source of the data for the blacklisted country.
e Risk Score: This column displays the risk score for the blacklisted country.

Sample Data for Sanctioned Countries

The following table provides sample data for blacklisted countries:
Table 30: Sample Data for Sanctioned Countries

ISO Country Country

Record ID Country Data Source Risk Score
Code Synonyms

IRAK, REPUBLIC
OF IRAQ, AL JUM-
HURIYAH AL
IRAQIYAH, AL IRAQ

1 IRAQ 1Q OFAC (Office of Foreign Assets Control) | 90
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Table 30: Sample Data for Sanctioned Countries

ISO Country Country .
Record ID Country Data Source Risk Score
Code Synonyms
DEMOCRATIC CONGO, THE
2 REPUBLICOF | CD DEMOCRATIC OFAC (Office of Foreign Assets Control) | 90
THE CONGO REPUBLIC OF THE
AFGHANI- ITAR (International Traffic in Arms Reg-
5 STAN AF NA ulations) 85
4 ZIMBABWE ZW NA ITAR (International Traffic in Arms Reg- 90
ulations)
CENTRAL - )
5 AFRICAN CF NA EAR ()Export Administration Regula- 85
REPUBLIC 1ons
6 BELARUS BY NA EQES()Export Administration Regula- 80

10.1.1.2.4 Stop Keywords Reference Data

The following columns are available in the template for keywords:
e Record ID: This column displays the record serial number for the keyword.
e Stop keyword: This column displays the keyword.
e Risk Score: This column displays the risk score for the keyword.

Sample Data for Sanctioned Stop Keywords

The following table provides examples based on keywords:

Table 31: Sample Data for Sanctioned Stop Keywords

Record ID Stop KeyWords Risk Score
1 EXPLOSIVE 80
2 DIAMOND 90
3 TERROR 80
4 TERRORIST 85
5 ARMS 80
6 NUCLEAR 90

10.1.1.2.5 Goods Prohibition Reference Data

The following columns are available in the template for prohibited goods:

e Record ID: This column displays the record serial number for the prohibited good. The record ID
is unique for every good.

e Good Code: This column displays the code of the prohibited good.
e Good Name: This column displays the name of the prohibited good.

e Good Description: This column displays the description of the prohibited good.
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Sample Data for Prohibited Goods

The following table provides sample data for prohibited goods:

Table 32: Sample Data for Prohibited Goods

Record ID Good Code Good Name Good Description

1 0207 43 00 Fatty livers Fatty livers, fresh or chilled
2 02089010 vory CONGO, THE DEMOCRATIC
3 020910 00 Ivory powder and waste | NA

4 3057100 Shark fins NA

5 430219 40 Tiger-Cat skins NA

10.1.1.2.6 Ports Prohibition Reference Data

The following columns are available in the template for prohibited ports:

e Record ID: This column displays the record serial number for the prohibited port. The record ID is
unique for every port.

e Country: This column displays the name of the country where the prohibited port is located.
e Port Name: This column displays the name of the prohibited port.
e Port Code: This column displays the code of the prohibited port.
e Port Synonyms: This column displays the synonym of the prohibited port.
Sample Data for Prohibited Ports

The following table provides sample data for prohibited ports:

Table 33: Sample Data for Prohibited Ports

Record ID Country Port Name Port Code Port Synonyms

1 IRAN, ISLAMIC REPUBLICOF | KHORRAM- IR KHO KHORRAMSHAHR Port

2 RUSSIA Sevastopol SMTP zi?aStOF’o"Po“ of Sevasto-
3 New Zealand Dunedin NZ ORR Otago Harbour

4 New Zealand Ravensbourne NZ ORR Otago Harbour

10.1.1.3 Extending Prohibition Screening

Oracle Financial Services Transaction Filtering, as delivered, allows for prohibition screening against
Nationality and Residency for Individuals and [country of] Operationand
[country of] Registration for Entities.Additional prohibition types can be added as
follows:

e Create new entries in the prohibition reference data with a new Prohibition Type name, for
example, "Employment Country".

e [Batch screening only] Extend the customer data preparation process to create a new attribute,
for example, dnEmploymentCountryCode.
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e Edit the appropriate screening process, to create the necessary match rules and clusters for the
new attribute.

OFS Transaction Filtering Admin Guide | 121



Configuring Risk Scoring Rules

11

Configuring Risk Scoring Rules

This chapter provides a brief overview of configuring Risk Scoring Rules for Transaction Filtering.
These rules are configured in the Inline Processing Engine (IPE). Transaction Filtering has a few ready-
to-use business rules. The following steps show the pre-configured business rules and how you can
create your business rules based on the requirements.

Before you configure the rules, you must update the sequence ID for IPE. To do this, execute the
following script in the Config schema as a post-installation step:

Begin p_set sequence value ('TASKS', '5000000','Y"); end;

For information on the post-installation activities, see the Oracle Financial Services Behavior Detection

Instal

lation Guide.

e screensnots snown 1or these steps are taken 1or existing

tables. You can perform similar steps for newly added tables.

To co
1.

nfigure rules in IPE, follow these steps:

Navigate to the Financial Services Analytical Applications Transactions Filtering landing
page. For more information, see the Inline Processing Menu.

Click Inline Processing. The Inline Processing page is displayed.

The following window shows the Profiles menu. Profiles are an aggregation of information. Pro-
files can be based on different grouping entities (For example, account and customer) and can
be filtered to only look at specific types of transactions. Profiles can also be based on time (last
three months) or activity counts (last 100 transactions). For more information on Profiles, see
the Managing Profiles chapter in the Oracle Financial Services Inline Processing Engine User
Guide.

Figure 90: Profiles Menu
ORACLE' Inline Processing

Association and Configuration Expressions Post Processing Actions Profiles virtual Profiles Evaluations Assessments

Home> >Profiles
Search = Go
Profile Name

status

"D Reset

Activity v Processing Segment

Profiles (0) 4 add [ Delete

profile Name

Activity Processing Segment Status Updated By Updiated On History

No Data Found

3.

Import data model tables into IPE using the Business Entities sub-menu. A Business Entity is a
virtual layer that can be added to an existing table. You can add a new business entity and search
for existing business entities to modify or remove a business entity For more information on
Business Entities, see the Managing Business Entities section in the Oracle Financial Services
Inline Processing Engine User Guide.

To import a table, follow these steps:
m  Click the Association and Configuration menu, then click the Business Entities sub-menu.

m  Select the Business Entity you want to import.

= Click Import Entity & Import Entity
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Figure 91: Import Table Action

Association and Configuration Expressions Post Processing Actions Profiles Virtual Profiles Evaluations Assessments

Home= = Association and Configuration= = Business Entities

Choose Entity & Import Entity [i] Delete

Entity Name* v
Business Entities (0) 4 add (£ edit (1 Delete 7 Synchronize

Entity Details [ save

Set Primary Key Attribute” v
Set Sequence |D Attribute v
Set Processing Status Attribute v

Attributes (0) [ edit

By default, all the tables defined for the entity (data model) are displayed. The Entity name is dis-
played in the format <Logical Name>-<Physical Name>.

Figure 92: Entities List
Search! & Gol # Reset

Entity Mame

Entities

st Entity Name

ACCT-ACCT
C5_ALERTS-CS_ALEATS

CUST-CUST

CUST_ACCT-CUST_ACCT

CUST_ADDR-CUST_ADDR

CUST_EMAIL_ADDR-CUST EMAIL_ADDR

CUST ID_DOC-CUST_ID_DOC
CUST_IMP_LICENSE-CUST_IMP_LICENSE

CUST P LICENSE GOODS-CUST_IMP_LICENSE GOODS
CUST_LIST_MEMBERSHIP-CUST_LIST_MEMBERSHIP

Cancel

m  Select an entity. The Business Entity fields are enabled. You can enter the following details:

Table 34: Business Entity Fields

Description

Enter a unique Business Name of the Entity. By default, the Business
Business Name Name is populated as the logical name provided for the Table in the data
model. The details of this field can be modified.
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Table 34: Business Entity Fields

Field Description

Entity Type

Select the Entity Type from the drop-down list. The following entity

types are available:
Activity: Select a table as Activity if the data is to be processed by
IPE as a part of assessment execution. To use Activity as a Refer-
ence, relevant Inline Datasets and Traversal Paths must be created.
For example, if wire transactions and cash transactions are two
activities, then there must be inline datasets created for them and
a traversal path connecting the two.

Reference: Select a table as a Reference if the table has static val-
ues for IPE. Reference data cannot be processed by IPE.

Lookup: Select a table as Lookup if it is used as a scoring table in
Evaluations. This can be used as a Reference.

After a table is imported, you cannot change the entity type of the table.

Processing Segment

Select the Processing Segment from the multi-select drop-down list.

Set Primary Key Attribute

Select the Primary Key Attribute from the drop-down list.

This shows all the columns of the table. This is a unique attribute of the
table which is imported. It is a mandatory field.

Composite Primary Keys are not supported.

Set Sequence ID Attribute

Select the sequence ID attribute from the drop-down list.
Select the sequence ID attribute from the drop-down list.
This field is enabled if you select Activity as the Entity Type.

DB Sequence Name

Enter the DB sequence name.

A DB Sequence must be created in the Atomic Schema. The name of that
Sequence must be provided in this field.

This field is enabled if you select Activity as the Entity Type.

Set Processing Status
Attribute

Select the processing status attribute from the drop-down list.

This attribute is updated by IPE to indicate if the assessment has passed
or failed.

This field is enabled if you select Activity as the Entity Type.

Set Processing Period
Attribute

Select the processing period attribute from the drop-down list.

This attribute defines the date or time when the activity has occurred.
For example, Transaction Time.

This field is enabled if you select Activity as the Entity Type.

Score Attribute

This field is enabled ONLY if you select Lookup as the Entity Type.
Select the Score Attribute from the drop-down list.
This attribute can be used in evaluation scoring.

m  Click Save.

1. Add a business entity. To do this, follow these steps:

m In the Business Entities sub-menu, select an entity from the Entity Name drop-down.
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Figure 93: Entities List
ORACLE’ Inline Processing

Association and Configuration  Expressions  PostProcessing Actions  Profies  VinualProfies  Evaluations  Assessments

Choose Entity @ Import Entity (1 Delete

Entity Name® v

FCC_TFXML_MSGTAG
Entity Details b save
Set Primary Key Attriouter | FOC-TTKMLSCRENG.BIC_RES

Set sequence ID Attroute | TCC-TTHMLSCRENG_ENTR_CTV_RES

et Processing Status Atrpute. | CC-TF-XMLSCRENG_GOODS _RES
FCC_TF X\IL_SCRENG_NAM_ADDR_RES
Attributes (0} (# Egit FCC_TF_XML_SCRENG_NARTVE RES
FCC_TF XML SCRENG _PORTS RES
FEC_TF XML _TRXN_TAG
FSI_RT_VISG_TAGS
FSI_RT_RAW_DATA

FSI_RT_WLS_RESPONSE

SETUP_RULE_CONFIGURATION

m  Click Add.

Entity Type v

D Sequence Name

Set Processing Period Attribute v

2. Provide the name, processing segment, and score attribute for the business entity.

Figure 94: Business Entity attributes

Mame* Message Tag Table

Processing Segment”  Transaction Filtering

Set Score Attribute

Add Cancel

M

3. Click Add. The new parameter is added to the list of Business Entities on the Business Entities

page.

4. Add ajoinin IPE from the Inline Datasets sub-menu in the Association and Configuration
menu. Inline Datasets are joins between two Business Entities. When you create an Inline Data-

set, you must define at least one join.
To add a join, follow these steps:

= Onthe Inline Datasets page, click Add.
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Figure 95: Inline Datasets page
ORACLE' Inline Processing

Association and Configuration Expressions Post Processing Actions Profiles Virtual Profiles Evaluations Assessments
Home>>Association and Configuration> > Inline Datasets
Search ™ Go 'O Reset
Inline Dataset Name
Start Table v End Table v
Inline Datasets (10) 4 Add Delete
Inline Dataset Name a  Start Table End Table Associations

Message Data Attributes to Transaction T: Message Data Attributes

se Message Data Attributes

it Message Dats Attributes

n Message Data Attributes

e Message Data Attributes

ge Tag_to Narrative

ge Tag to Ports

Resp Message Data Attributes

cening Response Message Data Attributes

Configuration Table Real Time Raw Data

Real Time Raw Data

e Tabl Real Time Raw Data

Transaction Tag Attributes
BIC Screening Response
Country City Screening Respons

Goods Screening Respanse

Name Addr Screening Response

Narrative Screening Response
Ports Screening Response
Rule Configuration Table
Message Tag Tsble

Screening Response

N MSG TAG ID = N MSG TAG ID: V BATCH RUN ID =V BATCH RUN ID

N M5G TAG
N MSG TAG
N MSG TAG
N MSG TAG
N MSG TAG
N MSG TAG
W GRP MG
N GRP MSG

N GRP MSG

D = N MSG TAG ID: ¥ BATCH RUN

D=N G ID: V BATCH RUN

D =N MS :V BATCH RUN

D=N :V BATCH RUN

D=N

AG ID:V BATCH RUN

D = N MSG TAG ID: V BATCH RUN

TYPE =V TXN TYPE CD

D = N GRP MSG ID

D =N GRP MsG ID

D =V BATCH RUN

D =V BATCH RUN

D =V BATCH RUN

D =V BATCH RUN

D =V BATCH RUN

D =V BATCH RUN

=]

5}

5]

5}

5]

5}

EEEEEEEERE

m  Enter a name for the inline dataset.
= In the Start Table field, select the start table of the join.
m Inthe End Table field, select the end table of the join.

Figure 96: Inline Datasets Attributes

Inline Dataset Details

Inline Dataset Name™ Message Tag to Rule Configuration Table

Start Table”  Real Time Raw Data v End Table® Rule Configuration Table v
Inline Dataset Condition Addlil Delete
£ Start Operator End
Attribute ¥ V_GRP_MSG_TYPE y¥=- v Attribute ¥ | V_TXN_TYPE_CD v
Save Cancel

= Click Add.

m  Click Save. The new dataset is added to the list of Inline Datasets on the Inline Datasets
page. For more information on inline datasets, see the Managing Inline Datasets section in
the Oracle Financial Services Inline Processing Engine User Guide.

1. Add a traversal path for each join defined in the Inline Datasets sub-menu. Traversal paths are
the paths between two or more entities. The traversal paths defined can be used to create
expressions, evaluations, and profiles.

To add a traversal path, follow these steps:
m  Click the Traversal Paths sub-menu in the Association and Configuration menu.

m  Onthe Traversal Paths page, click Add.
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Figure 97: Traversal Paths Page
ORACLE' Inline Processing

Assaciation and Configuration Expressions

Home» » Assaciation and Configurations »Traversal Paths

Search ™ Go 'O Reset
Traversal Path Name

Start Table

Traversal Paths (10) 4 Adg Delete

sk Traversal Path Name a  Start Table

Message Tag to

se Message Data Attributes

age Tag to Country and City Screenit Message Data Attributes

Message Tag to Goods Screening Respon: Message Data Attributes

Message Tag to Mame and sz Scree Message Data Attributes

Tag_to Marrative Screening Resp Message Data Attributes

IMessage Tag to Ports Screening Response Message Data Attributes

Message Tag to Rule Configuration Table Real Time Raw Data

Message Data Attributes

Real Time Raw Data

ening Response Tabl Real Time Raw Data

Post Processing Actions

Virtual Profiles Evaluations

v End Table

End Table

BIC Screening Response
Country City Screening Respons
Goods Screening Response
MName Addr Screening Response
Narrative Screening Response
Ports Screening Response

Rule Configuration Table
Transaction Tag Attributes
Message Tag Table

Screening Response

Assessments

Traversal Path Flow

Message Data Attributes : BIC Screening Response
Message Data Attributes : Country City Screening Respons
Message Data Attributes : Goads Screening Response
Message Data Attributes : Name Addr Screening Response
Message Data Attributes : Narrative Screening Response
Message Data Attributes : Ports Screening Response

Real Time Raw Data : Rule Configuration Table

Message Data Attributes : Transaction Tag Attributes

Real Time Raw Data : Message Tag Table

Real Time Raw Data : Screening Response

m  Enter a name for the traversal path.
= Inthe Start Table field, select the same start table that you selected in step c.<XREF>
= Inthe End Table field, select the same end table that you selected in step d.<XREF>

Figure 98: Traversal Paths Attributes

Traversal Path Details
Traversal Path Name Real Time to Message Tag

Start Table  Real Time Raw Data T End Table Rule Configuration Table T

Traversal Path Flow™ Addll Delete

3l Source Entity Destination Entity Sequence ID

Real Time Raw Data r Rule Configuration Table r 1

Save Cancel

m  Click Add.
m  Select the values for the traversal path flow as shown in the figure.

m  Click Save. The new path is added to the list of traversal paths on the Traversal Paths page.
For more information on traversal paths, see the Managing Traversal Paths section in the
Oracle Financial Services Inline Processing Engine User Guide.

2. Add an Expression on the risk score column of the newly created business entity which is to be
scored as a risk parameter from the Expressions menu. An expression is used as a filter when
creating evaluations or profiles. Expressions must only be created on the activity table on which
an evaluation is created.

In this example, two expressions are created. The first expression is for the column which holds
the value of the new risk parameter, and the second expression is for the calculations that are
needed to derive the risk score

To add an expression, follow these steps:

OFS Transaction Filtering Admin Guide | 127



Configuring Risk Scoring Rules

Click the Expressions menu.

On the Expressions page, click Add.

Figure 99: Expressions Page
ORACLE" Inline Processing

Association and Cenfiguration

D Reset

Search ®Go

Expression Name
Status
Expressions {26) 4 add

Expression Name

Amendments

Amount |SO20022
BIC Score
Batch Run ID

Benefician it Mumb:

ge Reference

Page 1 of2

Expressions Post Processing Actions Profiles Virtual Profiles Evaluations Assessments
Activity v Processing Segment v
v
Delete [ save
»  Description Status Activity Processing Segment
{ Message Tag TablesN_NUMBER_OF_AMENDMENT) WALID Real Time Raw Data Transaction F... G2
( Message Tag Table:V_AMOUNT) VALID Real Time Raw Data Transaction F... @&
{ Message Data Attributes:N_CNTRL_SUM_AMT) WVALID Message Data Aftributes Transaction F... 2
{ BIC Screening Response:N_Match_Score) WALID Message Data Aftributes  Transaction F... 22
{ Message Data Attributes:V_BATCH_RUN_ID) VALID Message Data Aftributes Transaction F... &2
[ Message Tag Table:V_BENF_ACC_NO) VALID Real Time Raw Data Transaction F... G2
{ Message Tag Table:V_BENF_ACC_ADDRS) VALID Real Time Raw Data Transaction F... @&
{ Country City Screening Respons:N_Match_Score) WVALID Message Data Aftributes Transaction F... 2
( Message Tag Table:V_CURRENCY) VALID Real Time Raw Data Transaction F... &
( Transaction Tag Attributes:V_CURRENCY) VALID Message Data Aftributes Transaction F... 2
{ Message Tag Table:V_DESTINATION_CNTRY) WALID Real Time Raw Data Transaction F... 22
{ Message Tag TableiV_DIRECTION) VALID Real Time Raw Data Transaction F.. 22
{ Goods Screening Response:N_MATCH_SCORE) WVALID Message Data Aftributes Transaction F... 22
( Real Time Raw Data:V_BIC_CODE) VALID Real Time Raw Data Transaction F... @&
{ Message Tag Table:V_M3SG_REF) VALID Real Time Raw Data Transaction F... @2

For the first expression, enter a name for the expression and select the values as shown in
the figure.

Figure 100: First Expression Attributes

Expression Mame*

Processing S

Variables¥ Add

Country of birth Activity®  Real Time Raw Data

==y

EgMENt ™ Transaction Filtering

Delete Apply Function To GroupEE Remaove Function From Group #= Apply Function to Expression

Group Order Operator Business Property (Business Entity. Business Attribute) Function Function Parameter
Variable Hsave B cance
Operator v
Business Entity®  Message Tag Table v
Business Attribute™ D _REQST_EXECUTION v

Add to Cumrent Group : Create Mew Group

Submit Close

Select the business entity and the business attribute where the value of the new parameter
resides.

Click the Save icon. The variable is displayed on the window.
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Figure 101: First Expression Displayed
Expression Mame® Country of birth Activity*  Real Time Raw Data v

=y

Processing Segment ™ Jransaction Filtering

Variables® Addld Delete Apply Function Ta GroupBE® Remaove Function From Group = Apply Function to Expression

Group Order Operator Business Property (Business Entity. Business Attribute) Function Function Parameter
1 Meszage Tag Table : D_RECET_EXECUTION
Variable I save B Cance
Operator v
Business Entity™ ¥
Business Attribute” T
Add to Current Group : Create New Group
Submit Close

m  For the second expression, enter a name for the expression and select the values as shown
in the figure.

Figure 102: Second Expression Attributes

Expression Name* Country of birth calculations Activity*  Real Time Raw Data v

(==

Processing segment *  Trapsaction Filtering

Variables¥ Addld Delete Apply Function To GroupBH Remove Function From Group #= Apply Function to Expression

Group Order Operator Business Property (Business Entity. Business Attribute) Function Function Parameter
Message Tag Table : D_RECST_EXECUTION
Variable - save B Cance
Operator  + v
Business Entity*  Message Tag Table ¥
Business Attribute® D _DATE OF ISSUE v
Add to Cumrent Group : Create Mew Group
Submit Close

m  Click the Save icon. The variable is displayed.
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Figure 103: Second Expression Displayed

Expression Name* Country of birth calculations Activity®  Real Time Raw Data v

=

Processing Segment™  Transaction Filtering

Variables¥ Addld Delete Apply Function To GroupBEE Remove Function From Group #= Apply Function to Expression

Group Order Operator Business Property (Business Entity. Business Attribute) Function Function Parameter
Meszage Tag Tabls : D_REQST_EXECUTION
2z 1 + Meszage Tag Table : D_DATE_OF_IS5UE
Variable b save B Cance
Operator v
Business Entity” ¥
Business Attribute™ ¥
Add to Current Group Create New Group
Submit Close

For information on applying a function to the group or expression, see the Managing Expres-
sions chapter in the Oracle Financial Services Inline Processing Engine User Guide.

m  Click Submit. The new expression is added to the list of expressions on the Expressions
page.

3. Add the following ready-to-use evaluations from the Evaluations Menu. Evaluations are logical
comparisons against conditions that result in a score. For information on the conditions, see the
Managing Evaluations section in the Oracle Financial Services Inline Processing Engine User
Guide.

You can define new rules according to your requirement using the expressions defined in the
earlier steps.

m  [SO20022 Risk-Currency VS Amount Threshold Evaluation

For all filter conditions mentioned in the following table, if the filter values are met as config-
ured then add a risk score of 20.

. 1S evaluation apphes to the Message category.
e This score is configurable.

Table 35: 1S020022 Risk-Currency VS Amount Threshold Evaluation Filters

SI.No Filter Name Filter Clause
Batch ID ( Message Data Attributes:V_BATCH_RUN_ID ) = BATCH RUN ID
Amount ( Message Data Attributes:N_CNTRL_SUM_AMT ) >= 10000
Currency ( Transaction Tag Attributes:V_ CURRENCY ) = 'EUR’

m  Risk- High Risk Party Evaluation
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For all filter conditions mentioned in the following table, if the filter values are met as configured
then add a risk score of 40.

Table 36: Risk- High-Risk Party Evaluation Filters

SI.No Filter Name Filter Clause

- ( Message Tag Table:V_BENF_ACC_NO) = ( Rule Configu-
Beneficiary Account Number ration Table:V. COND)

( Rule Configuration Table:V_RISK_RULE_CODE) =
Rule Name "TF_HIGH_RSK_PARTY'

Message Type ( Real Time Raw Data:V_GRP_MSG_TYPE) = 'MT700'

s (Message Tag Table:V_DIRECTION) in (('NBOUND,
Direction 'OUTBOUND'))

m  Risk-Currency VS Amount Threshold Evaluation

For all filters conditions mentioned in the following table, if the filter values are met as config-
ured then add a risk score of 25.

I NOTE IS SCore 1s configurabple.

Table 37: Risk-Currency VS Amount Threshold Evaluation Filters

SI.No Filter Name Filter Clause
Message Type '(IVRI'?EI()?C%E\/E?&'PZ&‘O?E;/_GRP_MSG_TYPE) in (‘'MT107, 'MT103/,
Jurisdiction ( Real Time Raw Data:V_BIC_CODE) = 'CHASUS33XXX'
Direction ( Message Tag Table:V_DIRECTION) in ('INBOUND','OUTBOUND")
Currency ( Message Tag Table:V_CURRENCY) = 'USD'
Amount ( Message Tag Table:V_AMOUNT) >= 10000

m  Risk-Currency VS Destination Country Evaluation

For all filters conditions mentioned in the following table, if the filter values are met as config-
ured then add a risk score of 20.

This evaluation works with reference table SETUP_ RULE CONFIGURATION, which is another way
of configuring evaluation or risk scoring rule. This evaluation is done using one of the lookup
tables from the database. Similarly, you can add more rules using the same table where columns
are generalized.

Table 38: Risk-Currency VS Destination Country Evaluation Filters

Filter Name Filter Clause

( Message Tag Table:V_CURRENCY) = ( Rule Configuration
Currency Table:V_CONDT)
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Table 38: Risk-Currency VS Destination Country Evaluation Filters

SI.No Filter Name

Destination Country

Filter Clause

( Message Tag Table:V_DESTINATION_CNTRY) = ( Rule Configu-
ration Table:V_COND?2)

Direction (Message Tag Table:V_DIRECTION) in ('INBOUND','OUTBOUND')
( Real Time Raw Data:V_GRP_MSG_TYPE) = ( Rule Configuration

Message Type Table:V_TXN_TYPE_CD)

Rule Name ( Rule Configuration Table:V_RISK_RULE_CODE) = 'TF_CCY_C-

TRY_RSK'

m  Risk-High Risk Destination Country Evaluation

For all filters conditions mentioned in the following table, if the filter values are met as config-

ured then add a risk score of 20.

I NOTE This Score 1S configurable.

Table 39: Risk-High Risk Destination Country Evaluation Filters

SI.No Filter Name Filter Clause
Amount ( Message Tag Table:V_AMOUNT) >= 10000
Currency (Message Tag Table:V_CURRENCY) = 'EUR'

Destination Country

( Message Tag Table:V_DESTINATION_CNTRY) in ('TH', 'PK)

Direction

(Message Tag Table:V_DIRECTION) = 'OUTBOUND'

Message Type

( Real Time Raw Data:V_GRP_MSG_TYPE) in (‘MT107,
'MT103', 'MT202C0OV', 'MT202")

m  Risk-High Risk Originator Country Evaluation

For all filters conditions mentioned in the following table, if the filter values are met as config-

ured then add a risk score of 20.
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INUII:

I'nIs score 1s contigurable.

Table 40: Risk-High Risk Originator Country Evaluation Filters

SI.No Filter Name Filter Clause
Amount ( Message Tag Table:V_AMOUNT) >= 10000
Currency (Message Tag Table:V_CURRENCY) = 'EUR'
( Real Time Raw Data:V_GRP_MSG_TYPE) in ('MT101', 'MT103/,
Message Type 'MT202COV', 'MT202')
Direction ( Message Tag Table:V_DIRECTION) = 'INBOUND'

Originator Country ( Message Tag Table:V_ORIGINATOR_CNTRY) in ('PK’, 'TH')

m  Risk-Trade Amendments Evaluation

For all filters conditions mentioned in the following table, if the filter value conditions are met as
configured then add a risk score of 20.

INUII:

I'n1s score 1s contigurable.

Table 41: Risk-Trade Amendments Evaluation Filters
SI.No Filter Name Filter Clause

Message Type ( Real Time Raw Data:V_GRP_MSG_TYPE) = 'MT707'

S ( Message Tag Table:V_DIRECTION) in
Direction ((INBOUND',OUTBOUND"))

( Message Tag Table:N_NUMBER_OF_AMENDMENT)

Number of Amendments >= §

m  Risk-WatchList Screening Evaluation

This evaluation or risk rule returns the match score generated from the matching engine. In the
case of multiple matches for a given message, it returns the maximum match score. The match-
ing rules are configured with different match scores in EDQ.

INUII:

e TNis evaluation applies to the SWIF I message category.
e This score is configurable.
m  Watch List Score

This evaluation or risk rule watch list response score. The matching rules are configured with dif-
ferent match scores in EDQ.
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NOIE

° I'nis evaluation applies 10 the I5U message category.

e This score is configurable.

Table 42: Watch List Score Filters

SI.No Filter Name

Watch List Score

Filter Clause

(Get Max Watch List Score(( Name Addr Screening
Response:N_MATCH_SCORE),Goods Score,Country and City
Score,BIC Score,Ports Score,Narrative Score)) > 50

Batch Run ID

( Message Data Attributes:V_BATCH_RUN_ID) =
‘BATCH_RUN_ID

To add an evaluation, follow these steps:
m  Click the Evaluations menu.

= On the Evaluations page, click Add.

Figure 104: Evaluations Page
ORACLE' Inline Processing

Association and Configuration Expressions  Post Processing Actions  Profiles  Virtual Profiles  Evaluations  Assessments
Home> >Evaluations
Search ®Go 'O Reset
Evaluation Name
Status
Evaluations (9) 4 Add [i] Delete f]save []Copy
2 Evalustion Name Score Activity Processing Segment  Status

15020022 Risk-Currency VS Amount Threshold Evz 20

Risk- High Risk Part; tion Rule Configuration Table:N_I B2 Real Time Raw Data

Risk-Currency VS Amount Threshold Evaluation 25 & Real Time Raw Data

Rule Configuration =]

Risk-Currency VS Destination Country Evaluation Table:N_RISK_PARAM_SCOR Real Time Reaw Data
E

Risk-High Risk Destination Country Evaluatien 20 2 Real Time Raw Data

Risk-High Risk Originator Country Evaluation 20 B2 Real Time Raw Data
Risk-Trade Amendments Evaluation 20 2] Real Time Raw Data

Risk-Watchlist Screening Evaluation Screening Response:N_SC.. @) Real Time Rew Data

watch List Score Watchlist response Score

m  Enter a name for the evaluation.

() Message Data Attributes Transaction Filtering VALID
Transaction Filtering  VALID

Transaction Filtering  vALID

Transaction Filtering  VALID

Transaction Filtering  vALID
Transaction Filtering  VALID
Transaction Filtering  vALID
Transaction Filtering  VALID

22 Message Data Attributes Transaction Filtering VALID

Activity .
Updated By Updated On History
TFADMN 02/12/2020 10:46:43 &
05/03/2018 04:47:24 &
01/04/2018 06:55:27 &
01/04/2018 06:56:59 @
01/04/2018 06:55:13 &
01/04/2018 06:54:31 an
05/03/2018 04:44:52 o
01/04/2018 06:57557 an
TFADMN 01/03/2020 07:0047 o

m  Select an activity for the evaluation and the Transaction Filtering processing segment.
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Source Expression”

Figure 105: Evaluations Attributes

Evaluation Details F Add Expression
Name™ country of birth Activity*

JOINTIPE" @) jnner ) Let
Filters (0) # add (£edit [0 Delete
Evaluation Scoring

SCOrERE” () kived O lookup () Expression
Associated Assessments (0)

Associated Profiles (0)

Associated Virtual Profiles (0)

Change Description

m To add a filter for the evaluation, click Add.

Real Time Raw Data

. Processing Segment* 5
Transaction Filtering v

save | Cancel

m  Select the expression as mentioned in step f.

Figure 106: Evaluations Filters

Filter Details

Filter Name Active flag

Country of birth calculations

y Operator*

-l save Close

comparatar Type® Expression  ® Literal Value

M ¥

m Click Save. The new evaluation is added to the list of evaluations on the Evaluations page.

4. Create an Assessment for the ready-to-use evaluations. The Assessments checks the logic of all
the evaluations and considers the sum of all the Evaluations for the output score.

NOIE

You can adjust the rnisk score for any given evaluation depending
on the requirement, but it must be within 40, because match rule
score configuration starts with 45, and match score must always
have high weightage than the individual evaluation risk score.

The risk score is calculated at the assessment level is as follows:

m  The total risk score of a message is the sum of all risk scores derived from configured evalu-

ations or risk rules including match score.

m Inthe case of multiple transactions, the risk score is the sum of all risk scores derived from

different evaluations across transactions.

m If the same evaluation is true for multiple transactions within a message, then the score is
considered once and the maximum one is considered.

m If different evaluations are true for different transactions, then it sums up all the risk scores

across transactions within a message.

To add an Assessment, follow these steps:

m  Click the Assessments menu.
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Figure 107: Assessments Page

ORACLE' Inline Processing

Association and Configuration Expressions Post Processing Actions Prafiles Vvirtual Profiles Evaluations Assessments

Homes > Assessments

Search ®Go D Reset

Assessment Name Activity .
Status .
Assessments (2) 4 add [ Delete (™ export
2 Assessment Name . Activity Processing Segment Status Updated By Updated on History

ssessment Real Time Raw Data Transaction Filtering VALID - 01/04/2018 06:58:19 al

Filtering

tion Filtering 1502002.

Message Data Attributes  Transaction Filtering VALID TFADMN 02/12/2020 10:47:07 Gl

m  Onthe Assessments page, click Add. The following image shows the evaluations for the
Transaction Filtering Assessment:

Figure 108: Assessments Attributes

Assessment Details AlHistory
Name+ Transaction Filtering Assessment Activityr  Real Time Raw j Processing Segment  Transaction Filtering
status VALD Execution mode  @Live OTest Persist Type | Records O Failed Records
Updated By ADMIN Updated On 01/04/2018 05:28:19 PM

Associated Evaluations (5) 2 map

& Evaluation Name Score Status Updated By
[ Risk-Currency Vs Amount Threshold Evaluation 25 VALID admin
[ Risk-Currency Vs Destination Country Evaluation Rule Configuration Table:N_RISK_PARAM_SCORE VALID admin
[ Risk-High Risk Destination Country Evaluation 20 VALID admin
[ Risk-High Risk Originator Country Evaluation 20 VALID admin
[ Risk-watchlist Screening Evaluation Screening Response:N_SCORE VALID admin

< 1

Evaluation Filters (0)

Assessment Score

scoring® (O Max of Evaluation Score (O Normalized Score @ Sum of Evaluation Score

8

Normalized To 0 Normalization Base 0 Cut-Off Score™
Assessment Outcome (4) B spve

s Action Score Lower Limit Score Upper Limit
[ Generate alert for Sanctions 60 -
[ Transaction Filtering Feedback JMS Message P =
[ cLEAN RESPONSE Transaction JMS Message o 59

[ HOLD RESPONSE Transaction JMS Message 60 i

Assessment Action Parameters (0)

Schedule
Assessment Database Parameters

Change Description

save | Cancel

The following image shows the evaluations for the Transaction Filtering 1IS020022 Assess-
ment:
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Figure 109: Sample Assessment

Assessment Detalls

Status VALD

Updated By TFADMIN

Associzted Evaluations (2) (7 Msp

Evaluation Filters (0)
Assessment Scare
Scoring®

alized To

o

Assessment Outcome (4) I ssue

Assessment Action Parameters (0

Schedule

Assessment Database Parameters

Change Description

Save | | Cancal

m  Provide the assessment name, activity, processing segment, assessment scoring method,

and change description for the assessment.

m  Click Save. The new assessment is added to the list of assessments on the Assessments
page. For more information on assessments, see the Managing Assessments section in the
Oracle Financial Services Inline Processing Engine User Guide.
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Appendix A: Watch Lists

Monitoring transactions against watch lists of sanctioned individuals and companies, internal watch
lists, and other commercial lists of high-risk individuals and organizations is a key compliance
requirement for financial institutions worldwide. These watch lists help financial institutions identify
customers who are sanctioned, live in sanctioned countries and any inbound or outbound transactions
associated with these customers.

HM Treasury Watch List

The HM Treasury publishes a sanctions list that can be used for screening in Transaction Filtering. The
sanctions list provides a consolidated list of targets listed by the United Nations, the European Union,
and the United Kingdom under legislation relating to current financial sanctions regimes. For more
information, see the HM Treasury website.

Oracle Transaction Filtering uses the list in a semi-colon delimited form. It can be downloaded from the
following location:

https://ofsistorage.blob.core.windows.net/publishlive/ConList.csv

OFAC Watch List

The US Treasury website states that The US Treasury's Office of Foreign Assets Control (OFAC)
administers and enforces economic and trade sanctions based on US foreign policy and national
security goals against targeted foreign countries, terrorists, international narcotics traffickers, and
those engaged in activities related to the proliferation of weapons of mass destruction. For more
information, see the Treasury website.

Oracle Transaction Filtering supports two lists that are produced by OFAC. The OFAC Specially
Designated Nationals (SDN) list, which is available for download in three separate parts from the
following links:

https://www.treasury.gov/ofac/downloads/sdn.csv
https://www.treasury.gov/ofac/downloads/add.csv
https://www.treasury.gov/ofac/downloads/alt.csv

The OFAC Consolidated Sanctions List, which can be downloaded in three separate parts from the
following links:

https://www.treasury.gov/ofac/downloads/consolidated /cons_prim.csv
https://www.treasury.gov/ofac/downloads/consolidated/cons_add.csv

https://www.treasury.gov/ofac/downloads/consolidated/cons_alt.csv

EU Watch List

The European Union applies sanctions or restrictive measures in pursuit of the specific objectives of
the Common Foreign and Security Policy (CFSP) as set out in Article 11 of the Treaty on European
Union.

The European Commission offers a consolidated list containing the names and identification details of
all persons, groups, and entities targeted by these financial restrictions. For more information, see the
European Commission website.

To download the consolidated list:
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1.  Go to https://webgate.ec.europa.eu/europeaid/fsd/fsf#!/account.
2. Create an account.

3. Navigate to https://webgate.ec.europa.eu/europeaid/fsd/fsf#!/files and open show settings for
crawler/robot.

4. Copy the URL for 1.0 XML (Based on XSD). This is in the format https: //web-

gate.ec.europa.eu/europeaid/fsd/fsf/public/files/xmlFullSanctionsList/
content?token=[username]. You must replace the [username] placeholder with the user
name you have created.

5. Enter this URL in your run profile or download the task.

UN Watch List

The United Nations (UN) or United Nations Security Council consolidated list is a watch list that
includes all individuals and entities who are subject to sanctions measures imposed by the Security
Council. For more information, see the UN Security Council website.

Download the consolidated list from https://www.un.org/sc/suborg/sites/www.un.org.sc.suborg/
files/consolidated.xml.

World-Check Watch List

World-Check provides a subscription-based service, offering a consolidated list of PEPs (Politically
Exposed Persons) and entities and individuals appearing on the HM Treasury, OFAC, and other world
lists. Three levels of subscription are provided: Standard, Premium, and Premium+. Some features of
the World-Check lists are only available to users with a higher subscription level. For more information,
see the World-Check website.

To download the World-Check Premium+ feed, set values in the WC Setup section of the watch list-
management. properties run profile as follows:

phase.WC\ -\ Download.enabled =Y

phase.WC\ -\ Download\ native\ aliases.enabled =Y
phase.WC\ -\ Stage\ reference\ lists.enabled =Y
phase.*.snapshot.*.use native aliases =1

To download the Standard or Premium feeds, set values in the WC Setup section of the watchlist-
management .properties run profile as follows:

phase.WC\ -\ Download.enabled =Y

phase.WC\ -\ Download\ native\ aliases.enabled = N
phase.WC\ -\ Stage\ reference\ lists.enabled =Y
phase.*.snapshot.*.use native aliases = 0

See the World-Check website for more details: https://risk.thomsonreuters.com/en/products/third-
party-risk/world-check-know-your-customer.html
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NOIE

L.6

L.7

L.8

If your Instance of OUracle Iransaction Filtering uses the WebLogIC
application server, and you are screening against the World-Check
watch list, then, to download the World-Check reference data suc-
cessfully, you must add the following to the 'Server Start' argu-
ments of your EDQ managed server: -
DUseSunHttpHandler=true. Thisis only required if you are
using the WebLogic application server and screening against the
World-Check watch list.

Dow Jones Watch List

Dow Jones provides a subscription-based service offering a consolidated list of PEPs (Politically
Exposed Persons) and entities and individuals appearing on the various sanctions lists. For more
information, see the Dow Jones website.

The Dow Jones watch list automated download task uses one of two script files that are provided with
Oracle Transaction Filtering to provide further configuration of the download process. These script
files are:

m  download-djw.sh (for use on Unix platforms)
m  download-djw.bat (for use on Windows platforms)

The script files are invoked by the automated task and will download the data files and copy them to
the appropriate sub-folder of the OEDQ landing area.

Dow Jones Anti-Corruption Watch List

Dow Jones provides a subscription-based service containing data to help you assess, investigate, and
monitor third-party risk about anti-corruption compliance regulation. For more information, see the
Dow Jones website.

The Dow Jones Anti-Corruption List automated download task uses one of two script files that are
provided with Oracle Transaction Filtering to provide further configuration of the download process.
These script files are:

m  download-djac.sh (for use on Unix platforms)
m  download-djac.bat (for use on Windows platforms)

The script files are invoked by the automated task and will download the data files and copy them to
the appropriate sub-folder of the OEDQ landing area.

Accuity Watch List

The Accuity Global watch list is a subscription-based service. The Accuity website states:

Accuity's proprietary collection of watch list screening databases is an aggregation of specially
designated individuals and entities compiled from dozens of regulatory and enhanced due diligence
lists from around the world. The global watch list provides the ideal framework for your Transaction
Filtering and interdiction filtering processes.

Accuity provides its aggregated data as a set of three lists as follows:

e The Regulatory Due Diligence (RDD) lists which cover sanctioned entities and individuals. The
Accuity Group File can also be used in conjunction with this list.

e Enhanced Due Diligence (EDD) lists which cover entities and individuals who are not part of the
regulatory sanctions lists, but whose activities may need to be monitored
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e The Politically Exposed Persons (PEPs) Due Diligence Database, and covering PEPs

Any or all the lists can be downloaded and used separately or in conjunction with each other. For more
information, see the Accuity website.

L.8.1  Using the Accuity Group File

The Accuity global Watchlist is created by aggregating multiple watch lists. As such, any given
individual or entity may be represented in the watch list by multiple entries using the GROUP . XML file.

In the GROUP . XML file, all records which represent the same individual or entity are collected into
groups, and each group is assigned a unique group ID. The group ID has a unique identifier to
differentiate it from the original record identifier in Enterprise Case Management (ECM). Records that
are not included in the group use their original Accuity record ID with a different identifier to indicate
that they are single records.

nly entities and individuals on the Regulatory Due Diligence
(RDD) watch lists are included in the group file.

The group file allows you to generate cases on individuals who are grouped together, instead of
generating cases on separate individuals. Groups are used by default. To change this, open Accuity
Data Store in the Watch List Management project and deselect the Use groups option.

Figure 110: Edit Data Store Window

( @- Edit Data Store ‘ 1 *]H

Server-based Acowty Watchlist (*.2p) Configuration

Worldwide Enhanced Due Diigence List (EDD) il EDD/edd. zip
Politically Exposed Persons List (PEP) Accuity PEP pep. 5p

Global Sanctions (SAN) Accuity [SAM/san. zip

Use project specific landing area

Lize groups o

Test, ..

QK Cancel

o

If you choose to use the group file but it is not present in your downloaded data, an error is generated.

L.8.2 New Alerts Resulting from Use of the Group File

Using the group file causes the original list ID for an entry to be replaced with the appropriate group ID.
The list ID is used in the alert key, so changes to the list ID will result in new alerts being raised for
existing, known relationships. There are two main scenarios in which this may occur:

Individuals or entities are moved into, out of, or between groups by Accuity, new alerts are generated
for existing relationships.
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INUII:

L.9

Use of the group Tile may result In new alerts being raised for exist-
ing relationships if the group file structure is changed by Accu-
ity. There is at present no way to circumvent this issue.

The Use Groups setting is changed after cases and alerts have already been generated. The setting for
the Use Groups option must be selected during the implementation phase of the project. After
screening has started, it must not be changed unless necessary. Changing this setting is likely to result
in duplication of existing alerts with a new alert ID.

Private Watch List

This section describes the structure of the . csv files used in the Private List Interface (PLI).

Private watch list data are provided in two . csv (comma-separated value) files;
privateindividuals.csvand privateentities.csv. These files come with a pre-defined
structure and set of validation rules. On installation, these files are populated with sample private
watch list data, which must be replaced with your data, once it has been transformed into the required
format.

NOIE

L.9.1

e [t1s recommended that you KeEep a copy of the sample pri-
vate watch list files, as they can be used to verify the cor-
rect functioning of your installation on a known data set.

e The files must be saved in UTF-8 format.

Three types of attributes are used in the PLI for screening:

Mandatory attributes: These attributes are tagged in the PLI tables with the [Mandatory attribute]
tag and are mandatory for screening.

Recommended attributes: These attributes are used in matching, typically to either eliminate false
positive matches that may occur if the mandatory fields alone were used or to reinforce the likelihood

of a possible match. They are tagged in the PLI tables with the [Recommended attribute] tag.

Optional attributes: These attributes are not used in matching. Information provided in these fields
may be of use in processes downstream of the match process.

Individual Private Watch List Input Attributes

This section lists the PLI fields used for individuals. In addition to the prescribed fields, fifty
customizable input attributes are available for individual private watch lists, out of which forty are string
attributes, five are date attributes and five are number attributes. They are available for any additional
inputs required by your private watch list.

The following table lists the individual PLI fields in order, the data format expected for each field, and
notes on their use in screening:

Figure 111: Individual Private Watch List Input Attributes

Field Name Expected Data Format Notes

This field is used to identify the source
list of the watch list record (for example,

ListSubKey String Private List, Accounting Private List,
Financial Private List, and so on). It is
included in the alert key.
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Figure 111: Individual Private Watch List Input Attributes

Field Name

ListRecordType

Expected Data Format

String

Notes

NA

ListRecordOrigin

String

This field is used to record the prove-
nance of a record when it is part of a
consolidated list.

ListRecordld

String

[Mandatory attribute] This attribute is
not used as part of the matching pro-
cess, but it must be populated with a
unique identifier.

PassportNumber

String

This is an optional field that may be used
to capture the passport numbers of cus-
tomers or individuals for use in the
review process.

Passport numbers are not used in the
default screening rules.

Nationalld

String

This is an optional field that may be used
to capture customer National IDs for use
in the review process.

The National IDs of customers and indi-
viduals must not use in the default
screening rules.

Title

String

This field must contain the titles of cus-
tomers or individuals (such as Mr/Mrs/
Dr/Herr/Monsieur). It is used to derive
gender values where gender is not
already stated and is used during the
review process.

Avoid putting titles in the name fields.

FullName

String

GivenName

String

FamilyName

String

[Mandatory attribute] The individual
matching process is based primarily on
the name supplied for the individual.
Either a full name, a pair of given and
family names, or an original script name
must be submitted to the screening pro-
cess for screening to proceed.

NameType

String

This is an optional field used in the
review process only. Multiple names may
exist for the same person. The Name
Type, therefore, denotes if the name is
the primary name of the listed party, or
an additional name (such as an Alias, or
Alternate Spelling). If two

Private list records were derived from a
single source with multiple names (such
as Mrs. Louise Wilson née Hammond
being split into two records, Louise Wil-
son and Louise Hammond) you may
wish to denote one as the primary name
and one as a maiden or alias name.
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Figure 111: Individual Private Watch List Input Attributes

Field Name

NameQuality

Expected Data Format

String

Notes

This field may be assigned a value of
Low, Medium, or High to indicate the
quality of the individual name. High is
used for Primary names and specified
good/high-quality aliases.

PrimaryName

String

For alias records, this field indicates the
main name for that record.

OriginalScriptName

String

[Mandatory attribute] The individual
matching process is based primarily on
the name supplied for the individual.
Either a full name, a pair of given and
family names, or an original script name
must be submitted to the screening pro-
cess for screening to proceed. If you
populate the Original Script Name, then
you will also need to enable two facets of
Match processor configuration that are
disabled by default: the Original Script
Name Cluster and some or all of the
Match Rules that include Original script
name in their name. To adapt the Match
Processor configuration, you will need to
open the Transaction screening project
within the Director user interface and
make the changes to every process used
during the Transaction Filtering installa-
tion.

Gender

String

The value supplied must be either ‘M’ or
‘F’. The gender is not used directly in the
matching process, but optionally, the
value of the Gender field can be used by
the elimination rules to eliminate poor
matches.

Occupation

String

This is an optional field that may be used
to eliminate records with "safe" occupa-
tions, in the review process and risk
scoring. Note that customer occupations
are not matched against list occupations
using the default screening rules.

DateofBirth

String, representing a date,
in the format

'YYYYMMDD'; day, month,
and year are required.

[Recommended attribute] Birth date
information can be used in matching to
identify particularly strong matches or to
eliminate matches that are too weak.

YearofBirth

String, in the format 'YYYY'.

NA

Deceased Flag

String

If populated, this optional field must
contain either Y or N.

DeceasedDate

String, representing a
date, in the format
"YYYYMMDD'".

If populated, this optional field must
contain either the current date or a date
in the past.
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Figure 111: Individual Private Watch List Input Attributes

Field Name Expected Data Format Notes
Address1 String
Address2 String These are optional fields that may be
Address3 String used in the review process.
Address4 String
City String
[Recommended attribute] City data is
State String used to strengthen potential match
information.
Postal Code String
. . [Recommended attribute] Address
AddressCountryCode (SZETJ?]% ISC(())dZecharacter country data is used to strengthen
Y ) potential match information.
N ) [Recommended attribute] The country
ResidencyCountryCode Sgﬂ?fr' ISC?)dZecharacter of residence can be used in optional
y ) country prohibition screening.
CountryOfBirthCode String; IS0 2-character NA

country code.

NationalityCountryCodes

String; comma separated
list of

ISO 2-character

country codes.

[Recommended attribute] The national-
ity can be used in optional country pro-
hibition screening.

ProfileHyperlink

String; a hyperlink to an
Internet or intranet resource
for the record.

This field may contain a hyperlink to an
Internet or intranet resource that can
provide reviewers with additional infor-
mation about the individual.

This field is included where the risk score

RiskScore Number, between 0 and 100 for a customer is calculated externally.
A number indicating the relative ‘riski-
ness’ of the Individual, considered as a
RiskScorePEP Number, between 0 and 100 | PEP. The risk score is expressed as an
integer between 1and 100, with Higher
numbers indicating a higher risk.
String, representing a
AddedDate date, in the format
YYYYMMDD'
String, representing a
LastUpdatedDate date, in the format These are optional fields for use in the

YYYYMMDD'

DataConfidenceScore

Number, between

review process.

0 and 100
DataConfidenceComment String
InactiveFlag String If populated, this optional field must

contain either Y or N.
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L.9.2

Figure 111: Individual Private Watch List Input Attributes

Field Name

InactiveSinceDate

Expected Data Format

String, representing a
date, in the format
'YYYYMMDD'

Notes

If populated, this optional field must
contain either the current date or a date
in the past.

PEPclassification

String

This field can be used to indicate the
type of PEP (for example, whether the
individual is part of an international
organization or government, and at what
level). It can be used to filter watch list
records and is primarily used by the
World-Check watch list, but could be
used by a private watch list if required.

customString1 to
customString40

String

customDatel to
customDate5

customNumber1to
customNumber5

Fifty custom fields are provided in the
private list data interface for individuals.
Forty of these are intended to hold string
data, five hold dates, and five numeric
data.

The interface file is a comma-separated
value (. csv) file, and so all fields intrin-
sically contain strings. However, during
the processing of Private watch lists, the
custom date and number fields are
checked to ensure that they include
appropriate data, and warning messages
are provided as output if they do not.

Entity Private Watch List Input (PLI) Attributes

This section lists the PLI fields used for entities. In addition to the prescribed fields, fifty customizable
input attributes are available for individual private watch lists, out of which forty are string attributes,
five are date attributes and five are number attributes. They are available for any additional inputs

required by your private watch list.

The following table lists the individual PLI fields in order, the data format expected for each field, and

notes on their use in screening:

Table 43: Entity Private Watch List Input Attributes

Field Name

ListSubKey

Expected Data Format

String

Notes

This field is used to identify the source
list of the watch list record (for example,
Private List, Accounting Private List,
Financial Private List, and so on). It is
included in the alert key.

ListRecordType

String

[Mandatory attribute] This field is used
when filtering alerts, to determine
whether the record is a sanctions or PEP
record. It must contain a value of SAN,
PEP, or a combination of these values. If
you want to include a combination of
values, the values must be comma-sepa-
rated and enclosed by double quotation
marks. For example: "SAN, PEP".

OFS Transaction Filtering Admin Guide | 146



Appendix A: Watch Lists
Private Watch List

Table 43: Entity Private Watch List Input Attributes

Field Name

ListRecordOrigin

Expected Data Format

String

Notes

This field is used to record the prove-
nance of a record when it is part of a
consolidated list.

ListRecordld

String

[Mandatory attribute] This attribute is
not used as part of the matching pro-
cess, but it must be populated with a
unique identifier.

RegistrationNumber

String

This is an optional field that may be used
to capture entity registration numbers
for use in the review process. Note that
entity registration numbers are not used
for matching in the default screening
rules.

EntityName

String

[Mandatory attribute] The entity match-
ing process is based primarily on the
name supplied for the entity. An entity
name or original script name must be
submitted to the screening process for
screening to proceed.

NameType

String

This is an optional field used in the
review process only. Multiple names may
exist for the same person. The Name
Type, therefore, denotes if the name is
the primary name of the listed party, or
an additional name (such as an Alias, or
Alternate Spelling). If two private list
records were derived from a single
source with multiple names (such as Mrs.
Louise Wilson née Hammond being split
into two records, Louise Wilson and Lou-
ise Hammond) you may wish to denote
one as the primary name and one as a
maiden or alias name.

NameQuality

String

This field may be assigned a value of
Low, Medium, or High to indicate the
quality of the individual name. High is
used for Primary names and specified
good or high-quality aliases.

PrimaryName

String

For alias records, this field indicates the
main name for that record.
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Table 43: Entity Private Watch List Input Attributes

Field Name

OriginalScriptName

Expected Data Format

String

Notes

[Mandatory attribute] The individual
matching process is based primarily on
the name supplied for the individual.
Either a full name, a pair of given and
family names, or an original script name
must be submitted to the screening pro-
cess for screening to proceed. If you
populate the Original Script Name, then
you will also need to enable two facets of
Match processor configuration that are
disabled by default. The Original Script
Name Cluster and some or all the Match
Rules that include Original script namein
their name. To adapt the Match Proces-
sor configuration, you will need to open
the Transaction screening project within
the Director user interface and make the
changes to every process used during
the Transaction Filtering installation.

AliaslsAcronym

String

If this field is set to Y, this flags an alias
as an acronym as opposed to a full entity
name. Leaving the field blank or setting
it to any other value does not affect
screening (that is, an alias is a full entity
name).

This flag is used during matching.

Vessellndicator

String

This field must be set to Y if the entity is
a vessel (a ship). It must be left empty or
set to N if the entity is not a vessel.

Vessellnfo

String

If the entity is a vessel, you can populate
this field with information about it: for
example, its call sign, type, tonnage,
owner, flag, and so on.

Address1

String

Address2

String

Address3

String

Address4

String

These are optional fields that may be
used in the review process.

City

String

State

String

Postal Code

String

[Recommended attribute] City data is
used to strengthen potential match
information.

AddressCountryCode

String; ISO 2-character
country code.

[Recommended attribute] Address
country data is used to strengthen
potential match information.

ResidencyCountryCode

String; ISO 2-character
country code.

[Recommended attribute] The entity's
registration country can be used in
optional country prohibition screening.
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Table 43: Entity Private Watch List Input Attributes

Field Name

OperatingCountryCodes

Expected Data Format

String; ISO 2-character
country code.

Notes

[Recommended attribute] Any of the
entity's operating countries can be used
in optional country prohibition screen-

ing.

ProfileHyperlink

String; a hyperlink to an
Internet or intranet resource
for the record.

This field may contain a hyperlink to an
Internet or intranet resource that can
provide reviewers with additional infor-
mation about the individual.

This field is included where the risk score

RiskScore Number, between 0 and 100 .
for a customer is calculated externally.
A number indicating the relative ‘riski-
ness’ of the individual, considered as a

RiskScorePEP Number, between 0 and 100 | PEP. The risk score is expressed as an
integer between 1and 100, with higher
numbers indicating a higher risk.

String, representing a date,
AddedDate in the format "YYYYMMDD'
LastUpdatedDate String, representing a date, These are optional fields for use in the

in the format 'YYYYMMDD'

DataConfidenceScore

Number, between 0 and 100

DataConfidenceComment

String

review process.

InactiveFlag

String

If populated, this optional field must
contain either Y or N.

InactiveSinceDate

String, representing a date,
in the format 'YYYYMMDD'

If populated, this optional field must
contain either the current date or a date
in the past.

PEPclassification

String

This field can be used to indicate the
type of PEP (for example, whether the
individual is part of an international
organization or government, and at what
level). It can be used to filter watch list
records and is primarily used by the
World-Check watch list, but could be
used by a private watch list if required.

customString1 to
customString40

String

customDatel to
customDate5

String, representing a date,
in the format 'YYYYMMDD'

customNumber1to
customNumber5

Number

Fifty custom fields are provided in the
private list data interface for individuals.
Forty of these are intended to hold string
data, five hold dates, and five numeric
data.

The interface file is a comma-separated
value (. csv) file, and so all fields intrin-
sically contain strings. However, during
the processing of Private watch lists, the
custom date and number fields are
checked to ensure that they include
appropriate data, and warning messages
are provided as output if they do not.
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Activities for System Audit

13

B.2

Step Identifier

Appendix B: System Audit Logging Information

This appendix contains information on the logs related to the Debug and Info log files.

Activities for System Audit

The following table contains information related to the system audit activities:

Table 44: Activities for System Audit

Activity Identifier Activity Name Activity Sequence
1 Raw Message Processing 1
2 Message Parser Processing 2
3 watch list Processing 3
4 Alert Manager Processing 4
5 Hold 5
6 Assigned 6
7 Escalated 7
8 Recommend to Block 8
9 Block 9
10 Recommend to Release 10
n Release n
12 Reject 12

Steps for System Audit Activities

The following table contains information related to the steps for the system audit activities:

Table 45: Steps for System Audit Activities

Activity Name

Step Name

Step Sequence

Status

. Record the receipt of the raw
1 Raw Message Processing message 1 Y
2 Raw Message Processing S(?chmizstZ%?eperSISted into 2 N
3 Message Parser Processing Raw Message parsed 1 N
4 Message Parser Processing iljwatgsgﬂfgtvlrrgfasslae ge persisted 2 N
5 watch list Processing Matching data prepared 1 N
6 watch list Processing Matching Engine Invoked 2 Y
7 watch list Processing Scoring Engine Invoked 3 Y
8 watch list Processing Scoring performed 4 Y
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Table 45: Steps for System Audit Activities

Step Identifier Activity Name Step Name Step Sequence Status

9 watch list Processing Response Received 5 Y

10 watch list Processing Response persisted 6 N

M Alert Manager Processing Transaction Hold 1 N

12 Alert Manager Processing Alert Persisted 2 N

3 Hold Hold Transaction Workflow 1 v
Invoked

14 Hold Hold Transaction Workflow com- 2 v
pleted

. Assigned Transaction Workflow
15 Assigned Invoked 1 Y
. Assigned Transaction Workflow

16 Assigned completed 2 Y
Escalated Transaction Workflow

17 Escalate Invoked 1 Y
Escalated Transaction Workflow

18 Escalate completed 2 Y

19 Recommend to Block NA NA NA
Blocked Transaction Workflow

20 Block Invoked 1 Y

21 Block Blocked Transaction Workflow 2 v
completed

22 Recommend to Release

23 Release Released Transaction Workflow 1 v
Invoked

24 Release Released Transaction Workflow 2 v
completed

25 Reject NA NA NA
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C.1.1

Appendix C: Process Modeller Framework (PMF)
Configurability

This appendix contains information on the steps required to configure the ready-to-use Process
Modeller Framework (PMF) workflow. On the Process Modeller page, click the transaction that you
want to configure and follow the steps in the following sequence. For information on how to access the
Process Modeller page, see the Process Modeller Menu.

Configuring the Human Task in the PMF Page
To configure all human tasks on the PMF page, follow these steps:

1. Navigate to the Process Flow subtab in the Process Modeller tab. The PMF page is displayed.

2. Dragand drop Human Task M on to the PMF page. For information on all components avail-
able, see the Components for Designing Your Process Flow chapter in the Oracle Financial Ser-
vices Analytical Applications Infrastructure Process Modelling Framework (PMF) Orchestration
Guide.

3. Double-click Human Task
4. Inthe Activity dialog, provide the following information:

m  Aunique activity name in the Activity Name field. After you provide a name, it appears after
the icon on the PMF page.

m  The activity description in the Activity Description field.
m  The current status of the transaction in the Status field.

m  The next status of the transaction in the Outcomes field.

5. Click Transitions ™ and then click Add.
m  Inthe Add New Transition dialog, provide the following information:
m A unique transition name in the Transition Name field.
m  The destination status of the transaction in the Connected To field.

m  The execution or decision rule for a status in the Decision Rule field. Here you need to map
the specific rule to the current status or create the rule according to the business require-
ment.

m  The order of the transaction in the Order field.

You can also configure the fields in the Action and Notifications subtabs. For more information,
see the Action Tab for Creating Tasks/Notification section in Oracle Financial Services Analyt-
ical Applications Infrastructure Process Modelling Framework (PMF) Orchestration Guide.

Mapping the Transaction Statuses and Transaction Outcomes

After you provide the new transaction status and outcome in step 4, you need to map the values in the
required tables to update the value on the PMF page.

To update the status on the PMF page, populate the following status in the Config schema:

1. Runselect * from AAI WF STATUS B t wheretv_app_package_id ="'OFS_SAC' and
select * from AAI WF STATUS TL where t.v_app_package_id ='OFS_SAC' queries.
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Appendix C: Process Modeller Framework (PMF) Configurability
Adding Data Fields for the PMF Status

C.3.1

2. IntheAAI WF STATUS_ B table, populate a unique entry inthe v_status_id column for each
new status and map the same entry inthe AAT WF STATUS TL table for a column. For example,
populate the entry OFS_sSAC inthev app package id column.

3. When you map the new status, it appears on the PMF page.
m  Ensure that data is provided in all required columns in the AAT WF STATUS TL table.

m  When doing the mapping in any other configuration tables, ensure that you provide the
same status that is mentioned inthe v_status name columninthe AAT WF STATUS TL
table.

To update the outcome on the PMF page, populate the following status in the Config schema:

1. Runtheselect * from AAI WF OUTCOME B t and wheretv_app_package_id ='OFS_SAC'
queries.

2. Inthe AATI WF OUTCOME B table, populate a unique outcome ID inthe v_outcome id column
for each new status and map the same entry in the AAT WF OUTCOME TL table.

s Ensure that data is provided in all required columns in the AAT WF OUTCOME TL table.

m  When doing the mapping in any other configuration tables, ensure that you provide the
same status that is mentioned in the AAT WF OUTCOME TL table.

m  After you complete the above steps, refresh the application and web servers.

Adding Data Fields for the PMF Status

To add a new data field for each new status, for example, TF. BLOCKED NEW, click the Data Fields
subtab in the Process Modeller page and click Add. For information on the fields, see the Data Fields
section in the Oracle Financial Services Analytical Applications Infrastructure Process Modelling
Framework (PMF) Orchestration Guide.

€ data field name contains more than one word, gIVe an under-
score (_) between each word. The name will not be valid if you pro-
vide a space between each word.

You can also edit an existing data field, follow these steps:
1. Select the radio button of the data field that you want to edit.
2. (Click Edit.

Adding Application Rules for the PMF Status

To add a new application rule for each new status, for example, RE_ TO Block Neuw, click the
Application Rule subtab in the Process Modeller page and click Add. For information on the fields,
see the Application Rules section in the Oracle Financial Services Analytical Applications
Infrastructure Process Modelling Framework (PMF) Orchestration Guide.

Mapping Rule Types to Application Rules
If you select a new rule type for the application rule, you must then map it to the rule.
To map arule, runthe select * from aal aom app_ comp attr mapping query.

If a static rule is present with n_static_grp_id = 501, then run the select * from AAI AOM STATIC
query.
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C.3.2 Mapping User Groups to Application Rules

If you have also mapped a new user group to the rule, then you need to map the entry in the
DOMAIN JUR GRP MAP table. After you map the user group to the rule, run the select * from
DOMAIN JUR GRP MAP query to update the DOMAIN JUR GRP MAP table.

The steps required to create a new user group are available in Creating New User Groups. For more
information, see the User Administrator section in the Oracle Financial Services Analytical
Applications Infrastructure User Guide.

C4qg Configurations Required for the Audit Tables

Before you update the tables, you must first provide a unique valueinthen_activity idcolumnin
the SETUP_RT AUD ACTIVITY table andthen providethe samevalueinthen activity idcolumn
inthe SETUP RT AUD STEPS table.

After thisis done, run the select * from SETUP RT AUD ACTIVITY query to update the
SETUP RT AUD ACTIVITY tableandrunthe select * from SETUP RT AUD STEPS query to
update the SETUP_RT AUD STEPS table.

After the tables are updated, provide two entries, 1and 2, inthen_step sequence column in the
SETUP_RT AUD STEPS table.

NOTE I'ne value provided inthe v_status_ name columnin the AAT W-
F_STATUS TL table must be a combination of one of the following
values:

e Thevalue providedinv_sanction status name in
dim sanctions_ status table and the name of the
transaction workflow invoked for entry 1.

e Thevalue providedinv_sanction status name in
dim sanctions_ status table and the name of the
transaction workflow completed for entry 2.

C.5 Configurations Required for the setup_rt_params Table
To configure the table in the ATOMIC schema, follow these steps:

1. Provide the function codeinthe v_attribute valuel columnwherev attribute namel
= 'TF_ FUNCTION CODES'.

2. Provide the status codes accordingtothe v_attribute namel valueinthev at-
tribute valuel columnwherev attribute namel = 'TF FUNCTION AND STA-
TUS_CODES'.

3. Provide all status codesinthev_attribute valuel column against each function code in the
v_attribute namel column. This displays the dynamic status filter.

4. Provide the code for each status to be displayed to the user for that function code inthe v_at-
tribute valuel column.

5. Provide the code for each status to be displayed to the user in the Transaction Summary
window inthev_attribute value2 column.

6. Provide the code for each action that must be displayed to the user for that transaction in the
v_attribute value3 column.

7. To create an order for the transactions, follow these steps:
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m  Provide TF USERWORKFLOWCLAUSE inthe v_param name column.
s  Provide TF_ ORDERBY PRECEDENCE inthev attribute namel column.
m  Provide TF_ ORDERBY FUNCCODE inthev attribute name2 column.

m  Provide the function code for which you want to do the orderinthe v_attribute value2
column. For example, use TFLTANYSE for the analyst user.

s  Provide TF ORDERBY CLAUSESinthev attribute name3 column.

= Provide the order by queryinthev attribute value3 column.Forasample value, see
the value for the TFLTANYSE function code.

Update the fields in the feedback response JSON for blocked and released payments in the
v_attribute valuel column in the FEEDBACK RESPNSE CONFIGURATION row and restart
the WebLogic server.

Updatethe v_attribute valuel columnasY wherev param name = 'ECM SANC-
TIONS PP’,if ECM pack is installed in the same server where Sanctions also installed.

C.6 TIME_ZONE Configurations Required for the dim_ -
sanctions_ status Table

To configure the table in the ATOMIC schema, follow these steps:

1.

Create a unique value for the new PMF statusinthen_sanction status_ code column. This
value must be the sameinthe AAT WF STATUS Band AAI WF STATUS TL columns. For more
information, see Configurations Required for the Audit Tables.<XREF>

Provide the activity name as mentioned in step 4 of the Configuring the Human Task in the PMF
Page <XREF>section in the v_remarks column.

Provide a unique data field value inthe v_applicable params columnwheren sanc-
tion staus key = 101 (ApplicationParams)and n_sanction staus key = 202 (PMF-
Params).

To update the image path for the alert status, update the v_sanction status img path
value.

To update the image path for the list of actions, updatethe v_sanction dropdown img path
value.

To configure the action status:
m  Provide the value StatusActon if a status action must be fired.

m  Provide the value PendingTrxnsCount if the count of pending transactions is required for
a particular action.

m  Provide the value PendingTrxnsSuspiciousCountAndStatusActon if the count of
pending transactions and count of pending suspicious transactions are both required.

Inthe v_data field column, give the same data field created in the PMF page data field sec-
tion.

Update the v_owner update columninthe £si rt alerts tableif the owner must be
updated.

Provide the audit message inthe v_audit msg column. This value must be the same as the
value provided inthe v_sanction status_name column. For more information, see Configu-
rations Required for the Audit Tables.
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NOIE For a new status, the v_applicable params column mustbe
left blank.

C.7 Creating New User Groups

To add a new user group, follow these steps:

N oA N2

Create a function.

Create a role.

Map the function to the role.

Create a user.

Map the user to a user group and a role.
Map the user to a user group and a domain.

Map the user to a user group.

C.8 Other Configurations

The user group is now created. After it is created, follow these steps:

1.

2
3
4.
5

Map the group in the domain jur grp map table.

Login to the Config schema.

Runthe select * from cssms_folder function map query.

Add the new function to the Transaction Filter folder (TransactionFiltering TFLTADMIN).

Runthe select t.v access code,t.v menu id from aai menu b t where
t.v_menu id in('OFS_TFLTSCRN', 'OFS_TFLT') query.

Add the new function inthe v_access_code column.
To map the new function, add an entryinthe v_access_code columninthe aai menu_ b table

by running a query with the entry mentioned in the following format: select * from
aal menu b t where t.v _menu id like 'SOFS TFLTS'; query.

To map the function to a folder, run a query with the function mentioned in the following format:
select * from cssms_folder function map p where p.v _function code like
"$STFS'; query.
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15 i&pPendix D: PMF Configurations for Pool of Ana-
yS

To configure the PMF Pool of Analyst configuration to set the new statuses, follow these steps:
1. Perform the following queries and introduce new status in the following tables.
m  Select* from AAI WF STATUS B t where t.v app package id = 'OFS SAC';
m  Select* from AAI WF STATUS TL t where t.v app package id = 'OFS SAC';

m  Createunique v_status_idin AAI WF STATUS_B table and map the same inthe AAT w-
F_STATUS_TL table and fill all the other columns data. This data will show in the PMF screen
while mapping new status.

Figure 112: Example 1

select t.* from aai wf status_b t where t.v_app package id = 'OF5_SAC' and t.v_status_id = 250;

Select aai_wf_status_b Select aai_wf_status_tl

- & e # B <€ H| -8B~
Row 1 Fields Comments ‘

» |V STATUS ID 250
V_APP_PACKAGE ID |OFS SAC ™

select t.* from aai wf status tl t where t.v app package id = 'OFS SAC' and t.v status id = 250;

O~ & c n [ <€ H| £~ E~
| |v.STATUSID |V STATUS NAME |V STATUS DESC |V LOCALE CODE |V APP PACKAGE ID |
p 1(250 ** Pending Block Recommended “ Pending Block Recommended */en_US “ OFS_SAC

2. Perform the following query and introduce new Outcome in both the following tables.
m Select* from AAI WF OUTCOME B ;
m  Select* from AAI WF OUTCOME TL;

s Create unique outcome IDin AAT WF _OUTCOME B table and map the same in AAI_WF_OUT-
COME_TL table and provide other columns data.

Figure 113: Example 2

saL Qutput Statistics

O~ | & c # = <€ H a1~ B~
V_OUTCOME_ID
p 1/250

select t.* from AAI WF OUTCOME TL t where t.v outcome id = 250;

O~ | & c # [ € H -8~
V_OUTCOME_ID __|V_OUTCOME_NAME |V_OUTCOME_DESC |V_LOCALE_CODE
p 1250 " Pending Block Recommended " Pending Block Recommended * en_US
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3. Perform the following query and add a new entry for the new status to come up in the TF_AC-
TION drop-down list while adding new Application rule.

-8Select * from AAI AOM STATIC t where t.n static grp i1d=501;

Figure 114: Example 3

select t.* from AAI_AOM STATIC t where t.n_static grp id=501 and t.v_static_val = 'TF_PNDNG_RECBLOCK';
O~ & ¢ n [ € H| £~ E-~

| |vsTATiCUD N_STATIC.GRP_ID |V STATIC VAL |

M| 1]~~TF PNDNG RECBLOCK 501 TF_ PNDNG RECBLOCK "™

4. Create Human task in PMF screen that you want to introduce in-between existing status or you
want to introduce new status or create separate status.

Activity

Activity Name*

Activity Description

Status* - New Status Name.

Outcomes - Where has to go (Destination Status).

Example: If we have to introduce a new status between Investigation and Recommend to Block
as Pending Recommend to Block, first add the new activity as shown in the following Figures
(Pending Block Recommended).

Figure 115: Activity Statuses
9

Activity ID > Job_1633667659310

Activity Name Pending Block Recommended

Activity Desc Pending Block Recommended

Activity Type -
Pending Block Recomm-
ended

Status Pending Block Recommended v

Outcomes
Recommend To Block X

Transitions

Add ->

Transition Name - Unique Name for the particular Transition.
Connected To — Destination status.

Decision Rule - Map to decision rule for particular status.
Order -1

Stroke — Default.

Example: First Transition between Investigation and Pending Block Recommended the next
one between Pending Block Recommended and Recommend to Block.
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Figure 116: Edit Transaction - Pending Block Recommended

Figure 117: Edit Transaction - Recommend To Block

Edit Transition

Order

Stroke ~

?

Edit Transition X
Transition Name 2 | Move to Pending Recommend to Block
Connected To ? Pending Block Recommended
Decision Rule > | PNDNG_R_to_Block_Outcome [
Order 7 | 1 |
Stroke 20 | pefault v
Ok
b 4
Transition Name 7 Move to Recommend to Block
Connected To ?  Recommend To Block
Decision Rule 7 | PNDNG_io_R_to_Block_OQOutcome l

| 1

Default

Ok

In Transition Decision Rule Map the specified rule for the current status. Or create as per business

requirement.

Example: For the decision rules, add the following 2 decision rules.
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Figure 118: Rule Details - Decision Rule 1

Rule Details
Name 7 | PNDNG_R_to_Block_Oulcome
Rulelype 7  pecisionRule
ExecutionTyp® 7 anribute Expression
Attribute 7 ¢ AUTORELEASE_FLAG v @ Add
ElAttribute Values.
Name Value
® TF_CURRENCY usD x l
® TF_ENABLE FOUR_EYES_FLAG TF_FOU... X .
® 2ZP_POOL_ANALYST_FL v " !
»® TF_ACTION TF_PND... X !
® TF_FUNCCODE TFLTAN... X l
® TF_ASSIGNEE_USER TF_LOG... X !
® TF_AUTORELEASE_FLAG N *® !

Figure 119: Rule Details - Decision Rule 2

Name 7 [F‘NDNG to_R_to_Block_Outcome

RuleType ?  pecisionRule

ExecutionType ?  Atrinute Expression

Attribute 7 7p | OGGED_USER_ACTED v & Add
ElAttribute Values
Name Value
x TF_CURRENCY usD X !
x TF_ENABLE_FOUR_EYES_FLAG TF_FOU... X !
x ZP_POOL_ANALYST_FL Y X !
x TF_ACTION TF_REC... X !
x TF_FUNCCODE TFLTAN... X !
x TF_ASSIGNEE_USER TF_LOG... % !
xR TF_AUTORELEASE_FLAG N x !
R ZP_LOGGED_USER_ACTED N x !
ok

Edit the existing decision rule, by adding the zP POOL_ANALYST FL.

NOTE The attribute ZP_LOGGED USER _ACTED value 1S Y then the user
has acted first on the POA status.
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Figure 120: Edit API Details

Edit API Details

Name > | R_to_Block_Outcome

RuleType ?  pecisionRule

ExecutionType ?  Agribute Expression

Attribute 7 v & Add
B Attribute Values
Name Value

b4 TF_ENABLE_FOUR_EYES_FLAG l TF_FOU... X !
b4 TF_AUTORELEASE_FLAG l N X !
b4 ZP_POOL_ANALYST_FL ‘ N X !
b3 TF_CURRENCY ‘ usbD X !
b4 TF_ACTION ‘ TF_REC... X !
R TF_FUNCCODE [ TFLTAN X !
R TF_ASSIGNEE_USER [ TF_LOG... X !

Save

Figure 121: Edit API Details — Adding Attribute Values

Edit API Details.

ElAttribute Selection

Name 7 |RB_TO_Block New

RuleType 2 pecisionRule

ExecutionType 7 agribute Expression

Attribute 2

Bl Attribute Values

Value

TF_ACTION
| TF BLOCKED NEW X

TF_FUNCCODE

| TFLTSUPRVE X

5. Access for the new status (example: Pending Review (96)) should be given to TFLTANYSE in
order to take/update action on events.

6. Follow these steps:

i. select* from setup rt params where V_PARAM NAME = 'TF FUNC-
TION AND STATUS CODES' and V_ATTRIBUTE NAMEl = 'TFLTANYSE';

ii. AppendV_ATTRIBUTE VALUE3 with the newly added Pending review Status.
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Mapping the dim_sanctions_status Table:

iii. Example: 2,96

NOIE

e JogettheV ATTRIBUTE VALUESJ,refer the dim_sanc-
tions status table.
e Thisisthe Customized example for Pending Review (96) to
be added manually.

Mapping the dim_sanctions_ status Table:

Create a new entry for newly created status and provide the unique n_sanction status code. The
new n sanction status_ code must be the same as AAT WF STATUS Band AAI WF STATUS TL
that you have created while configuring PMF screen.

Figure 122: dim_Sanctions_status Table

NN

> - ) it

File Project Edit Session Tools Configure View Help Plug-ins

Obiects oix| g

CEHEH®HAA
<CURRENT USER> v

Objects | Files m oL

[se

select t* from dim_sancti.. X

Output _ Statistics
lect t.* from dim sanct.

tus t where t.n sa

All objects Y=
. ) g~ & c # B <€ H
Recent objects Al || Rowt |Fields
Recycle bin »|N_SANCTION_STATUS_KEY 250
Functions N_SANCTION_STATUS_CODE 250
Procedures V_SANCTION_STATUS_NAME Pending Block Recommended
Packages V_SANCTION_STATUS_DESC Pending Block Recommended
Package bodies D_START_DATE 10/19/2016 =
Types D_END_DATE 12/31/1999 =
K‘;Z:Zd'es F_LATEST_IDENTIFIER \
Java sources V_REMARKS Pending Block Recommended
Java classes D_LAST_UPDATED_DATE 10/19/2016 =
DBMS_Jobs. v V_SANCTION_STATUS_IMG_PATH css/images/alerts_pb.png .
el 02 x| _V-SANCTION DROPDOWN_IMG_PATH |css/images/block recommend.png **
V_APPLICABLE_PARAMS <CLOB>
Window List | Templates V_STATUS_ACTION PendingTrxnsCountAndStatusActon "
B/ | sQL Window - select t.* from dim_s __|V_DATA FIELD TF_PNDNG_RECBLOCK
V_OWNER_UPDATE false
V_AUDIT_MSG Pending Block Recommended
V_STATUS_TYPE alert
V_SANC_ACTION_NAME Pending Block Recommended

Find

‘ V‘A

T & 1of1

AE @ O m v E

~ dox_atomic@(DESCRIPTION=(ADDR - 1 row selected in 0.116 seconds - - S

s

5 dox_atomic@(DESCRIPTION=(ADDRESS_LIST=(ADDRESS=(PROTOCOL=TCP)HOST=whf00bbm.in.oracle.com)(PORT=1521))(CO.. [E — & X
0 0n
v [ PL/SQL Clipboard 2%
S~ B~
Comments
< >
Enter filter text (]
~

select t.*, t.rowid

AAI_AOM_STATIC

select t.v_applicable params from dim_sa)

where t.n_sanction_status_key in (101,20:

and t.v_app_api_id in (1633667339406,151;

select t.* from AAI_AOM_STATIC t

where t

select t.*,t.rowid from AAI_AOM STATIC t

Adding Data Fields to the JSON Object

To add a new data field to the JSON object in the following clob columns, follow these steps:

Select t.v_applicable params from dim sanctions status t where
t.n sanction status_ keyin (101,202);
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Figure 123: Applicable Params
e params from dim sanctions status t

1ere t.n sanction status key in (101,202);

& Large Data Editor - dim_sanctions_status.v_applicable_parar

E[ hd ﬁ Q @ @ <>
VAPPLICABLE PARAMS | |Text  RTF HTML Hex  Extemndl
P 1|<CLOB> r
2|<CLOB> 2| ["TF _ACTION" : "Y",
3 |"TF _ESCALATED" : "Y",
4 |["TF_BLOCKED" : "Y",
5 |"TF_RELEASED" : "Y",
6 |"TF_RECBLOCK" : "Y",
7| |"TF_RECRELEASE" : "Y",
8 |"TF_REJECT" : "Y",
9 |"TF_FOUR_EYES" : "Y",
10 |"TF REQ RECRELEASE" : "Y",
11 |"TF_FALSE POSITIVE" : "Y",
12| |"TF CONFIRMED MATCH" : "Y",

13 "TF PNDNG RECBLOCK"

Also provide all the following fields:

m v sanction status img path - Image path for status of the alert image.

m v _sanction dropdown img path - Image path for action clicked list of action image.
m v _applicable params -keep it blank for new status column.

m v status_action - If only particular action has to be fired, then provide statusActon, if
PendingTrxnsCount is required for the particular action, then provide PendingTrxn-
sCount, and if PendingTrxnsCount and PendingSuspiciousCount both is required,
then provide PendingTrxnsSuspiciousCountAndStatusActon.

m v data field - Provide the same data field as added in AAT AOM STATIC table.
m v owner update - fsi rt alerts table v_owner column hasto be updated or not.

m v _remarks column name should be the same as that you have given name in pmf screen
Activity Name.

= Always provide v_owner update true only when status is as like end mode (Ex: Blocked,
Released) else provide as false.

m v _audit msg - Provide the Audit Message (Audit message should be same asv_sanc-
tion staus name value).

OFS Transaction Filtering Admin Guide | 163



Appendix D: PMF Configurations for Pool of Analyst
List of Attributes Passed to Workflow

D.3 List of Attributes Passed to Workflow

The following table provides the list of Attributes passed to workflow:

Table 46: SWIFT Message Types

Attributes Description

TEF ACTION

Action to be performed.

WE DSNID

Infodom value.

WF_MESSAGE_TYPE

Message Type.

WEF MESSAGE REFERENCE

Message Reference.

WE USER COMMENT

System hardcoded comment.

WE APPLICATION URL

Application url hardcoded logic.

TF_LOGIN USER

Logged in user.

TF FUNCCODE

Logged in user function code.

TF_ASSIGNEE USER

Logged in user.

TF_ENABLE FOUR _EYES -
FLAG

Y/N value based on the configuration.

TF CURRENCY

Currency of the message.

WF_OUTCOME_ID

Outcome Id for the action.

TF AUTORELEASE FLAG

Y/N based on the configuration for the message.

TF AMOUNT

Amount of the message.

TF WATCHLIST TYPE

Watchlist type of the event with maximum score of the message.

TF_WATCHLIST SUB TYPE

Watchlist sub type of the event with maximum score of the mes-
sage.

TF_MESSAGE_TYPE

Message Type of the message.

TF MSG_CATEGORY

Message Category of the message.

TF MSG_ PRIORITY

Message Priority of the message.

TF JURISDICTION

Jurisdiction of the message.

TF BUSINESS DOMAIN

Business Domain of the message.

TF_ALERT TYPE

Alert Type of the message (1 or 2).

ZP_POOL_ANALYST FL

Y/N based on the configurationin setup_rt params.

ZP_LOGGED USER_ACTED

if the logged in user is the same person who performed the previ-
ous actionthen ZP_ LOGGED USER_ACTED = Y elseitsN.

TF_GRP_MSG_ID

Group Message Id of the message.
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D.4 Attribute to Configure the Auto Refresh in Queue Man-
agement
The following table provides the list of Attribute to configure the Auto Refresh in Queue Management:

Table 47: Q_AUTO_REFRESH_TIME Attribute

Attributes Description

Provide the time in mille second for the
attributein CS APPLN PARAMS table.

Q_AUTO_REFRESH TIME By default it's 25000 i.e 25 seconds but the
value is editable.
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16 Appendix E: Delta Watch List Configurations

€S€ configurations are performed when you do not want to
download the full watch list, and only want to download the delta
watch list. This helps to reduce the download time and is not part
of the screening process.

Oracle recommends that you always use the full watch list during the screening process. Due to the
clustering strategy which is implemented in the screening process, you do not need to download the
delta watch list. There are certain cases in which you are required to download the delta watch list files,
for example, if the full watch list files are not yet available for download or if you want to save time.

Customers who download the delta watch list files must first download the full watch list files and then
download the delta watch list files. The delta watch list is then merged into the full watch list before
screening.

The following image shows the information flow for the delta watch list:

Figure 124: Flow for Delta Watch List

Day 1

FSI_WATCHLIST_INDIVIDUAL
Download

A —

FSI_WATCHLIST_ENTITIES

Day 2

R FSI_WATCHLIST_DELTA_INDIVIDUAL
DJW Delta '

FSI_WATCHLIST_DELTA_ENTITIES

When you download the full watch list, data is stored in the FSI WATCHLIST INDIVIDUAL and

FSI _WATCHLIST ENTITIES tables. When you download the delta watch list, data is first stored in the
FSI WATCHLIST DELTA INDIVIDUAL and FSI WATCHLIST DELTA ENTITIES tables. Then, based
on the value in the ACTION Flag tag in the delta watch list, it merges with the full watch list. The
ACTION flag key is a non-editable value, and can be one of the following values:

o new: If the value is new, it means that these records are new and are added to the full watch list
when the delta files are merged with the full watch list.

e chg: If the value is chg, it means that these records are modified and are added to the full watch
list when the delta files are merged with the full watch list.

e del: If the value is de1, it means that these records are no longer active and are removed from
the full watch list when the delta files are merged with the full watch list.
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NOTE You must always run the full watch Iist flles before you run the
delta watch list files. The full watch list files must be downloaded if,
for example, the download of the delta watch list files has failed for
multiple days. You can also run the full watch list once every week
to ensure that the complete data has been processed.

The following watchlist management jobs are used for the full list and the delta list:

m  Analyze Reference Data Quality

m  Download, Prepare, Filter, and Export All Lists

m  Generate StopPhrases

m  The following watchlist management job is used for the full list:

— Load List data from Stg to Processed table

m  The following Transaction Filtering job is used for the full list and the delta list:

— Main

Before you run the delta watchlist files, ensure that you run the full watchlist files. You can run the delta
watch list files if, for example, the delta downloads have failed for multiple days or the filter criteria are
changed. You can also run the delta watch list once every week to ensure that the complete data has

been processed.

E.1 Configurations for the Full and Delta Watch Lists

The following configurations must be done for both full and delta watch list updates in the
watchlist-management.properties run profile. The run profile is available in the
<domain name>/edq/oedqg.local.home/runprofiles/ directory when youlog in to the WinSCP

server.
e Setphase.
e Setphase.

e Setphase.
updates.

e Setphase.
database.

Initialise\ staged\ data.enabled = N to disablethe . jmp file updates
Initialise\ staged\ data\ DB.enabled = Y toinitialize the database.

Initilize\ Prepared\ List\ Data.enabled = Nto disablethe . jmp file

Initilize\ Prepared\ List\ Data\ DB.enabled = Y to prepare the

E.1.1 Running the Full Watch list

To run the full watch list, follow these steps:

1. Set the following properties in the watchlist-management.properties file:

m  phase.
m  phase.
m  phase.
m  phase.
m  phase.
m  phase.

m  phase.

DJW\ -\ Download.enabled = Y

DJW\ -\ Download\ Delta.enabled = N.

DJW\ -\ Stage\ reference\ lists.enabled = Y.
*.export.*.ind table name =FSI WATCHLIST INDIVIDUAL.
*.export.*.entities table name =FSI WATCHLIST ENTITIES.
Importl Full DB.enabled =Y

Import2 Full DB.enabled =Y
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m phase.Import3 Full DB.enabled =Y

2. Set the following properties in the transaction-screening.properties file

m  phase.DJW\
m  phase.DJW\
m  phase.DJW\
m  phase.DJW\

m  phase.DJW\

-\ Load\ without\ filtering.enabled = N

-\ Load\ without\ filtering\ DB.enabled = Y

-\ Load\ with\ filtering\ (Part\ 1).enabled = N

-\ Load\ with\ filtering\ (Part\ 1)\ DB.enabled =Y

-\ Load\ with\ filtering\ (Part\ 2).enabled = Y

3. Set the following properties in the transaction-screening-batch.properties file:

m  phase.DJW\
m  phase.DJW\
m  phase.DJW\
m  phase.DJW\

m  phase.DJW\

-\ Load\ without\ filtering.enabled = N

-\ Load\ without\ filtering\ DB.enabled = Y

-\ Load\ with\ filtering\ (Part\ 1).enabled = N

-\ Load\ with\ filtering\ (Part\ 1)\ DB.enabled =Y

-\ Load\ with\ filtering\ (Part\ 2).enabled = Y

E.1.2  Running the Delta Watch List

To run the delta watch list, set the following properties inthe watchlist-management.properties

file:
m  phase.DJW\
m  phase.DJW\
m  phase.DJW\
m  Setphase.*.

m  Setphase.*.
TIES.

-\ Download.enabled = N.

-\ Download\ Delta.enabled = Y.

-\ Stage\ reference\ lists.enabled = Y.
export.*.ind_table_name =FSI WATCHLIST DELTA INDIVIDUAL.

export.*.entities table name =FSI WATCHLIST DELTA ENTI-

m  phase.Importl Full DB.enabled = N

m  phase.Import2 Full DB.enabled = N

m  phase.Import3 Full DB.enabled = N

m  phase.Importl Delta DB.enabled = Y

m  phase.Import2 Delta DB.enabled = Y

m  phase.Import3 Delta DB.enabled = Y

E.1.3  Merging the Delta Watch List to the Full Watch List

To merge the delta watch list with the full watch list, set the following properties in the watchlist-
management .properties file:

e phase.Delta\ Merge.enabled = Y.

e phase.Linked\

Profiles.enabled = Y.
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E.2 Delta Watch List Configurations for the World-Check
Watch List
NOITE I'hnese contigurations are perrormed when you do not want to

E.2.1

download the full watch list, and only want to download the delta
watch list. This helps to reduce the download time and is not part
of the screening process.

Customer Screening recommends that you always use the full watch list during the screening process.
Due to the clustering strategy, which is implemented in the screening process, you must not download
the delta watch list. There are certain cases in which you must download the delta watch list files, for
example, if the full watch list files are not yet available for download or if you want to save time.

Customers who download the delta watch list files must first download the full watch list files and then
download the delta watch list files. The delta watch list is then merged into the full watch list before
screening.

The following image shows the information flow for the delta watch list:
Figure 125: Flow for Delta Watch List
Day 1

Download FSI_WC_WATCHLIST_INDIVIDUALS

O —

FSI_WC_WATCHLIST_ENTITIES

Day 2

Download I FSI_WC_WATCHLIST_DELTA_IND
WC Delta

FSI_WC_WATCHLIST_DELTA_ENT

When you download the full watch list, data is stored in the FST WC WATCHLIST INDIVIDUALS and
FSI _WC WATCHLIST ENTITIES tables. When you download the delta watch list, data is first stored in
the FSI WC WATCHLIST DELTA INDand FSI WC WATCHLIST DELTA ENT tables. Then the datais
merged into the main table. For more information, see Merging the Delta Watch List to the Full Watch
List.

'OU MuSst always run the full watch Nst files before you run the
delta watch list files. The full watch list files must be downloaded if,
for example, the download of the delta watch list files has failed for
multiple days. You can also run the full watch list once every week
to ensure that the complete data has been processed.

Configurations for the Full and Delta Watch Lists

The following configurations must be done for both full and delta watch list updates in the
watchlist-management.properties run profile. The run profile is available in the

<domain name>/edq/oedq.local.home/runprofiles/ directory when youlog in to the WinSCP
server.
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E.2.2

Set phase.
Set phase.

Set phase.
updates.

Set phase.
database.

Set phase.

Setphase.
= Y.

Set phase.

Set phase.
Y.

Initialise\ staged\ data.enabled = N to disablethe .jmp file updates

Initialise\ staged\ data\ DB.enabled = Y toinitialize the database.

Initilize\ Prepared\ List\ Data.enabled = N to disable the . jmp file

Initilize\ Prepared\ List\ Data\ DB.enabled = Y to preparethe

Al11\ List\ Entity\ and\ Individual\ reference\ data.enabled = N.

Al1\ List\ Entity\ and\ Individual\ reference\ data\ DB.enabled

DQ-Watchlist\ BIC\ Extraction\ JSON\ Preparation.enabled = N.

DQ-Watchlist\ BIC\ Extraction\ JSON\ Preparation\ DB.enabled =

Running the Full Watch List

To run the full watch list, follow these steps:

1.

Set the following properties in the watchlist-management - TF.properties file:

m  phase.WC\ -\ Download.enabled = Y.
m  phase.WC\ -\ Download\ Delta.enabled = N.
m  phase.WC\ -\ Stage\ reference\ lists.enabled = Y.

m  phase.
m  phase.
m  phase.
m  phase.

m  phase.

To run the full watch list without filtering,

*.export.*.wc_ind table name=FSI WC WATCHLIST INDIVIDUAL
*.export.*.wc_entities table name=FSI WC WATCHLIST ENTITIES

Importl Full DB.enabled =Y

Import2 Full DB.enabled Y
Import3 Full DB.enabled = Y

set the following proper-

ties:

m  phase.WC\ -\ Prepare\ without\ filtering.enabled = N

m  phase.WC\ -\ Prepare\ without\ filtering\ Full\ DB.enabled = Y

To run the full watch list with filtering, set the following properties:

(Part\ 1) .enabled = N

m  phase.WC\ -\

To

phase.WC\ -\
phase.WC\ -\

run the full

ties:

To

phase.WC\ -\
phase.WC\ -\
run the full

phase.WC\ -\

Prepare\ with\ filtering\

Prepare\ with\ filtering\

(Part\ 2).enabled = N

Prepare\ with\ filtering\ Full\ DB.enabled =Y

watch

Load\
Load\
watch

Load\

list without filtering, set the following proper-

without\ filtering.enabled = N
without\ filtering\ DB.enabled = Y
list with filtering, set the following properties:

with\ filtering\ (Part\ 1) .enabled = N
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m  phase.WC\ -\ Load\ with\ filtering\ (Part\ 1)\ DB.enabled =Y
m  phase.WC\ -\ Load\ with\ filtering\ (Part\ 2).enabled =Y
2. Set the following properties in the transaction-screening.properties file
m  phase.WC\ -\ Load\ without\ filtering.enabled = N
m  phase.WC\ -\ Load\ without\ filtering\ DB.enabled = Y
m  phase.WC\ -\ Load\ with\ filtering\ (Part\ 1).enabled = N
m  phase.WC\ -\ Load\ with\ filtering\ (Part\ 1)\ DB.enabled =Y
m  phase.WC\ -\ Load\ with\ filtering\ (Part\ 2).enabled =Y
3. Set the following properties in the transaction-screening-batch.properties file:
m  phase.WC\ -\ Load\ without\ filtering.enabled = N
m phase.WC \ -\ Load\ without\ filtering\ DB.enabled =Y
m  phase.WC \ -\ Load\ with\ filtering\ (Part\ 1).enabled = N
m  phase.WC \ -\ Load\ with\ filtering\ (Part\ 1)\ DB.enabled =Y

m  phase.WC \ -\ Load\ with\ filtering\ (Part\ 2).enabled =Y

E.2.3 Running the Delta Watch List

To run the delta watch list, follow these steps:

1. Set the following properties in the watchlist-management - TF.properties file:
m phase.WC\ -\ Download.enabled = N.
m  phase.WC\ -\ Download\ Delta.enabled = Y.
m  phase.WC\ -\ Stage\ reference\ lists.enabled = Y.
m  phase.*.export.*.wc ind table name=FSI WC WATCHLIST DELTA IND
m  phase.*.export.*.wc entities table name=FSI WC WATCHLIST DELTA ENT
m  phase.Importl Full DB.enabled = N
m  phase.Import2 Full DB.enabled = N
m  phase.Import3 Full DB.enabled = N
m  phase.Importl Delta DB.enabled = Y
m  phase.Import2 Delta DB.enabled = Y
m  phase.Import3 Delta DB.enabled = Y

2. To run the delta watch list without filtering, set the following properties:
m  phase.WC\ -\ Prepare\ without\ filtering.enabled = N
m set phase.WC\ -\ Prepare\ without\ filtering\ Delta\ DB.enabled = Y

To run the delta watch list with filtering, set the following properties:

m  phase.WC\ -\ Prepare\ with\ filtering\ (Part\ 1).enabled = N
m  phase.WC\ -\ Prepare\ with\ filtering\ (Part\ 2).enabled = N
m  phase.WC\ -\ Prepare\ with\ filtering\ Delta\ DB.enabled =Y
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E.2.4 Merging the Delta Watch List to the Full Watch List

To merge the delta watch list with the full watch list, set the following properties in the watchlist-
management .properties file:

e phase.WC\Delta\ Merge.enabled = Y.

e phase.WC\Linked\ Profiles.enabled = Y.
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17 Appendix F: Message Categories and Message
Types
A user of the Transaction Filtering application can use the following message categories:
e SWIFT Message Types
e 1S020022 Message Types
e Fedwire Message Types
e US NACHA Message Types
Each message category has different message types defined. The following tables list the message
categories and associated message types.
F.1 SWIFT Message Types
For the SWIFT message category, the message types numbered 1to 8 are the ready-to-use message
types that you can use after you log in. The other message types must be imported manually using the
SWIFT migration utility. For information on the steps, see Running the SWIFT Migration Utility.
Table 48: SWIFT Message Types
1 MT101 2 MT103 3 MT110 4 MT202
5 MT202COV 6 MT700 7 MT701 8 MT707
9 MT103STP 10 MT105 1" MTINM 12 MT112
13 MT190 14 MT191 15 MT192 16 MT195
17 MT196 18 MT198 19 MT199 20 MT210
21 MT290 22 MT291 23 MT292 24 MT295
25 MT296 26 MT298 27 MT299 28 MT300
29 MT399 30 MT400 31 MT410 32 MT412
33 MT455 34 MT490 35 MT491 36 MT492
37 MT495 38 MT496 39 MT498 40 MT499
a1 MT536 42 MT590 43 MT591 44 | MT599
45 MT606 46 MT607 47 MT671 48 MT699
49 MT711 50 MT720 51 MT721 52 MT730
53 MT734 54 MT742 55 MT747 56 MT750
57 MT752 58 MT754 59 MT756 60 MT760
61 MT767 62 MT768 63 MT769 64 MT790
65 MT791 66 MT795 67 MT796 68 MT798
69 MT799 70 MT802 VAl MT895 72 MT896
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Table 48: SWIFT Message Types

73 MT899 74 MT910 75 MT950 76 MT995
77 MT996 78 MT998 79 MT999 80 MT107
81 MT204 82 MT416 83 MT420 84 MT430
85 MT516 86 MT526 87 MT581 88 MT592
89 MT608 90 MT705 91 MT710 92 MT792
93 MT801 94 MTQ00 95 MT320 96 MT604
97 MT605 98 MT732 99 MT740 100 | MT940
101 MT942 102 MT985 103 | MT986 104 | MT890
105 MT895 106 | MT89%96 107 | MT899 108 MT900
109 MT910 110 MT940 m MT942 12 MTQ50
13 MT985 14 MT986 115 MT995 16 MT996
17 MT998 18 MT999 19 MT102 120 MT104
121 MT200 122 MT203 123 | MT456 124 MT708
125 MT321 126 MT540 127 | MT541 128 MT542
129 MT543 130 MT544 131 MT305 132 MT396
133 MT568 134 MT596 135 | MT696 136 MT304
137 MT350 138 MT362 139 | MT566

F.2 ISO20022 Message Types

For the ISO20022 message category, the following message types are the ready-to-use message types
that you can use after you log in.

Table 49: 1S020022 Message Types

1 Pain.001.001.08 2 Pacs.008.001.07 3 Pacs.003.001.02 4 Pacs.008.001.02

5 Pacs.008.001.08 6 | Pacs.010.001.03 7 Pain.001.001.09 8 Pacs.009.001.08

9 Pacs.004.001.09 10 | Camt.050.001.05

F.3 Fedwire Message Types

For the Fedwire message category, the following message types are the ready-to-use message types
that you can use after you log in.

Table 50: Fedwire Message Types

1 FDCTR1000 2 FDBTR1002 3 FDCTR1002 4 FDCTR1008
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Table 50: Fedwire Message Types

5 FDCTR1600 6 FDCTR1602 7 FDBTR1600 8 FDBTR1000
9 FDBTR1008 10 | FDBTR1602 11 | FDCTP1000 12 | FDCTP1002
13 FDCTP1008 14 | FDCTP1600 15 | FDCTP1602 16 | FDCKS1600
17 FDCKS1602 18 | FDDEP1600 19 | FDDEP1602 20 | FDFFR1600
21 FDFFR1602 22 | FDFFS1600 23 | FDFF$S1602 24 | FDDRC1031

25 FDDRW1032 26 | FDSVC1090 27 | FDDRB1631 28 | FDDRW1632
29 FDSVC1690 30 | FDSVC1590 31 | FDBTR1500 32 | FDDRC1531

33 FDDRW1532

F.4 US NACHA Message Types

For the US NACHA message category, the following message types are the ready-to-use message
types that you can use after you log in.

Table 51: US NACHA Message Types

1 | IAT 2 CTX 3 | BOC 4 | RCK
5 | POP 6 WEB 7 | CCD 8 | TEL
9 | PPD 10 ARC 11 | CE
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Appendix G: Invoking the PMF Workflow from
backend

This appendix describes invoking the Process Modeller Framework (PMF) workflow from the backend
for the alert.

Table52 provides the PMF workflow invoking parameters.

Table 52: PMF Workflow Invoking Parameters

Parameter Name Parameter Description

Object ID This represents the unique object ID. For Sanctions, the object ID can be
alert ID or Good Guy Whitelist ID.

Object Type This represents the object type for the object ID. For Sanctions, the object
type will be 301 for alert and 302 for Good Guy Whitelist.

Infodom This represents the name of the infodom in which Sanctions are
installed.

Segment This represents the name of the segment. For Sanctions, it will be
TFLSEGMENT.

User ID This represents the User ID that is triggering the workflow. Pass the value
as SYSTEM.

Locale This represents the locale. Pass the value as en_US.

Application Params This represents the list of workflow data fields with their respective value.

Security Params This represents the list of workflow security data fields with their respec-
tive value.

To trigger the workflow for Sanctions Alerts, follow the below code snippet.

DECLARE

lv_infodom varchar2 (4000);
lv_segment varchar2 (4000);
TYPE alert record ids IS TABLE OF fsi rt alerts.n grp msg id%TYPE;

1 alert record ids alert record ids;

appParams array varchar := array varchar();
secMap array varchar := array varchar();
BEGIN

appParams.extend() ;

appParams (1) := 'TF ACTION=MANUAL CLOSE';
appParams.extend() ;

appParams (2) := 'Role=SYSTEM';

select t.v_attribute valuel
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into
from
where
select
into
from
where
select
into
from

where

FOR recId IN 1

1lv_infodom

setup _rt params t

t.v_param name = 'TFLT INFODOM';

t.v_attribute valuel

lv_segment

setup _rt params t

t.v_param name = 'TFLT SEGMENT';
t.n _grp msg_id bulk collect

1 alert record ids

fsi rt alerts t

t.n status cd in (1,2);

1 alert record ids.COUNT loop

startWorkflowForExpireRecord(l alert record ids(recId),

'301"',

1v_infodom,

1lv_segment,

"SYSTEM',

'en US',

appParams,

secMap) ;
end loop;
EXCEPTION
WHEN OTHERS THEN
dbms output.put line (SQLCODE || SQLERRM) ;
ROLLBACK;

END;
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19 Appendix H: JMS Cluster Environment Creation

JMS servers act as management containers for the queues and topics in JMS modules that are targeted
to them. JMS cluster servers in a domain work together to provide a more scalable and reliable

application platform than a single server. A cluster appears to its clients as a single server, but it is a
group of servers acting as one.

19.1 JMS Server Creation

To create the JMS server and file store, follow these steps:

1. Loginto Weblogic Console.

2. From the Domain Structure select Services, click JMS Servers from Messaging drop-down,
and click New in the JMS Servers table.

Figure 126: Weblogic Console Page

Change Center T&l Home Log Out Preferences [24] Record Help | Q Welcome, weblogic | Connected to: ARAITEST
T T e rarrarta Home >Summary of JDBC Data Sources >Summary of JMS Servers
Configuration editing is enabled. Future Summary of JMS Servers

changes will automatically be activated as you
modify, add or delete items in this domain.
JMS servers act as management containers for the queues and topics in JMS modules that are targeted to them.
Domain Structure i i .
This page summarizes the JMS servers that have been created in the current WebLogic Server domain.

AAAITEST

#-Domain Partitions

-Environment P Customize this table
{-Deployments
=t-Services IMS Servers (Filtered - More Columns Exist)
i E-Messaging

New | | Delete

Showing 1to 2 of 2 Previous | Next
Store-and-Forward Agents

IMS Modules ]| Name & Persistent Store Target Current Target Health Scope Domain Partitions
Path Servi —
e services [LJ | IMSServer02 FileStore02 mns1 mns1 Global

- Bridges -

Data Sources [J | IMsServer03 FileStore03 mns2 mns2 Global

Persistent Stores

N - New | | Delete
Foreion INDT Providers —

Showing 1to 2 of 2 Previous | Next

How do I...
3. Inthe JMS Server Properties page, enter the JMS server name in the Name field and click Next.
Figure 127: JMS Server Properties Page

Change Center @ Home Log Out Preferences [&] Record Help | Y Welcome, weblogic | Connected to: AAAITES]

View changes and restarts Home >Summary of JDBC Data Sources >Summary of J.MS Servers

Configuration editing is enabled. Future Create a New JMS Server

changes will automatically be activated as you

modify, add or delete items in this domain. Back| | Next | Finish | Cancel

Domain Structure JMS Server Properties

ASAIDS"S;” osiiions The following properties will be used to identify your new JMS Server.
F * Indicates required fields
t-~Deployments
TR What would you like to niame your new JMS server?
| El-Messaging
£-IMS Servers . 2
- Store-and-Forward Agents og " Name:
£7JMS Modules
t--path Services Would you like this new JMS server to be restricted to a specific resource group template or resource group ?
#-Bridges
Data Sources Scope:

Global v
Persistent Stores

Fareian INDI Providers
Back | | Next | Finish | Cancel
How do I...

4. Inthe Select Persistent Store page, select Create a New Store from Persistent Store Field to
specify a persistent store for the new JMS server.
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Figure 128:

Select Persistent Store page

Change Center
View changes and restarts
Configuration editing is enabled. Future

changes will automatically be activated as you
modify, add o delete items in this domain.

Domain Structure
AAAITEST

[*-Domain Partitions
[-Environment
Deployments
E-Services
EH-Messaging
i--IMS Servers
+--Store-and-Forward Agents
JMS Modules
i--Path Services
B-Bridges

Data Sources
Persistent Stores

o o s [ ems) Ba |

Create a New JMS Server
Back | | Next | Finish | Cancel

Select Persistent Store
Specify a persistent store for the new JMS server.

Persistent Store: (none)

Back| |Next | Finish | Cancel

Home >Summary of JDBC Data Sources >Summary of JMS Servers

Welcome, weblogic | Connected to: AAAITEST|

v | Create a New Store

Foreion INDT Providers

5.

Figure 129: Select a store type page

In the Select a store type page, select File Store from Type Field and click Next.

Change Center
View changes and restarts
Configuration editing is enabled. Future

changes will automatically be activated as you
modify, add or delete items in this domain.

Domain Structure
AAAITEST
[#-Domain Partitions
[#-Environment
~-Deployments
[-Services
=} -Messaging
£--IMS Servers
Store-and-Forward Agents
IMS Modules
i--Path Services
- Bridges
Data Sources

Persistent Stores
Foreion INDT Praviders

ORACLE WebLogic Server Administration Console 12¢

@ Home Log Out Preferences [&] Record Help |
Home >Summary of JDBC Data Sources >Summary of JMS Servers
Create a New JMS Server
Back | | Next | Finish | Cancel
Select a store type.
Please select the type of store you wish to create from the list.

Type:

File Store v

Back | | Next | Finish | Cancel

Welcome, weblogic | Connected to: AAAITEST

6.
Next.

Figure 130:

File Store Properties page

In the File Store Properties page, enter the new file store name in the Name field and click

ORACLE WebLogic Server Administration Console 12¢

Change Center
View changes and restarts
Configuration editing is enabled. Future

changes will automatically be activated as you
modify, add or delete items in this domain.

Domain Structure
AAATTEST
[B-Domain Partitions
B -Environment
Deployments
EH-Services
&H-Messaging
i+ IMS Servers
i--Store-and-Forward Agents
£+-IMS Modules
i Path Services
B-Bridges
+--Data Sources
~~Persistent Stores
“--Foreian INDT Providers

How do I... =]

o Configure JMS system modules

« Configure custom persistent stores

@ Home Log Out Preferences

Record Help |
Home >Summary of JDBC Data Sources >Summary of JMS Servers

Create a New JMS Server
Back | | Next | Finish | Cancel

File Store Properties

The following properties will be used to identify your new file store.

* Indicates required fields

‘What would you like to name your new file store?

FileStore04]

‘What scope do you want to create your jms file store in ?

* Name:

Scope: Global v

The pathname to the directory on the file system where the file store is kept. This directory must exist on your system, so be sure to create it before completing this tab.

Directory:

Back | |Next | Finish | Cancel

Welcome, weblogic | Connected to: AAAITEST
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7. Inthe JMS File Store Targets page, select a target as one of the named server from Target Field
drop down and Click Finish.

NOTE e Only applications deployed to the selected servers or
clusters can use the JMS file store.

e When you target all or part of the cluster, the Administra-
tion Console initiates a two-phase deployment. Two-phase

deployment ensures that if the deployment fails for one
active server, it fails for all active servers.

Figure 131: JMS File Store Targets page
ORACLE WebLogic Server Administration Console 12¢ —

Change Center @ Home Log Out Preferences [&] Record Help | Q Welcome, weblogic | Connected to: AAAITEST]|
e £ IMS Servers >IMSServer02 >
View changes and restarts ‘ Home >Summary of JDBC Data Sources >Summary of JMS Servers >IJMSServer02 >Summary of JMS Servers
Configuration editing is enabled. Future Create a New JMS Server
changes will automatically be activated as you
modify, add or delete items in this domain. Back| Next | Finish | Cancel
Domain Structure | JMS File Store Targets
AAAITEST
+
{+"Domain Partitions This page indicates on which WebLogic Server instances or clusters the jms file store is accessible. Only applications that have been deployed to the selected servers or clusters can use this jms
E-Environment file store.
i-~Deployments
[=}-Services When you target all or part of a cluster, the Administration Console initiates a two-phase deployment. In general, such a deployment ensures that if the deployment fails for one active server, it
by M i fails for all active servers.
i essaging
: £--IMS Servers
{ " Store-and-Forward Agents Select a server instance for this file store.
£--IMS Modules
Pt Srees Target:
[#-Bridges
Data Sources
Persistent Stores Back| |Next | Finish | Cancel
Foreinn INDT Providers e

NOTE You will receive a message on successful activation and file store
creation.

8. Select the same target name from the JMS File Store Targets page in the Target field drop

down in the Select targets page and click Finish to create the JMS server and its respective file
store.

Figure 132: Select targets page

ORACLE WebLogic Server Administration Console 12¢ —

Change Center @ Home Log Out Preferences [&] Record Help | Q Welcome, weblogic | Connected to: AAAITEST|
View changes and restarts Home >Summary of JDBC Data Sources >Summary of JMS Servers >IMSServer02 >Summary of JMS Servers
Configuration editing is enabled. Future Create a New JMS Server

changes will automatically be activated as you

modify, add or delete items in this domain. Back| [Next |Fimsh |Cance\

Domain Structure

AAAITEST
B}-Domain Partitions

Select targets

Select the server instance or migratable target on which you would like to deploy this JMS server.
E-Environment .
- Deployiments Target:
[-Services
=H-Messaging Back| |Next | Finish | Cancel
+-IMS Servers
Store-and-Forward Agents
-IMS Modules
i+ Path Services
- Bridges
Data Sources
Persistent Stores.
Foreian INDT Providers
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19.2

JMS Module Creation

JMS system resources are configured and stored as modules similar to standard Java EE modules.
Such resources include queues, topics, connection factories, templates, destination keys, quota,
distributed queues, distributed topics, and JMS store-and-forward (SAF) parameters. You can
administratively configure and manage JMS system modules as global system resources.

To Create the JMS Module, follow these steps:
1. Loginto Weblogic Console.

2. From the Domain Structure Select Services, click JMS Modules from Messaging drop-down,
and Click New in the JMS Modules table.

Figure 133: Weblogic Console Page

Change Center

View changes and restarts

ORACLE WebLogic Server Administration Console 12¢

T = 3|
Welcome, weblogic | Connected to: AAAITEST|
Home >Summary of JDBC Data Sources >Summary of JMS Servers >JMSServer02 >Summary of JMS Servers >IMSServer01 >Summary of JMS Servers >Summary of JMS Modules

@ Home Log Out Preferences [ Record Help | Q

Configuration editing is enabled. Future

modify, add or delete items in this dormain.

changes will automatically be activated as you

Domain Structure
AAAITEST
[#-Domain Partitions
Environment
Deployments
Services

=F-Messaging

i--IMS Servers
i+-Store-and-Forward Agents
i--Path Services

#-Bridges

Data Sources

Persistent Stores

Foreion INDI Providers.

Summary of JMS Modules

IMS system resources are configured and stored as modules similar to standard Java EE modules. Such resources include queues, topics, connection factories, templates, destination keys, quota,

distributed queues, distributed topics, foreign servers, and IMS store-and-forward (SAF) parameters. You can administratively configure and manage JMS system modules as global system
resources.

This page summarizes the JMS system modules that have been created for this domain.

P Customize this table
JMS Modules

New | | Delete Showing 1to 10f 1 Previous | Next

(]| Name & Type Scope Domain Partitions

[ |rTT JMSSystemResource Global

New | | Delete Showing 1to 1 of 1 Previous | Next

3. Inthe Create JMS System Module page, enter the JMS Module name as RTI in the Name field

and click Next.

Figure 134: Create JMS System Module Page

Change Center
View changes and restarts

Configuration editing is enabled. Future
changes will automatically be activated as you
modify, add or delete items in this domain.

Domain Structure
AAAITEST
B-Domain Partitions
B-Environment
Deployments
Services

=HMessaging

i--IMS Servers
i Store-and-Forward Agents
i-JMS Modules
i--Path Services

[#-Bridges

Data Sources

Persistent Stores

Forsian INDT Providers,

* Configure JMS system modules
* Configure JMS servers

Health of Running Servers as of 6:23 AM

[ Failed (0)

[ Critical (0)
Overloaded (0)
I o

How do I... =

System Status =

Tl Home Log Out Preferences [ Record Help | Q Welcome, weblogic | Connected to; AAAITES
Home >Summary of JDBC Data Sources >Summary of IMS Servers >IMSServer02 >Summary of IMS Servers >JMSServer01 >Summary of JMS Servers >Summary of JMS Modules

Create JMS System Module

Back] [Next | Finish |Cance\

The following properties will be used to identify your new module.

JMS system resouirces are configured and stored as modules similar to standard Java EE modules. Such resources include queues, topics, connection factories, templates, destination keys, quota,

distributed queues, distributed topics, foreign servers, and JMS store-and-forward (SAF) parameters. You can administratively configure and manage JMS system modules as global system
resources.

* Indicates required fields

What would you like to name your System Module?

RTITest

Would you like this new JMS System Module to be restricted to a specific resource group template or resource group ?

* Name:

Scope: Global v

What would you like to name the descriptor file name? If you do not provide a name, a default will be assigned.

Descriptor File Name:

Where would like to place the descriptor for this System Module, relative to the jms configuration sub-directory of your domain?

Location In Domain:

Back | | Next | Finish | Cancel
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4. Select Servers or Clusters on which you deploy the JMS system module from the Targets Field.
The cluster name that was created in step 6.1.8 will be listed under IPECluster.

I NOTE You can configure the targets later if required.

Figure 135: Create JMS System Module
ORACLE WebLogic Server Administration Consale 12¢

Change Center | @ Home Log Out Preferences [2] Record Help |

Q Welcome, weblogic | Connected to: AAAITEST
Home >Summary of JDBC Data Sources >Summary of JMS Servers >JMSServer02 >Summary of IMS Servers >JMSServer01 >Summary of JMS Servers >Summary of JMS Modules
Configuration editing is enabled. Future Create JMS System Module
changes will automatically be activated as you
modify, add or delete items in this domain.

View changes and restarts

Back| |Next | Finish |Can0e\

Domain Structure The following properties will be used to target your new JMS system module.

ARATTEST
‘:; EO‘_“E"” Pa‘tt‘tk’”s Use this page to select the server or cluster on which you would like to deploy this JMS system module. You can reconfigure targets later if you wish.
BEnvironment
i~ Deployments
-Services Targets :
| EMessaging
| £--IMS Servers
Store-and-Forward Agents Servers
£+IMS Modules
i--Path Services ] Adminserver
[B-Bridges
Data Sources
Persistent Stores | ErEED
Foreion INDT Providers =
IPECluster
HowdoI.. = ® All servers in the cluster
( Part of the cluster
« Configure IMS system modules [ mnst
« Configure IMS servers [ mns2

System.Status = Back| |Next | Finish | Cancel
Health of Running Servers as of 6:26 AM

5. To add resources to the JMS system module and to create JMS modules check the box in the
Create JMS System Module page and click Finish.

NOTE You will receive message on successful creation of the JWS

module.
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Figure 136: Create JMS System Module

ORACLE WebLogic Server Administration Console 12¢

Clidies conti | @ Home LogOut Preferences [ Record Help | Q

View changes and restarts

Configuration editing is enabled. Future Create JMS System Module
changes will automatically be activated as you
modify, add or delete items in this domain. Back| [Next | Finish | T

Domain Structure

AAATTEST

H-Domain Partitions

1-Environment

Deployments

=H-Services

=F-Messaging
i--IMS Servers
i--Store-and-Forward Agents
£--IMS Modules

Add resources to this JMS system module

(] Would you like to add resources to this JMS system module?

Back | |Next |F|n|sn |Canoe\

Home >Summary of JDBC Data Sources >Summary of JMS Servers >JMSServer02 >Summary of JMS Servers >JMSServer01 >Summary of JMS Servers >Summary of JMS Modules

Use this page to indicate whether you want to immediately add resources to this IMS system module after it is created. JMS resources include queues, topics, connection factories, and such.

Welcome, weblogic | Connected to: AAAITEST|

i--Path Services
B-Bridges
Data Sources
Persistent Stores
Fareinn INDI Providers

Howdol...

« Configure JMS system modules

« Configure IMS servers

19.3 Sub-Deployment Creation

A sub-deployment is a mechanism by which JMS module resources such as queues, topics, and
connection factories are grouped and targeted to a server resource such as JMS servers, server

instances or cluster.
To create the Sub-Deployment follow these steps:

1. Login to Weblogic Console.

2. From the Domain Structure Select Services and click JMS Modules from Messaging drop-
down. The Summary of JMS Module page is displayed.

3. Select RTI from JMS Modules table. The Settings for RTI page is displayed.

4. Select subdeployments from the tabs.

5. Enter the sub-deployment name as RTI Deploy in subdeployment table and click Next.

Figure 137: Settings for RTI

Change Center @ Home Log Out Preferences [&] Record Help | Q

View changes and restarts

Configuration editing is enabled. Future Settings for RTT

changes will automatically be activated as you

modify, add or delete items in this domain. Configuration | Subdeployments = Targets = Security =~ Notes

Domain Structure
AAAITEST
[¥-Domain Partitions
BH-Environment
i--Deployments

grouped and targeted to a server resource (such as IMS servers, server instances, or cluster).

b Customize this table

Home >JMSServer02 >Summary of JMS Servers >JMSServer01 >Summary of JMS Servers >Summary of JMS Modules >RTI >Summary of JMS Modules >RTI >Summary of JMS Modules >RTI

This page displays subdeployments created for a JMS system module. A subdeployment is a mechanism by which JMS module resources (such as queues, topics, and connection factories) are

Welcome, weblogic I Connected to: AAAITEST|

Persistent Stores

E-Services
i EFMessaging Subdeployments
£-3Ms Servers
i~ Store-and-Forward Agents | New | | Delete Showing 1to 2 0f 2 Previous | Next
£--IMS Modules —
+-Path Services ||| Name# | Resources Targets
B-Bridges
= IMSServer02,
Data Sources [ | RTI Deploy JMsServer03

Foreion INDT Providers.

Cache Operation Message Destination Topic

(] |RTIsubdeploy RTI Feedback Queue, RTI Hold JMS Queue, Source Entity Queue, Wire Transaction Source Entity Queue, RTI Assessment Response Destination Topic, | JMSServer02,

IMSServer03

Howdo I... New | [Delete

« Configure subdeployments in JMS system
modules

Showing 1to 20f 2 Previous | Next
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6. Select the JMS servers created previously from the JMS Servers list from the Settings for RTI
Deploy page and click Save. The RTI sub-deployment is created.

I NOTE You can configure the targets later if required.
Figure 138: Settings for RTI Deploy Page
ORACLE WebLogic Server Administation Gonsole 120 e 202 9]
Change Center @ Home Log Out Preferences 2] Record Help | Q Welcome, weblogic | Connected to: AAAITEST]
View changes and restarts Home >IMSServer02 >Summary of JMS Servers >JMSServer01 >Summary of JMS Servers >Summary of JMS Modules >RTI >Summary of JMS Modules >RTI >Summary of JMS Modules >RTI
Configuration editing is enabled. Future Settings for RTI Deploy

changes will automatically be activated as you
modify, add or delete items in this domain. Save

Domain Structure
Use this page to select the targets for the subdeployment. You can reconfigure targets later if you wish.

AAATTEST
*-Domain Partitions
BH-Envi
T Environment e
i--Deployments
TEPNOS] [) Adminserver
E}-Messaging
£--IMS Servers
i~~Store-and-Forward Agents Clusters
i-IMS Modules —
i--Path Services [ 1PECIuster
(- Bridges ) Al servers in the cluster
Data Sources () Part of the cluster
Persistent Stores ) mns1
Foreinn INDT Providers, Y [ mns2
HowdoI...
JMS Servers
« Configure subdeployments in JMS system
modules (] 3MsServero1
System Status = IMSServer02
Health of Running Servers as of 7:09 AM
IMSServer03
I Failed (0)
[ Critical (0)

Overloaded (0) LSave,

19.4 Distributed Queues Creation

Depending on the type of resources selected you are prompted to enter the basic information for
creating the resources. For target resources like stand-alone queues and topics, connection factories,
distributed queues and topics, foreign servers, and JMS SAF destinations you can proceed to target
pages for selecting appropriate server targets. You can associate target resources with sub-
deployments, which is an advanced mechanism for grouping JMS module resources and the members
to server resources. To create the Distribute Queues, follow these steps:

NOTE Queues must be created as per the IPE Configuration guide with
the same naming convention. See Chapter 19.7 for information
about JMS Queue creation for SWIFT, Fedwire and 1ISO20022
Message types.

1. Login to Weblogic Console.

2. From the Domain Structure Select Services and click JMS Modules from Messaging drop-
down. The Summary of JMS Module page is displayed.

3. Select RTI from JMS Modules table. The Settings for RTI page is displayed.

4. Click New and select Distribute Queue from Create a New a JMS System Module Resource
page.
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Figure 139: Create a New JMS System Module Resource page
ORACLE WebLogic Server Administration Console 12¢ _

Change Center @ Home Log Out Preferences

Record Help | Welcome, weblog | Connected to: AAAITEST]|
= Home >Summary of JMS Modules >RTI >Summary of JMS Modules >RTI >Summary of JMS Modules >RTI >Summary of JMS Modules >RTI >Summary of JMS Modules >RTI
View changes and restarts
Configuration editing is enabled. Future Create a New JMS System Module Resource

changes will automatically be activated as you
modify, add or delete items in this domain.

Back | | Next | Finish | Cancel

Domain Structure
AAAITEST
[-Domain Partitions
[-Environment

Choose the type of resource you want to create.

Use these pages to create resources in a JMS system module, such as queues, topics, templates, and connection factories.

Deployments Depending on the type of resource you select, you are prompted to enter basic information for creating the resource. For targetable resources, like stand-alone queues and topics, connection
=}-Services factories, distributed queues and topics, foreign servers, and JMS SAF destinations, you can also proceed to targeting pages for selecting appropriate server targets. You can also associate
5 Messaging targetable resources with subdeployments, which is an advanced mechanism for grouping JMS module resources and the members to server resources.
i-IMS Servers

Store-and-Forward Agents () Connection Factory

Defines a set of connection configuration parameters that are used to create
{77 IMS Modules connections for IMS clients. More Info.
~Path Services
BF-Bridges () Queue Defines a point-to-point destination type, which are used for asynchronous
i~-Data Sources peer communications. A message delivered to a queue is distributed to only
~~Persistent Stores one consumer. More Info...
i-Forsion INDI Providers. =
() Topic Defines a publish/subscribe destination type, which are used for
HowdoI... B asynchronous peer communications. A message delivered to a topic is
distributed to all topic consumers. More Info...
« Configure quotas for destinations

* Configure JMS templates Distributed Queue

Defines a set of queues that are distributed on multiple JMS servers, but

« Configure destination keys which are accessible as a single, logical queue to JMS dlients. More Info...

« Configure topics

) () pistributed Topic Defines a set of topics that are distributed on multiple IMS servers, but which

» Configure queues are accessible as a single, logical topic to JMS clients. More Info...

« Configure connection factories

« Configure uniform distributed topics () Foreign Server Defines foreign messaging providers or remote WebLogic Server instances
that are not part of the current domain. More Info.

« Configure uniform distributed queues

« Configure foreign servers ) Ouota

Controls the allotment of system resources available to destinations. More

5. Enter the name and JDNI name in Name and JNDI Name Fields respectively as per the IPE
Configuration guide and click Next.

Figure 140: JMS Distributed Destination Properties page
ORACLE WwebLogic Server Administration Console 12¢ _—

Change Center @ Home Log Out Preferences [&] Record Help | Welcome, weblogic | Connected to: AAATTEST
View changes and restarts Home >Summary of IMS Modules >RTI >Summary of JMS Modules >RTI >Summary of JMS Modules >RTI >Summary of JMS Modules >RTI >Summary of JMS Modules >RTI
Configuration editing is enabled. Future Create a New JMS System Module Resource

changes will automatically be activated as you
modify, add or delete items in this domain.

Back| |Next |F|n|sh | Cancel

Domain Structure JMS Distributed Destination Properties

T?Ag) EmS;n Seefiioas The following properties will be sed to identify your new Distributed Quete. The current module is RTT
Bt oot * Indicates required fields
~Deployments
F-Services What would you like to name your new destination?
EF-Messaging
IMS Servers - ; -
Store-and-Forward Agents Name: DistributedQueue01
IMS Modules
Path Services What INDI Name would you like to use to look up your new destination?
-Bridges
i~-Data Sources INDI Name:

jms/feedbackQueue]|
i~-Persistent Stores

£—-Fareion INDI Providers o,
Queue members may be either created uniforrmly from a common configuration, or created and weighted individually to fine tune performance. How would you like to create queue members?
HowdoI.. =]
Destination Type: Uniform v
« Configure quotas for destinations
« Configure IMS templates Templates provide an efficient means of defining multiple destinations with similar configuration values. Would you like to use a template for this destination?
« Configure destination keys
« Configure topics Template: None v
« Configure queues
« Configure connectio factores [Back| [Next| |[Finish] || Cancel|

o Configure uniform distributed topics

6. Select Advanced Targeting.
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Figure 141: Create a New JMS System Module Resource page

ORACLE WebLogic Server Administration Console 12¢

Change Center
View changes and restarts

Configuration editing is enabled. Future

@ Home LogOut Preferences [&] Record Help | Q Welcome, weblogic|Cor\nected to: AAAITEST

Home >Summary of IMS Modules >RTI >Summary of JMS Modules >RTI >Summary of JMS Modules >RTI >Summary of JMS Modules >RTI >Summary of IMS Modules >RTT

Create a New JMS System Module Resource

changes will automatically be activated as you

modify, add or delete items in this domain. Back| [Next |F|n|5n |AdvancedTargeung |Cance\

Domain Structure
AAATTEST

The following properties will be used to target your new JMS system module resource

£-Dommal Partitions Use this page to view and accept the default targets where this JMS resource will be targeted. The defait targets are based on the parent JMS system module targets. If you do not want to
E-Environment accept the default targets, then click Advanced Targeting to use the subdeployment mechanism for targeting this resource.
Deployments
[=F-Services
=}-Messaging The following JMS module targets will be used as the default targets for your new JMS system module resource. If the module's targets are changed, this resource will also be retargeted
-JMS Servers appropriately.
Store-and-Forward Agents
~JMS Modules Targets :
-Path Services
[*-Bridges
i~-Data Sources ELEET
~Persistent Stores
Foreion INDI Providers d IPECluster

All servers in the cluster

How do I... =] Part of the cluster
mns1
« Configure quotas for destinations mns2

« Configure JMS templates

« Configure destination keys
Back | | Next | Finish | Advanced Targeting Cancel
» Configure topics T U

« Configure queues

7. Select RTISubdeploy from the subdeployment field drop down list and select the JMS servers
created. Click Finish. The distributed queue is successfully created.

NOTE You will receive message on successful creation of the JWS

distributed queue.

Figure 142: Create a New JMS System Module Resource page

T Messaging Ject the subdepl Fyou sel ing will
IMS Servers Select the subdeployment you want to use. If you select (none), no targeting will occur.
i~-Store-and-Forward Agents R is:

IMS Modles Hhceployments: RTISubdeploy  |(Creataalen Subdeniovment]
-Path Services
H-Bridges What targets do you want to assign to this subdeployment?
Data Sources
Persistent Stores Targets:
Farsinn INDT Providers bd
HowdoI... =] e
« Configure quotas for destinations =
[ Adminserver
s Configure JMS templates
« Configure destination keys
Clusters
« Configure topics
«+ Configure queues [ IPECluster
« Configure connection factories ) All servers in the cluster
+ Configure uniform distributed topics (e of the cluster
« Configure uniform distributed queues Timns2
« Configure foreign servers
* Configure JMS SAF IMS Servers
System Status =] [ JMsServero1
Health of Running Servers as of 7:13 AM V]
4 JmMsSservero2
[ Failed (0)
[ Critical (0) | IMSServero3
Overloaded (0)
[ Warning (0) §
_ 0K (1) Back | Next | Finish | Cancel
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19.5 Distributed Topic Creation

To create the Distribute Topic, follow these steps:

NOTE Topics must be created as per the IPE Configuration guide with the
same naming convention.

1. Loginto Weblogic Console.

2. From Domain Structure Select Services and click JMS Modules from Messaging drop-down.
The Summary of JMS Module page is displayed.

3. Select RTI from JMS Modules table. The Settings for RTI page is displayed.

4. C(Click New and select Distribute Topic from Create a New a JMS System Module Resource
page.

Figure 143: Create a New JMS System Module Resource page

IORACLE WebLogic Server Administration Console 12¢ _

Change Center @ Home LogOut Preferences [&] Record Help | Q Welcome, weblugic|C0nne(Ied to: AAAITEST

- Home >Summary of JMS Modules >RTI >Summary of JMS Modules >RTI >Summary of JMS Modules >RTI >Summary of JMS Modules >RTI >Summary of IMS Modules >RTI
View changes and restarts

Configuration editing is enabled. Future Create a New JMS System Module Resource
changes will automatically be activated as you
modify, add or delete items in this domain. Back| |Next | Einish | e

Domain Structure

IhAATTEST
B-Domain Partitions

Choose the type of resource you want to create.

T Use these pages to create resources in a JMS system module, such as queues, topics, templates, and connection factories.
B-Environment

+--Deployments Depending on the type of resource you select, you are prompted to enter basic information for creating the resource. For targetable resources, like stand-alone queues and topics, connection
[=-Services factories, distributed queues and topics, foreign servers, and JMS SAF destinations, you can also proceed to targeting pages for selecting appropriate server targets. You can also associate
| E-Messaging targetable resources with subdeployments, which is an advanced mechanism for grouping JMS module resources and the members to server resources.

£IMS Servers
+--Store-and-Forward Agents

H () Connection Factory Defines a set of connection configuration parameters that are used to create

{77IMS Modules connections for JMS dlients.  More Info.

~Path Services

-Bridges ) Queue Defines a point-to-point destination type, which are used for asynchronous
Data Sources peer communications. A message delivered to a queue is distributed to only
Persistent Stores one consumer.  More Info...
Foreion INDT Providers =

= () Topic Defines a publish/subscribe destination type, which are used for

How do I... = asynchronous peer communications. A message delivered to a topic is

distributed to all topic consumers. More Info...
« Configure quotas for destinations

« Configure JMS templates () Distributed Queue Defines a set of queues that are distributed on multiple JMS servers, but
« Configure destination keys which are accessible as a single, logical queue to JMS clients. More Info...

« Configure topics

istributed Topic Defines a set of topics that are distributed on multiple JMS servers, but which

« Configure quees are accessible as a single, logical topic to IMS dlients.  More Info...

« Configure connection factories
« Configure uniform distributed topics () Foreign Server Defines foreign messaging providers or remote WeblLogic Server instances
A - P— that are not part of the current domain. More Info...

« Configure uniform distributed queues

« Configure foreign servers O Quota.

Controls the allotment of system resources available to destinations. More

5. Enter the name and JDNI name in Name and JNDI Name Fields respectively as per the IPE
configuration guide and click Next.
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Figure 144: JMS Distributed Destination Properties page

ORACLE WebLogic Server Administration Console 12¢

Change Center @ Home Log Out Preferences [&] Record Help | Q Welcome, weblogic | Connected to: AAAITEST
View changes and restarts Home >Summary of JMS Modules >RTI >Summary of JMS Modules >RTI >Summary of JMS Modules >RTI >Summary of JMS Modules >RTI >Summary of JMS Modules >RTI

Configuration editing is enabled. Future Create a New JMS System Module Resource

changes will automatically be activated as you

modify, add or delete items in this domain. Back| | Next | e | T

Domain Structure

AAAITEST
[#-Domain Partitions

JMS Distributed Destination Properties

The following properties will be used to identify your new Distributed Topic. The current module is RTT

 A————— * Indicates required fields
Deployments
& S?MCES What would you like to name your new destination?
=-Messaging
"IMS Servers * = — =
b--Store-and-Forward Agents Name: DistributedTopic01
i--IMS Modules
Path Services ‘What JNDI Name would you like to use to look up your new destination?
[#-Bridges
Data Sources JNDI Name:

jms/topictest
Persistent Stores

Foreion INDT Providers 4
Topic members may be either created uniformly from a common configuration, or created and weighted individually to fine tune performance. How would you like to create topic members?
How do I... =]
Destination Type: Uniform v
« Configure quotas for destinations
« Configure JMS templates The Forwarding Policy for a topic defines how messages are forwarded to members. What forwarding policy would you like to use for this new destination?
e Configure destination keys
 Configure topics Forwarding Policy: Replicated v
« Configure queues
« Configure connection factories Templates provide an efficient means of defining multiple destinations with similar configuration values. Would you like to use a template for this destination?

e Configure uniform distributed topics Template: None >

« Configure uniform distributed queues

6. Select Advanced Targeting.

Figure 145: Create a New JMS System Module Resource page

ORACLE WebLogic Server Administration Console 12¢ ‘—

Change Center @ Home Log Out Preferences [&] Record Help | Q Welcome, weblogic | Connected to: AAAITEST
View changes and restarts Home >Summary of JMS Modules >RTI >Summary of JMS Modules >RTI >Summary of JMS Modules >RTI >Summary of IMS Modules >RTI >Summary of JMS Modules >RTI
Configuration editing is enabled. Future Create a New JMS System Module Resource

changes will automatically be activated as you
modify, add or delete items in this domain.

Back| [Next |F|n|sh |AuvancedTargeung |Cance\

Domain Structure
AAAITEST
B-Domain Partitions
B-Environment
i--Deployments
=H-Services

The following properties will be used to target your new JMS system module resource

Use this page to view and accept the default targets where this IS resource will be targeted. The default targets are based on the parent JMS system module targets. If you do not want to
accept the default targets, then click Advanced Targeting to use the subdeployment mechanism for targeting this resource.

Messaging The following JMS module targets will be used as the default targets for your new JMS system module resource. If the module's targets are changed, this resource will also be retargeted
£--JMS Servers appropriately.
i Store-and-Forward Agents
£+-IMS Modules Targets :
i--Path Services
[#-Bridges
i-Data Sources (I
~~Persistent Stores
i-~Foreian INDT Providers, = IPECluster
All servers in the cluster
HowdoI... =] Part of the cluster
mnsi
« Configure quotas for destinations mns2
« Configure IMS templates

 Configure destination keys
Back | | Next | Finish | Advanced Targeting Cancel
* Configure topics — s i

o Configure queues

o Confinire connectinn factaries

7. Select RTISubdeploy from the subdeployment field drop down list and select the JMS servers
created. Click Finish. The distributed topic is successfully created.

NOTE You will receive message on successful creation of the JWS
distributed topic.
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Figure 146: Create a New JMS System Module Resource page

--Store-and-Forward Agents
£--JMS Modules Subdeployments: RTISubdeploy v | Create a New Subdeployment

t-Path Services
#+Bridges What targets do you want to assign to this subdeployment?
Data Sources
Persistent Stores

i Targets :
Foreinn INDT Providers
How do I... = R
¢ Configure quotas for destinations -
[ | Adminserver
¢ Configure JMS templates
e« Configure destination keys
Clusters
« Configure topics
» Configure queues [ 1PECluster
» Configure connection factories ') All servers in the cluster
e« Configure uniform distributed topics - Part of the cluster
‘:| mnsl
e Configure uniform distributed queues ) mns2
« Configure foreign servers
« Configure JMS SAF IMS Servers
System Status = (] smsservero1
Health of Running Servers as of 7:19 AM
& IMSServer02
[ Failed (0)
[ Critical (0) IMSServer03

Overloaded (0)

19.6 Connection Factory Creation

To create the Connection Factory, follow these steps:

NOTE Connections must be created as per the IPE Configuration guide
with the same naming convention.

1. Loginto Weblogic Console.

2. From Domain Structure Select Services and click JMS Modules from Messaging drop-down.
The Summary of JMS Module page is displayed.

Select RTI from JMS Modules table. The Settings for RTI page is displayed.

4. C(Click New and select Connection Factory from Create a New a JMS System Module Resource
page.
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Figure 147: Create a New JMS System Module Resource page

ORACLE WebLogic Server Administration Console 12¢ _

Change Center @ Home Log Out Preferences Record Help | Q Welcome, weblogic | Connected to: AAAITEST
View changes and restarts Home >Summary of JMS Modules >RTI >Summary of JMS Modules >RTI >Summary of JMS Modules >RTI >Summary of JMS Modules >RTI >Summary of JMS Modules >RTI
Configuration editing is enabled. Future Create a New JMS System Module Resource

changes will automatically be activated as you
modify, add or delete items in this domain.

Back | | Next | Finish | Cancel

Domain Structure
AAATTEST
[#-Domain Partitions
[#-Environment

Choose the type of resource you want to create.

Use these pages to create resources in a JMS system module, such as queues, topics, templates, and connection factories.

Deployments. Depending on the type of resource you select, you are prompted to enter basic information for creating the resource. For targetable resources, like stand-alone queues and topics, connection
E-Services factories, distributed queues and topics, foreign servers, and JMS SAF destinations, you can also proceed to targeting pages for selecting appropriate server targets. You can also associate
Erricsig targetable resources with subdeployments, which is an advanced mechanism for grouping JMS module resources and the members to server resources.
£-IMS Servers

Store-and-Forward Agents Connection Factory Defines a set of connection configuration parameters that are used to create
IMS Modules connections for IS clients. More Info...

£Path Services
[*-Bridges
i-Data Sources

Queue Defines a point-to-point destination type, which are used for asynchronous

peer communications. A message delivered to a queue is distributed to only
—“Persistent Stores one consumer. More Info...
i-Foreion INDT Providers =
4 = () Topic Defines a publish/subscribe destination type, which are used for
How do I... asynchronous peer communications. A message delivered to a topic is
distributed to all topic consumers. ~More Info...
« Configure quotas for destinations
 Configure IMS templates () Distributed Queue Defines a set of queues that are distributed on multiple JMS servers, but
o S AT RS which are accessible as a single, logical queue to IMS dients.  More Info...

« Configure topics

Distributed Topic Defines a set of topics that are distributed on multiple JMS servers, but which

« Configure queues are accessible as a single, logical topic to JMS clients. More Info...

« Configure connection factories

5. Enter the name and JDNI name in Name and JNDI Name Fields respectively as per the IPE
Configuration guide and click Next.

Figure 148: Connection Factory Properties page

ORACLE WebLogic Server Administration Console 12¢ _

Change Center @ Home Log Out Preferences [22] Record Help | Q ‘Welcome, weblogic | Connected to: AAAITEST|
View changes and restarts Home >Summary of JMS Modules >RTI >Summary of JMS Modules >RTI >Summary of JMS Modules >RTI >Summary of JMS Modules >RTI >Summary of JMS Modules >RTI
Configuration editing is enabled. Future Create a New JMS System Module Resource

changes will automatically be activated as you
modify, add or delete items in this domain.

Back | | Next | Finish | Cancel

Domain Structure

AAAITEST N " B " . ¥
B}-Domain Bariifions The following properties will be used to identify your new connection factory. The current module is RTL.

B-Environment * Indicates required fields

Deployments
+-Services
Messaging

Connection Factory Properties

What would you like to name your new connection factory?

* Name: ConnectionFactoryTest

What INDI Name would you like to use to look up your new connection factory?

—Data Sources JINDI Name:

jms/connectionFactory|
i-Persistent Stores

t-Foraion INDT Providers i
The Connection Factory Subscription Sharing Policy Subscribers can be used to control which subscribers can access new subscriptions. Should subscriptions created using this factory be sharable?
Howdo ... 5]
Subscription Sharing Policy: Exclusive v
« Configure quotas for destinations
* Configure JMS templates The Client ID Policy indicates whether more than one JMS connection can use the same Client ID. Oracle recommends setting the Client ID policy to Unrestricted if sharing durable subscribers.
« Configure destination keys Subscriptions created with different Client ID policies are always treated as independent subscriptions. What Client 1D Policy would you like to use?
« Configure topics
Client ID Policy: Restricted v
« Configure queues
« Configure connection factories A connection factory can limit the number of messages that can queued for an asynchronous session. Should this connection factory impose a fimit?
o Configure uniform distributed topics
» Configure uniform distributed queues Maximum Messages per Session: 10

6. Select Advanced Targeting.
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Figure 149: Create a New JMS System Module Resource page

@ Home Log Out Preferences [2] Record Help | Q Welcome, weblogic | Connected to: AAAITEST

Change Center

" Home >Summary of JMS Modules >RTI >Summary of JMS Modules >RTI >Summary of JMS Modules >RTI >Summary of JMS Modules >RTI >Summary of JMS Modules >RTI
View changes and restarts

Configuration editing is enabled. Future Create a New JMS System Module Resource
changes will automatically be activated as you
modify, add or delete items in this domain. Back| [Next | Eee | Advanced Targeting | Cancel
Domain Structure The following properties will be used to target your new JMS system module resource
AAATTEST
£¥-Domain Partitions Use this page to view and accept the default targets where this IMS resource will be targeted. The default targets are based on the parent JMS system module targets. If you do not want to
B-Environment accept the default targets, then click Advanced Targeting to use the subdeployment mechanism for targeting this resource.
Deployments
[=-services
- Messaging The following JMS module targets will be used as the default targets for your new JMS system module resource. If the module's targets are changed, this resource will also be retargeted
£--IMS Servers appropriately.
{--Store-and-Forward Agents
£--IMS Modules Targets :
t--Path Services
#-Bridges
i~-Data Sources (T
~~Persistent Stores
--Fareinn INDI Providers ad IPECluster
All servers in the cluster
Howdo L. = Part of the cluster
mnsi
« Configure quotas for destinations iR

« Configure JMS templates

« Configure destination keys
Back | | Next Finish Advanced Targeting Cancel

« Configure topics

« Configure queues

7. Select the JMS Servers created and Click Finish. The Connection Factory is successfully created.

NOTE You will receive message on successful creation of the JWS
Connection Factory.

19.7  JMS Queue Creation for SWIFT, Fedwire and ISo20022
Message Types

The JMS Queues for Fedwire and 1ISO20022 are created similar to JMS Queue for SWIFT. For more
information about JMS Queue creation, see the IPE Configuration guide.

Table 53 provides the information about the JMS queues for SWIFT, Fedwire and 1ISO2022 message
types.

Table 53: WebLogic JMS Queues - Field Value

Message
Queue Name
Type JNDI name Subdeployment
SWIFT RTISource Entity | Enter the name as Enter the JNDI Select the
Queue RTI Source Entity name as jms/ Subdeployment as
Queue sourceEntityQueue | RTISubDeploy
FedWire RTI_Source Fed Enter the name as Eg':s;t;se_gnl\il?l Select the
Entity Queue RTI Source Entity ms/. Subdeployment as
Queue sourceFedEntity- RTISubDeploy
Queue
15020022 RTI_Source Sepa Enter the name as Egtrﬁgt;se.r‘:\g?l Select the
Entity Queue RTI Source Entity sourceSe] abntity. | Subdeploymentas
Queue Queue P y RTISubDeploy
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20

Appendix I: User Group Customization

When a new user group for Transaction Filtering is created from Oracle Financial Services Analytical

Applications (OFSAA) user Interface (Ul), you must insert an entry in the CSSMS_GROUP_MAST PACK
table manually with the product id OFsS_TF.
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21 Appendix J: Configurations for the Bearer Token

e Thefollowing section takes you through the process of generating a token and using it to get the

individual or entity JSON, depending on the API request. A token is used to authorize the
request.

e You can begin by generating a password for the user who sends the request. After the password
is generated, generate a token to authorize this request. The default time for token expiration is
3600 seconds (1 hour) and can be changed. To change the validity, see Change Token Validity.

21.1 Generate User Password

To generate a password for the user, follow these steps:

1. Login as a system administrator.

2. (Click System Configuration in the Administration page and select Configure Instance Access
Token. The Configure Instance Access Token window is displayed.

Figure 1: Administration Page

ADMINISTRATION

A )
®
- -

Configure Database Server ‘ :

Configure Application Server

" Identity Management Database Details Manage OFSAA Product Create New Application Information Domain
Configure Web Server Framework to manage fine Configure OFSAA Database iicanises Create New Application Create and maintain an
Server Enable additional products Information Domain

across Application Packs

Configure OLAP Details

access management constructs

Confi System Confi ti
eRgHIE YR Ral aEnan like passwords, user roles and

Configure Email Configuration functions

Configure Instanf\ﬁ;((es; Token

Processing Modelling
Framework

Processing Modelling
Framework

3. Inthe Configure Instance Access Token section, click Add. A new window is displayed.
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Figure 2: Configure Setup Access Token

4 Configure Instance Access Token

© Reset Search

4 Configure Instance Access Token

Add

Instance Name Instance Access Token

TFLT % 97b69571-55d3-4b9b-a673-84d4ff1b5305

L]

4. Enter the username in the Instance Name field and click Generate Token. The token is
displayed in the Instance Access Token Details section.

Figure 3: Generate Token Button

4 Configure Instance Access Token

Generate Token Close

4 |nstance Access Token Details

5. Copy and save the text generated in the Instance Access Token Details section.
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Figure 4: Setup Access Token Details

4 Configure Instance Access Token

Generate Token Close

* Instance Name | TFLT

4 |nstance Access Token Details

STP_ACC_NM=TFLT
STP_ENC_STR=VEZMVDpIZTU 1NTZmZCOwYzhILTRIZmMtYTIkYi0zYmYzNDEwYmQyMDU=
STP_ACC_TKN=ee5556fd-0c8e-4bfc-a9db-3bf3410bd205

The STP_ACC_NM field displays the username. The STP_ACC_TKN field displays the password.

6. Click Close * and log out as the system administrator.

21.2 Change Token Validity

To generate a password for the user, follow these steps:
1. Login as a system administrator.

2. (Click System Configuration in the Administration page and select Configure System
Configuration. The Configuration window is displayed.

Figure 5: Administration Page

ADMINISTRATION

Nl N

Configure Database Server

Configure Application Server
Identity Management Database Details Manage OFSAA Product Create New Application Information Domain
o

Configure Web Server

Configure OLAP Details

Configure System Configuration

Configure Email Configuration

Canfigure Instance Access Token

Processing Modelling
Framework
p odelling

3. Inthe Configuration window, change the token validity time in the API token validity in
seconds field.
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Figure 6: Configuration window with the API token validity in seconds field shown
[Configuration (2]

[Configuration Save Cancel

Environment Details

Database - ORACLE Server - Unix

General Details ~ Guest Login | | Optimization | | Other:

Number of invalid logins 10

Path for Application Packaging

Session Timeout Value(in
minute)
Link based token validity in -
60
minutes

ds

API token validity in secor

3600

Enable batch operation
notification

Enable batch owner

notification only

Security Question Enable

4. C(Click Save.

21.3 Generate Token

After the password is generated, you can generate the token. To generate the token, open your API
client and follow these steps:

NOTE e You may use the desktop version of the Postman client to
perform these steps. Postman is an open-source,
collaborative platform for API development. For more
information, see Postman Docs.

e You can also use any other API client, such as cURL. For
more information, see REST APIs for Oracle Database.

1. Open the Postman client and click Create a request.
2. Select the request type as GET and enter the request URL in the following format:
##APP URL##/rest-api/auth/v1/token

Figure 7: Request

GET http://fsgbu-mum-239.snbomprshared1.gbucdsint02bom.oracleven.com:7001/SANCB12/rest-
api/auth/v1/token

Authorization @ Heade B Bod Pre-request Scri Tact

Cookies

Type Basic A.

Username TFLT

e about authorization 2 Password

------------------------------------

Show Password

3. Select the Authorization menu and then select the TYPE as Basic Auth.
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4. Enter the username and password.

The username is the value generated for the STP_ACC_NM attribute and the password is the
value generated for the STP_ACC_TKN attribute.

5. Click Send. The token is displayed in the Response field.

Figure 8: Response

Body Cookies (1) Headers (9) Test Results ﬁ? 200 OK 1815ms 988EB  Save Response v
Pretty Raw Preview Visualize JSON v = |_. Q
1 R
2 "token_type": "Bearexr",
£ "expires_in": 3600,
4 "token": "eyJlOeXAi0iJKV1QilLCJIhbGci0iJSUzIINiJ9.

eyJqdGki0iIINTBINIMzYSO3MDFmLTOZNALYhmOCOWOTAONGZKYBhZ i TiLCIpe3Mi0iIGSVIPWi s ImF1ZCI6IKIGUOFBIL
wic3ViljoiRk1ST1oilCIpYXQi0jE20DAIMDUWMT gsImV4cCI6MTYAMDUwWODY x0HO .
LEIN_80H851AwzpwoN1tx8qx3111x1LpZ0B1GBEarWvidpxudPtIEWYGzroST2bRk9IX11EDN2ZF_JImdB8XcProNxpkylIUVSmW
dY1D7aFQq6FCId-BRkScYvayq8gv_a9IW_46srvipB413ktVPBQhDPmELvBmYKwq7 TkPU-6Kwrj2IS7mfCz3bpwiH-gblusqel
LXgk5ulafN8yZDhNKWOPUYZgNjuhOAYqkNPHG2a4KAFBAGMEY3ecTOGtEK _HR1dPkzkZmAmxk2a2KxuNKgNT9hLecmu9ckRQ2cK
4tX5rbpy-CTkLdpsFo2noZF -kx0jpd9rNnxo-U9Buqv2FRbA"

21.4 Send Requests

1. Do the following configuration before sending the request using the POST request feature.

a. Gotothe path
##DOMIAN HOME##/applications/##context.ear##/##context.war##/cont

b. Openthe RestAPIConf.properties file.

c. Addthe hostname and port values inside the RestAPIConf.properties file
For Example:
hostname=fsgbu-mum-239.snbomprsharedl.gbucdsint02bom.oraclevcn.com
port=7001

2. Requests are sent using the POST request feature. Use the token generated to authorize the
request and pass the JSON in the correct format.

NOTE e You may use the desktop version of the Postman client to
perform these steps. Postman is an open-source,
collaborative platform for API development. For more
information, see Postman Docs.

e You can also use any other API client, such as cURL. For
more information, see REST APIs for Oracle Database.

3. Inthe Postman client, select the request type as POST and enter the request URL in the following
format:

m  For SWIFT: ##APP URL##/rest-api/TFService/message/postMessage-
ToQueue?queueName=sourceEntityQueue&msgCheckFlag=N

s For|SO20022: ##APP URL##/rest-api/TFService/message/postMessage-
ToQueue?queueName=sourceSepaEntityQueue&businessName=RT SEPA Message
Attributes&domain=SR&msgCheckFlag=N&externalData=Message Direc-
tion:OUTBOUND
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s For Fedwire: ##APP URL##/rest-api/TFService/message/postMessage-
ToQueue?queueName=sourceFedEntityQueue&msgCheckFlag=N

Figure 9: Request

Untitled Request

POST v httpi//[servername]:[portnumber]/[context]/restapi/RTScreening/RTScreeningRestService/service/IndividualScreen/EntityScreen m

Params Authorization @ Headers (8 Body Pre-request Script Tests Setting

Query Params

KEY VALUE DESCRIPTION

4. Inthe Authorization menu, select the TYPE as Bearer Token.

Figure 10: Authorization

Untitled Request

POST v http://[servername]:[portnumber]/[context)/restapi/RTScreening/RTScreeningRestService/service/IndividualScreen/EntityScreer m

Params Authorization @ Headers (7 Body Pre-request Script ests Settings

rated when yc nd the request Token

Paste the token generated in the Token field.
Select Body tab and select raw.

Insert the message in the text field.

Click Send.

© N o W

Figure 11: Body Tab

POST http://100.76.144.22:7011/ofsaa/rest-api/ TFService/message/postMessageToQueue?
queueName=sourceEntityQueue&msgCheckFlag=N

Params ® Authorization ® Headers (9) Body e Pre-request Script Tests etting Cookies

none form-data x-www-form-urlencoded @ raw binary GraphQL  Text ~

1: FO1SABRRUMMAXXX5356135117} {2 : 01030831180814SL BZCHZZXXXX12341234560510170831N} {4:
:20: fe2a2619aldf8548
2 RED
80814USD100,
:33B:USD160,
:50A: /18681419536
SLBZCHZZ
:52A:SLBZCHZZ
) :56A:CHASUS33
:DEUTDEFF
/18081419530
SIRIO PANEL
1 :71A:SHA
14 -3
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OFSAA Support Contact Details

Raise a Service Request (SR) in My Oracle Support (MOS) for queries related to OFSAA applications.

OFS Transaction Filtering Admin Guide| 8


https://support.oracle.com/
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Send Us Your Comments

Oracle welcomes your comments and suggestions on the quality and usefulness of this publication.
Your input is an important part of the information used for revision.

e Didyou find any errors?

e Istheinformation clearly presented?

e Do you need more information? If so, where?

e Are the examples correct? Do you need more examples?
e What features did you like most about this manual?

If you find any errors or have any other suggestions for improvement, indicate the title and part
number of the documentation along with the chapter/section/page number (if available) and contact
the Oracle Support.

Before sending us your comments, you might like to ensure that you have the latest version of the
document wherein any of your concerns have already been addressed. You can access My Oracle
Support site which has all the revised/recently released documents.
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	1. Click Financial Services Sanctions Pack.


	Figure 12: Financial Services Sanctions Pack Menu
	1. Click FEDWIRE Configuration Admin. The Configuration Screen is displayed.

	Figure 13: FEDWIRE Configuration Admin Sub-menu
	3.2.6 Process Monitor Menu

	Figure 14: Process Monitor Menu Page
	3.2.7 Run Definition Menu
	1. Click Financial Services Sanctions Pack.


	Figure 15: Financial Services Sanctions Pack Menu
	1. Click Run Definition. The Run page is displayed.

	Figure 16: Transaction Filtering Admin Sub-menu
	3.2.8 List Management Menu
	1. Click Financial Services Sanctions Pack.


	Figure 17: Financial Services Sanctions Pack Menu
	1. Click List Management. The Good Guy Summary page is displayed.

	Figure 18: List Management Sub-menu
	3.2.9 Inline Processing Menu
	1. Click Financial Services Sanctions Pack.


	Figure 19: Financial Services Sanctions Pack Menu
	1. Click Inline Processing. The Inline Processing page is displayed.

	Figure 20: Inline Processing Sub-menu

	3.3 Queue Management
	3.3.1 List View
	1. Log in to the application as Analyst, Supervisor, or Senior Supervisor.
	2. Select the Financial Services Analytical Applications Transaction Filtering.
	3. From the Application Navigation List, select Queue Management.

	Figure 21: Queue List in List View
	3.3.2 Grid View

	Figure 22: Queue List in Grid View
	NOTE
	Only Analyst/Supervisor/Senior Supervisor can view the number of alerts details in each Queue.
	3.3.3 Archiving a Queue
	1. Log on to the Customer Screening application.
	2. Click Common Tasks, then click Rule Run Framework, and then click Process. The Process page appears.
	3. Search for Queue in the Code field and select QueueArchive.

	Figure 23: Process Page
	4. Click Edit . The Process page opens in Edit mode.

	Figure 24: Process Definition (Edit Mode)
	5. Select the QueueArchival object and then select Component.
	6. In the Parameters window, select the QueuArchival task and then click drop-down list . By default the parameter value will be selected as “TF”.

	Figure 25: Component Selector Window
	7. Click OK to close the Parameters window.
	8. Click OK.
	9. Click Save.




	3.4 Troubleshooting Your Display
	3.4.1 Enabling JavaScript
	1. Navigate to the Tools menu.
	2. Click Internet Options. The Internet Options dialog box is displayed.
	3. Click the Security tab and then click Local Intranet.
	4. Click Custom Level. The Security Settings dialog box is displayed.
	5. In the Settings list and under the Scripting setting, select all options.
	6. Click OK, then click OK again to exit the Internet Options dialog box.

	3.4.2 Enabling Cookies
	3.4.3 Enabling Temporary Internet Files
	1. Navigate to the Tools menu.
	2. Click Internet Options. The Internet Options dialog box is displayed.
	3. On the General tab, click Settings. The Settings dialog box is displayed.
	4. Click Every visit to the page.
	5. Click OK, then click OK again to exit the Internet Options dialog box.

	3.4.4 Enabling File Downloads
	1. Navigate to the Tools menu.
	2. Click Internet Options. The Internet Options dialog box is displayed.
	3. Click the Security tab and then click Local Intranet.
	4. Click Custom Level. The Security Settings dialog box is displayed.
	5. Under the Downloads section, ensure that Enable is selected for all options.
	6. Click OK, then click OK again to exit the Internet Options dialog box.

	3.4.5 Setting Printing Options
	1. Navigate to the Tools menu.
	2. Click Internet Options. The Internet Options dialog box is displayed.
	3. Click the Advanced tab. In the Settings list.
	4. Under the Printing setting, click Print background colors and images.
	5. Click OK to exit the Internet Options dialog box.

	NOTE
	For best display results, use the default font settings in your browser.
	3.4.6 Enabling the Pop-Up Blocker
	1. Navigate to the Tools menu.
	2. Click Internet Options. The Internet Options dialog box is displayed.
	3. Click the Privacy tab. In the Pop-up Blocker setting, select Turn on Pop-up Blocker. The Settings are enabled.
	4. Click Settings to open the Pop-up Blocker Settings dialog box.
	5. In the Pop-up Blocker Settings dialog box, enter the URL of the application in the text area.
	6. Click Add. The URL appears in the Allowed Sites list.
	7. Click Close, then click Apply to save the settings.
	8. Click OK to exit the Internet Options dialog box.

	3.4.7 Setting Preferences
	1. In the Financial Services Analytical Applications Transactions Filtering landing page, select Preferences from the user name drop-down list. The Preferences page is displayed.

	Figure 26: Preferences Page
	1. In the Set My Home Page drop-down list, select the window that you want to view when you log in.
	2. In the Date Format drop-down list, select the date format that you want to see. The options available are dd/MM/yyyy or M/dd/yyyy.
	3. Click Save to save your preferences.





	4 Managing User Administration
	4.1 About User Administration
	4.2 Managing User Administration
	Table 3: User Administration
	Action
	Description
	Creating and Authorizing a User
	Create a user. This involves providing a user name, user designation, and the dates between which the user is active in the system.
	Mapping a User with a User Group
	Map a user to a user group. This enables the user to have certain privileges that the mapped user group has.
	4.2.1 Creating and Authorizing a User
	4.2.2 Mapping Users with User Groups


	Table 4: User Group-Role Mapping
	Role
	Group Name
	User Group Code
	Administrator
	Transaction Filtering Administrator Group
	TFLTADMINISTATORGRP
	Analyst
	Transaction Filtering Analyst Group
	TFLTANALYSTGRP
	Supervisor
	Transaction Filtering Supervisor Group
	TFLTSUPERVISORGRP
	Senior Supervisor
	Transaction Filtering Senior Supervisor Group
	TFSNRRSUPERVISORGRP
	Audit
	Transaction Filtering Audit Group
	TFAUDITGRP



	5 General Configurations
	5.1 Configuring the Application Level Parameters
	1. Navigate to the Financial Services Analytical Applications Transactions Filtering landing page.
	2. Click Transaction Filtering Admin. The Application Level Parameter Configuration is displayed.
	Figure 27: Application Level Parameter Configuration Tab
	3. In the Audit section, select Yes to view the Debug details or select No to view the Info details.

	NOTE
	For more information on the values in the Status column, see System Audit Logging Information.
	4. In the 4 Eyes section, select Yes to enable the four-eyes workflow and select No to disable the four-eyes workflow.


	NOTE
	If the 4 Eyes workflow is enabled, then the new alert data should be posted to the UI to view the new options which are Message Statuses, Blocked Recommended and Released Recommended.
	5. In the EDQ section, provide the following values:
	6. In the ECM L2 Analysis section, select Yes to enable and then provide the following values:
	7. In the FEEDBACK section, enter the URL where we need to post messages for HOLD, RELEASE, CLEAN, BLOCK in the feedback queue in the FEEDBACK URL field.
	8. Click Save. The following confirmation message is displayed: Records Updated Successfully.



	5.2 Configuring the Good Guy Matching Parameters
	1. Navigate to the Financial Services Analytical Applications Transactions Filtering landing page.
	2. Click Transaction Filtering Admin and then click the Good Guy Matching Configuration tab.
	Figure 28: Good Guy Matching Configuration Tab

	5.3 Configuring the SLA Parameters
	NOTE
	The SLA time must be defined in HH:MM:SS format.
	1. Navigate to the Financial Services Analytical Applications Transactions Filtering landing page.
	2. Click Transaction Filtering Admin and then click the SLA Configuration tab.
	Figure 29: SLA Configuration Tab
	3. Enter the SLA time in HH:MM:SS format.
	4. Select an automatic action for an alert that is overdue. You can do one of the following:
	5. Select Yes to enable a specific combination, else select No.
	6. To create a combination, use the following conditions. This is an optional step.

	Table 5: General Actions
	To...
	Do this...
	Add a configuration
	Click Add. The values appear in a tabular format.
	Update a configuration
	Select the configuration you want to update, update the value of one or more fields, and click Update. The updated value is displayed in the table.
	Remove a configuration
	Select the configuration you want to remove and click Remove. The selected configuration is removed from the table.
	Clear the values of some of the fields in a configuration
	Click Clear. You can only clear the values of the Cut-Off Time, Currency, and Amount fields.
	Enable all configurations
	Click Enable All.
	Disable all configurations
	Click Disable All.




	5.4 Automatic Assignments of Alerts
	NOTE
	The Transaction Filtering application assigns all new alerts to the Analyst by default.
	Alerts cannot be assigned to a user who is mapped to the Admin role.

	NOTE
	You cannot change the mode of assignment from automatic to manual for an alert that is already assigned. You can only select a mode of assignment for new alerts.
	1. Navigate to the Financial Services Analytical Applications Transactions Filtering landing page.
	2. Click Transaction Filtering Admin and then click the Auto Assignment Configuration tab.
	3. Select Automatic to auto-assign the alert to the selected role. Select Manual to manually assign an alert to the selected user.
	Figure 30: Auto Assignment Configuration Tab with Based on Load Balancing Selection
	Figure 31: Auto Assignment Configuration Tab Custom Criteria with Combination of Load Balancing
	Table 6: General Actions
	To...
	Do this...
	Add a configuration
	Click Add. The values appear in a tabular format.
	Update a configuration
	Select the configuration you want to update, update the value of one or more fields, and click Update. The updated value is displayed in the table.
	Remove a configuration
	Select the configuration you want to remove and click Remove. The selected configuration is removed from the table.
	Clear the values of some of the fields in a configuration
	Click Clear. You can only clear the values of the Currency and
	Amount fields.
	Enable all configurations
	Click Enable All.
	Disable all configurations
	Click Disable All.




	5.5 Configuring the Cut-Off Parameters for Alerts
	NOTE
	The cut-off time must be defined in HH:MM:SS format and will be based on your locale.

	NOTE
	If you set different cut-off times, ensure that you define the conditions in such a way that the cut-off time defined for a specific set of conditions does not overwrite the cut-off time defined for another set of conditions.
	1. Navigate to the Financial Services Analytical Applications Transactions Filtering landing page.
	2. Click Transaction Filtering Admin and then click the Cut-Off Configuration tab.
	Figure 32: Cut-Off Configuration Tab
	3. Enter the cut-off time in HH:MM:SS format. This is the time period by when the alert must be closed by the investigator.
	4. Enter the locale. The cut-off time is displayed based on your selection.
	5. Select Yes to enable a specific combination, else select No.
	6. To create a combination, use the following conditions. This is an optional step.

	Figure 33: General Actions
	To...
	Do this...
	Add a configuration
	Click Add. The values appear in a tabular format.
	Update a configuration
	Select the configuration you want to update, update the value of one or more fields, and click Update. The updated value is displayed in the table.
	Remove a configuration
	Select the configuration you want to remove and click Remove. The selected configuration is removed from the table.
	Clear the values of some of the fields in a configuration
	Click Clear. You can only clear the values of the Cut-Off Time, Currency, and Amount fields.
	Enable all configurations
	Click Enable All.
	Disable all configurations
	Click Disable All.



	5.6 Setting the Priority for Messages
	NOTE
	The ready-to-use application extracts some of the key fields of the message into the FSI_RT_MSG_TAG table.
	1. Run the following query to view the SETUP_RT_PARAMS table:
	2. Search for the MESSAGE_PRIORITY value in the V_PARAM_NAME column.
	3. In the V_ATTRIBUTE_VALUE1 column, write the query or function to define the priority.



	5.7 Running the Purge Utility
	NOTE
	The archival period can be configured by users who have the required permissions under each legal entity policy or local data protection requirements. The archival period also applicable for the AdminGuide_Transaction Filtering_8.0. 7.0.0 and AdminGu...
	1. Go to the purgeTF.sh file in the <installed area>/ficdb/bin/ directory and replace the ##Infodom## placeholder with the name of your Infodom.
	2. Run the purge utility from the <installed area>/ficdb/bin/ directory using the following command:
	3. Verify the purge logs in the following directory:



	5.8 Adding, Editing or Deleting Good Guy Records
	5.8.1 Adding a Good Guy Record
	1. Click List Management on the Financial Services Analytical Applications Transactions Filtering landing page.
	2. In the Good Guy Summary section, click Add . A pop-up window is displayed.

	Figure 34: Good Guy Summary Pop-up Window
	3. Enter the required details.
	4. Click Save.
	5.8.2 Editing a Good Guy Record
	1. In the Good Guy Summary section, click Actions.
	2. From the drop-down list, click Edit.
	3. Make the necessary changes to the record.
	4. Enter your reasons for editing the record.
	5. Click Save.
	5.8.2.1 Updating the Status of an Expired Alert

	5.8.3 Deleting a Good Guy Record
	1. In the Good Guy Summary section, click Actions.
	2. From the drop-down list, click Delete.
	3. Enter your reasons for deleting the record.
	4. Click Save.

	5.8.4 Good Guy Attributes
	1. WL - entities - prepared data:
	2. WL - individuals - prepared data

	5.8.5 Managing the Good Guy Attributes
	1. From the EDQ URL, open the Director and the Transaction_Screening Project.


	Figure 35: Transaction Screening Project
	2. From Processes, open the Name & Address Match.

	Figure 36: Name and Address Match
	3. Expand the group and double click “Concatenates the flag columns which makes the Hash Key”.
	4. You can map and unmap required set of attributes to make the hash key.

	Figure 37: Attributes for Concatenates the flag columns which makes the Hash Key

	5.9 Generating Email for Different Statuses
	5.9.1 Notification Email
	5.9.2 Task Email

	5.10 Configuring Alerts in Multiple Jurisdictions and Business Domains
	NOTE N
	All jurisdictions in the system reside in the FCC_SWIFT_JSRDSN_MAP table.

	NOTE
	All business domains in the system reside in the FCC_SWIFT_BUS_DMN_MAP table.
	5.10.1 Configuring Jurisdictions and Business Domains
	1. Load all the jurisdictions. To do this, run the query SELECT * FROM FCC_SWIFT_JSRDSN_MAP and load the jurisdictions in the V_JRSDCN_CD column in the FCC_SWIFT_JSRDSN_MAP table.

	Table 7: Columns used to provide additional information for Jurisdictions
	Column
	Data Type and Length
	V_EXTRACTED_SWIFT_FIELD
	VARCHAR2(100 CHAR)
	V_JRSDCN_CD
	VARCHAR2(40 CHAR)
	V_CUST_COLUMN_1
	VARCHAR2(4000 CHAR)
	V_CUST_COLUMN_2
	VARCHAR2(4000 CHAR)
	V_CUST_COLUMN_3
	VARCHAR2(4000 CHAR)
	V_CUST_COLUMN_4
	VARCHAR2(4000 CHAR)
	N_CUST_COLUMN_1
	NUMBER(20)
	N_CUST_COLUMN_2
	NUMBER(20)
	N_CUST_COLUMN_3
	NUMBER(20)
	N_CUST_COLUMN_4
	NUMBER(20)
	2. Load all the business domains in the V_BUS_DMN_CD column in the FCC_SWIFT_BUS_DMN_MAP table.


	Table 8: Columns used to provide additional information for Business Domains
	Column
	Data Type and Length
	V_EXTRACTED_SWIFT_FIELD
	VARCHAR2(100 CHAR)
	V_JRSDCN_CD
	VARCHAR2(40 CHAR)
	V_CUST_COLUMN_1
	VARCHAR2(4000 CHAR)
	V_CUST_COLUMN_2
	VARCHAR2(4000 CHAR)
	V_CUST_COLUMN_3
	VARCHAR2(4000 CHAR)
	V_CUST_COLUMN_4
	VARCHAR2(4000 CHAR)
	N_CUST_COLUMN_1
	NUMBER(20)
	N_CUST_COLUMN_2
	NUMBER(20)
	N_CUST_COLUMN_3
	NUMBER(20)
	N_CUST_COLUMN_4
	NUMBER(20)
	3. Map user groups to the appropriate jurisdiction and business domain. To do this, run the query SELECT * FROM DOMAIN_JUR_GRP_MAP and do the mapping in the DOMAIN_JUR_GRP_MAP table and map with the additional columns STATUS_CD, ALERT_TYPE_CD.




	NOTE
	Refer N_SANCTION_STATUS_CODE column from DIM_SANCTIONS_STATUS table for list of Status codes.
	Refer N_ALERT_TYPE_CODE column from DIM_SANC_TF_ALERT_TYPE table for list of alert types.
	4. Put the appropriate SQL query in the Message_jurisdiction and Message_Business_Domain rows to derive the jurisdiction and business domain respectively in the Setup_Rt_Params table.
	5.10.2 Configurations to Automatically Assign Transactions
	5.10.3 Configurations to Automatically Release Transactions



	5.11 Version Control
	5.11.1 Version Control for SWIFT Messages and IPE
	1. Export the new file using the and save it in your local drive.
	2. Import the file into the Transaction Filtering application.

	5.11.2 Version Control for ISO20022
	1. Export the new file and save it in your local drive.
	2. Import the file into the Transaction Filtering application.
	3. You can now compare this file with another file. Ensure that you place these files in separate folders.

	5.11.3 Version Control for EDQ
	1. In the EDQ application, copy the two different versions of the .dxi files into the EDQ Director menu.
	2. Click View and select Configuration Analysis in the EDQ Director menu.
	3. In the popup which appears, select the versions that you want to compare.
	4. Click Configuration.
	5. In the popup which appears, select the differences only and click OK.
	6. In the same window, select Start Comparison. This gives all changes between the two files.


	5.12 Running the Migration Utility for SWIFT and Fedwire
	1. Navigate to the TF_Swift_Migration_Utility/config directory.
	2. Open the Dynamic.properties file and update the placeholders as shown:
	Table 9: Configurations required in the Dynamic.properties file when running the export file
	Placeholder
	Update with...
	##jdbcurl##
	Your JDBC URL.
	##username##
	The Atomic Schema user name using which you want to execute the files.
	##password##
	The Atomic Schema password for the user name.
	##infodom##
	Your Infodom name.
	##SWIFT_MSG_ID##
	Your SWIFT ID. This is available in the n_sanction_swift_msg_id column in the dim_sanctions_swift_details table.
	If you are providing multiple IDs, add the IDs separated by commas. For example, 1,2,3,4.
	3. Navigate to the TF_Swift_Migration_Utility/bin directory and run the export.sh SWIFTMSGEXPORT MSG_TYPES command.


	WARNING
	Do not change the folder name to MSG_TYPES. This will overwrite the ready-to-use message types provided with the utility.
	1. Navigate to the FIC_HOME/Transaction_Processing/TF_Swift_Migration_Utlity/ config directory.
	2. Open the SWIFT_MSG_TYPES.txt file and add the message types that you want to import to the Exported folder mentioned in the export configuration steps.
	3. Open the Dynamic.properties file and update the placeholders as shown:
	Table 10: Configurations required in the Dynamic.properties file when running the import file
	Placeholder
	Update with...
	##jdbcurl##
	Your JDBC URL.
	##username##
	The Atomic Schema user name using which you want to execute the files.
	##password##
	The Atomic Schema password for the user name.
	4. Navigate to the TF_Swift_Migration_Utlity/bin directory and run the import.sh SWIFTMSGIMPORT MSG_TYPES command.




	WARNING
	Do not change the folder name to MSG_TYPES. This will overwrite the ready-to-use message types provided with the utility.
	5.12.1 Restoring a Previous Message Configuration
	1. Export the message configuration from the environment.



	NOTE
	Ensure that you save the configuration.
	2. To restore the previous version, Import the saved configuration.



	5.13 Running the Migration Utility for ISO20022
	1. Navigate to the $FIC_HOME/Transaction_Processing/TF_Config_Migration_Utility/config directory.
	2. Open the Dynamic.properties file and update the placeholders as shown:
	Table 11: Configurations required in the Dynamic.properties file when running the export file
	Placeholder
	Update with...
	##jdbcurl##
	Your JDBC URL.
	##username##
	The Atomic Schema user name using which you want to execute the files.
	##password##
	The Atomic Schema password for the user name.
	##infodom##
	Your Infodom name.
	##N_XSD_CONF_ID##
	Your ISO20022 ID. This is available in the n_xsd_conf_id column in the fcc_tf_xml_xsd_conf table.
	If you are providing multiple IDs, add the IDs separated by commas. For example, 1,2,3,4.
	3. Navigate to the TF_Config_Migration_Utility/bin directory and run the required command.
	1. Navigate to the TF_Config_Migration_Utility/config directory.
	2. Open the Dynamic.properties file and update the placeholders as shown:


	Table 12: Configurations required in the Dynamic.properties file when running the import file
	Placeholder
	Update with...
	##jdbcurl##
	Your JDBC URL.
	##username##
	The Atomic Schema user name using which you want to execute the files.
	##password##
	The Atomic Schema password for the user name.
	##infodom##
	Your Infodom name.
	##N_XSD_CONF_ID##
	Your ISO20022 ID. This is available in the n_xsd_conf_id column in the fcc_tf_xml_xsd_conf table.
	If you are providing multiple IDs, add the IDs separated by commas. For example, 1,2,3,4.
	3. Navigate to the TF_Config_Migration_Utility/bin directory and run the required command.



	5.14 Configuring JMS Correlation ID
	Figure 38: JMS Message Output Queue

	5.15 Configuring Parallel Processing
	5.16 Configuring Additional Columns on the Alert List page
	1. Add an entry in this table "FCC_SANC_LIST_PAGE_CONFIG" to configure a new value in the column drop-down section for FSI_RT_ALERTS
	NOTE
	"COLUMN_NAME" column must have alias column name value in the parent table like caseId, bicCodeKey and so on.
	2. Add an entry in this table "FCC_SAN_LIST_CONFIG" to configure a new value in the filter search section for TF_LIST_FILTER.
	3. Add an entry in this table "FCC_SAN_LIST_CONFIG_TL" to configure a new value in the filter search section.


	NOTE
	N_CONFIG_ID column value in this table must match with N_CONFIG_ID value in "fcc_san_list_config" table..
	4. Update "v_query" column in table "FCC_SANC_LIST_PAGE_QUERY_CONF" where "V_QUERY_IDENTIFIER" column value is ‘TF_ALERTLIST_GRID', with the new column details in select query to get the data for new column.
	5. Update "v_query" column in table "FCC_SANC_LIST_PAGE_QUERY_CONF" where "V_QUERY_IDENTIFIER" column value is ‘TF_ALERTLIST_GRID_FROM_QUEUE', with the new column details in select query to get the data for new column.
	6. Update "v_query" column in table "FCC_SANC_LIST_PAGE_QUERY_CONF" where "V_QUERY_IDENTIFIER" column value is ‘TF_CLOSED_ALERT_GRID', with the new column details in select query to get the data for new column
	7. This is an optional step.Do not follow the below steps if you are trying to configure the column from the existing listed tables in the query do not follow the below steps. If not, follow the below step,



	5.17 Retrigger Functionality
	5.17.1 Configuring Data Source in WebLogic Application Server
	1. Open WebLogic Application Server. For more information, see Oracle Financial Services Sanctions Pack Installation and Configuration Guide.
	2. From the LHS menu (Domain Structure), click Services Data Sources. The Summary of JDBC Data Sources window is displayed.
	3. Select SANCINFO from the Data Sources table. The Settings for SANCINFO window is displayed.
	4. Select the Connection Pool tab.
	5. Click Advanced. The Advanced informations are displayed.
	6. Click and select the Test Connections On Reserve Check box and enter the value as SQL IS VALID in Test Table Name.
	7. Click Save.


	5.18 Configuring New Watchlist Summary Field Name
	1. Access the Config schema and access the messages_en_US table.
	2. Map the new field names in messages_en_US table as below:
	NOTE
	The remaining parameter entries can be same as other entries in the table.



	6 Configuring the SWIFT Message Parameters
	1. Navigate to the Financial Services Analytical Applications Transactions Filtering landing page.
	2. Click SWIFT Configuration Admin. The Message and Screening Configurations tab is displayed.
	NOTE
	The following screens are the same for the Fedwire and SWIFT message parameters.

	6.1 Message and Screening Configurations Window
	Figure 39: Sample format for MTC11/MTC22/MTC33/MTC44 SWIFT message type
	Figure 40: Message and Screening Configurations Window for SWIFT
	6.1.1 Adding or Updating a New Message Type
	1. Click the Add/Update button. The Attachment Details window is displayed.
	2. Select the type of message that you want to add or update from the drop-down list.


	Figure 41: Attachment Details Window
	3. To upload an attachment, click Choose File . You can upload only one attachment at a time.

	NOTE
	This file must be of the format .json or .txt.
	4. Click Upload.
	5. Click Submit. The message is displayed in the following table as <Message Type_draft>.
	6.1.2 Repeating Sequences
	6.1.3 Configuring Message and Transaction References
	Figure 42: Reference Configuration Window



	6.2 <Message Type> Subfield Level Configuration Window
	Figure 43: <Message Type> Subfield Level Configuration Window
	1. To add a subfield, provide the required values in the fields shown in the window and click Add . Enter values in the following fields:

	Table 13: Fields in the <Message Type> Subfield Level Configuration Window
	Fields
	Field Description
	Expression Identifier
	Enter a unique identifier. It must begin with an alpha character and must not contain any spaces. This is a mandatory field.
	Expression Name
	Enter a name for the expression. The name must be in capital letters. This is a mandatory field.
	Expression Description
	Enter a description for the Expression. This is a mandatory field.
	Field
	This field displays a complete list of fields in the drop-down for the given message type. Select the field from this drop-down field to configure the expression.
	Field/Subfield Name
	This field displays the respective field name or subfield options for the field that was previously selected. Select the subfield from the drop- down list.
	Subfield Expression Format & Occurrence
	This field is populated when the Field is selected. Select an expression as it as or an element from that expression. You can also enter the number of occurrences for the expression within that message. By default, it is always 1.
	Add button
	To add a subfield, provide the required values in the fields shown above and click Add .
	Update button
	To update an existing subfield, click the name of the subfield. After you make the changes, click Update .
	Remove button
	To remove an existing subfield, click the name of the subfield and click Remove .
	Clear button
	To clear the data in these fields, click Clear .
	2. To update an existing subfield, click the name of the subfield. After you make the changes, click Update.
	3. To remove an existing subfield, click the name of the subfield and click Remove.
	4. To clear the data in these fields, click Clear.



	6.3 <Message Type> Screening Configuration Window
	Figure 44: <Message Type> Screening Configuration Window
	Table 14: Fields in the <Message Type> Screening Configuration Window
	Fields
	Field Description
	Screening WebService
	Select a screening web service from the drop-down list. This field lists all the supported matching web services in the Transaction Filtering application. The following web services are available:
	· Identifier
	· Country and City
	· Goods Screening
	· Name and Address
	· Narrative or Free Text Information
	· Port Screening

	The fields for all web services except Goods Screening are as shown here. For information on the fields for Goods Screening, see Fields for Goods Web Services.
	Expression (ID-Name)
	Select an expression identifier. When you select an expression identifier, the values are populated in the Field and Field/Subfield Name fields.
	Field
	Select the field name.
	Field/Subfield Name
	Select the subfield name. This displays the expression.
	Enable
	Select Yes to enable the web service. Select No to disable the web service.
	Message Direction
	Select INBOUND(o) and OUTBOUND(i) based on the screening requirement from the drop-down list. If a field must be screened only for incoming messages, select inbound, else select outbound. If that field must be screened for both inbound and outbound, ...
	Jurisdiction
	Select All to apply the Webservice for all jurisdictions or select the specific jurisdiction to apply the webservice for a specific jurisdiction.
	Use the kdd_jrsdcn table to configure the jurisdiction values. It has the following columns:
	JRSDCN_CD: Values must be unique.
	JRSDCN_NM: Actual jurisdiction name.
	JRSDCN_DSPLY_NM: Jurisdiction name displayed in the Message and Configurations screen.
	JRSDCN_DESC_TX: Optional field to adbusinesd descriptions for the jurisdictions.

	Add button
	To add a web service, provide the required values in the fields shown above and click Add.
	Update button
	To update a web service, select the web service that you want to update and click Update.
	Remove button
	To remove a web service, select the web service that you want to remove and click Remove.
	Enable All button
	To enable all web services, click Enable All.
	Disable All button
	To disable all web services, click Disable All.
	Figure 45: Fields for Goods Web Services


	Table 15: Fields in the Goods Web Service Window
	Fields
	Field Description
	Expression Identifier
	Select the Expression for the good.
	Tag
	Select the tag related to the good. Based on the tag selected, the field name is populated.
	Field Name
	The field name is populated based on the tag selected.
	Message Direction
	Select INBOUND(o) and OUTBOUND(i) based on the screening requirement from the drop-down list. If a field must be screened only for incoming messages, select inbound, else select outbound. If that field must be screened for both inbound and outbound, ...
	Enable
	Select Yes to enable the message in a direction. Select No to disable the message in a direction.
	Add button
	To add a web service, provide the required values in the fields shown above and click Add.
	Update button
	To update a web service, select the web service that you want to update and click Update.
	Remove button
	To remove a web service, select the web service that you want to remove and click Remove.
	Enable All button
	To enable all web services, click Enable All.
	Disable All button
	To disable all web services, click Disable All.
	6.3.1 Enabling or Disabling a Web Service


	Table 16: Web Services in Transaction Filtering
	Web Service
	Web Service ID
	Name and Address
	Name and Address
	BIC
	BIC
	Country and City
	Country and City
	Narrative or Free Text Information
	Narrative or Free Text Information
	Port Screening
	Port Screening
	Goods Screening
	Goods Screening
	6.3.2 Updating and Removing a Web Service
	6.3.3 Populating Data for the Trade Goods and Trade Port Web Services
	1. In the EDQ Director menu, go to the Watch List Management project.
	2. Right-click on the Reference Data Refresh job.
	3. Click Run. Provide a unique run label and run profile.
	4. When you run this job, the port and goods reference data are refreshed at the same time.
	5. Go to the Transaction Filtering project.
	6. Right-click on the MAIN-Shutdown Real-time Screening job to shut down all web services.
	7. Click Run.
	8. Right-click on the MAIN job to restart all web services.
	9. Click Run.




	6.4 <Message Type> Other Field/Subfield Configuration Window
	Figure 46: <Message Type> Other Field/Subfield Configuration Window
	Table 17: Fields in the <Message Type> Other Field/Subfield Configuration Window
	Fields
	Field Description
	Generic Business Data
	This field displays the Business Name of the record that is selected. It is mandatory to configure this field.
	If the message contains one or more of the B, C, D, or E sequences, you must configure the field with the first tag of the sequence according to the SWIFT standard.
	Message Direction
	Select INBOUND(o) and OUTBOUND(i) based on the screening requirement from the drop-down list. If a field must be screened only for incoming messages, select inbound, else select outbound. If that field must be screened for both inbound and outbound, ...
	Expression (ID-Name)
	Select an expression identifier. When you select an expression identifier, the values are populated in the Field and Field/Subfield Name fields.
	Field
	Select the field name.
	Field/Subfield Name
	Select the Subfield Name. This displays the Expression.
	Add button
	To add a web service, provide the required values in the fields shown above and click Add.
	Update button
	To update a web service, select the web service that you want to update and click Update.
	Remove button
	To remove a web service, select the web service that you want to remove and click Remove.



	7 Configuring the Fedwire Message Parameters
	1. Navigate to the Financial Services Analytical Applications Transactions Filtering landing page.
	2. Click FEDWIRE Configuration Admin. The Message and Screening Configurations tab is displayed.
	NOTE
	The following screens are the same for the Fedwire and SWIFT message parameters.
	Figure 47: Message and Screening Configurations tab for Fedwire


	7.1 Message Type Configuration Window
	Figure 48: Sample Fedwire Message
	Figure 49: Message and Screening Configurations tab for Fedwire
	7.1.1 Adding or Updating a New Message Type
	1. Click Add/Update. The Attachment Details window is displayed.
	2. Select the type of message that you want to add or update from the drop-down list.


	Figure 50: Attachment Details Window
	3. To upload an attachment, click Choose File . You can upload only one attachment at a time.

	NOTE
	This file must be of the format .json or .txt.
	4. Click Upload.
	5. Click Submit. The message is displayed in the following table as <Message Type_draft>.
	7.1.2 Configuring Message and Transaction References
	Figure 51: Reference Configuration Window



	7.2 <Message Type> Subfield Level Configuration Window
	Figure 52: <Message Type> Subfield Level Configuration Window
	1. To add a subfield, provide the required values in the fields shown in the window and click Add . Enter values in the following fields:

	Table 18: Fields in the <Message Type> Subfield Level Configuration Window
	Fields
	Field Description
	Expression Identifier
	Enter a unique identifier. It must begin with an alpha character and must not contain any spaces. This is a mandatory field.
	Expression Name
	Enter a name for the expression. The name must be in capital letters. This is a mandatory field.
	Expression Description
	Enter a description for the Expression. This is a mandatory field.
	Field
	This field displays a complete list of fields in the drop-down for the given message type. Select the field from this drop-down field to configure the expression.
	Field/Subfield Name
	This field displays the respective field name or subfield options for the field that was previously selected. Select the subfield from the drop- down list.
	Subfield Expression
	Format & Occurrence
	This field is populated when the Field is selected. Select an expression as it as or an element from that expression. You can also enter the number of occurrences for the expression within that message. By default, it is always 1.
	Add button
	To add a subfield, provide the required values in the fields shown above and click Add .
	Update button
	To update an existing subfield, click the name of the subfield. After you make the changes, click Update.
	Remove button
	To remove an existing subfield, click the name of the subfield and click Remove.
	Clear button
	To clear the data in these fields, click Clear .


	7.1 <Message Type> Screening Configuration Window
	Figure 53: <Message Type> Screening Configuration Window
	Table 19: Fields in the <Message Type> Screening Configuration Window
	Fields
	Field Description
	Screening WebService
	Select a screening web service from the drop-down list. This field lists all the supported matching web services in the Transaction Filtering application. The following web services are available:
	· BIC
	· Country and City
	· Goods Screening
	· Name and Address
	· Narrative or Free Text Information
	· Port Screening

	The fields for all web services except Goods Screening are as shown here. For information on the fields for Goods Screening, see .
	Expression (ID-Name)
	Select an expression identifier. When you select an expression identifier, the values are populated in the Field and Field/Subfield Name fields.
	Field
	Select the field name.
	Field/Subfield Name
	Select the subfield name. This displays the expression.
	Enable
	Select Yes to enable the web service. Select No to disable the web service.
	Message Direction
	Select INBOUND(o) and OUTBOUND(i) based on the screening requirement from the drop-down list. If a field must be screened only for incoming messages, select inbound, else select outbound. If that field must be screened for both inbound and outbound, ...
	Jurisdiction
	Select All to apply the Webservice for all jurisdictions or select the specific jurisdiction to apply the webservice for a specific jurisdiction.
	Use the kdd_jrsdcn table to configure the jurisdiction values. It has the following columns:
	· JRSDCN_CD: Values must be unique.
	· JRSDCN_NM: Actual jurisdiction name.
	· JRSDCN_DSPLY_NM: Jurisdiction name displayed in the Message and Configurations screen.
	· JRSDCN_DESC_TX: Optional field to add descriptions for the jurisdictions.

	Add button
	To add a web service, provide the required values in the fields shown above and click Add.
	Update button
	To update a web service, select the web service that you want to update and click Update.
	Remove button
	To remove a web service, select the web service that you want to remove and click Remove.
	Enable All button
	To enable all web services, click Enable All.
	Disable All button
	To disable all web services, click Disable All.
	Figure 54: Fields for Goods Web Services


	Table 20: Fields in the Goods Web Service Window
	Fields
	Field Description
	Expression Identifier
	Select the Expression for the good.
	Tag
	Select the tag related to the good. Based on the tag selected, the field name is populated.
	Field Name
	The field name is populated based on the tag selected.
	Message Direction
	Select INBOUND(o) and OUTBOUND(i) based on the screening requirement from the drop-down list. If a field must be screened only for incoming messages, select inbound, else select outbound. If that field must be screened for both inbound and outbound, ...
	Enable
	Select Yes to enable the message in a direction. Select No to disable the message in a direction.
	Add button
	To add a web service, provide the required values in the fields shown above and click Add.
	Update button
	To update a web service, select the web service that you want to update and click Update.
	Remove button
	To remove a web service, select the web service that you want to remove and click Remove.
	Enable All button
	To enable all web services, click Enable All.
	Disable All button
	To disable all web services, click Disable All.
	7.1.1 Enabling or Disabling a Web Service


	Table 21: Web Services used in Transaction Filtering
	Web Service
	Web Service ID
	Name and Address
	Name and Address
	BIC
	BIC
	Country and City
	Country and City
	Narrative or Free Text Information
	Narrative or Free Text Information
	Port Screening
	Port Screening
	Goods Screening
	Goods Screening
	7.1.2 Updating and Removing a Web Service
	7.1.3 Populating Data for the Trade Goods and Trade Port Web Services
	1. In the EDQ Director menu, go to the Watch List Management project.
	2. Right-click on the Reference Data Refresh job.
	3. Click Run. Provide a unique run label and run profile.
	4. When you run this job, the port and goods reference data are refreshed at the same time.
	5. Go to the Transaction Filtering project.
	6. Right-click on the MAIN-Shutdown Real-time Screening job to shut down all web services.
	7. Click Run.
	8. Right-click on the MAIN job to restart all web services.
	9. Click Run.




	7.2 <Message Type> Other Field/Subfield Configuration Window
	Figure 55: Other Field/Subfield Configuration Window
	Table 22: Fields in the <Message Type> Other Field/Subfield Configuration Window
	Fields
	Field Description
	Generic Business Data
	This field displays the business name of the record that is selected. It is mandatory to configure this field.
	If the message contains one or more of the B, C, D, or E sequences, you must configure the field with the first tag of the sequence according to the Fedwire standard.
	Message Direction
	Select INBOUND(o) and OUTBOUND(i) based on the screening requirement from the drop-down list. If a field must be screened only for incoming messages, select inbound, else select outbound. If that field must be screened for both inbound and outbound, ...
	Expression (ID-Name)
	Select an expression identifier. When you select an expression identifier, the values are populated in the Field and Field/Subfield Name fields.
	Field
	Select the field name.
	Field/Subfield Name
	Select the Subfield Name. This displays the Expression.
	Add button
	To add a web service, provide the required values in the fields shown above and click Add.
	Update button
	To update a web service, select the web service that you want to update and click Update.
	Remove button
	To remove a web service, select the web service that you want to remove and click Remove.



	8 Configurations for ISO20022 Message Parameters
	NOTE
	The XPath of an element is the logical structure or hierarchy of the element within the XSD file.

	8.1 Configuring the ISO20022 Message Parameters
	1. On the Financial Services Analytical Applications Transactions Filtering landing page, click ISO20022/XML Configuration Admin. The Configuration window is displayed.
	Figure 56: Configuration Window - ISO20022
	2. To upload a new XSD file, click Add Message. An Attachment Details dialog box opens.

	Figure 57: Add Message Dialog Box
	3. Select the message provider and message type for the web service. If required, you can also select the message scheme. If you select a message scheme, then the message types change depending on the selected combination of the message provider and ...

	NOTE
	The message provider, message scheme, and message type values are mapped in the fcc_tf_xml_pro_sch_msg_map table.
	4. To upload the parent XSD file and one or more child XSD files, click Upload and select the XSD file from your local drive. After you select the file and click Open, the XSD file name appears next to the Upload button. Select the radio button next ...
	Figure 58: Add Message Dialog Box


	NOTE
	To view the child elements for a parent element, mouse over the parent element and click the parent element in the Tree view. If Zero is displayed beside the element name, it means that there are no more child elements you can drill down to.
	5. Click Submit. The ISO20022 parameter name appears in the Message List section with _Draft attached to the parameter name.
	Figure 59: Message List Window
	6. Navigate to ISO20022/XML Configuration Admin in the Admin UI. To complete the configuration, click the message provider link. The XML Screening Configuration tab is displayed.

	Figure 60: Message List Window
	Table 23: Other Actions
	To...
	Do this...
	Add a web service configuration
	Click Add. The following fields appear:
	Figure 61: Add a web service configuration

	Select the message direction and enable or disable the web service and click Save. Clicking Clear clears any values selected. If you click Cancel, the fields disappear.
	In the Tree view, right-click any element node and click the element to view the element’s XPath. The fields appear in the Screening XPath Configuration List section.
	Figure 62: Add a web service configuration - tree view

	Update a web service configuration
	Select the configuration you want to update and click Update. The fields shown in the previous row appear. Make the required changes and click Save. The updated values are displayed in the Screening XPath Configuration List section.
	Remove a web service configuration
	Select the configuration you want to remove and click Remove. The selected configuration is removed from the Screening XPath Configuration List section.
	Enable all web service configurations
	Click Enable All.
	Disable all web service configurations
	Click Disable All.
	7. Navigate to ISO20022/XML Configuration Admin in the Admin UI and click the message provider link. To add the screening configuration of External Attribute, select the Attributes under the Screening External Attribute Configuration list. The Screen...
	Figure 63: External Attribute List Window




	NOTE
	The Add button will only appear when the user configures the FCC_TF_XML_EXTERNAL_ATTR and FCC_TF_XML_EXTERNAL_ATTR_MLS tables. Refer the following examples.
	Figure 64: Example 1
	Figure 65: Example 2
	Table 24: Other Actions
	To...
	Do this...
	Add an external attribute configuration
	Click Add. The following fields appear:
	Figure 66: Add an External Attribute configuration

	Select the message direction and enable or disable the web service and click Save. Clicking Clear clears any values selected. If you click Cancel, the fields disappear.
	Update a web service configuration
	Select the configuration you want to update and click Update. The fields shown in the previous row appear. Make the required changes and click Save. The updated values are displayed in the Screening External Attribute Configuration List section.
	Remove a web service configuration
	Select the configuration you want to remove and click Remove. The selected configuration is removed from the Screening External Attribute Configuration List section.
	Enable all web service configurations
	Click Enable All.
	Disable all web service configurations
	Click Disable All.
	1. After configuring the External Attributes, give the following attribute names (Same attribute names which are populated in the above tables) in message posting jsp.
	2. To view the message tag configurations for a field, click the XML Message Configuration tab.
	Figure 67: XML Message Configuration Tab


	Table 25: Other Actions
	To...
	Do this...
	Add a message configuration
	Click Add. The following fields appear:
	Figure 68: Add a message configuration

	Select the business data value, message direction, enable or disable the value, choose the Priority 1 XPath and Priority 2 XPath, and click Save. Clicking Clear clears any values selected. If you click Cancel, the fields disappear.
	In the Tree view, right-click any element node and click the element to view it’s XPath. The fields appear in the Message Tag Configuration List section.
	Figure 69: Add a message configuration - tree view

	Update a message configuration
	Select the configuration you want to update and click Update. The fields shown in the previous row appear. Make the required changes and click Save. The updated values are displayed in the Message Tag Configuration List section.
	Remove a message configuration
	Select the configuration you want to remove and click Remove. The selected configuration is removed from the Message Tag Configuration List section.



	NOTE NOTE
	The ready-to-use business data values are available in the DIM_TF_XML_MSG_TAG_FLD column. You can add a new value in this column.
	3. Click Submit. The ISO20022 parameter name is updated in the Message List without _Draft.
	Figure 70: Message List Window


	NOTE
	If an earlier configuration exists with the same message version, then this configuration is disabled, and the new configuration is enabled.
	8.1.1 Running the ISO20022 Batch
	1. Create a folder for the MIS date with the folder name as ##FIC_MIS_DATE## (the date on which we run the ISO20022 batch) in the following directory structure:
	2. Create two folders called OUTBOUND and INBOUND inside the MIS Date folder and create a folder called INPUT inside both the folders.



	NOTE
	All the ISO20022 XMLs must be either kept inside the INPUT folder inside the OUTBOUND folder or the INPUT folder inside the INBOUND folder based on the direction of the message XML. The ISO20022 batch takes these XMLs as input when it is run.

	NOTE
	When we take an action (RELEASE/BLOCK) on an alert from the Investigation User Interface, a feedback XML is recreated for the corresponding file with the name ##FILE_NAME##_feedback.xml and the name of the previous file with the same name becomes ##F...
	1. Navigate to the Run page. For more information, see the Run Definition Menu.
	Figure 71: Run Page
	2. Select the TF_SEPA_messages_batch_process batch and click Fire Run. The Fire Run page is displayed.

	Figure 72: Fire Run Page
	3. Select Single as the Request Type.
	4. Select Create & Execute in the Batch field. The MIS Date field is displayed.
	5. Select the date on which you want to execute the run. This date must be the same as the folder you create before you run the ISO20022 batch. In the example shown, since the MIS Date folder name is 20190913, the date you must select is 09/13/2019.
	6. Click OK.

	Figure 73: Batch Monitor Page
	Figure 74: Tasks in the Batch Monitor Page


	NOTE
	If the batch run fails, you must restart the batch. In this case, the batch run ID changes.
	Table 26: Task Details
	Task ID
	Task Name
	Task Description
	Task1
	TF_CallXMLParser
	Parses the XML data into the pre-processing tables.
	Task2
	TF_CallXMLEDQ
	Calls EDQ data to check if there are any matches.
	Task3
	Message Data Attributes
	NA
	Task4
	TF_CallXMLRTIPopulation
	Moves data from the ISO20022 configuration tables to the SWIFT configuration tables to generate OBI reports.
	Task5
	TF_CallXMLAlertGeneration
	Creates alerts and loads data into the alert tables.
	Task6
	TF_CallXMLImmediateFeedbackCreation
	Populates the feedback table.
	Task7
	TF_CallXMLImmediateFeedbackFileGeneration
	Generates the feedback in an XML format in the INBOUND/feedback directory for the date on which the run is triggered.
	Task8
	TF_CallXMLHighlight
	Populates the highlighted column in the fsi_rt_al_raw_data table.
	Task9
	TF_CallUpdateAdditionalMsgDtls
	Populates the post-processing alert table with the additional details provided for the alert.
	Task10
	TF_CallXMLStructuredSepa
	Populates the data in the Structured Message tab in the Investigation User Interface.




	8.2 Audit Queries
	Table 27: Audit Queries for ISO20022
	Table Name
	Query
	Description
	FCC_TF_XML_XSD_CONF
	Select * from FCC_TF_XML_XSD_CONF_HIST
	Run this query to see the history of all the actions that have been performed.
	FCC_TF_XML_MSG_TAG_FLD_XPATH
	Select * from FCC_TF_XML_MSG_TAG_FLD_XPATH _HIST
	Run this query to see the history of all the actions performed in the XML Message Configuration tab.
	FCC_TF_XML_SCRENG_XPATH_GRP
	Select * from FCC_TF_XML_SCRENG_XPATH_GRP _HIST
	Run this query to see the XPath for each parent element.
	FCC_TF_XML_SCRENG_FLD_XPATH
	Select * from FCC_TF_XML_SCRENG_FLD_XPATH _HIST
	Run this query to see the XPath for each subfield.



	9 Configurations for the US NACHA Batch Process
	1. On the Financial Services Analytical Applications Transactions Filtering landing page, click Financial Services Sanctions Pack.
	Figure 75: Financial Services Sanctions Pack Menu
	2. Click Run Definition. The Run page is displayed.

	Figure 76: Run Definition Link
	3. In the Run page, select the TF_US_NACHA_Batch_Process batch.

	Figure 77: Run Page
	4. Click Edit . The Run page is displayed in Edit mode.

	Figure 78: Run Definition (Edit Mode)
	5. Click Selector and then click Job from the drop-down list. The Component Selector window is displayed.

	Figure 79: Component Selector Window
	1. Deselect the 21099:TF87INFO:OFS_TFLT:NA task.
	2. Click Ok. The Run page with the Run Definition is displayed in Edit mode.
	3. Provide a Name for the batch.

	Figure 80: Run Definition (Edit Mode) – Batch Name
	4. Click Next.
	5. Click Save.
	6. Click No in the Run Rule Framework dialog box.

	Figure 81: Run Rule Framework Dialog Box

	10 Enterprise Data Quality (EDQ) Configurations
	10.1 Performance Improvement Measures for EDQ
	NOTE
	The following are some recommendations to help improve performance when you are dealing with bulk transactions. Perform these steps ONLY after you have completed all configurations for EDQ.


	10.2 EDQ Configuration Process Flow
	Figure 82: Enterprise Data Quality (EDQ) Configuration Steps
	1. Import the Watchlist Management.dxi file from the FIC_HOME/SanctionsCommon path.
	2. Import the Transaction_Screening.dxi file from the FIC_HOME/Transaction_Processing path (This is for SWIFT messages only).
	3. Import the Transaction_Screening_SEPA.dxi file from the FIC_HOME/Transaction_Processing path (This is for ISO20022 messages only).
	4. For these projects, enter the applicable organization-specific Atomic schema details in the Edit Data Store window. To access the the Edit Data Store window, follow these steps:

	Figure 83: Director Menu in EDQ
	Figure 84: Project Browser Pane
	Figure 85: Edit Data Store Window
	5. Load the Reference data. For more information on Reference data, see Viewing Reference Data for Web Services.
	6. Update the command area path in the following locations:

	Figure 86: Edit Task Window
	7. Go to the EDQ URL and open the Server Console menu. The Server Console landing page appears.

	Figure 87: Server Console Menu in EDQ
	8. Run the following jobs under the Watchlist Management project:
	9. Run the MAIN job under the Transaction_Screening project.
	10. Change the EDQ URL in the Transaction Filtering application. To change the EDQ URL, see Configuring the Application Level Parameters.

	NOTE
	The first time you set up the Transaction Filtering application, you must change the EDQ URL.
	11. Configure the message and screening parameters, if required.
	10.2.1 Importing the Transaction Screening Project
	10.2.2 Configuring Watch List Management and Transaction Filtering


	NOTE
	The properties controlling match rules are not included in the watchlist-screening.properties run profile by default. For more information, see Configuring Match Rules .
	10.2.2.1 Preparing Watch List Data
	10.2.2.2 Setting Up Private Watch List


	NOTE
	OEDQ release 12c has a base config folder and a local config folder. The base config folder is called oedqhome and the local config folder is called oedqlocalhome. The names may differ in some cases. For example, dots or underscores may be inserted i...
	1. Transform your private watch list data into the format specified in the Private List Interface chapter in the Oracle Financial Services Data Interfaces Guide.
	2. Replace the data in the privateindividuals.csv and privateentities.csv files with your transformed private watch list data.


	NOTE
	The files must be saved in UTF-8 format.
	1. Move your private watch list data to the staging area by setting phase.PRIV\ -\ Stage\ reference\ lists.enabled to Y.
	2. Set phase.PRIV\ -\ Prepare\ without\ filtering.enabled to Y to prepare the private watch list without filtering.
	10.2.2.2.1 Showing Watch List Staged Data/Snapshots in the Server Console User Interface
	10.2.2.2.2 Configuring Match Rules


	NOTE
	Ensure that data is available in the ref_port_cntry table before you begin the matching process. This table contains the port code for a port name and the corresponding port country. For more information on matching, see https://docs.oracle.com/ midd...

	NOTE
	Ensure that values are capitalized and characters are escaped as applicable.
	10.2.2.2.3 Configuring Jobs
	1. In the Watchlist_Management-<patch number> project, double-click the Load List data from Stg to Processed table job. All processes related to the job are displayed.

	Figure 88: EDQ Director Menu
	2. Right-click the WatchListLoadPreparedData process and click Enable.
	10.2.2.3 Filtering Watch List Data
	10.2.2.3.1 Enabling Watch List Filtering
	10.2.2.3.2 Configuring Watch List Filtering




	NOTE
	After data is filtered out, it is not possible to filter it back in. For example, if all entities are filtered out in the Watchlist Management project, even if the Transaction_Screening project is configured to include entities, they will not appear ...
	Figure 89: Reference Data Editor - Filter - Settings Window


	NOTE
	In the Filter - Settings reference data, a value of Y indicates that all records must be included - in other words, no filter must be applied.
	10.2.2.3.3 Primary and Secondary Filtering, and Linked Records


	NOTE
	Only the World-Check and DJW watch lists can provide Linked Profiles.
	10.2.2.3.4 Setting Multiple Values for Primary and Secondary Filters


	NOTE
	When you set the Filter - Settings reference data to N, only the records that match the values set in the corresponding reference data are included. For example, if you set the value of All name qualities to N in Filter - Settings, then you can deter...
	10.2.2.3.5 Filtering World-Check Data
	1.1.1.1 5.0.0.4 Setting Filtering options in the Run Profiles
	10.1.1.1.6 Setting Primary Filters and Linked Profiles in the Watchlist Management Project
	1. In the Director menu, open the Watchlist Management project and expand the Reference Data node.
	2. Locate the Filter - Settings reference data and double-click to open it.
	3. Ensure the List/sub-list value in the WC-SAN row is set to Y.
	4. Set the Entities value in the WC-SAN row to N.
	5. Set the Inactive value in the WC-SAN row to N.
	6. Set the All Origins value in the WC-SAN row to N.
	7. Ensure all other values in the WC-SAN row are set to Y.
	8. Click OK to close the reference data and save changes.
	9. Locate the Filter - Origins reference data and double-click to open it.
	10. Add a new row with the following values:
	11. Change the Linked Profiles value in the WC-SAN row to Y.
	12. Click OK to close the Filter Settings reference data and save changes.

	10.1.1.1.7 Setting Secondary Filters in the Transaction_Screening Project
	1. Open the Transaction_Screening project, and expand the reference data link.
	2. Locate the Filter - Settings reference data file, and double-click to open it.
	3. Set the Deceased value in the WC-SAN row to N.
	4. Click OK to close the reference data and save changes.

	10.1.1.1.8 Screening All Data Using Sanctions Rules

	10.1.1.2 Viewing Reference Data for Web Services
	10.1.1.2.1 Bad BICs Reference Data

	Table 28: Sample Data for Sanctioned BICs
	Record ID
	BIC
	Data Source
	Risk Score
	1
	SIIBSYDA
	OFAC (Office of Foreign Assets Control)
	85
	2
	FTBDKPPY
	OFAC (Office of Foreign Assets Control)
	90
	3
	DCBKKPPY
	OFAC (Office of Foreign Assets Control)
	85
	4
	ROSYRU2P
	OFAC (Office of Foreign Assets Control)
	90
	5
	INAKRU41
	OFAC (Office of Foreign Assets Control)
	90
	6
	SBBARUMM
	OFAC (Office of Foreign Assets Control)
	90
	10.1.1.2.2 Blacklisted Cities Reference Data


	Table 29: Sample Data for Sanctioned Cities
	Record ID
	Country
	City
	ISO City Code
	Data Source
	Risk Score
	1
	IRAQ
	ARBIL
	ABL
	OFAC (Office of Foreign Assets Control)
	90
	2
	IRAQ
	ABU AL FULUS
	ALF
	OFAC (Office of Foreign Assets Control)
	90
	3
	IRAQ
	AMARA (AL- AMARAH)
	AMA
	OFAC (Office of Foreign Assets Control)
	85
	4
	IRAQ
	ARAK
	ARK
	OFAC (Office of Foreign Assets Control)
	90
	10.1.1.2.3 Blacklisted Countries Reference Data


	Table 30: Sample Data for Sanctioned Countries
	Record ID
	Country
	ISO Country Code
	Country Synonyms
	Data Source
	Risk Score
	1
	IRAQ
	IQ
	IRAK, REPUBLIC OF IRAQ, AL JUMHURIYAH AL IRAQIYAH, AL IRAQ
	OFAC (Office of Foreign Assets Control)
	90
	2
	DEMOCRATIC REPUBLIC OF THE CONGO
	CD
	CONGO, THE DEMOCRATIC REPUBLIC OF THE
	OFAC (Office of Foreign Assets Control)
	90
	3
	AFGHANISTAN
	AF
	NA
	ITAR (International Traffic in Arms Regulations)
	85
	4
	ZIMBABWE
	ZW
	NA
	ITAR (International Traffic in Arms Regulations)
	90
	5
	CENTRAL AFRICAN REPUBLIC
	CF
	NA
	EAR (Export Administration Regulations)
	85
	6
	BELARUS
	BY
	NA
	EAR (Export Administration Regulations)
	80
	10.1.1.2.4 Stop Keywords Reference Data


	Table 31: Sample Data for Sanctioned Stop Keywords
	Record ID
	Stop KeyWords
	Risk Score
	1
	EXPLOSIVE
	80
	2
	DIAMOND
	90
	3
	TERROR
	80
	4
	TERRORIST
	85
	5
	ARMS
	80
	6
	NUCLEAR
	90
	10.1.1.2.5 Goods Prohibition Reference Data


	Table 32: Sample Data for Prohibited Goods
	Record ID
	Good Code
	Good Name
	Good Description
	1
	0207 43 00
	Fatty livers
	Fatty livers, fresh or chilled
	2
	0208 90 10
	Ivory
	CONGO, THE DEMOCRATIC REPUBLIC OF THE
	3
	0209 10 00
	Ivory powder and waste
	NA
	4
	3057100
	Shark fins
	NA
	5
	4302 19 40
	Tiger-Cat skins
	NA
	10.1.1.2.6 Ports Prohibition Reference Data


	Table 33: Sample Data for Prohibited Ports
	Record ID
	Country
	Port Name
	Port Code
	Port Synonyms
	1
	IRAN, ISLAMIC REPUBLIC OF
	KHORRAMSHAHR
	IR KHO
	KHORRAMSHAHR Port
	2
	RUSSIA
	Sevastopol
	SMTP
	Sebastopol,Port of Sevastopol
	3
	New Zealand
	Dunedin
	NZ ORR
	Otago Harbour
	4
	New Zealand
	Ravensbourne
	NZ ORR
	Otago Harbour
	10.1.1.3 Extending Prohibition Screening






	11 Configuring Risk Scoring Rules
	NOTE
	The screenshots shown for these steps are taken for existing tables. You can perform similar steps for newly added tables.
	1. Navigate to the Financial Services Analytical Applications Transactions Filtering landing page. For more information, see the Inline Processing Menu.
	2. Click Inline Processing. The Inline Processing page is displayed.
	Figure 90: Profiles Menu
	3. Import data model tables into IPE using the Business Entities sub-menu. A Business Entity is a virtual layer that can be added to an existing table. You can add a new business entity and search for existing business entities to modify or remove a ...

	Figure 91: Import Table Action
	Figure 92: Entities List
	Table 34: Business Entity Fields
	Field
	Description
	Business Name
	Enter a unique Business Name of the Entity. By default, the Business Name is populated as the logical name provided for the Table in the data model. The details of this field can be modified.
	Entity Type
	Select the Entity Type from the drop-down list. The following entity types are available:
	· Activity: Select a table as Activity if the data is to be processed by IPE as a part of assessment execution. To use Activity as a Reference, relevant Inline Datasets and Traversal Paths must be created. For example, if wire transactions and cash ...
	· Reference: Select a table as a Reference if the table has static values for IPE. Reference data cannot be processed by IPE.
	· Lookup: Select a table as Lookup if it is used as a scoring table in Evaluations. This can be used as a Reference.

	After a table is imported, you cannot change the entity type of the table.
	Processing Segment
	Select the Processing Segment from the multi-select drop-down list.
	Set Primary Key Attribute
	Select the Primary Key Attribute from the drop-down list.
	This shows all the columns of the table. This is a unique attribute of the table which is imported. It is a mandatory field.
	Composite Primary Keys are not supported.
	Set Sequence ID Attribute
	Select the sequence ID attribute from the drop-down list.
	Select the sequence ID attribute from the drop-down list.
	This field is enabled if you select Activity as the Entity Type.
	DB Sequence Name
	Enter the DB sequence name.
	A DB Sequence must be created in the Atomic Schema. The name of that Sequence must be provided in this field.
	This field is enabled if you select Activity as the Entity Type.
	Set Processing Status
	Attribute
	Select the processing status attribute from the drop-down list.
	This attribute is updated by IPE to indicate if the assessment has passed or failed.
	This field is enabled if you select Activity as the Entity Type.
	Set Processing Period
	Attribute
	Select the processing period attribute from the drop-down list.
	This attribute defines the date or time when the activity has occurred. For example, Transaction Time.
	This field is enabled if you select Activity as the Entity Type.
	Score Attribute
	This field is enabled ONLY if you select Lookup as the Entity Type.
	Select the Score Attribute from the drop-down list.
	This attribute can be used in evaluation scoring.
	1. Add a business entity. To do this, follow these steps:
	Figure 93: Entities List
	2. Provide the name, processing segment, and score attribute for the business entity.

	Figure 94: Business Entity attributes
	3. Click Add. The new parameter is added to the list of Business Entities on the Business Entities page.
	4. Add a join in IPE from the Inline Datasets sub-menu in the Association and Configuration menu. Inline Datasets are joins between two Business Entities. When you create an Inline Dataset, you must define at least one join.

	Figure 95: Inline Datasets page
	Figure 96: Inline Datasets Attributes
	1. Add a traversal path for each join defined in the Inline Datasets sub-menu. Traversal paths are the paths between two or more entities. The traversal paths defined can be used to create expressions, evaluations, and profiles.

	Figure 97: Traversal Paths Page
	Figure 98: Traversal Paths Attributes
	2. Add an Expression on the risk score column of the newly created business entity which is to be scored as a risk parameter from the Expressions menu. An expression is used as a filter when creating evaluations or profiles. Expressions must only be ...

	Figure 99: Expressions Page
	Figure 100: First Expression Attributes
	Figure 101: First Expression Displayed
	Figure 102: Second Expression Attributes
	Figure 103: Second Expression Displayed
	3. Add the following ready-to-use evaluations from the Evaluations Menu. Evaluations are logical comparisons against conditions that result in a score. For information on the conditions, see the Managing Evaluations section in the Oracle Financial Se...





	NOTE
	This evaluation applies to the ISO message category.
	This score is configurable.
	Table 35: ISO20022 Risk-Currency VS Amount Threshold Evaluation Filters
	Sl.No
	Filter Name
	Filter Clause
	Batch ID
	( Message Data Attributes:V_BATCH_RUN_ID ) = BATCH RUN ID
	Amount
	( Message Data Attributes:N_CNTRL_SUM_AMT ) >= 10000
	Currency
	( Transaction Tag Attributes:V_ CURRENCY ) = 'EUR'

	Table 36: Risk- High-Risk Party Evaluation Filters
	Sl.No
	Filter Name
	Filter Clause
	Beneficiary Account Number
	( Message Tag Table:V_BENF_ACC_NO) = ( Rule Configuration Table:V_COND1)
	Rule Name
	( Rule Configuration Table:V_RISK_RULE_CODE) = 'TF_HIGH_RSK_PARTY'
	Message Type
	( Real Time Raw Data:V_GRP_MSG_TYPE) = 'MT700'
	Direction
	( Message Tag Table:V_DIRECTION) in (('INBOUND', 'OUTBOUND'))



	NOTE
	This score is configurable.
	Table 37: Risk-Currency VS Amount Threshold Evaluation Filters
	Sl.No
	Filter Name
	Filter Clause
	Message Type
	( Real Time Raw Data:V_GRP_MSG_TYPE) in ('MT101', 'MT103', 'MT202COV', 'MT202')
	Jurisdiction
	( Real Time Raw Data:V_BIC_CODE) = 'CHASUS33XXX'
	Direction
	( Message Tag Table:V_DIRECTION) in ('INBOUND','OUTBOUND')
	Currency
	( Message Tag Table:V_CURRENCY) = 'USD'
	Amount
	( Message Tag Table:V_AMOUNT) >= 10000

	Table 38: Risk-Currency VS Destination Country Evaluation Filters
	Sl.No
	Filter Name
	Filter Clause
	Currency
	( Message Tag Table:V_CURRENCY) = ( Rule Configuration Table:V_COND1)
	Destination Country
	( Message Tag Table:V_DESTINATION_CNTRY) = ( Rule Configuration Table:V_COND2)
	Direction
	( Message Tag Table:V_DIRECTION) in ('INBOUND','OUTBOUND')
	Message Type
	( Real Time Raw Data:V_GRP_MSG_TYPE) = ( Rule Configuration Table:V_TXN_TYPE_CD)
	Rule Name
	( Rule Configuration Table:V_RISK_RULE_CODE) = 'TF_CCY_CTRY_RSK'



	NOTE
	This score is configurable.
	Table 39: Risk-High Risk Destination Country Evaluation Filters
	Sl.No
	Filter Name
	Filter Clause
	Amount
	( Message Tag Table:V_AMOUNT) >= 10000
	Currency
	( Message Tag Table:V_CURRENCY) = 'EUR'
	Destination Country
	( Message Tag Table:V_DESTINATION_CNTRY) in ('TH', 'PK')
	Direction
	( Message Tag Table:V_DIRECTION) = 'OUTBOUND'
	Message Type
	( Real Time Raw Data:V_GRP_MSG_TYPE) in ('MT101', 'MT103', 'MT202COV', 'MT202')



	NOTE
	This score is configurable.
	Table 40: Risk-High Risk Originator Country Evaluation Filters
	Sl.No
	Filter Name
	Filter Clause
	Amount
	( Message Tag Table:V_AMOUNT) >= 10000
	Currency
	( Message Tag Table:V_CURRENCY) = 'EUR'
	Message Type
	( Real Time Raw Data:V_GRP_MSG_TYPE) in ('MT101', 'MT103', 'MT202COV', 'MT202')
	Direction
	( Message Tag Table:V_DIRECTION) = 'INBOUND'
	Originator Country
	( Message Tag Table:V_ORIGINATOR_CNTRY) in ('PK', 'TH')



	NOTE
	This score is configurable.
	Table 41: Risk-Trade Amendments Evaluation Filters
	Sl.No
	Filter Name
	Filter Clause
	Message Type
	( Real Time Raw Data:V_GRP_MSG_TYPE) = 'MT707'
	Direction
	( Message Tag Table:V_DIRECTION) in (('INBOUND','OUTBOUND'))
	Number of Amendments
	( Message Tag Table:N_NUMBER_OF_AMENDMENT) >= 5



	NOTE
	This evaluation applies to the SWIFT message category.
	This score is configurable.

	NOTE
	This evaluation applies to the ISO message category.
	This score is configurable.
	Table 42: Watch List Score Filters
	Sl.No
	Filter Name
	Filter Clause
	Watch List Score
	(Get Max Watch List Score(( Name Addr Screening Response:N_MATCH_SCORE),Goods Score,Country and City Score,BIC Score,Ports Score,Narrative Score)) > 50
	Batch Run ID
	( Message Data Attributes:V_BATCH_RUN_ID) = :BATCH_RUN_ID
	Figure 104: Evaluations Page
	Figure 105: Evaluations Attributes
	Figure 106: Evaluations Filters
	4. Create an Assessment for the ready-to-use evaluations. The Assessments checks the logic of all the evaluations and considers the sum of all the Evaluations for the output score.





	NOTE
	You can adjust the risk score for any given evaluation depending on the requirement, but it must be within 40, because match rule score configuration starts with 45, and match score must always have high weightage than the individual evaluation risk ...
	Figure 107: Assessments Page
	Figure 108: Assessments Attributes
	Figure 109: Sample Assessment



	12 Appendix A: Watch Lists
	L.1 HM Treasury Watch List
	L.2 OFAC Watch List
	L.3 EU Watch List
	1. Go to https://webgate.ec.europa.eu/europeaid/fsd/fsf#!/account.
	2. Create an account.
	3. Navigate to https://webgate.ec.europa.eu/europeaid/fsd/fsf#!/files and open show settings for crawler/robot.
	4. Copy the URL for 1.0 XML (Based on XSD). This is in the format https://webgate.ec.europa.eu/europeaid/fsd/fsf/public/files/xmlFullSanctionsList/ content?token=[username]. You must replace the [username] placeholder with the user name you have created
	5. Enter this URL in your run profile or download the task.

	L.4 UN Watch List
	L.5 World-Check Watch List
	NOTE
	If your instance of Oracle Transaction Filtering uses the WebLogic application server, and you are screening against the World-Check watch list, then, to download the World-Check reference data successfully, you must add the following to the 'Server ...


	L.6 Dow Jones Watch List
	L.7 Dow Jones Anti-Corruption Watch List
	L.8 Accuity Watch List
	L.8.1 Using the Accuity Group File
	NOTE
	Only entities and individuals on the Regulatory Due Diligence (RDD) watch lists are included in the group file.
	Figure 110: Edit Data Store Window
	L.8.2 New Alerts Resulting from Use of the Group File



	NOTE
	Use of the group file may result in new alerts being raised for existing relationships if the group file structure is changed by Accuity. There is at present no way to circumvent this issue.


	L.9 Private Watch List
	NOTE
	It is recommended that you keep a copy of the sample private watch list files, as they can be used to verify the correct functioning of your installation on a known data set.
	The files must be saved in UTF-8 format.
	L.9.1 Individual Private Watch List Input Attributes
	Figure 111: Individual Private Watch List Input Attributes
	Field Name
	Expected Data Format
	Notes
	ListSubKey
	String
	This field is used to identify the source list of the watch list record (for example, Private List, Accounting Private List, Financial Private List, and so on). It is included in the alert key.
	ListRecordType
	String
	NA
	ListRecordOrigin
	String
	This field is used to record the provenance of a record when it is part of a consolidated list.
	ListRecordId
	String
	[Mandatory attribute] This attribute is not used as part of the matching process, but it must be populated with a unique identifier.
	PassportNumber
	String
	This is an optional field that may be used to capture the passport numbers of customers or individuals for use in the review process.
	Passport numbers are not used in the default screening rules.
	NationalId
	String
	This is an optional field that may be used to capture customer National IDs for use in the review process.
	The National IDs of customers and individuals must not use in the default screening rules.
	Title
	String
	This field must contain the titles of customers or individuals (such as Mr/Mrs/ Dr/Herr/Monsieur). It is used to derive gender values where gender is not already stated and is used during the review process.
	Avoid putting titles in the name fields.
	FullName
	String
	[Mandatory attribute] The individual matching process is based primarily on the name supplied for the individual. Either a full name, a pair of given and family names, or an original script name must be submitted to the screening process for screenin...
	GivenName
	String
	FamilyName
	String
	NameType
	String
	This is an optional field used in the review process only. Multiple names may exist for the same person. The Name Type, therefore, denotes if the name is the primary name of the listed party, or an additional name (such as an Alias, or Alternate Spel...
	Private list records were derived from a single source with multiple names (such as Mrs. Louise Wilson née Hammond being split into two records, Louise Wilson and Louise Hammond) you may wish to denote one as the primary name and one as a maiden or ...
	NameQuality
	String
	This field may be assigned a value of Low, Medium, or High to indicate the quality of the individual name. High is used for Primary names and specified good/high-quality aliases.
	PrimaryName
	String
	For alias records, this field indicates the main name for that record.
	OriginalScriptName
	String
	[Mandatory attribute] The individual matching process is based primarily on the name supplied for the individual. Either a full name, a pair of given and family names, or an original script name must be submitted to the screening process for screenin...
	Gender
	String
	The value supplied must be either ‘M’ or ‘F’. The gender is not used directly in the matching process, but optionally, the value of the Gender field can be used by the elimination rules to eliminate poor matches.
	Occupation
	String
	This is an optional field that may be used to eliminate records with "safe" occupations, in the review process and risk scoring. Note that customer occupations are not matched against list occupations using the default screening rules.
	DateofBirth
	String, representing a date, in the format
	'YYYYMMDD'; day, month, and year are required.
	[Recommended attribute] Birth date information can be used in matching to identify particularly strong matches or to eliminate matches that are too weak.
	YearofBirth
	String, in the format 'YYYY'.
	Deceased Flag
	String
	If populated, this optional field must contain either Y or N.
	DeceasedDate
	String, representing a
	date, in the format
	'YYYYMMDD'.
	If populated, this optional field must contain either the current date or a date in the past.
	Address1
	String
	These are optional fields that may be used in the review process.
	Address2
	String
	Address3
	String
	Address4
	String
	City
	String
	[Recommended attribute] City data is used to strengthen potential match information.
	State
	String
	Postal Code
	String
	AddressCountryCode
	String; ISO 2-character country code.
	[Recommended attribute] Address country data is used to strengthen potential match information.
	ResidencyCountryCode
	String; ISO 2-character country code.
	[Recommended attribute] The country of residence can be used in optional country prohibition screening.
	CountryOfBirthCode
	String; ISO 2-character country code.
	NA
	NationalityCountryCodes
	String; comma separated
	list of
	ISO 2-character
	country codes.
	[Recommended attribute] The nationality can be used in optional country prohibition screening.
	ProfileHyperlink
	String; a hyperlink to an Internet or intranet resource for the record.
	This field may contain a hyperlink to an Internet or intranet resource that can provide reviewers with additional information about the individual.
	RiskScore
	Number, between 0 and 100
	This field is included where the risk score for a customer is calculated externally.
	RiskScorePEP
	Number, between 0 and 100
	A number indicating the relative ‘riskiness’ of the Individual, considered as a PEP. The risk score is expressed as an integer between 1 and 100, with Higher numbers indicating a higher risk.
	AddedDate
	String, representing a
	date, in the format
	'YYYYMMDD'
	These are optional fields for use in the review process.
	LastUpdatedDate
	String, representing a
	date, in the format
	'YYYYMMDD'
	DataConfidenceScore
	Number, between
	0 and 100
	DataConfidenceComment
	String
	InactiveFlag
	String
	If populated, this optional field must contain either Y or N.
	InactiveSinceDate
	String, representing a
	date, in the format
	'YYYYMMDD'
	If populated, this optional field must contain either the current date or a date in the past.
	PEPclassification
	String
	This field can be used to indicate the type of PEP (for example, whether the individual is part of an international organization or government, and at what level). It can be used to filter watch list records and is primarily used by the World-Check w...
	customString1 to
	customString40
	String
	Fifty custom fields are provided in the private list data interface for individuals. Forty of these are intended to hold string data, five hold dates, and five numeric data.
	The interface file is a comma-separated value (.csv) file, and so all fields intrinsically contain strings. However, during the processing of Private watch lists, the custom date and number fields are checked to ensure that they include appropriate d...
	customDate1 to
	customDate5
	customNumber1 to
	customNumber5
	L.9.2 Entity Private Watch List Input (PLI) Attributes

	Table 43: Entity Private Watch List Input Attributes
	Field Name
	Expected Data Format
	Notes
	ListSubKey
	String
	This field is used to identify the source list of the watch list record (for example, Private List, Accounting Private List, Financial Private List, and so on). It is included in the alert key.
	ListRecordType
	String
	[Mandatory attribute]This field is used when filtering alerts, to determine whether the record is a sanctions or PEP record. It must contain a value of SAN, PEP, or a combination of these values. If you want to include a combination of values, the va...
	ListRecordOrigin
	String
	This field is used to record the provenance of a record when it is part of a consolidated list.
	ListRecordId
	String
	[Mandatory attribute] This attribute is not used as part of the matching process, but it must be populated with a unique identifier.
	RegistrationNumber
	String
	This is an optional field that may be used to capture entity registration numbers for use in the review process. Note that entity registration numbers are not used for matching in the default screening rules.
	EntityName
	String
	[Mandatory attribute] The entity matching process is based primarily on the name supplied for the entity. An entity name or original script name must be submitted to the screening process for screening to proceed.
	NameType
	String
	This is an optional field used in the review process only. Multiple names may exist for the same person. The Name Type, therefore, denotes if the name is the primary name of the listed party, or an additional name (such as an Alias, or Alternate Spel...
	NameQuality
	String
	This field may be assigned a value of Low, Medium, or High to indicate the quality of the individual name. High is used for Primary names and specified good or high-quality aliases.
	PrimaryName
	String
	For alias records, this field indicates the main name for that record.
	OriginalScriptName
	String
	[Mandatory attribute] The individual matching process is based primarily on the name supplied for the individual. Either a full name, a pair of given and family names, or an original script name must be submitted to the screening process for screenin...
	AliasIsAcronym
	String
	If this field is set to Y, this flags an alias as an acronym as opposed to a full entity name. Leaving the field blank or setting it to any other value does not affect screening (that is, an alias is a full entity name).
	This flag is used during matching.
	VesselIndicator
	String
	This field must be set to Y if the entity is a vessel (a ship). It must be left empty or set to N if the entity is not a vessel.
	VesselInfo
	String
	If the entity is a vessel, you can populate this field with information about it: for example, its call sign, type, tonnage, owner, flag, and so on.
	Address1
	String
	These are optional fields that may be used in the review process.
	Address2
	String
	Address3
	String
	Address4
	String
	City
	String
	[Recommended attribute] City data is used to strengthen potential match information.
	State
	String
	Postal Code
	String
	AddressCountryCode
	String; ISO 2-character country code.
	[Recommended attribute] Address country data is used to strengthen potential match information.
	ResidencyCountryCode
	String; ISO 2-character country code.
	[Recommended attribute] The entity's registration country can be used in optional country prohibition screening.
	OperatingCountryCodes
	String; ISO 2-character country code.
	[Recommended attribute] Any of the entity's operating countries can be used in optional country prohibition screening.
	ProfileHyperlink
	String; a hyperlink to an Internet or intranet resource for the record.
	This field may contain a hyperlink to an Internet or intranet resource that can provide reviewers with additional information about the individual.
	RiskScore
	Number, between 0 and 100
	This field is included where the risk score for a customer is calculated externally.
	RiskScorePEP
	Number, between 0 and 100
	A number indicating the relative ‘riskiness’ of the individual, considered as a PEP. The risk score is expressed as an integer between 1 and 100, with higher numbers indicating a higher risk.
	AddedDate
	String, representing a date, in the format 'YYYYMMDD'
	These are optional fields for use in the review process.
	LastUpdatedDate
	String, representing a date, in the format 'YYYYMMDD'
	DataConfidenceScore
	Number, between 0 and 100
	DataConfidenceComment
	String
	InactiveFlag
	String
	If populated, this optional field must contain either Y or N.
	InactiveSinceDate
	String, representing a date, in the format 'YYYYMMDD'
	If populated, this optional field must contain either the current date or a date in the past.
	PEPclassification
	String
	This field can be used to indicate the type of PEP (for example, whether the individual is part of an international organization or government, and at what level). It can be used to filter watch list records and is primarily used by the World-Check w...
	customString1 to
	customString40
	String
	Fifty custom fields are provided in the private list data interface for individuals. Forty of these are intended to hold string data, five hold dates, and five numeric data.
	The interface file is a comma-separated value (.csv) file, and so all fields intrinsically contain strings. However, during the processing of Private watch lists, the custom date and number fields are checked to ensure that they include appropriate d...
	customDate1 to
	customDate5
	String, representing a date, in the format 'YYYYMMDD'
	customNumber1 to
	customNumber5
	Number





	13 Appendix B: System Audit Logging Information
	B.1 Activities for System Audit
	Table 44: Activities for System Audit
	Activity Identifier
	Activity Name
	Activity Sequence
	1
	Raw Message Processing
	1
	2
	Message Parser Processing
	2
	3
	watch list Processing
	3
	4
	Alert Manager Processing
	4
	5
	Hold
	5
	6
	Assigned
	6
	7
	Escalated
	7
	8
	Recommend to Block
	8
	9
	Block
	9
	10
	Recommend to Release
	10
	11
	Release
	11
	12
	Reject
	12


	B.2 Steps for System Audit Activities
	Table 45: Steps for System Audit Activities
	Step Identifier
	Activity Name
	Step Name
	Step Sequence
	Status
	1
	Raw Message Processing
	Record the receipt of the raw message
	1
	Y
	2
	Raw Message Processing
	Raw Message persisted into structure table
	2
	N
	3
	Message Parser Processing
	Raw Message parsed
	1
	N
	4
	Message Parser Processing
	Parsed Raw Message persisted into structure table
	2
	N
	5
	watch list Processing
	Matching data prepared
	1
	N
	6
	watch list Processing
	Matching Engine Invoked
	2
	Y
	7
	watch list Processing
	Scoring Engine Invoked
	3
	Y
	8
	watch list Processing
	Scoring performed
	4
	Y
	9
	watch list Processing
	Response Received
	5
	Y
	10
	watch list Processing
	Response persisted
	6
	N
	11
	Alert Manager Processing
	Transaction Hold
	1
	N
	12
	Alert Manager Processing
	Alert Persisted
	2
	N
	13
	Hold
	Hold Transaction Workflow Invoked
	1
	Y
	14
	Hold
	Hold Transaction Workflow completed
	2
	Y
	15
	Assigned
	Assigned Transaction Workflow Invoked
	1
	Y
	16
	Assigned
	Assigned Transaction Workflow completed
	2
	Y
	17
	Escalate
	Escalated Transaction Workflow Invoked
	1
	Y
	18
	Escalate
	Escalated Transaction Workflow completed
	2
	Y
	19
	Recommend to Block
	NA
	NA
	NA
	20
	Block
	Blocked Transaction Workflow Invoked
	1
	Y
	21
	Block
	Blocked Transaction Workflow completed
	2
	Y
	22
	Recommend to Release
	23
	Release
	Released Transaction Workflow Invoked
	1
	Y
	24
	Release
	Released Transaction Workflow completed
	2
	Y
	25
	Reject
	NA
	NA
	NA



	14 Appendix C: Process Modeller Framework (PMF) Configurability
	C.1 Configuring the Human Task in the PMF Page
	1. Navigate to the Process Flow subtab in the Process Modeller tab. The PMF page is displayed.
	2. Drag and drop Human Task on to the PMF page. For information on all components available, see the Components for Designing Your Process Flow chapter in the Oracle Financial Services Analytical Applications Infrastructure Process Modelling Framewor...
	3. Double-click Human Task .
	4. In the Activity dialog, provide the following information:
	5. Click Transitions and then click Add.
	C.1.1 Mapping the Transaction Statuses and Transaction Outcomes
	1. Run select * from AAI_WF_STATUS_B t where t.v_app_package_id = 'OFS_SAC' and select * from AAI_WF_STATUS_TL where t.v_app_package_id = 'OFS_SAC' queries.
	2. In the AAI_WF_STATUS_B table, populate a unique entry in the v_status_id column for each new status and map the same entry in the AAI_WF_STATUS_TL table for a column. For example, populate the entry OFS_SAC in the v_app_package_id column.
	3. When you map the new status, it appears on the PMF page.
	1. Run the select * from AAI_WF_OUTCOME_B t and where t.v_app_package_id = 'OFS_SAC' queries.
	2. In the AAI_WF_OUTCOME_B table, populate a unique outcome ID in the v_outcome_id column for each new status and map the same entry in the AAI_WF_OUTCOME_TL table.


	C.2 Adding Data Fields for the PMF Status
	NOTE
	If the data field name contains more than one word, give an underscore (_) between each word. The name will not be valid if you provide a space between each word.
	1. Select the radio button of the data field that you want to edit.
	2. Click Edit.



	C.3 Adding Application Rules for the PMF Status
	C.3.1 Mapping Rule Types to Application Rules
	C.3.2 Mapping User Groups to Application Rules

	C.4 Configurations Required for the Audit Tables
	NOTE
	The value provided in the v_status_name column in the AAI_WF_STATUS_TL table must be a combination of one of the following values:
	The value provided in v_sanction_status_name in dim_sanctions_status table and the name of the transaction workflow invoked for entry 1.
	The value provided in v_sanction_status_name in dim_sanctions_status table and the name of the transaction workflow completed for entry 2.



	C.5 Configurations Required for the setup_rt_params Table
	1. Provide the function code in the v_attribute_value1 column where v_attribute_name1 = 'TF_ FUNCTION_CODES'.
	2. Provide the status codes according to the v_attribute_name1 value in the v_attribute_value1 column where v_attribute_name1 = 'TF_FUNCTION_AND_STATUS_CODES'.
	3. Provide all status codes in the v_attribute_value1 column against each function code in the v_attribute_name1 column. This displays the dynamic status filter.
	4. Provide the code for each status to be displayed to the user for that function code in the v_attribute_value1 column.
	5. Provide the code for each status to be displayed to the user in the Transaction Summary window in the v_attribute_value2 column.
	6. Provide the code for each action that must be displayed to the user for that transaction in the v_attribute_value3 column.
	7. To create an order for the transactions, follow these steps:
	8. Update the fields in the feedback response JSON for blocked and released payments in the v_attribute_value1 column in the FEEDBACK_RESPNSE_CONFIGURATION row and restart the WebLogic server.
	9. Update the v_attribute_value1 column as Y where v_param_name = ' ECM_SANCTIONS_PP’,if ECM pack is installed in the same server where Sanctions also installed.

	C.6 TIME_ZONE Configurations Required for the dim_sanctions_status Table
	1. Create a unique value for the new PMF status in the n_sanction_status_code column. This value must be the same in the AAI_WF_STATUS_B and AAI_WF_STATUS_TL columns. For more information, see Configurations Required for the Audit Tables.<XREF>
	2. Provide the activity name as mentioned in step 4 of the Configuring the Human Task in the PMF Page <XREF>section in the v_remarks column.
	3. Provide a unique data field value in the v_applicable_params column where n_sanction_staus_key = 101 (ApplicationParams) and n_sanction_staus_key = 202 (PMFParams).
	4. To update the image path for the alert status, update the v_sanction_status_img_path value.
	5. To update the image path for the list of actions, update the v_sanction_dropdown_img_path value.
	6. To configure the action status:
	7. In the v_data_field column, give the same data field created in the PMF page data field section.
	8. Update the v_owner_update column in the fsi_rt_alerts table if the owner must be updated.
	9. Provide the audit message in the v_audit_msg column. This value must be the same as the value provided in the v_sanction_status_name column. For more information, see Configurations Required for the Audit Tables.
	NOTE
	For a new status, the v_applicable_params column must be left blank.


	C.7 Creating New User Groups
	1. Create a function.
	2. Create a role.
	3. Map the function to the role.
	4. Create a user.
	5. Map the user to a user group and a role.
	6. Map the user to a user group and a domain.
	7. Map the user to a user group.

	C.8 Other Configurations
	1. Map the group in the domain_jur_grp_map table.
	2. Login to the Config schema.
	3. Run the select * from cssms_folder_function_map query.
	4. Add the new function to the Transaction Filter folder (TransactionFiltering TFLTADMIN).
	5. Run the select t.v_access_code,t.v_menu_id from aai_menu_b t where t.v_menu_id in('OFS_TFLTSCRN','OFS_TFLT') query.
	6. Add the new function in the v_access_code column.
	7. To map the new function, add an entry in the v_access_code column in the aai_menu_b table by running a query with the entry mentioned in the following format: select * from aai_menu_b t where t.v_menu_id like '%OFS_TFLT%'; query.
	8. To map the function to a folder, run a query with the function mentioned in the following format: select * from cssms_folder_function_map p where p.v_function_code like '%TF%'; query.


	15 Appendix D: PMF Configurations for Pool of Analyst
	1. Perform the following queries and introduce new status in the following tables.
	Figure 112: Example 1
	2. Perform the following query and introduce new Outcome in both the following tables.

	Figure 113: Example 2
	3. Perform the following query and add a new entry for the new status to come up in the TF_ACTION drop-down list while adding new Application rule.

	Figure 114: Example 3
	4. Create Human task in PMF screen that you want to introduce in-between existing status or you want to introduce new status or create separate status.

	Figure 115: Activity Statuses
	Figure 116: Edit Transaction – Pending Block Recommended
	Figure 117: Edit Transaction – Recommend To Block
	Figure 118: Rule Details – Decision Rule 1
	Figure 119: Rule Details – Decision Rule 2
	NOTE
	The attribute ZP_LOGGED_USER_ACTED value is Y then the user has acted first on the POA status.
	Figure 120: Edit API Details
	Figure 121: Edit API Details – Adding Attribute Values
	5. Access for the new status (example: Pending Review (96)) should be given to TFLTANYSE in order to take/update action on events.
	6. Follow these steps:
	i. select * from setup_rt_params where V_PARAM_NAME = 'TF_FUNCTION_AND_STATUS_CODES' and V_ATTRIBUTE_NAME1 = 'TFLTANYSE';
	ii. Append V_ATTRIBUTE_VALUE3 with the newly added Pending review Status.
	iii. Example: 2,96




	NOTE
	To get the V_ATTRIBUTE_VALUE3 ; refer the dim_sanctions_status table.
	This is the Customized example for Pending Review (96) to be added manually.

	D.1 Mapping the dim_sanctions_status Table:
	Figure 122: dim_Sanctions_status Table

	D.2 Adding Data Fields to the JSON Object
	Figure 123: Applicable Params

	D.3 List of Attributes Passed to Workflow
	Table 46: SWIFT Message Types
	Attributes
	Description
	TF_ACTION
	Action to be performed.
	WF_DSNID
	Infodom value.
	WF_MESSAGE_TYPE
	Message Type.
	WF_MESSAGE_REFERENCE
	Message Reference.
	WF_USER_COMMENT
	System hardcoded comment.
	WF_APPLICATION_URL
	Application url hardcoded logic.
	TF_LOGIN_USER
	Logged in user.
	TF_FUNCCODE
	Logged in user function code.
	TF_ASSIGNEE_USER
	Logged in user.
	TF_ENABLE_FOUR_EYES_FLAG
	Y/N value based on the configuration.
	TF_CURRENCY
	Currency of the message.
	WF_OUTCOME_ID
	Outcome Id for the action.
	TF_AUTORELEASE_FLAG
	Y/N based on the configuration for the message.
	TF_AMOUNT
	Amount of the message.
	TF_WATCHLIST_TYPE
	Watchlist type of the event with maximum score of the message.
	TF_WATCHLIST_SUB_TYPE
	Watchlist sub type of the event with maximum score of the message.
	TF_MESSAGE_TYPE
	Message Type of the message.
	TF_MSG_CATEGORY
	Message Category of the message.
	TF_MSG_PRIORITY
	Message Priority of the message.
	TF_JURISDICTION
	Jurisdiction of the message.
	TF_BUSINESS_DOMAIN
	Business Domain of the message.
	TF_ALERT_TYPE
	Alert Type of the message (1 or 2).
	ZP_POOL_ANALYST_FL
	Y/N based on the configuration in setup_rt_params.
	ZP_LOGGED_USER_ACTED
	if the logged in user is the same person who performed the previous action then ZP_LOGGED_USER_ACTED = Y else its N.
	TF_GRP_MSG_ID
	Group Message Id of the message.


	D.4 Attribute to Configure the Auto Refresh in Queue Management
	Table 47: Q_AUTO_REFRESH_TIME Attribute
	Attributes
	Description
	Q_AUTO_REFRESH_TIME
	Provide the time in mille second for the attribute in CS_APPLN_PARAMS table. By default it’s 25000 i.e 25 seconds but the value is editable.



	16 Appendix E: Delta Watch List Configurations
	NOTE
	These configurations are performed when you do not want to download the full watch list, and only want to download the delta watch list. This helps to reduce the download time and is not part of the screening process.
	Figure 124: Flow for Delta Watch List


	NOTE
	You must always run the full watch list files before you run the delta watch list files. The full watch list files must be downloaded if, for example, the download of the delta watch list files has failed for multiple days. You can also run the full ...

	E.1 Configurations for the Full and Delta Watch Lists
	E.1.1 Running the Full Watch list
	1. Set the following properties in the watchlist-management.properties file:
	2. Set the following properties in the transaction-screening.properties file:
	3. Set the following properties in the transaction-screening-batch.properties file:

	E.1.2 Running the Delta Watch List
	E.1.3 Merging the Delta Watch List to the Full Watch List

	E.2 Delta Watch List Configurations for the World-Check Watch List
	NOTE
	These configurations are performed when you do not want to download the full watch list, and only want to download the delta watch list. This helps to reduce the download time and is not part of the screening process.
	Figure 125: Flow for Delta Watch List


	NOTE
	You must always run the full watch list files before you run the delta watch list files. The full watch list files must be downloaded if, for example, the download of the delta watch list files has failed for multiple days. You can also run the full ...
	E.2.1 Configurations for the Full and Delta Watch Lists
	E.2.2 Running the Full Watch List
	1. Set the following properties in the watchlist-management - TF.properties file:
	2. Set the following properties in the transaction-screening.properties file:
	3. Set the following properties in the transaction-screening-batch.properties file:

	E.2.3 Running the Delta Watch List
	1. Set the following properties in the watchlist-management - TF.properties file:
	2. To run the delta watch list without filtering, set the following properties:

	E.2.4 Merging the Delta Watch List to the Full Watch List




	17 Appendix F: Message Categories and Message Types
	F.1 SWIFT Message Types
	Table 48: SWIFT Message Types
	1
	MT101
	2
	MT103
	3
	MT110
	4
	MT202
	5
	MT202COV
	6
	MT700
	7
	MT701
	8
	MT707
	9
	MT103STP
	10
	MT105
	11
	MT111
	12
	MT112
	13
	MT190
	14
	MT191
	15
	MT192
	16
	MT195
	17
	MT196
	18
	MT198
	19
	MT199
	20
	MT210
	21
	MT290
	22
	MT291
	23
	MT292
	24
	MT295
	25
	MT296
	26
	MT298
	27
	MT299
	28
	MT300
	29
	MT399
	30
	MT400
	31
	MT410
	32
	MT412
	33
	MT455
	34
	MT490
	35
	MT491
	36
	MT492
	37
	MT495
	38
	MT496
	39
	MT498
	40
	MT499
	41
	MT536
	42
	MT590
	43
	MT591
	44
	MT599
	45
	MT606
	46
	MT607
	47
	MT671
	48
	MT699
	49
	MT711
	50
	MT720
	51
	MT721
	52
	MT730
	53
	MT734
	54
	MT742
	55
	MT747
	56
	MT750
	57
	MT752
	58
	MT754
	59
	MT756
	60
	MT760
	61
	MT767
	62
	MT768
	63
	MT769
	64
	MT790
	65
	MT791
	66
	MT795
	67
	MT796
	68
	MT798
	69
	MT799
	70
	MT802
	71
	MT895
	72
	MT896
	73
	MT899
	74
	MT910
	75
	MT950
	76
	MT995
	77
	MT996
	78
	MT998
	79
	MT999
	80
	MT107
	81
	MT204
	82
	MT416
	83
	MT420
	84
	MT430
	85
	MT516
	86
	MT526
	87
	MT581
	88
	MT592
	89
	MT608
	90
	MT705
	91
	MT710
	92
	MT792
	93
	MT801
	94
	MT900
	95
	MT320
	96
	MT604
	97
	MT605
	98
	MT732
	99
	MT740
	100
	MT940
	101
	MT942
	102
	MT985
	103
	MT986
	104
	MT890
	105
	MT895
	106
	MT896
	107
	MT899
	108
	MT900
	109
	MT910
	110
	MT940
	111
	MT942
	112
	MT950
	113
	MT985
	114
	MT986
	115
	MT995
	116
	MT996
	117
	MT998
	118
	MT999
	119
	MT102
	120
	MT104
	121
	MT200
	122
	MT203
	123
	MT456
	124
	MT708
	125
	MT321
	126
	MT540
	127
	MT541
	128
	MT542
	129
	MT543
	130
	MT544
	131
	MT305
	132
	MT396
	133
	MT568
	134
	MT596
	135
	MT696
	136
	MT304
	137
	MT350
	138
	MT362
	139
	MT566


	F.2 ISO20022 Message Types
	Table 49: ISO20022 Message Types
	1
	Pain.001.001.08
	2
	Pacs.008.001.07
	3
	Pacs.003.001.02
	4
	Pacs.008.001.02
	5
	Pacs.008.001.08
	6
	Pacs.010.001.03
	7
	Pain.001.001.09
	8
	Pacs.009.001.08
	9
	Pacs.004.001.09
	10
	Camt.050.001.05


	F.3 Fedwire Message Types
	Table 50: Fedwire Message Types
	1
	FDCTR1000
	2
	FDBTR1002
	3
	FDCTR1002
	4
	FDCTR1008
	5
	FDCTR1600
	6
	FDCTR1602
	7
	FDBTR1600
	8
	FDBTR1000
	9
	FDBTR1008
	10
	FDBTR1602
	11
	FDCTP1000
	12
	FDCTP1002
	13
	FDCTP1008
	14
	FDCTP1600
	15
	FDCTP1602
	16
	FDCKS1600
	17
	FDCKS1602
	18
	FDDEP1600
	19
	FDDEP1602
	20
	FDFFR1600
	21
	FDFFR1602
	22
	FDFFS1600
	23
	FDFFS1602
	24
	FDDRC1031
	25
	FDDRW1032
	26
	FDSVC1090
	27
	FDDRB1631
	28
	FDDRW1632
	29
	FDSVC1690
	30
	FDSVC1590
	31
	FDBTR1500
	32
	FDDRC1531
	33
	FDDRW1532


	F.4 US NACHA Message Types
	Table 51: US NACHA Message Types
	1
	IAT
	2
	CTX
	3
	BOC
	4
	RCK
	5
	POP
	6
	WEB
	7
	CCD
	8
	TEL
	9
	PPD
	10
	ARC
	11
	CIE



	18 Appendix G: Invoking the PMF Workflow from backend
	Table 52: PMF Workflow Invoking Parameters
	Parameter Name
	Parameter Description
	Object ID
	This represents the unique object ID. For Sanctions, the object ID can be alert ID or Good Guy Whitelist ID.
	Object Type
	This represents the object type for the object ID. For Sanctions, the object type will be 301 for alert and 302 for Good Guy Whitelist.
	Infodom
	This represents the name of the infodom in which Sanctions are installed.
	Segment
	This represents the name of the segment. For Sanctions, it will be TFLSEGMENT.
	User ID
	This represents the User ID that is triggering the workflow. Pass the value as SYSTEM.
	Locale
	This represents the locale. Pass the value as en_US.
	Application Params
	This represents the list of workflow data fields with their respective value.
	Security Params
	This represents the list of workflow security data fields with their respective value.


	19 Appendix H: JMS Cluster Environment Creation
	19.1 JMS Server Creation
	1. Log in to Weblogic Console.
	2. From the Domain Structure select Services, click JMS Servers from Messaging drop-down, and click New in the JMS Servers table.
	Figure 126: Weblogic Console Page
	3. In the JMS Server Properties page, enter the JMS server name in the Name field and click Next.

	Figure 127: JMS Server Properties Page
	4. In the Select Persistent Store page, select Create a New Store from Persistent Store Field to specify a persistent store for the new JMS server.

	Figure 128: Select Persistent Store page
	5. In the Select a store type page, select File Store from Type Field and click Next.

	Figure 129: Select a store type page
	6. In the File Store Properties page, enter the new file store name in the Name field and click Next.

	Figure 130: File Store Properties page
	7. In the JMS File Store Targets page, select a target as one of the named server from Target Field drop down and Click Finish.

	NOTE
	Only applications deployed to the selected servers or clusters can use the JMS file store.
	When you target all or part of the cluster, the Administration Console initiates a two-phase deployment. Two-phase deployment ensures that if the deployment fails for one active server, it fails for all active servers.
	Figure 131: JMS File Store Targets page


	NOTE
	You will receive a message on successful activation and file store creation.
	8. Select the same target name from the JMS File Store Targets page in the Target field drop down in the Select targets page and click Finish to create the JMS server and its respective file store.
	Figure 132: Select targets page



	19.2 JMS Module Creation
	1. Log in to Weblogic Console.
	2. From the Domain Structure Select Services, click JMS Modules from Messaging drop-down, and Click New in the JMS Modules table.
	Figure 133: Weblogic Console Page
	3. In the Create JMS System Module page, enter the JMS Module name as RTI in the Name field and click Next.

	Figure 134: Create JMS System Module Page
	4. Select Servers or Clusters on which you deploy the JMS system module from the Targets Field. The cluster name that was created in step 6.1.8 will be listed under IPECluster.

	NOTE
	You can configure the targets later if required.
	Figure 135: Create JMS System Module
	5. To add resources to the JMS system module and to create JMS modules check the box in the Create JMS System Module page and click Finish.



	NOTE
	You will receive message on successful creation of the JWS module.
	Figure 136: Create JMS System Module



	19.3 Sub-Deployment Creation
	1. Log in to Weblogic Console.
	2. From the Domain Structure Select Services and click JMS Modules from Messaging drop- down. The Summary of JMS Module page is displayed.
	3. Select RTI from JMS Modules table. The Settings for RTI page is displayed.
	4. Select subdeployments from the tabs.
	5. Enter the sub-deployment name as RTI Deploy in subdeployment table and click Next.
	Figure 137: Settings for RTI
	6. Select the JMS servers created previously from the JMS Servers list from the Settings for RTI Deploy page and click Save. The RTI sub-deployment is created.

	NOTE
	You can configure the targets later if required.
	Figure 138: Settings for RTI Deploy Page



	19.4 Distributed Queues Creation
	NOTE
	Queues must be created as per the IPE Configuration guide with the same naming convention. See Chapter 19.7 for information about JMS Queue creation for SWIFT, Fedwire and ISO20022 Message types.
	1. Log in to Weblogic Console.
	2. From the Domain Structure Select Services and click JMS Modules from Messaging drop- down. The Summary of JMS Module page is displayed.
	3. Select RTI from JMS Modules table. The Settings for RTI page is displayed.
	4. Click New and select Distribute Queue from Create a New a JMS System Module Resource page.
	Figure 139: Create a New JMS System Module Resource page
	5. Enter the name and JDNI name in Name and JNDI Name Fields respectively as per the IPE Configuration guide and click Next.

	Figure 140: JMS Distributed Destination Properties page
	6. Select Advanced Targeting.

	Figure 141: Create a New JMS System Module Resource page
	7. Select RTISubdeploy from the subdeployment field drop down list and select the JMS servers created. Click Finish. The distributed queue is successfully created.



	NOTE
	You will receive message on successful creation of the JWS distributed queue.
	Figure 142: Create a New JMS System Module Resource page



	19.5 Distributed Topic Creation
	NOTE
	Topics must be created as per the IPE Configuration guide with the same naming convention.
	1. Log in to Weblogic Console.
	2. From Domain Structure Select Services and click JMS Modules from Messaging drop-down. The Summary of JMS Module page is displayed.
	3. Select RTI from JMS Modules table. The Settings for RTI page is displayed.
	4. Click New and select Distribute Topic from Create a New a JMS System Module Resource page.
	Figure 143: Create a New JMS System Module Resource page
	5. Enter the name and JDNI name in Name and JNDI Name Fields respectively as per the IPE configuration guide and click Next.

	Figure 144: JMS Distributed Destination Properties page
	6. Select Advanced Targeting.

	Figure 145: Create a New JMS System Module Resource page
	7. Select RTISubdeploy from the subdeployment field drop down list and select the JMS servers created. Click Finish. The distributed topic is successfully created.



	NOTE
	You will receive message on successful creation of the JWS distributed topic.
	Figure 146: Create a New JMS System Module Resource page



	19.6 Connection Factory Creation
	NOTE
	Connections must be created as per the IPE Configuration guide with the same naming convention.
	1. Log in to Weblogic Console.
	2. From Domain Structure Select Services and click JMS Modules from Messaging drop-down. The Summary of JMS Module page is displayed.
	3. Select RTI from JMS Modules table. The Settings for RTI page is displayed.
	4. Click New and select Connection Factory from Create a New a JMS System Module Resource page.
	Figure 147: Create a New JMS System Module Resource page
	5. Enter the name and JDNI name in Name and JNDI Name Fields respectively as per the IPE Configuration guide and click Next.

	Figure 148: Connection Factory Properties page
	6. Select Advanced Targeting.

	Figure 149: Create a New JMS System Module Resource page
	7. Select the JMS Servers created and Click Finish. The Connection Factory is successfully created.



	NOTE
	You will receive message on successful creation of the JWS Connection Factory.


	19.7 JMS Queue Creation for SWIFT, Fedwire and ISo20022 Message Types
	Table 53: WebLogic JMS Queues - Field Value
	Message Type
	Queue Name
	Fields
	Name
	JNDI name
	Subdeployment
	SWIFT
	RTI Source Entity Queue
	Enter the name as RTI Source Entity Queue
	Enter the JNDI name as jms/ sourceEntityQueue
	Select the Subdeployment as RTISubDeploy
	FedWire
	RTI Source Fed Entity Queue
	Enter the name as RTI Source Entity Queue
	Enter the JNDI name as jms/ sourceFedEntityQueue
	Select the Subdeployment as RTISubDeploy
	ISO20022
	RTI Source Sepa Entity Queue
	Enter the name as RTI Source Entity Queue
	Enter the JNDI name as jms/ sourceSepaEntityQueue
	Select the Subdeployment as RTISubDeploy



	20 Appendix I: User Group Customization
	21 Appendix J: Configurations for the Bearer Token
	21.1 Generate User Password
	1. Log in as a system administrator.
	2. Click System Configuration in the Administration page and select Configure Instance Access Token. The Configure Instance Access Token window is displayed.
	Figure 1: Administration Page
	3. In the Configure Instance Access Token section, click Add. A new window is displayed.

	Figure 2: Configure Setup Access Token
	4. Enter the username in the Instance Name field and click Generate Token. The token is displayed in the Instance Access Token Details section.

	Figure 3: Generate Token Button
	5. Copy and save the text generated in the Instance Access Token Details section.

	Figure 4: Setup Access Token Details
	6. Click Close and log out as the system administrator.


	21.2 Change Token Validity
	1. Log in as a system administrator.
	2. Click System Configuration in the Administration page and select Configure System Configuration. The Configuration window is displayed.
	Figure 5: Administration Page
	3. In the Configuration window, change the token validity time in the API token validity in seconds field.

	Figure 6: Configuration window with the API token validity in seconds field shown
	4. Click Save.


	21.3 Generate Token
	NOTE
	You may use the desktop version of the Postman client to perform these steps. Postman is an open-source, collaborative platform for API development. For more information, see Postman Docs.
	You can also use any other API client, such as cURL. For more information, see REST APIs for Oracle Database.
	1. Open the Postman client and click Create a request.
	2. Select the request type as GET and enter the request URL in the following format:
	Figure 7: Request
	3. Select the Authorization menu and then select the TYPE as Basic Auth.
	4. Enter the username and password.
	5. Click Send. The token is displayed in the Response field.

	Figure 8: Response



	21.4 Send Requests
	1. Do the following configuration before sending the request using the POST request feature.
	a. Go to the path ##DOMIAN_HOME##/applications/##context.ear##/##context.war##/conf
	b. Open the RestAPIConf.properties file.
	c. Add the hostname and port values inside the RestAPIConf.properties file For Example: hostname=fsgbu-mum-239.snbomprshared1.gbucdsint02bom.oraclevcn.com port=7001

	2. Requests are sent using the POST request feature. Use the token generated to authorize the request and pass the JSON in the correct format.
	NOTE
	You may use the desktop version of the Postman client to perform these steps. Postman is an open-source, collaborative platform for API development. For more information, see Postman Docs.
	You can also use any other API client, such as cURL. For more information, see REST APIs for Oracle Database.
	3. In the Postman client, select the request type as POST and enter the request URL in the following format:
	Figure 9: Request
	4. In the Authorization menu, select the TYPE as Bearer Token.

	Figure 10: Authorization
	5. Paste the token generated in the Token field.
	6. Select Body tab and select raw.
	7. Insert the message in the text field.
	8. Click Send.

	Figure 11: Body Tab
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